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Dear Reader,

Thank you for choosing The Hidden Power of Photoshop Elements 3. This book is part 

of a new wave of Sybex graphics books, all written by outstanding authors—artists and

teachers who really know their stuff and have a clear vision of the audience they’re writing

for. It’s also part of our growing library of truly unique digital imaging books.

Founded in 1976, Sybex is the oldest independent computer book publisher. More

than twenty-five years later, we’re committed to producing a full line of consistently

exceptional graphics books. With each title, we’re working hard to set a new standard for

the industry. From the paper we print on, to the writers and photographers we work with,

our goal is to bring you the best graphics books possible.

I hope you see all that is reflected in these pages. I’d be very interested to hear your

comments and get your feedback on how we’re doing. To let us know what you think

about this, or any other Sybex book, please visit us at www.sybex.com. Once there, go to the

product page, click on Submit a Review, and fill out the questionnaire. Your input is

greatly appreciated.

Please also visit www.sybex.com to learn more about the rest of our graphics line.

Best regards,

Dan Brodnitz

Publisher
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SYBEX unless otherwise indicated and is protected by copyright to SYBEX or other copyright owner(s) as indicated in the media files (the

“Owner(s)”). You are hereby granted a single-user license to use the Software for your personal, noncommercial use only. You may not repro-

duce, sell, distribute, publish, circulate, or commercially exploit the Software, or any portion thereof, without the written consent of SYBEX

and the specific copyright owner(s) of any component software included on this media. ■ In the event that the Software or components

include specific license requirements or end-user agreements, statements of condition, disclaimers, limitations or warranties (“End-User

License”), those End-User Licenses supersede the terms and conditions herein as to that particular Software component.  Your purchase,

acceptance, or use of the Software will constitute your acceptance of such End-User Licenses. ■ By purchase, use or acceptance of the Software

you further agree to comply with all export laws and regulations of the United States as such laws and regulations may exist from time to time.

Software Support Components of the supplemental Software and any offers associated with them may be supported by the specific

Owner(s) of that material, but they are not supported by SYBEX. Information regarding any available support may be obtained from the

Owner(s) using the information provided in the appropriate read.me files or listed elsewhere on the media. ■ Should the manufacturer(s) or

other Owner(s) cease to offer support or decline to honor any offer, SYBEX bears no responsibility. This notice concerning support for the

Software is provided for your information only. SYBEX is not the agent or principal of the Owner(s), and SYBEX is in no way responsible for

providing any support for the Software, nor is it liable or responsible for any support provided, or not provided, by the Owner(s).

Warranty SYBEX warrants the enclosed media to be free of physical defects for a period of ninety (90) days after purchase. The Software

is not available from SYBEX in any other form or media than that enclosed herein or posted to www.sybex.com.  If you discover a defect in the

media during this warranty period, you may obtain a replacement of identical format at no charge by sending the defective media, postage

prepaid, with proof of purchase to:

SYBEX Inc.
Product Support Department
1151 Marina Village Parkway
Alameda, CA 94501
Web: http://www.sybex.com

After the 90-day period, you can obtain replacement media of identical format by sending us the defective disk, proof of purchase, and a check

or money order for $10, payable to SYBEX.

Disclaimer SYBEX makes no warranty or representation, either expressed or implied, with respect to the Software or its contents, qual-

ity, performance, merchantability, or fitness for a particular purpose. In no event will SYBEX, its distributors, or dealers be liable to you or any

other party for direct, indirect, special, incidental, consequential, or other damages arising out of the use of or inability to use the Software or

its contents even if advised of the possibility of such damage. In the event that the Software includes an online update feature, SYBEX further

disclaims any obligation to provide this feature for any specific duration other than the initial posting. ■ The exclusion of implied warranties is

not permitted by some states. Therefore, the above exclusion may not apply to you. This warranty provides you with specific legal rights; there

may be other rights that you may have that vary from state to state. The pricing of the book with the Software by SYBEX reflects the allocation

of risk and limitations on liability contained in this agreement of Terms and Conditions.

Shareware Distribution This Software may contain various programs that are distributed as shareware. Copyright laws apply to

both shareware and ordinary commercial software, and the copyright Owner(s) retains all rights. If you try a shareware program and continue

using it, you are expected to register it. Individual programs differ on details of trial periods, registration, and payment. Please observe the

requirements stated in appropriate files.

Copy Protection The Software in whole or in part may or may not be copy-protected or encrypted.  However, in all cases, reselling or

redistributing these files without authorization is expressly forbidden except as specifically provided for by the Owner(s) therein.
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Foreword

Some of the best friendships are often unexpected. About three years ago I

posted a note to a Photoshop forum hosted by Richard Lynch. After a bit of conversing I

realized that not only did this guy know his way around Photoshop, but he’s a heck of a

nice guy to boot. I’m pleased to call Richard not only my peer, but my friend as well. ■ I

have to admit, I used to be a Photoshop purist. I was one of those people who scoffed at

the idea of any software being worth its salt against the Big Daddy. Imagine my disbelief

when Richard asked me if I’d ever consider teaching or writing about Photoshop Ele-

ments. But with a little effort, Richard eventually opened my eyes to the fact that Photo-

shop Elements is an incredibly powerful and capable program. ■ Photoshop Elements has

the functionality to edit and create professional images and graphics. And with the new

features in Photoshop Elements 3, it’s even easier for users to achieve corrections and

manipulations that at one time only Photoshop could do. ■ As I learned, the potential of

Elements may not be immediately obvious, and that is where Richard’s book steps in. The

Hidden Power of Photoshop Elements 3 reveals capabilities you might never know existed in

the software. It also provides Richard’s power-boosting tools that further shorten the list

of things Elements “can’t do.” ■ If you haven’t already, BUY THIS BOOK. I stand by my

assessment that there is no other person on the planet who knows Photoshop Elements

like Richard does. Once again he converts a kid’s bike into a Harley: He takes Elements, a

very affordable piece of software, and shows how it can tackle tasks just like its big brother

Photoshop. Other books give you the basics; this book gives you both the tools that help

make your images look great and the skills to use those tools. With Richard Lynch leading

the way, you’ll be a pro in no time.

—Al Ward, certified Photoshop addict, author,

and trainer; webmaster, Action Fx Photoshop

Resources (http://actionfx.com); author,

Photoshop for Right Brainers: The Art of Photo

Manipulation, Al Ward’s Photoshop Produc-

tivity Toolkit: Over 600 Time Saving Actions,

Photoshop Elements 2 Special Effects
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Introduction

I’d been a photography-book editor, digital retoucher, and Photoshop author for

10 years, using Photoshop as my primary image-editing tool, when someone asked me to

look at Photoshop Elements for the first time. I was a little reluctant, having heard it was

nothing but a dumbed-down version of Photoshop. I expected that I wouldn’t find it very

interesting and I’d just be wasting my time. From what I understood, the tools I used all

the time were missing, including channels, Curves, masking, CMYK tools, and Blend If. I

was pretty sure I’d never be able to take the program seriously.

It just goes to show: Never judge a book by how someone else describes the cover.

Instead of being bored with the simplicity of Photoshop Elements, I became fascinated

by the possibilities. After toying with Elements for only a few minutes, the program and the

possibilities piqued my interest—it seemed there was more to Elements than I’d heard, and

it seemed like a pretty powerful program. I continued to explore the program, and within a

few days I had discovered ways to either use or imitate every feature I’d heard was missing.

Elements could do a lot more than most people thought, and more than even the manufac-

turer let on. It got to the point where I began wondering what Photoshop Elements couldn’t

do, rather than worrying about what the differences were between this program and Photo-

shop. I looked around to see if there were other sources that said the same thing, and I

couldn’t find any. It was then that I realized that I should write a book to tell about what I’d

learned and show what Elements could really do.

Since I started working with Elements, one idea became clear to me: fancy tools can

actually stand in the way of learning. You don’t learn much by pressing a button—no

matter how sophisticated the button is. Some tools in image editing programs help you

forget about fundamentals entirely, and can isolate you from the process. You end up

pressing buttons and not really understanding what is going on. For example, ask almost

anyone (who hasn’t read this book) to make an RGB separation without using channels.

This is something that anyone serious about image editing should understand conceptu-

ally and be able to do, because it is fundamental to working with and displaying the

image. Yet many of the most experienced digital professionals wouldn’t be able to do it.

Knowing how components separate offers a whole different historical and scientific basis
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for evaluating, altering, and correcting digital images and color. And understanding how

to separate components provides a solid foundation for understanding the way images

are created and stored—on film and digitally. That is why this book not only gives you

tools that simplify complicated processes, but it explains exactly how each works, step-

by-step. I have found that understanding the process is a better, more fundamental, way

to look at and understand images from the ground up.

I learned a lot in the process of discovering Elements, and as a result I’ve gone back to

the fundamentals of working with images. I wrote The Hidden Power of Photoshop Ele-

ments 2 to capture that discovery in hopes of helping other users understand the power of

the program and what they can do with digital images. Now, in The Hidden Power of Pho-

toshop Elements 3 the goal is to clarify and expand on that first attempt based on the feed-

back I received, as well as create a toolset compatible with the changes in the Elements

program and interface. Both books free up powerful image properties and provide tools

for users that help make Elements a serious professional image-editing tool.

As a 12+ year veteran of digital image editing, I use Elements every day for even the

most challenging image-editing projects. With the addition of 16-bit support and the abil-

ity to import RAW files, there is really almost nothing that Elements can’t do. This book

shows you how.

What Makes a Good Image?
Photoshop Elements gives you the power to alter any pixel in an image. You can techni-

cally do anything. Like a brick-worker building a building, you can get in and create your

image one pixel at a time to get exactly what you want. If you know what you like and

what you don’t, it should be easy to improve and create images. Just look at the image or

canvas and know what you want to see. Once you know—and can trust—what you want

to see on-screen, all you have to do is make whatever changes are necessary so that your

image looks the way you imagine it. The whole process should be simple, right? Just click a

button and fix it; then print and be done with it.

But it isn’t always that easy.

The problem starts because of numbers and possibilities. There can be millions of pix-

els in an image. Each pixel can be one of millions of colors. Every pixel can be altered with

numerous tools and options in groups or separately, with changes based on surrounding

pixels or considered on a pixel-by-pixel basis. The color and tone of each pixel has to be
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orchestrated to work together with other pixels adjacent to it to form a recognizable

whole. When you are finished, that whole has to look as you imagined it. Getting that pic-

ture out of your imagination certainly isn’t as easy as taking a picture. And building

images one pixel at a time overcomplicates the problem of creating what you want to see.

Not knowing where to start and what tools to choose just makes the process of working

with images that much more difficult.

You have to simplify the approach.

Elements gives you what is potentially a big heavy tool box. Some people blindly fall

into a trap, thinking they have to understand and use every tool, filter, and effect, and

strap all those tools to their tool belt in order to be able to use the program efficiently or to

do anything the “right” way. There are two things wrong with that idea:

• You don’t need to know how to use every tool, filter, or effect; you just need the right

ones. There are probably many tools (and shortcuts!) that you never use.

• There isn’t really a right way and a wrong way; there are harder and easier ways, and

ways that are more and less effective.

In Elements there are numerous tools. Not all are essential, some are redundant, some

are merely toys, and some are gimmicky, trendy, or unpredictable. While almost all have

their place when you get to know them, the ones that are the most powerful, most useful,

and most often used—just like the hammer and screwdriver in a carpenter’s tool belt—are

often not the most spectacular.

A few others have to be coaxed out of hiding, which is part of what the Hidden Power

title is all about, and some of what the book will do for you.

Not everything that makes an image look better requires a lot of creativity. There are

techniques you can use to make an image look better that require very little thinking at all.

In fact, much of the initial process of image correction should be nearly automatic. If there

is a dust speck in a scan, you’ll need to remove it; if color correction needs to be done,

you’ll need to correct it. Although there are several ways to approach making any change,

if you have a few favorite tools and techniques, the process of correction becomes much

simpler.

In other words, applying a somewhat limited number of tools and techniques can get

you most of the effects you will ever need to improve your images. Using what you have in

an image and making the most out of that is often key to getting the best results. Some of
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the most helpful and powerful information in images is hidden or ignored. This book

helps reveal that image content and simplifies the tools you will need to use and apply.

With fewer tools (and rules) to remember, you can concentrate on what to do with the

images rather than pondering options or quizzing yourself as to how to apply the tools.

Using image content to leverage selective changes can help target corrections in ways that

freehand work nearly never will. It is a fundamental approach. By using fewer tools, you

won’t be weighed down by the heavy tool belt. Concentrating on a smaller set of tools and

using a structured approach will simplify the corrections you make in any image.

But What Corrections Do You Make?
Say you go to the airport to pick up your cousin who has been in the African jungles for a

decade. No one has seen him in all that time, let alone seen the talking monkeys he was on

the trail of. It sounds like a great photo opportunity, so you grab your camera and head

out the door.

You meet him at the airport gate and take some snapshots of him all haggard and

weather-beaten from his grueling years living in nature. He looks fresh out of National

Geographic.

Later, when you open the images on your computer, they seem to have come out pretty

well. But the first thing you probably won’t do in this situation is add an effect that sets his

head on fire. Besides occasionally applying a special effect, the biggest wow you can get

from your images will usually be achieved by

• Taking a good picture that clearly shows an interesting subject

• Using targeted corrections to make those images look the best you can

Most people viewing your picture will want to see the subject of your image, and you

can’t get that by burying the subject in flames. Special effects have their time and place,

but when the subject and image can be good enough on their own, you can do more to

improve the look of your photographic images with good corrections. The idea behind

this book is to give you a from-the-ground-up method not only for making better images

by correction, but also for understanding what makes a better image in the first place. You

will find the hidden power not only in Photoshop Elements, but also in your subjects and

images. The goal of this book is to make people viewing your images say “Wow!” not in

response to flames or other effects or magic, but because your images look great.
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Much of what used to be my standard process in image correction has been rearranged

because of my experience with Photoshop Elements. The result is that my process is now

simpler and my images have changed for the better. That was a somewhat shocking

change to have happen after 10 years of experience editing digital images. It was like a car-

penter looking at his hammer and suddenly realizing that it actually had two sides and

could do more than just bang the nails in. The more shocking thing is that the techniques

you’ll read about in The Hidden Power of Photoshop Elements 3 tear down the wall of dif-

ference between Photoshop and Elements. I use the same techniques in both programs

these days, and—except for a few differences in the interface—I often forget which pro-

gram I’m in. The most obvious fact is that it doesn’t matter, but the hidden fact is that I

learned my current techniques from Elements, not Photoshop. Using the techniques in

this book, you won’t often be left using Elements limply and apologetically, as if you were

banging in screws with your hammer; you’ll be using a regular screwdriver—the proper

tool—to fasten your screws.

The Goal of This Book
The goal of The Hidden Power of Photoshop Elements 3 is to take apart the process of correct-

ing images and the images themselves. You’ll learn professional corrections that can be

applied with simplicity, and you’ll become familiar with the powerful tools you need to know

and how they apply to any image. This dissection of process and getting back to fundamentals

starts immediately by looking at an essential toolset. The dissection of images starts by look-

ing at tone and separating color into tone before color correction or editing. There can be

millions of colors in an image, but there are only 256 grayscale tone levels in a single 8-bit

color component…and that number is much easier to handle. Grayscale tone is the essence

of color and content—and creating a better image starts from that simple representation.

This book is for

• The serious Photoshop Elements user who may feel they are outgrowing or could get

more from the program

• Photographers moving into digital imaging who need powerful tools for image

correction

• Graphics professionals who thought their only choice for working with digital images

was Photoshop

• Anyone who wants to make their images look better
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The focus of the book is on

• Learning a process of approaching images with proven methods and the right tools to

make your image corrections

• Learning new tools that Elements supposedly doesn’t have to bolster your editing

arsenal

• Working through what you need to do in realistic situations with realistic images by

using realistic expectations to get real results

The book is not about

• Exploring every last tool in the interface in excruciating detail

• Making crazy effects

The techniques provided here will help you take your corrections to a professional level

without hocus-pocus or steps that are impossible to comprehend. It will reveal how to do

many things that are generally thought to be impossible using Elements, such as using

Curves and channels, implementing duotones, working in CMYK, and applying image

snapshots. The solutions are used right in Photoshop Elements—with no plug-ins, addi-

tional investment, or other programs to learn. You’ll see what happens behind the scenes

in step-by-step procedures, and you’ll be given the tools—customized Hidden Power

tools created just for this book—to move through those steps quickly. Though created for

this book, the tools will work with any image. These tools empower you to make the most

out of Photoshop Elements, and they can be found nowhere else but in this book.

How This Book Is Organized
As you go through the book you will discover a mixture of practical theory, examples of

the types of changes you’ll make in images, and projects to work on to help you under-

stand the process as well as why it works. Projects are put together so that you don’t just

complete an exercise or press a button and ogle the result, but so that you see what goes

on behind the scenes to help understand what you have done. When you understand,

you can apply that understanding to other images predictably—either by using tools pro-

vided to drive a process, or by manually applying learned techniques. There are clear

goals from the outset of the procedures, and the examples provided ensure that you can

see the change when they have created the desired result. This understanding will enable
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you to apply the techniques you learn to other images so that your images can be

improved consistently.

You will learn to take apart image color and tone entirely by using several color-

separation methods, and to isolate color components, image objects, and areas in a num-

ber of different ways. When you can isolate colors and image areas, this enables you to

correct those areas separately from the rest of the image and exchange, move, and replace

elements to make better images. After images are corrected and manipulated, you will

learn about options for output, including making custom separations to CMYK and duo-

tones. The section on the Web includes everything from how to include your images on a

web page to creating animation and rollover effects. Hidden Power tools are introduced

throughout to reveal functionality and simplify procedures.

Chapter 1: Essentials of Images and Image Editing In this chapter you’ll learn the basic con-

cepts for simplifying your approach to images and corrections. First you’ll learn the basic

procedure as a step-by-step process for approaching any image manipulation. Then there

is a listing of tools you’ll need in different stages of correction and a breakdown of what

you want to use them for. You’ll also learn all the background you need for understanding

the nuts and bolts of your images—not the mathematics and obscure calculations, but the

solid theory at the bottom of what you see and how that translates to digital images on

your computer.

Chapter 2: Separating Image Components This book is not mostly black-and-white by

accident. The raw fact is that color in digital images is stored as a tonal representation 

of color light components. To make good corrections and manipulations, it is best to

become an expert in extracting and working with tone. You’ll see how to split color into

simpler tonal representations, and we’ll look at how black-and-white tone can become

color again.

Chapter 3: Correcting Image Tone Tone is integral to implementing color and making

effective color changes. Understanding how to work with tone can make a big difference

in the color results. We’ll look at doing minor cleanup, evaluating images, and adjusting

tone with Levels, Curves, basic sharpening, and advanced masking to isolate image areas.

Chapter 4: General Color Correction: Applying Levels and Curves Levels and Curves correc-

tions learned in tonal correction in Chapter 3 are applied to color images to show how
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general corrections of tone and color parallel. You’ll see the advantages of both tools in

color correction and work through specific examples applying each tool.

Chapter 5: Specific Color Enhancement Once you’ve completed general color correction, it

is time to get into more selective color corrections. Changes can be initiated by special

controls inherent in specific tools, or combined to produce highly targeted and effective

results. This chapter introduces color range, color-specific masking, history application,

duotoning, channel mixing and calculations, CMYK, and controlling printed results.

Chapter 6: Altering Composition Similar to how you can take apart image color, you can

extract image elements from an image and then replace, adjust, or remove them. This

gives you control over image composition by giving you control of all the objects in an

image.

Chapter 7: Reshaping Image Elements With image elements separated and corrected, you

are free to reshape, redesign, and repurpose image parts. Creating new objects is some-

times a good solution for correcting problems, and it brings together many of the tech-

niques you’ve learned to this point. You’ll learn to manipulate tone and color to create

object shape and depth and work through an example to create an image object entirely

from scratch.

Chapter 8: Vectors Vectors provide another way to control image content, which can be

valuable in making resolution-independent, scalable artwork and using printer capabili-

ties to their fullest extent. Do more of the impossible by creating and storing your own

custom shapes and applying clipping paths.

Chapter 9: Options for Printing More options exist for printing than just working with

your inkjet printer at home. In this chapter, we look at how to get the best results at home,

in addition to other options that may be more attractive and less costly than you think.

Learn how to print to the edge of the page and get real CMYK prints from your custom

separations.

Chapter 10: Creating and Using Web Graphics Web graphics generally follow the same

steps for creation as regular images, but some special attributes keep them distinct from

images you use in print. Learn to get your images into a web page, and also how to imple-

ment a rollover and create image animation.
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The Hidden Power Tools
One of the most important parts of this book is the collection of Hidden Power tools pro-

vided on the CD. The tools are meant for readers of this book only and should not be

shared freely. Tools must be installed into Photoshop Elements to be accessible.

To install the tools, first locate the proper Hidden Power installer for your computer

system platform on the CD. Installers are supplied for both Macintosh and Windows for

Photoshop Elements 3. Tools have not been tested on earlier versions of Elements. After

you have chosen the installer for your operating system, initiate the installation by double-

clicking the installer. Target the installation by choosing the Elements program folder

when prompted; be sure to carefully read the instructions as they appear on-screen. You’ll

need a password for the installation, and these are provided here:

Operating System Installer Password

PC/Windows HpforPE3.exe hiddenpower3

Macintosh Hidden Power for Elements 3 hiddenpower3

If you have any trouble with the tool installation, please read the troubleshooting file

on the CD, and visit the hiddenelements.com website for information that becomes avail-

able after publication.

After you’ve installed the tools, you’ll be able to access them in the Styles and Effects

palette. Open the Styles and Effects palette by choosing Styles and Effects from the Win-

dow menu (Windows users should be in the Image Editor rather than Organizer). With

the Styles and Effects palette on-screen, choose Effects from the drop-down list at the top-

left of the palette—this will populate the effects categories in the drop-down list on the

right. Choose the Power categories (PowerSeparations, PowerTools1, PowerTools2, and

PowerBonus) to reveal the power tool listings. The use of most of the tools is discussed in

the book. The bonus tools are extra tools. These are described in the readme file for the

tools on the CD and can be discussed on the forum for the book (visit the website for the

forum link: www.hiddenelements.com).

These Hidden Power tools will enable you to access additional tools for Elements such

as Curves or Color Balance, and they will condense some of the longer step-by-step proce-

dures you’ll learn in the book into clicks of the mouse. I expect to expand on these tools

even more after the release of this book. Check the website and newsletter for additions

(you can subscribe to the newsletter from the website).
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Practice Image Files
All images used as practice files in the book are provided on the accompanying CD so that

readers can work along with the exercises. They are Mac- and Windows-compatible and

are provided in common formats supported by Photoshop Elements. These images are for

educational purposes only and should not be used freely elsewhere.

Compatible with Windows and Macintosh
Just as Photoshop Elements and the Hidden Power tools work on both Macintosh and Win-

dows operating systems, the book always gives shortcuts for both so that users on either plat-

form can successfully use the book and techniques. The standard notation for shortcuts

gives Mac and Windows keys at the same time: Mac / Windows + keystroke. For example,

Command/Ctrl+O will open an image, that is, use Command+O on a Mac, and Ctrl+O on

a PC. The following table of keyboard equivalents will cover almost any situation:

Macintosh Windows Example

Shift Shift Shift+X

Option Alt Option/Alt+X

Command Ctrl Command/Ctrl+X

Control+click Right-click Control+click/right-click

When three or more keys are required, the Mac and PC keystrokes are included in their

entirety. For example, stamping visible content to the currently active layer is the rather

extended shortcut: Command+Option+Shift+E / Ctrl+Alt+Shift+E for Mac / PC.

Going Further with Hidden Power
There are several ways that you can contact me via the Internet. I am interested in your

questions and comments as a means to improve the book in the future, to put frequently

asked questions to rest, to develop new tools, and to correct any typos or other errors that

When following along with the book’s step-by-step instructions, use the methods suggested

in the steps for accessing the tools, or procedures may not function correctly. For example,

opening Levels with the keyboard shortcut (Command/Ctrl+L) will open the Levels dialog

box but will not produce an adjustment layer, and this can affect the outcome of a procedure

that depends on the adjustment layer being created.
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may have slipped in when I wasn’t looking. Use rl@ps6.com or thebookdoc@aol.com to con-

tact me directly. Depending on volume, I’ll respond personally to e-mail as often possible,

and I look forward to your input. Frequently asked questions will be answered in the Hid-

den Power of Photoshop Elements Newsletter. Additional information can be found on the

website for the book or the Sybex website.

The Hidden Power Websites
I’ve set up a website with more information about the book at www.hiddenelements.com.

The site includes information for readers, including links to the newsletter, additional

tools, tutorials, a forum, and a contact page where you can enter comments, questions,

and other feedback.

Sybex also strives to keep you supplied with the latest tools and information you need

for your work. Please check their website at www.sybex.com for additional content and

updates that supplement this book. Enter the book’s ISBN, 4385, in the Search box (or

search for lynch), and click Go to get to the book’s update page.

The Hidden Power Newsletter
The Hidden Power of Photoshop Elements Newsletter keeps you up to date on any changes,

notifies you of any tools I’ve made available, and answers frequently asked questions. I

send the newsletter to all subscribers; the frequency of the newsletter depends on the vol-

ume of questions. All you have to do is subscribe by submitting your e-mail address to get

it. You can sign up at the Hidden Power site: www.hiddenelements.com. Subscription is free,

and the newsletter is available to anyone who wants to join.

Hopefully you see from all this that I don’t plan to leave readers stranded in deep water.

If you have questions about the book, tools, or installation, contact me by e-mail or in the

forum; other people will have those same questions, too, and I’ll be glad to answer them as

time allows.

Now let’s get on with uncovering the Hidden Power of Photoshop Elements.
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Part I
Preparation and Concepts for
Serious Image Editing

Serious image editing requires serious preparation. Problems in

your images that you can ignore when you are just starting out

become far more important as you gain experience editing.

What you don’t want to do when you work on images is spend

hours correcting something that would have taken moments to

fix at the time of capture. So your first task in working with any

image should be to always take the time to capture the best

image information that you can. Get the best capture as a photo

or scan, instead of one you will just plan to fix later. The better

the information you start with, the more likely you’ll have what

you need to make the best result.

Capturing the best information and getting the best results

require understanding the images themselves and how image

information is retained and displayed. Before getting into image

editing, there are some concepts that must be clear. Understand-

ing these concepts and setting up images correctly can help you

bring the right information into Photoshop Elements, optimize

image processing, and develop an approach to the processing

itself. This part of the book lays the groundwork you’ll need for

stepping into more advanced concepts.

Chapter 1 Essentials of Images and Image Editing
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Chapter 1
Essentials of Images and Image Editing

There are really only a few types of change that can be made in an image, and they revolve

around altering content. You choose the tools to use and then work with tone and color to

change the composition. That’s it. If your process covers tool selection, color correction,

and composition changes, you are doing what you should for every image.

Following a process and understanding the possibilities gives you a solid foundation to

work from. Although the actual changes for each image may be very different, you can use

the same set of tools and the same editing process just about every time. The purpose of

this chapter is to outline the process and concepts for you. With this foundation, you can

then jump into making your images better.

The Image Editing Process

The Tools You’ll Need

Basic Concepts of Tone, Contrast, and Color

Understanding and Using Color Management

Resolution

Knowing Your Equipment and Images
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The Image Editing Process
When you go on a vacation, it is a good idea to make a checklist to help you remember

everything you have to do before you go and everything you want to bring along. When

approaching image correction, a checklist can help ensure that you’ve covered all the

essentials. The list should cover everything you will have to do to an image, and you’ll

want to do the steps in a particular order until you develop your own preferences and

methods.

The process that follows is one that I have developed over many years of working with

digital images, and it covers all the steps you will need to take in correcting images. For

some images you’ll skip a step, and for others you might spend hours indulging one step

or another. During the process of correction, you will generally want to work from global

changes down to smaller and more specific changes.

The steps come in three parts:

Preparation Be sure your system and program setup are correct and that you know what

you want to do with the image.

Correction Take specific steps to achieve your goals in correcting the image.

Purposing Finalize the image to target it to specific output.

Image Correction Checklist
Each set of steps in the image editing process is outlined in the following checklist. Con-

sider this checklist your plan for editing images. It is the roadmap that all of the technique

covered in the following chapters falls into.

Preparation

1. Be sure that your monitor is calibrated and that you have set up your preferences and

tested your output. Doing so ensures your best chance of getting the results you

intend. (See “Understanding and Using Color Management,” later in this chapter.)

2. Store the original image file safely and work with a copy to do all of your image edit-

ing. If any step goes awry, you will want to be able to return to the original image to

start over, or you may want to repurpose the original in the future.

3. Consider resolution and color. Have in mind a target range for the resolution and a

color mode for the final image. You may work at different resolutions and in differ-

ent color modes throughout, but knowing what you need from the outset can help

you work smarter, with fewer color conversions (which you generally want to try to

4 ■ chapter 1: Essentials of Images and Image Editing
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avoid). See “Types of Color” and “What Image Resolution to Use,” later in this

chapter.

4. Evaluate the image. This analysis can include looking at color and tone, determining

the image type (high-key, low-key, high contrast), evaluating the extent of work to 

be done, and considering the composition. The result of the evaluation should be a

short list of things you want to improve or change. See “Evaluating Image Tones” in

Chapter 3.

Correction

5. Make general color and tonal corrections. Be sure to make a good general correction

at this point, but don’t spend a lot of time getting it exact. A good general correction

will point out some flaws that may otherwise lurk in the image until later in the

process. While it isn’t bad to double back during the process, it can unnecessarily

increase the amount of time you spend on images. See “Redistributing Tone with

Levels” and “Snapping and Fading Contrast with Curves” in Chapter 3 and “Levels

Correction for Color” and “Curves Correction for Color” in Chapter 4.

6. Make general damage corrections, such as eliminating dust from scans, fixing cracks

and holes in scanned images, and reducing digital noise. See “Doing Minor Cleanup

First” in Chapter 3 and “Minor Cleanup for Color Images” in Chapter 4.

7. Make more involved color correction. This means do more intensive tonal and color

adjustments, but not spot adjustments (using selection or masking). Those correc-

tions will come later. See “Snapping and Fading Contrast with Curves” in Chapter 3

and “Curves Correction for Color” in Chapter 4.

8. Crop and size the image so that you are working with only the image area you really

need. See “Cropping as a Tool for Composition” in Chapter 6.

9. Make major specific compositional changes and corrections, including replacing

parts of the image with replacement parts you have created. This is the final composi-

tional change. See Chapters 6 and 7.

10. Make targeted color and tonal corrections to selected parts of the image. You’ll revisit

techniques from Chapters 1 through 7 to select and mask changes to specific areas of

an image. Chapter 5 might hold the most to mine in this step.

11. Make final fine-tuning adjustments to sharpening, contrast, and brightness.

12. Save the layered RGB version of the image. Be sure to give the file a new name, so you

do not save over the original.

the image editing process ■ 5
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Purposing

13. Simplify the image as appropriate. This step may include flattening the image or

merging layers, altering the color mode, or removing extraneous image information.

14. Make final color and tonal adjustments to optimize the image for output and use.

This step can include such changes as setting white and black points and making

device-specific color changes. See suggestions in Chapter 9, “Options for Printing.”

15. Save the image in output file format.

16. Package the image for output and use.

This checklist may seem long, but each step will often not be very involved. Some steps

you will do naturally, and some take just a moment. Practicing correction by following the

steps in the list can ensure that you make all adjustments and corrections that you intend

to in achieving your goals for the image. The tools to use in each of these steps are

reviewed in the next section. While this provides a solid process, using the process cor-

rectly depends on how well you understand your images. The sections that follow the

checklist provide the fundamentals you need to use the process.

The Tools You’ll Need
In each step of the image editing process, you can use a small subset of the tools and com-

mands in Elements to accomplish your goals. Having a list of these tools helps you know

what tools to concentrate on and master, while leaving other tools safely behind. Concen-

trating on the smaller tool set will help streamline your image processing and keep you on

target during the editing process.

The tool set listed in Table 1.1 is based on the steps described in the preceding section.

Most of these tools are standard tools you already have in Photoshop Elements; others are

add-ins you will find on this book’s companion CD. These “Hidden Power tools” can

simplify processes or add new functionality to Photoshop Elements. See the “Hidden

Power Tools” section of the book’s introduction for instructions on how to load and

access these tools.

You may occasionally reach outside this suggested tool set for a special purpose, but

this listing offers a general guideline to simplifying the tools needed to get excellent and

consistent results. The choices are based not on which tool is easiest to use, but on which

will provide the best results.

Don’t delete or merge shape layers that may be important to your output.
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P R O C E S S  S T E P T O O L U S E  T H I S  T O O L  T O  D O  W H A T ? L O C A T I O N

Adobe Gamma is on
your computer’s Con-
trol Panel or the Pho-
toshop Elements CD.
Display Calibrator
Assistant can be found
in the Displays System
Preferences by clicking
the Calibrate button
under the Color tab.

Save As File ➔ Save As

New File ➔ New

Image Size Image ➔ Resize ➔

Image Size

Mode Image ➔ Mode

Eyedropper Eyedropper tool in the
toolbox

Info palette Display sampled readouts. Window ➔ Info

Histograms Image ➔ Histograms

Levels Enhance ➔ Adjust
Brightness/Contrast ➔

Levels

Levels Enhance ➔ Adjust
Brightness/Contrast ➔

Levels

Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Clone Stamp Clone Stamp tool in
the toolbox

Healing Brush Healing Brush in the
toolbox

Masking Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Continues

Customize selections by using
masking.

Make smart brush-style corrections
via sampling of other image areas.

Make brush-style corrections via sam-
pling of other image areas.

6: Make general
damage corrections.

Adjust tonal levels and balance color
as a process.

Basic Color
Correction

Reduce color noise associated with
digital capture.

Reduce Color
Noise

Use simple sliders to adjust tonal
dynamic range.

5: Make general
color and tonal
corrections.

View image histograms as part of the
Levels dialog box display.

View a chart and statistics showing
tonal mapping of the image.

Sample to check color and tone val-
ues in specific image areas.

4: Evaluate the
image.

Use equipment settings to adjust
image color and resolution at capture.

Scanner or
digital camera

Change the image color mode of an
open image.

Change the size and resolution of an
open image.

Set the color, size, and resolution to
use for new images.

3: Specify resolution
and color settings.

Save your image with a specific name
and location.

2: Store the origi-
nal image.

Do free, easy monitor calibration and
ICC profile generation in one process.

Adobe Gamma
(PC) or Display
Calibrator Assis-
tant (Mac)

1 : Calibrate the
monitor.

Table 1.1

Tool Set

the tools you’ll need ■ 7
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Continued

P R O C E S S  S T E P T O O L U S E  T H I S  T O O L  T O  D O  W H A T ? L O C A T I O N

Copy Edit ➔ Copy

Paste Edit ➔ Paste

Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Separations category

Curves Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Hue/Saturation Layer ➔ New Adjust-
ment Layer ➔ Hue
Saturation

Color Balance Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Crop Crop tool in the 
toolbox

Image Size Image ➔ Resize ➔

Image Size

Polygonal Lasso tool
in the toolbox

Masking Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Copy Edit ➔ Copy

Paste Edit ➔ Paste

Transform Reshape an isolated object. Image ➔ Transform

Guides Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools2 category

Add Noise Filter ➔ Noise ➔ Add
Noise

Continues

Roughen up tones that are unnatu-
rally smooth.

Place nonprinting edges for 
alignment.

Paste a copied area from the clip-
board into a new layer.

Copy a selected image area to the
clipboard.

Customize the visibility of layered
image parts and control the intensity
of selections.

Select regular and irregularly shaped
image objects.

Marquee and
Polygonal
Lasso

9: Make specific
compositional
changes.

Change the physical dimension
and/or number of pixels in an image.

Change the image size by cropping
out or adding extra canvas area.

8: Crop and size
the image.

Adjust color by balancing the influ-
ence of color opposites.

Adjust color by using slider controls
to alter hue, increase/decrease satura-
tion, and affect general lightness and
darkness.

Make custom multirange adjustments
to tone, contrast, and color by using
one of the most powerful correction
tools.

Split images into component colors
and tone (channels) to simplify and
target adjustments.

Luminosity
and Color,
RGB, and RGBL
separations

7: Make advanced
color corrections.

Paste a copied area from the clip-
board into a new layer.

Copy the selected image area to the
clipboard.
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Continued

P R O C E S S  S T E P T O O L U S E  T H I S  T O O L  T O  D O  W H A T ? L O C A T I O N

Gaussian Blur Filter ➔ Blur ➔ Gauss-
ian Blur

History Brush Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Gradient Map Layer ➔ New Adjust-
ment Layer ➔ Gradient
Map

Masking Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Blend Mask Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Unsharp Masking Filter ➔ Sharpen ➔

Unsharp Mask

12: Save the image. Save As Save with a new filename. File ➔ Save As

Merge Layers ➔ Merge
Linked, Layers ➔
Merge Visible, 
Layers ➔ Merge Down

Flatten Layers ➔ Flatten Image

Text To Shape Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools2 category

Mode Convert to final color space. Image ➔ Mode

Levels Make final adjustments to tone. Enhance ➔ Adjust
Brightness/Contrast ➔

Levels

Blend Mask Adjust white point. Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power-
Tools1 category

Continues

14: Optimize the
image for final out-
put and use.

Globalize type handling by convert-
ing type to vector layers.

Remove extra layers and image con-
tent when there are no vector layers
to preserve.

Remove extra layers and image con-
tent when there are no vector layers
to preserve.

13: Simplify as
appropriate.

Work with both local and fine contrast
in the image to improve edge defini-
tion and contrast in color and tone.

11: Make final fine-
tuning adjustments.

Influence specific tones and colors by
using tone and color measurement.

Customize the visibility of layered
image parts and control intensity of
selections.

Influence specific tones and colors by
using gradients.

Paint in adjustments from filtered
results (for example, to target Dodge
and Burn).

10: Make targeted
color and tonal
corrections.

Smooth out tones that are unnatu-
rally rough.
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4385c01.qxd  11/7/04  11:27 PM  Page 9



Continued

P R O C E S S  S T E P T O O L U S E  T H I S  T O O L  T O  D O  W H A T ? L O C A T I O N

Hidden Power Tools
under Effects on the
Styles and Effects
palette, in the Power
Separations category

Save As Save with a new filename. File ➔ Save As

Save For Web File ➔ Save For Web

DCS Templates Hidden Power Tools
folder included on the
book’s CD

The tools mentioned here will all be explored in this book as part of the exercises in

making image corrections. This listing cuts out many tools, most of which provide redun-

dant (and sometimes inferior) means of completing tasks. If you use these tools to follow

the methods described in the book, you will find that other tools are seldom necessary.

Several other minor tools will sneak in at points during the exercises; while they are not

specifically mentioned, they are mostly related to or substitutes for tools covered in the

categories in the list.

One tool that does not fit into any particular step, but is very useful, is the History

palette, shown in Figure 1.1. When doing serious correction and experimentation, it

should become a good friend. For example, when you have taken several steps that have

not accomplished what you hoped,

a single click on the History palette

can step you back to an earlier

point in the development of the

image so you don’t have to start 

all over again. This lets you undo

multiple steps at once, or compare

before and after changes at a click.

It’s a real time-saver and a helpful

tool.

Assemble the image parts and organ-
ize the content to complete purpos-
ing and storage.

Permanent
and/or tempo-
rary storage
devices

16. Package the
image for output
and use.

Use custom files to allow unsupported
color modes (CMYK and spot color).

Save Web images with limited color
and transparency.

15: Save in output
file format.

Create separations for print ready
files.

Separations
(CMYK and
Duotone)

10 ■ chapter 1: Essentials of Images and Image Editing
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The History palette
acts like a multiple

Undo. Just click a
previous state, and

the image reverts to
the way it looked

then.
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Basic Concepts of Tone, Contrast, and Color
Without light, there would be no images. Light is what shapes the subject of images. It

strikes an object that you are photographing, reflects back through the camera lens, and

creates the color and tone captured in the exposure for the image. Light shapes the object,

because shadows and highlights reveal object contour. The subtle interplay of tones, con-

trast, and color gives shape to objects and defines the subject of an image.

Tonal range is the difference between the lightest and darkest image areas. The greater

the difference is between the lightest and darkest areas of an image, the greater the tonal

range. The way light and dark tones play against one another is contrast. The more stark

the difference is between light and dark image areas, the greater the contrast. If tonal range

and contrast are not balanced correctly, an image will appear too light, too dark, too flat,

or too harsh and contrasty, as illustrated in Figure 1.2.

Too light

Too harsh Balanced

Too dark Too flat

Figure 1.2

One image can look
many different
ways, but the best
way usually uses 
full range and flat-
tering contrast.
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Creating a dynamic image starts with making the most of the tonal range that exists in

the image. Contrast (or lack of contrast) between tones within that range helps define

image character. Not every image will naturally have high contrast and a broad tonal

range. Some images may be naturally high-key (light, usually with moderate to low con-

trast), low-key (dark, usually with moderate to low contrast), or simply low contrast. Usu-

ally, the goal of correction is to maintain the natural character, or key, of an image while

adjusting tone and contrast to enhance and improve dynamics. If there are 255 possible

grays for your image, and you use only 100 of those, the image is really only 40 percent as

dynamic as it might be. If you adjust the tonal range, the image can become more visually

dynamic; if you adjust with care, you won’t lose the natural quality of the image.

Both tone and contrast work in almost the same way in color and black-and-white

images: you want to make the most of and expand tonal range and dynamics while main-

taining image character. The difference is, when you extend the tonal range in a black-

and-white image, you get more potential grays; when you make similar adjustments in

color images, you get more potential colors.

Color as Tone
Color is a pretty simple thing to manage if you’re picking out clothes, drapes, or uphol-

stery. In those cases it is already mixed and applied for you. If you don’t have experience

with color mixing, it isn’t until the first time you actually try to correct the color of an

image that the complexity of color comes alive. If you’ve never had any training in art and

color theory, understanding how color works can be a little confusing. Add to that the

existence of different color modes (theoretical ways of defining color), and color becomes

still more complex. Even more confusion can grow from the fact that color is stored in

your digital images as grayscale. Because color can be split into simple grayscale compo-

nents, it is important to understand how grayscale (tone and contrast) can also define

color. However complex, you have to understand color and how it works in digital images

to apply it and achieve the results you want.

For the most part, images that you will work with in color will be in RGB mode. RGB

stands for red, green, and blue. It is an additive light-based color theory: different combi-

nations and intensities of red, green, and blue lights make up the set of available colors. As

the red, green, or blue lights are made brighter and applied with more intensity, the result-

ing color gets brighter, and colors mix in these varying intensities to form other colors.

Full intensity of red, green, and blue results in white; lack of red, green, and blue results in

black. It is a theory that works great with projection, such as on your monitor and some

projection TVs. Breaking images into their component RGB colors is how your monitor

displays color.
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Each color you see in an image is made up of

these three colors in different combinations. Each

of the three colors has 256 intensities in 8-bit

images (Elements does have 16-bit capability,

which is discussed more later in this chapter and 

in the “Bit Depth” section of the appendix). The

grayscale representations of the intensity of the red,

green, and blue are stored as grayscale information

in your image files. Light coming into a camera or

sensed by a scanner is actually broken into these

three components to be stored. Later the informa-

tion is reassembled, allowing your computer to

reproduce full-color images from the RGB.

This theory and practice have been around for

quite a while. One of the earliest photographers to

create color images did it in Russia in the early

1900s, before there was color film. Sergei

Mikhailovich Prokudin-Gorskii (1863–1944)

made glass plates three at a time when he took pic-

tures with a specially designed camera, filtering for

the red, green, and blue components of light to

record the strength (tone) of each component on

what was essentially grayscale film. The plates

would record the captured light as grayscale, and

then using a special projector, Prokudin-Gorskii

would project the images simultaneously with red,

green, and blue filters to reproduce the color images on a screen. Figure 1.3 shows one of

Prokudin-Gorskii’s images; a composited version of this image is also presented in this

book’s color section. (These plates are from the collection at the U.S. Library of Congress,

which can be accessed at http://lcweb2.loc.gov/pp/prokquery.html.)

Inside each of your color images are the primary source colors: red, green, and blue.

These source colors are stored as grayscale representations and mappings of the intensity

of red, green, and blue light in every pixel in your image. When you work on color images,

the changes that you make affect all three of the source colors at the same time. The

grayscale color components can be separated out of your images and retrieved for use in

adjusting your image dynamics, tone, contrast, and color.
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Red

Blue Composite

Green

Figure 1.3

This image by
Prokudin-Gorskii,
titled Man in Uni-
form, Seated on
Chair, Outside, was
taken around 1910
by separating color
into grayscale RGB
plates. Scans of the
glass plates can be
composited to
achieve a full-color
result (as shown in
this book’s color
section).
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Breaking down color information into color components may not always be to your

advantage when making corrections, but it can often be helpful when trying to isolate

damage and perform advanced color correction. The ability to make separations into

image components is a key concept of this book. If you understand how to make compo-

nent separations and how these separations combine to create your images, it opens a

world of possibility for improving images.

As Prokudin-Gorskii did in creating his “color” images, we can re-create representation

of color as grayscale by filtering digital images. When the color components are separate,

they can be adjusted one at a time, simplifying the way you work with color. This can help

when correcting color-specific defects, in simplifying an approach to images and correc-

tions, in developing a better understanding of what happens when you apply a tool to

color images, and in doing the most complex color alterations and corrections. Let’s look

a little more at color types and color management.

Types of Color
Color in your images can be measured in several ways. Photoshop Elements uses color

modes, which as I said earlier are really just different ways of depicting color and tone. The

following are the four modes you can use:

• RGB

• Indexed Color

• Grayscale

• Bitmap

Image color mode and file type are two very different things. Knowing which color

modes appear in which file types (and which file types to use with a certain color mode) is

often essential for correctly purposing your images.

Later in this section and elsewhere in the book I’ll talk about other color modes, including

LAB, CMYK, RGBL and Duotone. These are not technically working color modes in Elements,

but you can achieve these separations and save the separations to files using Elements.

Photoshop has a palette called Channels, which is not included with Elements. The Channels

palette, like the Layers palette, enables you to edit color components and manipulate them

separately (in RGB as well as other color modes). This can be a great tool in making complex

color corrections. Even though there is no formal Channels palette, this book shows you how

to access and alter channel information easily, just as if you had a Channels palette working

for you. The channels are referred to as components.
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For the most part, people using Photoshop Elements will be working with 8-bit color

images in RGB mode. This mode offers the broadest flexibility for tool use, and is the

mode most images are in when captured or created. As I have said, RGB refers to the type

of color storage; in this case information is stored as red, green, and blue components. 

8-bit refers to the exactitude of the color representation, or the number of variations that

can be stored per pixel in a color component. There are 16 million potential colors in 

8-bit RGB, based on 256 possible tonal variations in each of the three color components

(256 × 256 × 256 = 16,777,216 possible variations). That’s one big box of Crayolas! In

fact, it is the largest color set of any of the color modes you will be working with in Ele-

ments, except when using 16-bit RGB. A larger number of possible colors in your image

allows finer distinction between colors and helps changes that you make to images blend

more evenly.

16-bit is perceived to be an advantage over 8-bit: with 35,184,372,088,832 potential col-

ors, images can theoretically have better integrity, and changes are less apt to damage

image information. When working with 16-bit images, however, some important tools

and functions are not available for image correction—most notable of these is layers.

Other drawbacks to 16-bit include greatly increased file size, greater computer horsepower

needed to process the images, and the lack of ability to use output from a 16-bit file (at

present, information must be converted to 8-bit for print processing and display).

Generally, you will work in 8-bit RGB for the best access to tools and the most pre-

dictable behavior of images. When the image is complete (that is, all changes you are

going to make have been made), then you can consider converting the RGB image to

other modes as required for your final purpose. You can save RGB files in many formats,

but you will probably most often use TIFF (print), Photoshop (archive), JPEG (Web), and

PDF (portability).

Indexed Color is a much more limited color mode than RGB and is almost always asso-

ciated with GIF Web images. This color set has a maximum of 256 colors. The colors are

created as a table by using hex values: six-character codes that represent specific colors (see

the Hex Code Chart on the Hidden Power CD). The colors cannot be mixed, and must be

one or another of the colors in the table. The goal of limiting colors, especially in the case

of Web images, is to simplify files and make them smaller. In the case of Web images, this

helps transfer them more quickly.

Regardless of what you read elsewhere, 8-bit files can be returned to 16-bit in Elements. This

will not magically restore 16-bit information that may have been lost or unavailable, but it

will enable you to restore the advantage of 16-bit editing to 8-bit images. See the “16-Bit

Images” sidebar later in this section.
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Even without any experience in converting to Indexed Color from RGB, it may be

obvious that converting all of your 16 million potential colors from an 8-bit RGB into a

measly set of 256 colors for Indexed Color may not always produce the best results. In

converting to Indexed Color from RGB, almost all of your original color will have to

change. Of course, the results can be disastrous when imposed on a full-color image.

However, there are color tricks (such as dithering) that can make Indexed Color’s color

sets appear larger than they really are. Because color is applied rather than mixed, Indexed

Color is a difficult color mode to work in. Moving to this color mode will almost always be

a last-step conversion, and almost always will be done in converting images for display on

the Web (when JPEG is not used). They are almost always saved in GIF format.

Grayscale (Figure 1.4) is also limited, but to no color at all. This “color” mode has 256 lev-

els of gray tones (in 8-bit mode) that make up all you see in standard black-and-white images,

or when working with individual color channels (such as color components extracted from

RGB images). Generally you should convert images to grayscale when you are printing

images without color, so that you can get the best depiction of tone (without depending on

the color device to convert color for you). Taking the color out of an image can be simple, but

it can also be considered an art, because what looks good in color may not look good at all in

a straight conversion to black-and-white (though we will look at various ways to improve

your results). Grayscale images are most often used in black-and-white print jobs.

Bitmap images are like grayscale, but are more strictly formed in black or white—using

no grays. Pixels are either white (off) or black (on), as illustrated in Figure 1.5. For the most

part, bitmap images are used with line art (pen-and-ink-type line drawings). Bitmap will

probably be the least used color mode of those available. You will probably save Bitmap

mode images in TIFF or BMP formats. High-resolution bitmap images are sometimes used

for line art and other special purposes for print, such as creating dithered drop-shadows for

use in layout.

b

c

a

Figure 1.4

Grayscale gradients
showing black-to-
white gradients in

(a) 10 steps (10 per-
cent darker in each),
(b) 25 steps (10 lev-

els darker in each)
and (c) 255 steps

(every level of gray).
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CMYK color (depicting images with cyan, magenta, yellow, and black) is a common

printing color scheme that is not really available to Elements users as a color mode. It is

how color is most often depicted in print. While you will not work in a CMYK color mode

in Elements, you will usually print with CMYK color. The theory is similar to RGB in that

a limited set of colors are used as inks to create the visible color set. At the same time,

CMYK is perceptually the opposite of RGB. While RGB is based on additive color (the

more light or color you add, the brighter it gets), CMYK is subtractive (the more ink/color

you add, the darker it gets, because the light striking the color is absorbed). Figure 1.6

shows how two ink halftones combine for a darker result.

These BMP bitmap images are different from the color bitmaps used in screen shots and

other images as a common file format on Windows computers.

Figure 1.5

The magnification of
a portion of the orig-
inal bitmap image
reveals the bitmap
patterning.
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Conversion from RGB to CMYK is often disappointing, because CMYK can portray

fewer colors even though there is one more color in the set. The easiest way to understand

this is to consider efficiency. While light is pretty much 100 percent efficient when pro-

jected, the absorption of light by ink pigments is not. Because pigments do not provide

perfect light absorption, the color they reflect is not perfect in conversion. Black is added

to the CMY color set as an attempt to increase the efficiency of absorption. As an additive,

it produces only redundant color (color that should have been reproducible in a 100 per-

cent efficient CMY pigment set). As a result of the inefficiency, the CMYK color set suf-

fers, and results in less dynamic color and tone than RGB.

There is a supposition that you cannot work with CMYK images in Elements because it

is not a supported color mode, but this is not entirely true. Although the program is not

set up to handle CMYK directly, an indirect approach can enable you to make custom

CMYK separations and usable CMYK images that can help you improve printed output.

The file format used with CMYK is often TIFF, PDF, or Photoshop EPS. Regretfully, none

of these will work directly. However, later in the book I will show you how you can essen-

tially hijack another file format (DCS: Desktop Color Separation) that will allow saving

and manipulating files as CMYK.

1 6 - B I T  I M A G E S

Some users wonder—and even worry—about using 16-bit mode for image editing. 16-bit

images offer more color detail: whereas 8-bit can reproduce “only” 16 million colors per pixel,

16-bit can reproduce more than 35 trillion (based on Photoshop’s color handling). While this

difference between 16-bit and 8-bit may be significant for archival purposes, for most cases

in the real world, it should not make a noticeable difference in your images. You might see

the difference if you are making extreme changes to an image or trying to rescue image

detail from shadows and highlights. However, most output devices can’t handle the addi-

tional image information in 16-bit images, and it is questionable whether technology will

meet the 16-bit challenge in the near future, or if human perception can really distinguish

between the results.

+ =

Figure 1.6

Samples of black
(45°, left image) and

cyan (108°, middle
image) halftone dots

as grayscale. When
the halftone dots are

printed over one
another (right), col-

ors combine to
absorb more light.
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Photoshop Elements supports some 16-bit color adjustment as of version 3. Previously it

would convert 16-bit images to 8-bit when opening. The only real gain you have for 16-bit images

is in importing original 16-bit information or temporarily extending the usable color space for

your images while you work on them. If you have a camera or scanner that creates 16-bit images,

be sure, as suggested, to store copies of original images before converting to 8-bit.

When possible, working in 16-bit rather than 8-bit can provide an advantage for grayscale

images, arguably more so than color. The measly 256 colors in the single grayscale compo-

nent can more easily run out of image room and variation than the 16 million variations per

pixel in 8-bit color. While you can’t apply all tools in 16-bit (Elements does not, for example,

support layers with 16-bit images), you can make some corrections using 16-bit, and you can

switch back to 16-bit after making 8-bit modifications (using Hidden Power techniques).

To temporarily switch to 8-bit, do the following:

1. Have a 16-bit image open.

2. Duplicate the image (File ➔ Duplicate).

3. Put your new filename in the As field. For this example, use Temp 8-Bit. Click OK.

4. Change the mode of the Temp 8-Bit image to 8-bit (Image ➔ Mode ➔ Convert To 

8-Bits/Channel).

5. Make any corrections you want involving layers, and so forth, that you can’t do in 16-bit mode.

6. Make a selection of the entire image using Select All (Command/Ctrl+A), Copy (Com-

mand/Ctrl+C). Then activate the original 16-bit image and Paste (Command/Ctrl+V).

When you paste, the image information you have been manipulating in 8-bit will convert

to 16-bit. There are, of course, some limitations to the effectiveness of this conversion, but

you can return to 16-bit mode and save the manipulation as a 16-bit file.

You can also convert files that were originally 8-bit images to 16-bit:

1. Have a flattened 8-bit image open. Check the Height and Width in pixels by using Image

Size (Image ➔ Resize ➔ Image Size) and note the values.

2. Make a selection of the entire image using Select All and Copy.

3. Open the Hidden 16.psd image on the Hidden Power CD.

4. Resize the image (using Image Size again) to the Height and Width determined in step 1.

Accept the changes by clicking OK.

5. Paste.

This will paste the 8-bit information into the 16-bit file, converting it during the process.

Changes that you make while in 16-bit mode will reflect the advantages of 16-bit files. You

can now fluidly move from 8-bit to 16-bit files in Elements. 

See the appendix for more information on 16-bit images.
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Understanding and Using Color Management
A buzz phrase in image correction is color management. If you are not familiar with this

term, or if you have heard of it but don’t know quite what it is, this section covers most of

what you need to know. Although it is something you should take seriously, color man-

agement does not have to be as complex or mysterious as it tends to be. This brief discus-

sion will help you become familiar with it, poke it with a stick, and see that it is dangerous

if completely ignored. We’ll look at your options, get set up, and get on with the main

course of editing images with confidence as you pass color management by with a better

understanding and a knowing grin.

Color management is supposed to be a means of helping you get better color consis-

tently. That sounds good, and it is usually the reason why people think it is something

they can’t do without. By using color management, the goal is to have a better chance of

your images looking the same from a variety of outputs (print and display). Color man-

agement uses profiles that describe how your display handles color to help translate what

you see to other devices and how those devices handle color (via a common color palette

and profiles of those other devices). The profile from your monitor or working color space

can be embedded (saved) with your image file to act as the color interpreter for other

devices (monitors and printers).

Every device has its own profile, which acts as the interpreter on its end, so the devices

can speak the same color language and adjust for differences. The key to full color man-

agement is that every device has to have a profile to be able to interpret other profiles, so

the translation will work reliably. The embedded profile will affect images behind the

scenes, both to help represent color correctly on-screen and to serve as a translator to

other devices. In theory, that results in a better image. All this automatic translation

sounds very appealing, like I’m serving the chocolate cake first.

This is all nice in theory, but the sad fact is, it doesn’t necessarily work in practice.

There are a lot of points in image processing where detours or errors can occur. Your

profile can get dropped, changed, or ignored, or it can just plain be wrong. Profiling can

occur where you don’t expect it, and other profiles can be wrong, causing information in

your image to be misinterpreted. Any of these can cause unexpected results.

First, you are responsible for building yourself a color profile—unless you use a

generic one (not recommended). You have to set up the profile correctly, and there is

no guarantee that you will (even if you follow instructions) because the process involves

This section deals only with Elements Color Management options. For more information on

using printer profiles, see the “Printing with a Profile” section in Chapter 9.
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your assessment of color by eye (if you don’t use a profiling device), and that may not be

entirely accurate. Second, every step between saving your image and sending it to the

printer has to both respect the color management and process it correctly. This is where

the chocolate cake turns to mud pie.

Although profiling was planned to function behind the scenes and stay with your

image, you can’t be sure that the results you get are based on the choices you have made to

embed your monitor profile in the image—unless you manage each step of the process.

You also can’t be sure that you really want the process to respect your profile (for exam-

ple, if it is not correct). Embedding a profile doesn’t work consistently because it can’t be

enforced: even if you embed a profile, some device or person along the way can drop your

settings. There are devices that don’t recognize color management settings; there are serv-

ices that don’t use them in processing. If your results depend on the color management,

and the wrong color profile is embedded or the profile is missing, you are just as likely—

or more likely—to get a bad result than you are without embedding color profiles.

Your only chance for guaranteed success using embedded color profiles is to make a

study of how the profiles work, and become intimately knowledgeable about the output

types and processes you use. Reading your printer manual is not necessarily intimate

knowledge; it goes somewhat deeper than that.

Even with this additional effort, using color management and embedding profiles

requires testing. Funny thing is, you have another choice: not embedding profiles. Not

embedding profiles can have pitfalls and also requires testing. It does, however, remove

the potential added complexity of using embedded profiles. In the long run, if you set up

your system correctly by calibrating your monitor and creating a monitor profile (an ICC

profile that describes your monitor) , not embedding profiles can often lead to more pre-

dictable results. You should not entirely dismiss color management, and you should create

a monitor profile—even if you are not embedding profiles in your images. This helps cali-

brate your monitor and adjust the view of your screen. Embedding profiles in your

images, on the other hand, is like an extra half-step in a staircase that can just as likely trip

you up as ease your progress up the stairs—depending on how much you are paying

attention. My experience is that you are more likely to trip over that half-step and swear at

it than praise it.

None of this is to say that you can’t embed profiles with success! You can, and if you 

do currently, don’t change what you do. My perspective on using or not using profiles is a

lot like my perspective on images: don’t change what works, change what doesn’t. If you

currently use embedded profiles and everything works fine, stay with them. If you don’t

use profiles with success, don’t use profiles, or you have never looked at them, or you
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don’t understand what they are and how to use them, practice color management with the

following fast, safe, and effective system:

1. Calibrate your monitor and create a monitor profile (I’ll show you how to do this in a

moment).

2. Don’t embed profiles.

To be reasonably successful with color management, the Photoshop Elements user

needs to calibrate, create a monitor profile (which Elements uses for image viewing), and

choose how to handle profiles by making a selection in Color Settings. Even if you choose

No Color Management, you are still using color management—you just choose not to

embed profiles in your images. Calibrating your monitor and creating the monitor’s color

profile helps ensure that you see a best representation of the images on your display. This

best representation should show what your image will look like on most other displays—

and, for the most part, what it will look like in print. The next few sections present in a lit-

tle more depth what you should expect to see on your monitor, how to calibrate, and what

to do to build an ICC profile for your monitor.

What You See Should Be What You Get
One problem with trusting your visual sense is that it assumes that what you see on-screen

is the right thing. Regrettably, that is not probable without calibration. All monitors are

different, and the settings for display and color will affect what you see. If you haven’t cali-

brated, colors on your screen might look different from colors on someone else’s—and

worse, they might not match or even come close to the color that gets printed.

If you are looking at a screen that is shifted green and you depend on the color to be accu-

rate, a good correction will tone down the greens to make the image look right on-screen.

This will cause output of any kind to be shifted toward reds (the opposite of green). Calibra-

tion will help compensate for shifts by flattening the response of your screen.

The goal of calibration is simple: you want to be able to trust what you see on your

monitor, within reason. If you can trust what you see, you can mostly use your visual

sense to correct your images.

I say mostly because even if you’ve calibrated your monitor, you have merely adjusted it

for best performance. You are going to get the most out of your monitor, but the monitor

itself may have some limitations—and there are inherent limitations in printing, so it is

likely that there will be some differences between what you see on-screen and the result in

print. Although you probably won’t reach perfection, calibrating your monitor gives you a

far better chance of at least coming close. With some selective checking, you should be

able to feel confident in what you’ll get as a result.
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Calibrating Your Monitor and Building an ICC Profile
In this section you’ll look at how to calibrate your monitor and create a monitor profile.

Creating the profile helps your system adjust previews so images on-screen appear accu-

rately. Before you begin, you should know several things about the response and perform-

ance of your monitor, including the manufacturer-suggested color temperature, gamma,

and phosphor settings. These settings should be available from the manufacturer (call tech

support and ask for an engineer if necessary).

What you use for calibration may vary. In the past, Adobe provided Adobe Gamma for

monitor calibration for Mac and Windows users. It is no longer provided for the Mac

because the Display Calibrator Assistant is a standard utility on OS X and above. Wizi-

WYG is another free utility from Praxisoft for Mac and Windows, available from their

website (www.praxisoft.com).

In the following steps, I describe the sequence (and show the screens) of Adobe

Gamma for Windows; alongside these, I include some matching screens for Display Cali-

brator Assistant for Mac OS X(the order will be slightly different). Each of these utilities is

similar in respect to what they do, and any will work for purposes of calibration and creat-

ing the profile. For the most part, you can simply start them up and read the directions as

they appear on-screen. If you are lucky enough to have a calibration device (such as the

Spyder by ColorVision), use that for calibrating your monitor instead of the following

procedure; calibration by hardware calibration devices will be more accurate than calibra-

tion by eye.

Color temperature reflects the monitor display color for the white point, which really

measures the color of white on your monitor. It is usually 6500, 7500, or 9300 degrees on

the Kelvin scale. The higher the number, the more blue (or cool) there is in the white; the

lower the number, the more red (or warm) there is. It is an inherent characteristic of your

display and can subtly affect the appearance of color on-screen.

Gamma is a measure of tonal response, often a number between 1 and 3 with two deci-

mal places. Phosphors are a set of six numbers with x and y coordinates for red, green, and

blue; these numbers can have up to three decimal places. These settings vary between

monitor brands and models, so don’t make assumptions about them or copy someone

else’s. Find the settings in your manual or contact the manufacturer (via the website or

technical support—again asking for an engineer if necessary).

Monitor manufacturers don’t always put monitor specs for phosphors, white point, and

gamma in the manuals. You’ll likely have to seek it out. When you obtain the information,

write it down. I usually write the settings right on the cover of the monitor manual for easy

reference.
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Your monitor should be in an area that will minimize glare, and lighting (except where

noted during the calibration) should be as you will have it when you are most frequently

using the computer and monitor. Lighting should generally be subdued and indirect if

possible. Changes in lighting will require recalibrating the monitor. The monitor can be

calibrated to different light conditions, but it is easier to maintain a consistent room light-

ing than to add it as a variable in color corrections. Extremely bright or overly dark rooms

might cause some problems with calibrations and monitor viewing. Optimally, room

lighting should be bright enough that you can read and view materials that are not on the

screen, yet not so bright that it causes glare or washes out the display. After creating your

profile, be sure the lighting where you work remains the same as when you calibrated the

monitor.

Before you begin, you should also locate the monitor’s brightness, contrast, and color

controls. If your monitor has an option to reset to factory settings, do it now. If there is no

reset option, use the monitor controls to normalize the screen by eye. Grays should look flat

gray rather than a little warm or cool. After resetting or adjusting color, leave these controls

alone and do not change them after calibration. Now you are ready to start calibration.

1. Turn on your monitor and system, and let the monitor warm up for at least 30 minutes.

2. If you haven’t done it yet, read the owner’s manual for the monitor to see if it pro-

vides suggestions for calibration.

3. Open Adobe Gamma by double-clicking the icon in the Control Panel folder. You

should see the screen illustrated in Figure 1.7. If Adobe Gamma is not in the Control

Panel folder, find it on the Photoshop Elements CD.

Figure 1.7

The initial Adobe
Gamma and Display
Calibrator Assistant

screens

Calibration will be slightly different in every operating system and OS version, though the

options in various dialog boxes will be similar.
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4. Click Step By Step. This will lead you through the process of calibrating and creating

an ICC profile for your monitor. Click the Next button.

5. In the Description field, type a name for the profile you will be creating (Figure 1.8).

You can enter a lot of information here, but it’s best to keep it short. I find it handy to

name the monitor and add the date, so the profiles are easy to identify. If you use out-

put white point settings (step 12), you may also want to include this value in the

name. Click the Next button.

6. Using the monitor controls, set the contrast all the way up and then adjust brightness

until the smaller gray box in the center is dark enough that it is just barely discernable

from the larger black box surrounding it (see Figure 1.9). If you notice the white

frame beginning to darken at any point, stop darkening the screen. If necessary,

adjust the brightness setting to lighten the screen a bit until the frame is bright white

again. As you fine-tune this adjustment, it may help to squint or use your peripheral

vision to get the center square as dark as possible without losing the brightness of the

white frame. When you are satisfied with the adjustments, click the Next button.

Figure 1.9

Concentric squares
in Adobe Gamma, or
a square and oval in
Display Calibrator
Assistant, help you
adjust the screen
contrast by observa-
tion while making
adjustments to the
physical monitor
settings.

Figure 1.8

Type the profile
name in the
Description field.
(The opportunity to
name the calibra-
tion comes last in
Display Calibrator
Assistant sequence.)
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7. On the screen that appears, select Custom to open the Custom Phosphors screen

shown in Figure 1.10.

8. Type the six values obtained from the manufacturer of your

monitor in the appropriate fields. You don’t have to know what

each number means, but you do have to place each one cor-

rectly. Click the OK button to close the Custom Phosphors

screen and accept the changes. This returns you to the Adobe

Gamma Assistant dialog box.

9. Click the Next button. The screen that appears (Figure 1.11) enables you to adjust

gamma. Select the View Single Gamma Only check box. Using the slider, adjust the

appearance of the outer square (the alternating lines of black and white) so that it

matches the tone of the 50 percent black center. Adjust the appearance by squinting at

the screen (to blur the box slightly in your vision) while moving the slider. The goal is for

the entire square to seem to have a uniform tone.

10. In the Gamma field, type the Gamma value you got from the manufacturer. You will

be able to enter a two-decimal value, but Adobe Gamma will round the value off

when you save the entry.

Figure 1.11

Sliders help you
visually adjust for

the monitor gamma.

If you change monitors, you will obviously have to build a new profile. Other less-obvious

reasons to build a new profile are monitor aging and changes in response due to use, replac-

ing your system hard drive, and changing room lighting (or computer placement).
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11. Click the Next button. The screen that

appears (shown in Figure 1.12) allows

adjustment of the monitor’s white point.

Set the monitor’s white point by choos-

ing the value in the drop-down list that

corresponds with the number you got

from the manufacturer. (If you do not

know what value to choose, see the fol-

lowing note.)

12. Click the Next button. The screen that appears (Figure 1.13) will enable you to select

a white point for output. This selection should be based on the color temperature of

the intended output media. If you are unsure, or you are creating images for the Web,

use the Same As Hardware setting.

13. Click the Next button. The next screen (Figure 1.14) enables you to compare calibra-

tion before and after the adjustments you made in the previous steps. Click to toggle

the Before and After buttons several times, comparing the appearance of your screen

as you toggle back and forth. Specifically, note the grays in the dialog box and see

whether the color appears more neutral before or after adjustment. The more neutral

(lacking any color, and looking flat gray), the better the calibration.

Figure 1.13

Output white point
differs from monitor
white point. This set-
ting should reflect
the color tempera-
ture of your output.
This may be another
monitor, paper, or a
projection screen.

A second option on this screen enables you to measure the white point. To do this, dim (or

turn off) the lighting in your work area and click the Measure button. A set of three gray

squares will appear on a black background. Click the square that seems most flatly gray and

repeat until the test closes.
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14. If the before and after results are noticeably different, run through the process again

(steps 3 to 13).

15. Click the Finish button to accept the changes.

What you have just done is calibrated your monitor and created an ICC profile for it.

The calibration helps you to be sure the image information you see on-screen is reason-

ably accurate. The ICC profile is a description of how color appears on your system. This

information is used for previews, and can be used if you embed profiles in your images to

help describe color in your image to other ICC-aware devices.

Although Adobe Gamma is an adequate tool for visual calibration, calibration devices

(see the example in Figure 1.15) can measure more accurately than your eye, and will

probably measure a greater number of gray levels and create more accurate profiling. The

devices take measurements directly from your screen and create a profile based on those

measurements. Using such a device can ensure that your monitor is calibrated properly,

and it may actually save some time during calibrations.

Color Preferences
Most Preferences settings in Photoshop Elements are just a matter of personal preference,

and they can be changed at any time as you see fit. However, the one group of settings that

you will be required to make a choice about and stick to is Color Settings. This is where you

can define how Elements handles images with profiles that you open, what color space you

want to work in, and whether profiles get embedded in your images by default. The choice

you make can be important to your results, and will certainly affect how you work with

images. If you are not sure about what to

select, or if you are unfamiliar with some of the

terminology just used, that’s OK. Your options

and explanation of terms are covered here.

Before we dive in: how much of this do

you really need to know? Probably not that

much if you use the techniques suggested in

this book. The following explanation

attempts to clarify why certain suggestions

are made.

I never calibrate one time and sit back satisfied—even when using a calibration device. I run

through the process a few times to be sure I have the best calibration.
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Understanding Color Space

The color space is a defined color set—a mapping of what colors are possible for your

image. Some spaces are said to be larger than others, and this isn’t technically accurate. All

8-bit RGB images have the same number of potential colors. On the other hand, different

RGB color spaces are mapped to cover a wider or smaller range of potential colors—not

bigger color spaces with more colors, just broader spaces that cover a greater range.

Because different RGB color spaces map to different color sets, all RGB is not the same,

though it is born of the same theory.

The difference between one color space and the next is the range or set of colors that

the color space covers. In other words, the numbers in two files defined by different color

spaces can be exactly the same, as numbers, yet the display or print result would end up

different because the numbers in those files represent different colors (however slight the

difference). What you really need to focus on here is what the mappings intend to cover.

You can know the name of the color space, but that may not tell you a lot about what you

are working with. Two common workspaces applicable to Photoshop Elements are sRGB

and Adobe RGB.

Each RGB file has the same number of potential colors—no matter what color space you

choose to use.

Figure 1.15

The ColorVision Spy-
der device attached
to a monitor
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sRGB is a “limited” RGB color space in that it assumes some limitations of a common

RGB monitor to display all RGB colors. Because of inherent limitations in monitor pro-

jection, sRGB is mapped to enable you to record color in your files that most monitors

should display correctly. All this really means is that colors are not mapped to the full

potential gamut of RGB. The images you make in sRGB color space are more likely to be

compatible with what can generally be displayed on other monitors. In other words, it is a

generic and friendly color space if you are sharing images for viewing on monitors. This is

usually the assumed profile if an image is not tagged (that is, does not have an embedded

profile).

Adobe RGB (1998) is a wider-gamut RGB color space than sRGB. It maps to a color set

that attempts to better describe colors available on CMYK printers (notably purer cyan).

Because it maps a broader range of colors than sRGB, Adobe suggests that it may be a bet-

ter choice for working with images that are intended for print. The drawback to using

Adobe RGB is that you may be manipulating color that you can’t see accurately on screen.

If color management actually works as designed, however, optimized images for either

Adobe RGB or sRGB should appear very nearly the same on monitors or in print.

When you’re working with your images and profiles are not embedded, devices using

the color file have to make an assumption about the color space. Generally the assumption

will be that a generic RGB space was used; that means sRGB rather than Adobe RGB.

Therefore, numbers may be interpreted differently than you intend. An Adobe RGB image

opened as an sRGB image will desaturate because of the wider gamut numbers being

mapped to the smaller gamut color space. The only real choice when using Adobe RGB is

to embed the profile (tag the files as Adobe RGB) and ensure, along the route of the image,

that the profiles are respected. In other words, using Adobe RGB is a commitment to

using embedded profiling and, most likely, full color management.

A third profile you can use for color management in Elements is the custom ICC monitor pro-

file you created for your monitor after calibration. You’ll see it as the Embed Color Profile

choice in the Save As screen when you are using No Color Management—if you have cor-

rectly set up the profile per earlier instructions. This profile attempts to describe the way your

monitor handles color. It is used by Elements as a means of attempting to create an accurate

preview of colors in conjunction with your working color space.

The difference between color spaces is the range of color in their mapping.
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The Color Settings Dialog Box

The Color Settings dialog box pops up the first time you open Elements, before you do

anything. If you have already dismissed this (or want to change preferences after reading

this), you can revisit the settings by opening the Color Settings dialog box (Edit ➔ Color

Settings), which is shown in Figure 1.16. The three choices seem straightforward enough,

but the names really don’t tell you what the settings do—and they may be a little deceiv-

ing. People might choose Full Color Management simply because that wording seems the

most savory choice. Regretfully, that may not be the best choice, and the Help button isn’t

much help.

Here are descriptions and some important background information for each choice:

No Color Management This choice ignores any existing profile in an image if one is pres-

ent when you open it. On saving, Photoshop Elements will not embed a profile with your

image. The option to embed a profile is available by choosing Save As from the File menu;

to embed a profile, you simply select the Embed Color Profile check box. The profile

embedded will be based on the ICC profile you created for your monitor.

If you change the Color Settings while an image is open, changing to Limited Color Man-

agement will offer the option to embed the sRGB profile if using Save As, but will not

embed a profile otherwise. Changing to Full Color Management will save a profile fitting

to the current color mode (these options are outlined in the following description for Full

Color Management).

Limited Color Management Selecting this option will convert the image to sRGB when it is

opened using whatever profile is included. The resulting image will use the sRGB color

space. On Save, no profile will be embedded. The option to embed is available using Save

As, and the sRGB profile will be embedded if you choose this option.

If you change color management settings while the image is open, changing to No Color

Management will allow you the option of saving by manually embedding the monitor

profile you created. Changing to Full Color Management will save the image with a profile

fitting to the color mode (these options are outlined in the following description for Full

Color Management).

Figure 1.16

Many users may not
understand what
the options on this
dialog box really
mean.

understanding and using color management ■ 31

4385c01.qxd  11/7/04  11:27 PM  Page 31



Full Color Management This option retains a color profile if it is present in an opened

image. On Save, the original profile will be retained with the image. The option to disable

embedding the profile can be found in the Save As dialog box. Opening a new image or an

image with no existing profile will cause Photoshop Elements to retain the profile with the

image based on the color mode. These choices are the same when changing Color Settings

while an image is open:

RGB will have the Adobe RGB (1998) profile.

Indexed Color will have the Adobe RGB (1998) profile.

Grayscale will have a Dot Gain 20 percent profile.

Bitmap will have no profile.

Notice that if you want to ignore, convert, retain, or embed a profile , you can do that

by manipulating the Color Settings before and after an image is opened. Changing Color

Settings in midstream will enforce different rules and create different results. This may be

a pain, and it is something you probably won’t do very often, but it can come in handy

when you get a bad profile or when an opened file does not convert during opening the

way you think it should. Attempting to open the image by using different settings might

improve the initial result.

It is really a personal decision as to how to manage color. However, the level of complex-

ity and unknowns in working with images seems to rise quite a bit if you choose to embed

profiles and use working spaces outside of the more standard sRGB. It is likely that by using

optimal techniques for correction (as defined by this book), there should be little difference

in your results no matter which color space you use. This is why I suggest using No Color

Management and simplifying the workflow. Personally, I work with color management off

until I get an image that has a profile embedded. In that case, I might try to open the file by

using different Color Settings to see if I get a better-looking conversion. Otherwise, I stick to

the things I normally do because I can depend on my normal workflow to get consistent

results. I almost never embed a profile unless it is specifically requested.

Resolution
Put as simply as possible, resolution is a measure of potential detail in your images. High

resolution suggests that there will be intricate detail; low resolution suggests that detail

may be compromised. It would seem, if this description holds, that you would always

want high resolution if you consider detail important. But that’s not always the case. What

you really want is the correct resolution, and this depends not only on what size you want

the result to be but also on what medium you will be using. Output and display can use

image resolution in different ways, so the result doesn’t depend only on what the resolu-

tion of the image is; it depends on how much there is as well as how it is used.
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In print, if you don’t have enough resolution to meet the needs of the output, images

won’t look as sharp as they could; if you have too much, file sizes are unnecessarily large

and processing will take longer than it needs to—and the results will not improve. On the

Web, images without enough resolution will be too small; those with too much will be too

large. This rule also carries over into other display-based technologies such as film

recorders, which make high-resolution images on film from digital files. You can’t just

guess how much image information you need; you have to know the amount you really

need and work within those parameters. Understanding what resolution is and how it is

used is the only way to use it correctly.

While dpi is really an output term, it’s often used casually as a universal term for reso-

lution (spi, ppi, dpi, and even lpi). The various resolution-related terms can be tricky to

use correctly and consistently, but you should know what they mean and use them prop-

erly when you mean something specific. To simplify with better accuracy, use spi when

speaking of capture (scan sampling), ppi when discussing digital files, dpi when consider-

ing output resolution, and lpi in the context of halftone dot size.

spi (samples per inch) Capture resolution. The number of scanning and digital capture

samples per inch.

ppi (pixels per inch) Digital file resolution. The assigned number of digital pixel elements

to be used in printing or display of an image.

dpi (dots per inch) Printer resolution. The number of bitmap dots (smallest printing com-

ponent) an output can create per inch.

lpi (lines per inch) A measure of halftone dot size. Halftone dots are made of multiple

printer dots. The number of rows of halftone dots per inch.

How Image Resolution Is Measured
Image resolution is usually measured in one of several ways: the number of total pixels

(image dimension in pixels), the size of the file (number of bytes, kilobytes, or megabytes),

or the amount of information per inch (ppi, or pixels per inch). One way of measuring the

file size is not necessarily better or worse than another, as long as you can consistently

achieve the desired result—without guesswork.

Measuring image resolution in total pixels or file size is not the most intuitive or useful

approach for most people working in Elements. Both of these are usually used to measure

source image size, such as with scans or images from digital cameras. While the measures

tell the quantity of image information in a file, the parameters don’t dictate how the infor-

mation is used. A 2100×1500 image in total pixels could be a 7×5 inch image at 300 ppi, 

or a 21×15 inch image at 100 ppi—and it can be used that way simultaneously. The num-

ber of pixels used in an image measured as total pixels is essentially arbitrary. An image
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measured with a file size of 12 MB might be about a third larger in RGB than CMYK. In

black-and-white (grayscale), a 12 MB image would be much larger still—about four times

the area of a 12 MB CMYK image. The lack of a controlling parameter to lock in the size 

of the image when using total pixels or file size keeps you from knowing exactly what you

have and how the image will be applied if you look at file size alone. File size is probably

the least-used measure of resolution, and it makes sense only in a workflow where color

mode is static (for example, images are either only RGB or only CMYK).

Most Elements users will use ppi as a measure of image resolution because it is the most

compatible in comparing to output resolutions. This type of measure tells how much of the

image pixel information should be applied per inch. Because printer resolution is most

often a finite measure (based on the printer’s dpi: how many printer dots can be made per

inch), using ppi measurement makes it easy to determine the optimal match between digi-

tal image information and what the printer will need to produce the best results.

What Image Resolution to Use
Some people generalize and suggest using 300 ppi as a standard resolution for images

going to print. For Web images is it usually accepted that images should be 72 ppi. While

these are pretty good as general-purpose guidelines, they don’t tell the entire story. 300 ppi

may be more than is necessary for all home printers, and may actually be too little for

demanding output (such as film recorder output). Because monitor resolutions can vary,

your 72 ppi image on a 96 dpi screen would actually be about 75 percent of the intended

size. Neither choice is likely to ruin your output, in most cases.

Because output differs, there is no one universal magic formula to figure out what reso-

lution to use. Each output type has a target range (minimum and maximum), based on its

capability to process and use image information. Once you know the range you need as a

result, you simply use that range as a target when working on an image. Know what your

service company or printer manufacturer recommends for output on the devices you use.

This may require reading the manuals or giving a call to the service company to find out.

The optimal range is the range where the image will perform the best in application; it is

possible to get acceptable results by going outside the range depending on how you imple-

ment the image and the results that you expect.

Table 1.2 shows the approximate resolutions you will want to use for your images,

depending on how you want to use them. An image sent to a device that uses a specified

output resolution should have a specific target ppi. The table shows some real-world

examples of output resolution and workable ppi ranges. Calculations for the table were

based on the formulas shown in the Calculation Used column; square brackets in the cal-

culations indicate the range of values used to determine the lowest and highest resolution

acceptable in that media.
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O U T P U T  A P P R O X I M A T E  I M A G E  C A L C U L A T I O N  

M E D I A R E S O L U T I O N F I L E  R E S O L U T I O N U S E D

Web 72–96 dpi (monitor) 72–96 ppi ppi = dpi

Inkjet (stochastic) 720 dpi 180–234 ppi [1 to 1.3] × (dpi / 4)

Inkjet (stochastic) 1440 dpi 360–468 ppi [1 to 1.3] × (dpi / 4)

Halftone, low resolution 75–100 lpi 116–200 ppi [1.55 to 2] × lpi

Halftone, normal 133–150 lpi 233–350 ppi [1.55 to 2] × lpi

Halftone, high resolution 175–200 lpi 271–400 ppi [1.55 to 2] × lpi

Line art 600–3000 dpi 600–1342 ppi (dpi/600)
1⁄2 × 600

Film recorder 4K (35mm) 2731×4096 pixels Total pixels

Film recorder 8K (6×9cm) 5461×8192 pixels Total pixels

Note that these resolutions are suggested and not absolute. Images will still print and dis-

play at other resolutions, but the results may not be predictable or efficient. Actual resolu-

tion needs may be somewhat flexible based on circumstances, such as paper and equipment

used, original image quality, expected results, and so forth. Be sure to read manufacturer

suggestions, and take most of the advice offered by service companies—they should know

how to get the best results from their equipment.

Resizing Images
Changing the size of an area that a group of pixels occupies can come in two forms: one

causes you to resample an image (using Bicubic, Bilinear, or Nearest Neighbor interpola-

tion), and the other changes the resolution to redistribute pixels over a smaller or larger area:

Redistributing pixels does nothing to actually change the content (mathematics) of

the image information that is stored; it just suggests that the content will be applied

over a different area.

Resampling, on the other hand, actually changes the content of your images, and

changes it permanently.

The larger the amount of resizing (the greater the percentage increase or decrease), the

more it affects the image content. One of these two things, redistributing or resampling,

has to happen each time you either change the size of the whole image (using Image Size,

not Canvas Size) or change the size of a selection by stretching or transforming.

When you upsample or downsample an image or image area and retain the resolution,

Photoshop Elements has to interpret and redistribute tonal and color information, either

creating (upsampling) or removing (downsampling) pixels. It does this through interpola-

tion (adding image information) or decimation (removing image information), which are

really fancy names for making an educated guess. Resampling an image to make it larger

will never fill in information that is not already there, no matter what you do and which

Table 1.2

Approximate
Resolution for 
Various Media
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plug-in you use. That trick you’ve seen on TV, where a pixelated image gets clearer and

clearer as they zoom in, is reverse engineered. The only thing you can really do to reclaim

image detail that you don’t already have is reshoot an image or rescan (assuming that the

detail is present in what you are scanning). What resampling will do is estimate and aver-

age differences between pixels to make a best guess. Details will tend to soften (upsample)

or be lost (downsample).

Photoshop Elements has three methods of interpolation (methods of figuring out how

to insert new pixels or remove existing ones as you change an image’s size), and five inter-

polation options. Nearest Neighbor, Bilinear, and Bicubic are the methods. Bicubic

Smoother and Bicubic Sharper are Bicubic interpolation options that have been added in

Elements 3.

Nearest Neighbor When you resize using Nearest Neighbor interpolation, Photoshop

Elements picks a representative color from those that already exist in the image. Whether

upsampling or downsampling, there is no averaging to create new colors or tones. Near-

est Neighbor is useful, for example, for controlled upsampling of screenshots without

blurring.

Bilinear Bilinear interpolation behaves much like Bicubic and is supposed to be faster, but

I’ve never clocked them. During the sampling, new tones and colors can be introduced

between existing colors that are not in the original image. This can blur sampling of hard

edges, but can provide a smooth transition for tones (Nearest Neighbor might provide a

blockier, stepped result). One thing about Bilinear upsampling is that it remains more

true to simple averaging between neighboring tones and adds fewer new qualities to an

image than Bicubic. At times these properties prove to be an advantage in retaining look

and feel, and in others they may result in softening. It is useful when you want a straight-

forward averaging, which may be useful when downsampling images.

Bicubic The resampling process creates new image information by averaging, like Bilinear,

but goes one step further to provide a tiny bit of sharpening to the result. This is intended to

counteract the blurring result of averaging. It changes a greater number of pixels with the

same radius setting as Bilinear, but may generally give a better visible result in most cases

than Bilinear. It is the real workhorse for sizing images. Bicubic Sharper is like Bicubic, but

with enhanced sharpening; Bicubic Smoother is like Bicubic, but with less sharpening.

While making up information and decimating it sound like bad things, each has its

purpose. Usually you should avoid upsampling—especially if the option exists for gaining

more detail through a better-targeted source image. However, images can be upsampled

with some success, depending on the desired quality—provided the change isn’t huge.
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Upsampling 10 percent or even 20 percent may not be noticeable if the source image is

sharp. Usually you will upsample only to make up small gaps (if necessary) between the

resolution you have in an image and what you really need, or to adjust borrowed image

components (elements you are compositing from other images).

Downsampling, while certainly damaging and compromising to image content,

should be less noticeable in your results. Image information indeed gets averaged or

eliminated, but if downsizing is being done for the right reason, any details you lose

would have been lost on output or display anyway. Detail loss is inherent in the process

of downsizing or outputting images at a smaller size: even if the equipment used could

reproduce detail at a smaller size, eventually details will pass the limit of the human eye’s

ability to discern them.

Multipurpose Images
Making images that you’ll use for more than one purpose (for example, print and Web)

can cause a little problem. Optimally, you’d like to work with images so that you target the

result. Doing so ensures that you retain all of the actual image detail rather than relying on

interpolation or decimation and your choice for sampling type to produce the right

results. It is a simple fact that an image going to print on a high-resolution printer should

have more information than one at the same size used on the Web, or you will not opti-

mize detail.

You have only two solutions in working with dual-purpose images:

• Create two images, each with a specific purpose.

• Create one image and resize.

Either of these choices poses a trade-off. In creating two images, you sacrifice valuable

time in repeating processes. It is often self-defeating to work on two images to produce the

same results (even using a detailed script) because the difference in size and volume of

information in the image will produce different results with the same application of tools.

In creating one image and resizing, you have to allow either interpolation of new image

information or decimation, which may not be the optimal process. You can’t work on

small images and resize up, because detail will not be present.

The best way to go about working with multipurpose images is usually to work with

them at the highest resolution and then resize them smaller. Working at the higher of two

or more resolutions retains the details for the higher-resolution presentations, and deci-

mates detail that will not be reproducible at lower resolutions. Softening or other ill-effects

from severe resizing can be countered somewhat by sharpening. (See “(Un)Sharpening and

Boosting Contrast” in Chapter 3 for more information on sharpening.)
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Knowing Your Equipment and Images
Part of working with images on your computer is learning the nuances of systems and

software, and having some idea about what you expect to do with the images. You are

responsible for knowing your equipment and the purpose of your images. This section

cannot help if you are having trouble with your computer system, but it can tell you what

to look for and where to get help. Similarly, it doesn’t tell you what exactly to do with

images but does present some general guidelines for how to proceed.

Know Your Equipment
Because all computers and systems are not alike, it is impossible to cover every nuance of

every system in every situation in one book. There are innumerable digital cameras on the

market, a plethora of ways to get the images off the cameras, and hundreds of home print-

ers to print the result to. Software configurations and utilities can cause fresh problems

while solving others, and compatibilities can be an issue with both hardware and software.

If you have trouble getting the images off your camera, or have trouble with your

printer or computer, the place to find answers is in the user manual for these devices and

through technical support from manufacturers.

The following is a short checklist of maintenance tasks you should recognize, under-

stand, and perform for your computer, peripherals, and software.

Scanners (and Analog Film)

• Calibrate your scanner per manufacturer suggestions.

• Maintain a regimen for cleaning the scanner and scanned objects.

• Be sure to use proper connections and connection settings.

• Consider having important images scanned by scanning services, which may have

better equipment and resolution than you may have at home (for example, scan nega-

tives and slides to a Kodak Photo CD rather than on a home flatbed scanner).

Digital Cameras

• Choose appropriate settings per manufacturer recommendations, and don’t change

settings if you don’t know what they do.

• Learn about special features and settings by reading the manual.

• Understand image control and exposure.

• Understand how to format camera storage.

• Know how to properly connect a camera to your computer and download images

from the camera.
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Printers

• Use appropriate paper and inks as suggested by the manufacturer.

• Read maintenance and cleaning suggestions and follow these practices rigorously.

• Don’t expect RGB results from a CMYK printer. CMYK is a smaller color space,

meaning there are simply fewer colors available.

Computer Software and Hardware

• Maintain a firewall if using an open Internet connection.

• Use virus protection software to minimize problems with infected digital files, espe-

cially if you trade a lot of files. Never open a file from an outside source (even a

known source) if it has not been scanned for viruses.

• Maintain a schedule of maintenance for data backup, disk error scanning, and associ-

ated digital maintenance (such as defragmenting).

• Check manufacturer websites regularly for software updates, bug fixes, and compati-

bility notices.

• Keep a log of program installations to help locate software conflicts.

• Don’t jump to conclusions. Note multiple problems in the operation of your system.

If you have problems with more than one program or device, there may be a common

link to the real cause.

• Simplify your system whenever possible by detaching chronically unused peripherals

and uninstalling unnecessary software.

Know Your Image
Some matters involved in repairing and compositing images are not really judgment calls,

and some are. One thing no book or manual can tell you is exactly what you want to do

with an image. While I can suggest proven ways of getting good results, learning to evalu-

ate an image’s composition and deciding what to do to improve it will be a judgment call.

Your judgment will improve over time and with practice.

Don’t ever say it is good enough if it isn’t good enough. Give up on an image only

when it is not worth the effort to improve it. There is almost nothing you can’t do with an

image if you have the desire. You can also correct the same image from now until dooms-

day, improving it in increments all the time. Sometimes putting an image aside for a day

or two can give you a new perspective: when you come back to it, you may see solutions

you hadn’t previously considered. Solutions won’t always jump out at you, and sometimes
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you’ll have to manufacture them. In trying to stretch your limitations, no matter what you

are attempting to do to an image, chances are you will learn from each solution you

attempt.

The more you work with images, the easier and quicker the manipulations will become.

Now let’s push some pixels…
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Part II
Wrestling with Image Tone and Contrast

Understanding the workings of a digital image starts with separat-

ing the image into its components of color and tone. But separat-

ing components isn’t just an interesting exercise. In the long run,

understanding separations empowers you to make image repairs

beyond the obvious application of standard tools, ramping up the

power of Photoshop Elements. Understanding the basics of sepa-

rating images into components gives you the power to make other

separations as well, including working with CMYK in Elements.

Getting confident with separation empowers you to make

changes. If your image shows mottling, uneven color, or some

other problem that is color- or tone-specific, taking apart the

image elements can help you focus on the real problem. It’s like

treating a wound with plastic surgery instead of just putting a

bunch of stitches and some gauze over it.

Chapter 2 Separating Image Components

Chapter 3 Correcting Image Tone
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Chapter 2
Separating Image Components

Splitting color images into components helps you leverage existing image information to

make changes that would otherwise be either difficult or impossible in Photoshop Ele-

ments. For example, a simple use of separations gives you ultimate control over convert-

ing images from color to black-and-white. With a little ingenuity, you can use separations

to mask specific colors or tones to help you target corrections and changes.

Before you master more complex color separation, you need to learn to handle simpler

concepts, such as filtering RGB channels and separating luminosity (tone). Once you can

make separations, it opens the door to creative image enhancement. We will start by look-

ing at the importance of separation in getting the most out of black-and-white conver-

sions, and we’ll also look at how separation is integral to forming color in images.

The Art of Turning Color to Black-and-White

Turning Black-and-White to Color Again

Applying Color: Separating the Color Component and Hand-Coloring
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The Art of Turning Color to Black-and-White
Black-and-white images hold a different kind of interest than color images. Sometimes

you may want to turn a color image to grayscale to create black-and-white images or duo-

tones (colorized grayscale, like sepia toning). Other times you may want to remove color

from an image so you can then colorize it (hand-color, or reapply existing color to revised

image tone).

There is more to making a good conversion to black-and-white than just choosing

Grayscale from the Mode menu to convert your color to tone. Color images can present

about 16 million variations for each pixel, whereas black-and-white is less robust in being

able to display only 256 levels of tone in 8-bit. Color adds a layer of distinction between

objects in an image: objects can be a similar tone, or darkness/lightness, but distinct in

color. So, while objects may be easy to distinguish in a color image, they can merge or

become less distinct when the image is converted to black-and-white. In other words, if

you take a color image with clearly defined objects and then choose Grayscale to convert

to black-and-white, some of the distinct differences might wash away with the color. Usu-

ally the result—considering how drastic the change is—is surprisingly not catastrophic.

Except in extreme cases, you’ll still be able to see your subject. Different means of han-

dling the conversion can produce better (or worse) results. The key here is that separating

the components provides you options not only for making conversions, but for making

your conversions better.

The simplest way to convert from color to tone is by either converting the image to Gray-

scale mode or desaturating the image. For example, instead of just changing to Grayscale

mode, you can use Enhance ➔ Color ➔ Remove Color, or desaturate the image by using the

Hue/Saturation function (move the Master Saturation slider to -100). These one-step

processes, each produce the same result, based on combining tonal values in the red, green,

and blue channels of an RGB image in specific percentages.

However, the result of the straightforward conversion to tone may not result in the

black-and-white image you’d expect to see. The converted image can be rather blah, lack-

ing definition and contrast between objects. Looking to other qualities that exist, hidden

in the original color of the image, can help provide sources for improving the result.

There are various ways to separate out tones based on color, luminosity/brightness/

tone (each of these three are essentially the same), and saturation. Once you learn to make

separations, you can use the information to replace, supplement, and combine with other

tones to produce improved results. Separating tone can also isolate image components for

necessary repairs, and is often a handy technique to use during image restorations.
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For our first trick, we’ll be doing the impossible by separating a color image into RGB

color components (known as channels in Photoshop). It is “impossible” because Photo-

shop Elements does not have channels, at least not as part of the interface. There is, how-

ever, more than one way to coax RGB components out of any image in Elements. In this

case, you’ll be separating the channel components in the Layers palette. In doing this, you

can see how separations work and create at least three sources for working with tone in

your image—all at the same time.

Separating Color Components (Creating Channels)
Just because a tool is not in the Photoshop Elements program interface does not mean it

can’t be mimicked or invoked in another way. In the case of channels and separations, the

interface for channels may be formally missing, but the light components of the image

that make up the channel content are still there. The red, green, and blue color informa-

tion exists in your color images or else you wouldn’t have color. Just like Prokudin-

Gorskii, who took an image and separated it into RGB components to capture on his glass

plates (see Chapter 1), you will be able to take any color image and split out the compo-

nents by filtering for red, green, and blue in the layers. This will enable you to mimic

channels and take a better look at the tone information as separate color components.

First, you’ll look at how to make RGB separations with a long, but rather simple, step-

by-step process. The separation process mimics Prokudin-Gorskii’s in that you will take

an image and separate out the color components by applying filters, in this case using

layer modes and a few simple color properties. There is an automated way to do the same

thing using the Hidden Power tools included on the book’s companion CD. These tools

are provided so that you don’t have to do the manual steps for the separation each time

you need it. However, don’t just skip the steps and go right for the automated tools,

because you won’t learn anything. What you learn here is imperative in preparing you for

more difficult separation and image control challenges to come.

This set of steps was designed to work with a flattened image (one with only a Back-

ground layer). Your image can be flattened by choosing Layer ➔ Flatten Image if it is not

flattened already (if it is, the option will be grayed-out in the menu). Follow along using

the sample image lily.psd (an orange flower) provided on the Hidden Power CD.

Create the Red Component

First, create the red component:

1. Open the image you want to separate.

2. Duplicate the Background layer (Layer ➔ Duplicate Layer). In the dialog box that

appears, change the name of the layer to Red. Click OK.
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3. Make a fill layer by choosing Layer ➔ New Fill Layer ➔ Solid Color. Click OK. When

the Color Picker dialog box appears, set the color to red (enter values: R = 255, G = 0,

B = 0). Click OK. The image will be red; you’ll fix that in the next few steps.

4. Set the fill layer mode to Multiply by selecting Multiply from the Blending Mode

drop-down list in the upper left of the Layers palette. Multiply will effectively filter the

color image for the red light information, isolating it (see the graphic pictured here).

5. Merge the layers by choosing Layer ➔ Merge Down (Command/Ctrl+E) to commit

the red filtering. You can turn this red light into a channel by adding equal parts of

blue and green to the red in the following steps.

6. Duplicate the Red layer (Layer ➔ Duplicate Layer). This creates a layer named Red

Copy. You’ll need it only temporarily, so there is no need to rename it. Click OK.

7. Make a Hue/Saturation adjustment layer by choosing Layer ➔ New Adjustment Layer
➔ Hue/Saturation. When the Hue/Saturation dialog box appears, use the sliders or

type in the following settings: Hue: +120, Saturation: 0, Lightness: 0. This will change

the color of the red component to green without affecting the tone. Click OK.

8. Merge the Hue/Saturation and Red Copy layers by choosing Layer ➔ Merge Down

(Command/Ctrl+E). This commits the change of color from red to green without

affecting the tone.

9. Set the current layer mode to Screen by selecting Screen from the Blending Mode

drop-down list in the upper left of the Layers palette. Screen mode acts by applying

layer information as additive light.

10. Duplicate the Red Copy layer (Layer ➔ Duplicate Layer). This creates a layer named Red

Copy 2. Again, this is a temporary layer, so there is no need to rename it. Click OK.

11. Make a Hue/Saturation adjustment layer by choosing Layer ➔ New Adjustment Layer ➔

Hue/Saturation. In the Hue/Saturation dialog box, specify these settings: Hue: +120,

Saturation: 0, Lightness: 0. This changes the color of the layer to blue. Click OK.

12. Merge the layers by choosing Layer ➔ Merge Down (Command/Ctrl+E). This com-

mits the change in color from green to blue—still not affecting the tone. The red fil-

tered component is now in the Layers palette in equal parts of red, green, and blue

(see the corresponding graphic). Combining them correctly (as you’ll do in the next

steps) will give you the red color channel as black-and-white tone.

You’ll often need to return to the Background layer to extract different color information, so

duplicating the Background layer at the start leaves you the original source to work from.
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13. Activate the Red layer; then link it to Red Copy and Red Copy 2 by clicking the link-

ing box for each copy layer.

14. Merge the linked layers by choosing Layer ➔ Merge Linked. The result will be a single-

layer grayscale representation of the red light component in the original image. This is

the same thing as the red channel. Your layers should look like this graphic.

Create the Green Component

Similar steps to creating the red component will help you extract the green component:

15. Hide the Red layer by clicking its layer visibility toggle (the eyeball icon) .

16. Activate the Background layer, duplicate it (Layer ➔ Duplicate Layer), and rename the

duplicate layer Green. Click OK.

17. Make a fill layer (Layer ➔ New Fill Layer ➔ Solid Color). The Color Picker dialog box

appears. Set the color to green (R = 0, G = 255, B = 0). Click OK. The whole image

will be green.

18. Set the layer mode of the Color Fill layer to Multiply to reveal the green light compo-

nent of your image. Click OK. Your layers palette should look like the graphic that

appears here.

19. Merge layers by choosing Layer ➔ Merge Down (Command/Ctrl+E).

20. Duplicate the Green layer (Layer ➔ Duplicate). The result will be a layer named 

Green Copy.

21. Make a Hue/Saturation adjustment layer (Layer ➔ New Adjustment Layer ➔ Hue/Satu-

ration) with these settings: Hue: +120, Saturation: 0, Lightness: 0. This changes the

color of the layer to blue.

22. Merge the layers by choosing Layer ➔ Merge Down.

23. Set the layer mode to Screen by selecting Screen from the Blending Mode drop-down

list in the upper left of the Layers palette.

24. Duplicate the Green Copy layer. This will result in a duplicate layer named Green

Copy 2.

25. Make a Hue/Saturation adjustment layer with these settings: Hue: +120, Saturation: 0,

Lightness: 0. This changes the color of the layer to red.

26. Merge the layers by choosing Layer ➔ Merge Down. Your layer stack should look like

this graphic.

27. Activate the Green layer, and then link it to Green Copy and Green Copy 2 by clicking

the linking boxes of the copy layers.
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28. Merge the linked layers (Layer ➔ Merge Linked). This composites the layers into a 

single-layer grayscale representation of the green light component in the original

image. Your layers should look like this graphic.

Create the Blue Component

29. Hide the Green layer by clicking its visibility toggle.

30. Activate the Background layer, duplicate it, and name the new layer Blue.

31. Make a fill layer (Layer ➔ New Fill Layer ➔ Solid Color). The Color Picker dialog box

appears. Set the color to blue (R = 0, G = 0, B = 255). Click OK. The whole image will

be blue.

32. Set the layer mode to Multiply to reveal the blue light component. Click OK. The

layers should look like the graphic pictured here.

33. Merge the layers (Layer ➔ Merge Down).

34. Duplicate the Blue layer (Layer ➔ Duplicate).

35. Make a Hue/Saturation adjustment layer with these settings: Hue: +120, Saturation 0,

Lightness, 0. This changes the color of the layer to red.

36. Merge the layers by choosing Layer ➔ Merge Down (Command/Ctrl+E).

37. Set the current layer mode to Screen.

38. Duplicate the Blue Copy layer.

39. Make a Hue/Saturation adjustment layer (Layer ➔ New Adjustment Layer ➔ Hue/Satu-

ration) with these settings: Hue: +120, Saturation: 0, Lightness: 0. This changes the

color of the layer to green.

40. Merge the layers by choosing Merge Down. The layers should look like this graphic.

41. Activate the Blue layer; then link the Blue, Blue Copy, and Blue Copy 2 layers.

42. Merge the layers by choosing Layer ➔ Merge Linked. Your layers palette should look

like the next graphic.

You have separated the image into three channels, one for each of the primary light

components: red, green, and blue. These components can be looked at as a source for mak-

ing conversion to black-and-white, as well as a source for learning about the nature of light

and RGB theory. These are exactly the same components you would get using the Channels

palette in Photoshop. Save this image by a different name so you can find it later.

Take a moment to examine the layers representing the separate light components by view-

ing them individually. Note the qualitative differences between the red, green, and blue

channels. The representations reveal specific qualities about light in each spectrum.
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Figure 2.1 shows an image of an orange flower against a green background separated

into its components. (See the color representation of this flower in the color section.)

Now that you have seen the separation, you can accomplish the same set of 42 steps in a

single click. Just go to the Hidden Power tools on the Styles and Effects palette, open any

RGB image, and click the Split RGB in the PowerSeparations category of Effects. This will

execute the steps for you. Splitting RGB should be done on a flattened RGB image—results

with images that are not flattened may be somewhat unpredictable and can generate errors.

Separation is a key concept for grasping everything that follows in the book—it isn’t

just a neat parlor trick. It is a lossless process based on light theory—lossless in that it

won’t do any damage to your images. If you can navigate the steps but don’t really under-

stand what each is doing, deeper understanding will come, either as you proceed through

the book or as you repeat the exercise and learn the process.

Separating Luminosity
Separating luminosity from your images is another way to extract valuable tonal informa-

tion and representation of black-and-white. Luminosity is a component of Lab color, which

is a color model that distinguishes color components from tone (lightness). Because this

color model considers tone separately from color, the luminosity component is often a

good representation of what we would expect to see in black-and-white.

Photoshop Elements does not have Lab as one of the image color modes. However, as

with RGB, luminosity and color components can be extracted from an image in more than

one way, and can easily be represented using layers. As a purer measure of tone, the lightness

If you haven’t installed the Hidden Power tools, you can find the tools on the CD and instruc-

tions for installing them in the Introduction to this book (see “The Hidden Power Tools” in the

Introduction). Supplementary information on installing and troubleshooting can be found

on the hiddenelements.com website and the Hidden Power of Photoshop Elements forums

at retouchpro.com.

Red Green Blue

Figure 2.1

These images were
created using the
separation steps in
the previous proce-
dure. Note that the
green looks the most
like what you might
expect as a grayscale
conversion.
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component is often useful when RGB separations may not provide an advantage. For

example, and as you will see, luminosity and color separation is invaluable for color noise

reduction, as often happens in images recorded by digital cameras using fast shutter speeds.

Extracting Luminosity from Color

The following steps will enable you to extract luminosity from any RGB image. Use the

flower image again (lily.psd) with these steps so you can compare the differences in the

resulting grayscale components.

1. Open the lily.psd image.

2. Duplicate the Background layer (Layer ➔ Duplicate Layer). This will be a temporary

layer, so it does not need to be named. Change the layer mode to Luminosity by choos-

ing it from the Blending Mode drop-down list in the upper left of the Layers palette.

3. Activate the Background layer by clicking on it in the Layers palette.

4. Create a new layer (Layer ➔ New ➔ Layer). This creates a new layer between the back-

ground and the copy. Name the layer Luminosity and click OK.

5. Fill the new layer with gray by choosing Edit ➔ Fill and then selecting 50 percent Gray

from the drop-down menu.

6. Duplicate the Composite layer. Name the layer Luminosity and click OK. Your layers

should look like this graphic.

7. Activate the Background Copy layer by clicking on it in the Layers palette.

8. Merge the Background Copy and the Luminosity layer (Layer ➔ Merge Down).

9. Choose Luminosity from the Blending Mode drop-down list in the upper left of the

Layers palette. Your layers palette should look like the next graphic.

With the layer mode changed to Luminosity, what will display is the lightness (or L

channel from the Lab color model), which is a representation of image tone. Save the

resulting file so that you can come back to it later. Comparing this result to the components

of an RGB separation as well as the straight conversion to grayscale by desaturation (as

shown in Figure 2.2) should show some distinct differences in quality. Depending on the

source of the image (digital capture or analog), the content of the image, and the quality

and quantity of light in the capture, these differences will be more—or less—pronounced.

The luminosity component information can be extracted from an image in a single step

by using Hidden Power tools. Just click the Split Luminosity Hidden Power tool in the

PowerSeparations category of Effects; the steps for separating luminosity will execute

when the tool is clicked. The tool will create three elements: the Luminosity component,

the Color component, and the Composite layer. The Color component is Luminosity’s

partner: the components work together to create image color and tone in a similar way
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that RGB color components combine to create a color image. The Composite layer is just

a canvas for the layer components to present against—as if the components are being pro-

jected to a screen. To view the image without the color, activate the Color layer and click

its visibility toggle on the Layers palette to shut off the view. To view the image with-

out the luminosity (essentially this is color and saturation), activate the Luminosity layer

and click its layer visibility toggle to off (the Color layer toggle should be on).

The Split Luminosity power tool should be used on flattened RGB images. We’ll look

more at the color component a little later when we look at how saturation information

can help in CMYK separation.

Making Black-and-White by Borrowing the Best Tone
Sometimes a simple conversion works just fine for changing a color image to black-and-

white. The most straightforward conversion to black-and-white is accomplished by convert-

ing RGB to Grayscale or desaturating. You can also create black-and-white representations

of an image by using components from the RGB or luminosity separations. Sometimes a

component of one of these conversions will suffice, and other times you have to look around

and be more creative by borrowing and combining the tones that you can find lurking in

various components from different separations. This is where the art of converting to black-

and-white comes in: you have to have the vision to see what will combine for an interesting

result.

If you look at the components of an RGB separation, the most representative compo-

nent of what you’d expect to see in black-and-white will often be the green channel. This

is because green is more naturally in the center of the visual spectrum and more closely

resembles how humans perceive tone. The red channel is toward the infrared spectra, and

the blue channel is toward the ultraviolet. Therefore, the red channel more closely repre-

sents infrared capture, and blue is more like ultraviolet.

a b

Figure 2.2

The luminosity, or
lightness, separation
for the image (a)
shows a somewhat
different and often
better representa-
tion of image tone
than simply desatu-
rating the image (b).
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Very often, luminosity will provide an easy source to extract a good black-and-white

representation of any image. It is less prone to color noise and at times will look surpris-

ingly smooth, even when RGB separations have strong color noise (again, this color noise

can happen with images shot with a digital camera in low light).

All of the separation possibilities can show you tonal representations that are somewhat

different—different from each other and different from straight desaturation. Sometimes

a subtle adjustment in any of these three representations can yield greatly improved results

in what otherwise would have been a straight conversion. These adjustments may be sim-

ple changes in tone using correction tools such as Curves (a Hidden Power tool that we’ll

look at in Chapter 3) or Levels. Or the changes may be made by using different areas of the

image from different components and combining them with isolation, masking, or selec-

tion. We will look at methods for making these adjustments in later chapters.

Figure 2.3 shows five possibilities for a simple conversion to black-and-white from a

single image, plus one result that combines three of the separations. For simple conver-

sions, the blue and red can usually be discarded right away as sources because they are not

often good representations of the way you will perceive image tone. However, red and

blue can sometimes be used to make other adjustments (for example, to create selections,

create masks, make calculations between components, mix components, or apply using

histories—all of these techniques are presented in subsequent chapters). Comparison of

the green, luminosity, and grayscale conversion from RGB may reveal different specific

advantages. Adjustment of the available tones in more than one of the separated compo-

nents may create the best result.

Red Green Blue

Luminosity Desaturate Composite of three separations

Figure 2.3

Looking at the five
simple conversions

of image tone can
reveal distinct

advantages in both
representing the

images and select-
ing objects or
components.
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The composite image in Figure 2.3 uses the luminosity, red, and green components.

First, the luminosity component is used as a background: it is lightened to act as a canvas

to set off the flower. The flower is isolated from the green component by using the red

component as a mask. The flower is then just overlaid on the luminosity component by

using layers. The techniques for masking and combining components is covered in later

pages, so we won’t look at those techniques here. We will look more at how to specifically

make adjustments like this in topics that arise throughout the book.

Turning Black-and-White to Color Again
While separations can be useful for creating black-and-white images, the components are

useful for color only if you can recombine them to display color again. Prokudin-Gorskii

had a similar problem after capturing his separations on the glass plates. He had to put

his glass plates in a projector and simultaneously project them in near-perfect alignment

with appropriate filtering (in the form of color cells) to re-create the color result on a

screen.

In Photoshop Elements, you can use layer color and modes to “combine” the sepa-

rated RGB components to re-create the image color. The result can be achieved without

actually combining the separated components. Leaving the components as separate layers

is a great benefit during color correction because you can then adjust each component

and view how those changes affect the color as the changes are made. Layered compo-

nents can be affected by other changes simultaneously, including selection, masking and

adjustment layers.

Compositing Separated Components into a Color Image
The following procedure should be used on an image that has been separated into red,

green, and blue layer components by following the steps in the previous section, “Separat-

ing Color Components (Creating Channels).” The steps in the procedure that follows will

partially reverse the process of creating the separations by enabling the components to dis-

play the color result. These steps are essential in letting you see the image as it should

appear on-screen.

This procedure consists of two phases, preparing the RGB layers and then changing

components to projected light.
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Prepare the RGB Layers

You should be starting with an image that has Red, Green, Blue, and Background layers as

pictured in this graphic. You can either follow the earlier separation procedure to create

the layers, or open any RGB image and click the Split RGB tool in the PowerSeparations

category of Effects. To prepare the layers, follow these steps:

1. Activate the Background layer of the separated image.

2. Make a new layer (Layer ➔ New ➔ Layer). Name the layer Composite. Click OK. This

layer will serve as a canvas for the composite—performing almost the same function

as a projection screen.

3. Fill the layer with black by choosing Edit ➔ Fill. Select Black from the Contents drop-

down list and click OK to complete the fill.

4. Reorder the layers if necessary by clicking and dragging them up or down in the layers

palette. The layers should be in the following order from top to bottom: Red, Green,

Blue, Composite, and Background.

5. Hide the Red and Green layers by turning off their visibility toggles (click the eyeball

icons) on the Layers palette. Your layers should look like the corresponding graphic

shown here.

Changing Tones to Projected Light

Now you need to convert each tonal representation of the image back to a colored light

component so they can recombine for a full-color result:

6. Activate the Blue layer and set the color mode to Screen. Applying the layer as a

screen will lighten the tone of the black composite layer.

7. Make a fill layer (Layer ➔ New Fill Layer ➔ Solid Color). Set the mode for the fill layer

to Multiply. Click the Group With Previous check box (so it is checked) to group the

fill layer with the Blue layer. Click OK.

8. The Color Picker dialog box appears. Set the color to blue (R = 0, G = 0, B = 255).

Click OK. Steps 6 through 8 convert the appearance of the blue component layer

from grayscale back to blue. The resulting effect is that the blue tone projects on the

Composite layer as the blue light component would. The layers should look like the

graphic shown here. In the following steps, you will do the same for the Green and

Red layers.

9. Activate the Green layer and set the layer mode to Screen. This further lightens the

composite because you have added information from the green light source.

10. Make a fill layer (Layer ➔ New Fill Layer ➔ Solid Color). Set the Mode for the fill layer

to Multiply. Click the Group With Previous check box so that it is checked. Click OK.
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11. The Color Picker dialog box appears. Set the color to green (R = 0, G = 255, B = 0).

Click OK. Steps 9 through 11 convert the appearance of the green component layer

from grayscale back to green, and apply the green to the Composite layer as green

light.

12. Activate the Red layer and set the layer mode to Screen.

13. Make a fill layer (Layer ➔ New Fill Layer ➔ Solid Color). Set the Mode for the fill layer

to Multiply. Click the Group with Previous check box so that it is checked. Click OK.

14. The Color Picker dialog box appears. Set the color to red (R = 255, G = 0, B = 0).

Steps 12 through 14 convert the appearance of the red component layer from

grayscale back to red, and apply the red tone to the Com-

posite layer as red light.

At this point, the image will appear to be in RGB color in

the image window, but the color components will still be

available separately in the Layers palette (see Figure 2.4). To

adjust an individual color component, you can create a new

adjustment layer (as many as necessary) between the color

layer and the fill layer. You can make any type of adjustment

to the component, as long as it adjusts the individual compo-

nent layers (Red, Green, and Blue) and not the fill layers. The

result can be converted back to an RGB image, without com-

ponents, by flattening.

Steps to change the separated RGB components to color layers, adding color fill to sepa-

rations you created, can be accomplished by using a single click with Hidden Power tools.

Clicking Preview RGB in the PowerSeparations category of Effects will perform steps 1 to

14 in this procedure. To perform both the separation and the preview of an image in one

easy step, click Split RGB w-Preview in the same category of Effects. Split RGB w-Preview

should be performed on a flattened RGB image. These Hidden Power tools will be invalu-

able to you in working through the book and making future image corrections by provid-

ing a useful, quick means of creating RGB separations.

Applying Color: Separating the Color Component
and Hand-Coloring
Separations represent the source components of an image in its original colors. Color can

be introduced to your images and enhanced in other ways. Colorizing (or hand-coloring)

images is an artistic approach to adding color. It differs from recombining RGB compo-

nents into color or adding back the color element of a luminosity separation: it is a separate
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The separated colors
in the image are suc-
cessfully combined
to re-create the
color in layers while
being kept separate.
This enables you to
work with layers as 
if they were Photo-
shop channels.
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application of color. The color you apply may be a radical change from any original color.

The tone, color, or components in the image can be used as a canvas to paint the color on.

Color can be applied to tone in an infinite number of ways, using various Photoshop

Elements tools. The color application can be done with simple painting tools or with a

more complex color application (for example, gradient mapping and/or blending). We’ll

take a brief look here at applying original color to tone and applying new color, to further

delve into how color and tone work together to create the images you see.

Looking at Color Distinctly from Tone
Earlier in this chapter, you extracted the tone from an image(see the exercise in “Extract-

ing Luminosity from Color”), and the byproduct of completing that separation was a

luminosity component. That component represented the tone as separate from the color

in the image. The separation didn’t address the color component, which can be isolated as

well. The color component represents the hue and saturation of the image separate from

the tone. You can think of hue as color (perhaps as picked from a color wheel) and satura-

tion as the purity or vibrancy of that color.

Isolating and reapplying original color to tone is pretty simple in a luminosity and

color separation—not nearly as complex as re-creating color from RGB separations. Start-

ing with an image that you have extracted a luminosity component from in the earlier

exercise, your image should have the following layers from the top down: Luminosity,

Composite, and Background. (If you don’t have the image with these layers, open

lily.psd and repeat the steps in “Extracting Luminosity from Color.”) Completing the

separation to extract the color is done in a few easy steps:

1. Duplicate the Background layer. Name the duplicate layer Color.

2. Move the Color layer to the top of the stack.

3. Change the mode of the Color layer to Color (see the graphic pictured here).

In completing these few steps, you have added the color back to the image tone by

using a separate color component layer. You can then work on the color and lightness

(luminosity) components individually. That is, you can adjust the image tone separate

from the color, and adjust the color independent of the tone. The color component can be

extracted, changed, and applied to the original image, it can be applied to the extracted

luminosity component, or it can be applied to other tone variations, such as the tone cre-

ated by an RGB component. Figure 2.5 shows the result of a completed luminosity and

color separation, with a sample of how adjustment layers could be placed for simple alter-

ations to color and tone.

The way color is working here is more like how an artist might mix paint. Color mixes

with tone to produce a result. If there is no color, the tone is applied in grayscale. If there
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is no tone (white), the color is applied, but results in no color value: because there is no

tone in pure white, there is no tone in the applied color. The darker the tone, the darker

the applied color, until it turns black. When the image is black, the color layer again shows

no effect on the visible result. The brightness/lightness is mixed with hue and saturation (a

color) to make the result. This is much more straightforward and intuitive than RGB,

encompassing different advantages.

When a color in an image seems wrong, you might

need to make a change in the color or tone—or both—to

get it right. One or the other won’t always work to get you

where you want to go. Separating the components gives

you more freedom to work with color and tone independ-

ently to achieve the desired result.

We’ll look much more in depth at adjusting image

color in Chapter 5. In the following section, we’ll con-

tinue exploring adding color to tone.

Basic Hand-Coloring
Hand-coloring is the art of applying color by hand to images (usually black-and-white

images). The effect can be anything from the addition of a simple color wash to garish

additions of color, glitter, and other media. It can be lots of fun: either in attempting to re-

create color in an image (in restoration or colorization), or in just replacing color for wild

effects. In a way it can be a better coloring book (for adults or children). For our purposes,

hand-coloring is another step in the study of applying color to tone.

E X P L O R I N G  C O L O R  A N D  T O N E  T H R O U G H  T H E  C O M P O S I T E  L A Y E R

The Composite layer in Hidden Power separations is used as a canvas for applying and mix-

ing separated components. If you fill the Composite layer with white, shut off the view for

Luminosity and leave Color viewed. The image will turn white, even though the visibility for

the color layer is still on. What many would expect is that the color for the image would be

applied to the white composite. This is actually what is happening, and the result is very

revealing about the relationship between color and tone. Because there is no tone in white,

there is nothing for the color to display.

The point is, the display of color is directly dependent on tone: if you want color to display

differently (lighter or darker), you’ll have to manipulate the tone rather than the color. Making

tone darker in an area of color will darken the color; lightening tone will lighten color. If you

want another hue (for example, if you want to turn green to blue), you can change the color

layer from the separation without affecting the tone.
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With tonality and
color separated, you
can effectively con-
trol one component
without affecting
the other. Here Lev-
els are applied to
tone, and Hue/Satu-
ration to color
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The simplest way to add color to a black-and-white image is a method similar to apply-

ing the color component in the luminosity and color separation. Try this out:

1. Open any one of the separations you have made for the lily, or create a black-and-

white result for any image.

2. Copy the layer you want to color to a new image (on the Layers palette, choose More ➔

Duplicate Layer, and then choose New from the Document drop-down list in the Dupli-

cate Layer dialog box).

3. Flatten the New image (Layer ➔ Flatten Image) and change to RGB mode (Image ➔

Mode ➔ RGB Color) if necessary.

4. Create a new layer above the black-and-white image background, and set the new

layer mode to Color. Name the layer Color or something more appropriate to the

color you will be applying (see the next step).

5. Change the Foreground color to the color you would like to paint in the image (click

the foreground swatch on the toolbar to open the Color Picker, or use the Eyedropper

to sample a color from another color image).

6. Choose the Brush tool (press B on the keyboard), and paint over the areas where you

would like to apply the color in the new layer.

7. To paint in another color, repeat steps 5 to 6. Your layer setup should look like

Figure 2.6.

Figure 2.6

In this technique
color gets flatly

painted over tone in
its own layer.
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The preceding steps let you paint with whatever colors you like. Colors could be added

all in a single layer, as in this example, or directly to the tone, but these options offer less

opportunity to adjust the colors later. For more flexibility, you can add additional colors

to separate layers. To add additional colors on separate layers in the lily.psd image, con-

tinuing from the previous exercise, you could just do the following:

• Create a new layer (call it something appropriate to the second color you want 

to add).

• Drag the new layer to the top of the layer stack.

• Change its mode to Color.

• Repeat steps 5 to 11. A sample of a multi-layered approach appears in Figure 2.7.

The drawback to this hand-coloring method is that

tone gets flatly covered with color. Although the color

varies as you see it because of the underlying tone, it

doesn’t always map as you would expect—it can be

weaker or stronger in areas because the tone below it

varies. You can adjust the color with layer opacity, 

and other tools, like smudge, Gaussian Blur, and other

filters.

If you try this in an image with people and attempt

to replace the skin tones, the flatness of the resulting

skin tones will be quite evident and unnatural. Though

this result can be improved by adjusting the quality of

the color you are applying (see “Managing Image

Noise,” where skin tone is adjusted using noise), the

color isn’t as “smart” as you might expect. A Gradient

Map can often be a better choice for hand-coloring.

Hand-Coloring with Gradient Maps
Usually, applying flat color is not the best way to hand-color images. Instead, you can use

gradients, which create a progressive change in color. Gradients can be applied using the

Gradient tool or Gradient Map adjustment layers. The Gradient tool applies the gradient

color according to the pattern selected in the options in the direction and distance that

you apply the tool. This has somewhat limited application in hand-coloring and is more

likely to be used in creating effects. Gradient Map adjustment layers replace colors and/or

tones by using a customized color mapping. When a gradient map is applied, Elements

replaces each level of gray with its corresponding gradient color as you’ve set it up in the

gradient mapping.
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application.
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So, say you have a grayscale image, and you apply a gradient map that has 100 percent

red (R = 255, G = 0, B = 0) at the halfway point on the gradient (50 percent gray). All of

the gray pixels at 50 percent brightness will display as red. If this gradient blends evenly to

black at 0 percent and white at 100 percent, the red will fade to pink and then white where

tones in the image get lighter; the red will darken to brick and then black where tones in

the image get darker. Gradient application of color and tone can be infinitely more com-

plex than this simple example by using more complicated gradients.

Remapping color and tone can work well in a limited area of an image. For example,

you might use selection or masking to target a specific area of an image for recoloring skin

tones. You can combine effects of two or more different gradient maps in a single image

by using different maps with different selections or masks. Gradient Maps can also be used

to create toning effects—for example, in sunset scenes or for duotone effects—so that the

tone in an image can be associated almost exactly one-to-one with color.

To work with gradient maps, you need to be able to create and manipulate gradients.

To work with gradients you will use the Gradient Editor, which can be opened from the

Gradient Map dialog box. Open the Gradient Map dialog box by applying a gradient map

as an adjustment layer (Layer ➔ New Adjustment Layer ➔ Gradient Map, click OK). When

the Gradient Map dialog box is open, click the color bar under Gradient Used For

Grayscale Mapping to open the editor.

Once the Gradient Editor is open, you can edit the current gradient, and create and

save custom gradients for reuse. New gradients are created by adding and removing color

and opacity stops, choosing a name, and clicking the New button. These new gradients are

stored in the gradient library and are available whenever you choose gradient functions.

Figure 2.8 shows the Gradient Editor dialog box and a breakdown of the major features.

Gradient preview bar

Midpoint control
Active stop indicator

Name

Opacity stop

Color stop

Figure 2.8

The Gradient Editor
allows the creation

of custom color and
tone alterations

based on existing
image tone.
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Features in the Gradient Editor include buttons, the Name field, opacity and color

stops, and Stops options.

Buttons

• Click More to reveal Presets panel options. You can change the way the swatches are

viewed in the Presets panel or change the gradient sets that are viewed.

• Click OK to accept the current values and close the dialog box.

• Click Cancel to close the editor without accepting changes.

• Click Load to load a gradient set.

• Click Save to save the current gradients as a set.

• Press the Alt/Option key to change the Cancel button to a Reset button. Click Reset to

eliminate all changes made since the editor was opened and revert to the original values.

• Click New to create a new preset. This will save a swatch with the current settings

and name.

• Click Delete to remove an active color or opacity stop. See “Opacity and Color Stops”

below for more on stops.

Name

• Enter a name for the current gradient, and then click New to save the gradient (in its

current settings) to the Presets list.

Opacity and Color Stops

• Add a stop by clicking above or below the preview bar. Opacity stops are added by

clicking above the gradient preview bar; color stops are added by clicking below the

gradient preview bar.

• Remove a stop by clicking it, holding the mouse button down, and dragging the stop

off the preview bar. Alternately, you can click the Delete button with the desired 

stop active.

• Click a stop to activate it. The stop with its triangle colored black is the active stop

(the stop whose settings appear in the Stops section of the dialog box).

• Double-click a color stop to open the Color Picker.

applying color: separating the color component and hand-coloring ■ 61

4385c02.qxd  11/7/04  11:29 PM  Page 61



Stops Options

• The Stops options on the top row of the Stops section show the values for the active

opacity stop. To set Opacity for a stop, activate the desired stop and enter a number

or click the arrow to drop down a slider.

• The Stops options on the bottom row apply to the active color stop. The Color swatch

provides a preview of the stop’s color; click it to open the Color Picker.

• Enter a Location value for either stop type to accurately position the stop (from 0 per-

cent at the far left to 100 percent at the far right).

• Click the Delete button to remove the active stop.

Editing Your Gradient

Setting up your gradient requires adding color stops to the bottom of the gradient bar to

control the application of color to the tones in the image. To add a color stop, click just

below the gradient bar and then drag the stop to the position on the gradient bar where

you want to locate it. The color of the stop can be changed in several ways:

• Sample color directly from the image (moving your cursor over the image changes it

to the sample tool).

• Double-click the color stop to open the Color Picker.

• Make a selection (Foreground, Background, or User Color) from the drop-down

menu next to the Color swatch.

The opacity of the color application can be controlled by the opacity stops set on the

top of the gradient bar. If you choose color carefully, the colors you apply should affect

simply the color you want to see.

The image to which you will be applying the Gradient Map can be converted to

grayscale if you like, but this isn’t necessary; the map will work on the image tonality inde-

pendently of current color. In some cases, it may actually be easiest to leave the color in

the image so you can use the existing colors as sample color for the enhancement. Differ-

ent images will require different handling depending on the color that exists and what you

want to accomplish. You may want to adjust image tone or separate out image areas

before applying gradient maps.

Applying a Gradient Map

One of the simplest applications of a gradient is to use it to make tone adjustments in a

grayscale image. In fact, the Gradient Editor can be used just like a Levels or Curves adjust-

ment (we’ll look at how to make Levels and Curves adjustments in the next chapter).
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Try this simple Gradient Map application to adjust image tone:

1. Open any flattened black-and-white image (or open a color image, flatten the image,

click the Split Luminosity Hidden Power tool in the PowerSeparations category of

Effects, shut off the Color layer, and flatten again). If the image is in Grayscale mode,

change it to RGB mode.

2. Press D on the keyboard to reset the Foreground and Background colors on the toolbox.

3. Open a Gradient Map by choosing Layer ➔ New Adjustment Layer ➔ Gradient Map.

Click OK on the New Layer dialog box. This opens the Gradient Map dialog box with

the Foreground-to-Background gradient default.

4. Click the Gradient Used For Grayscale Mapping swatch on the dialog box. This opens

the Gradient Editor.

5. Click directly on the white color stop at the right of the gradient preview bar. This

reveals a color midpoint (small gray diamond) in the center of the bar at the bottom.

6. Position the Gradient Editor so you can see your image, and move the slider right and

then left of center while watching what happens to the image. (You may have to

release the slider to see the result). Moving the slider left should lighten the image,

and moving it right should darken it.

This simple application remaps the tone of the image based on the position of the

slider. You can create far more complex tonal adjustments by adding color and opacity

stops to the preview bar.

On the Hidden Power CD, you’ll find an image titled oceansun.psd (Figure 2.9), taken at

sunrise. This example is selected specifically to show how dramatic a Gradient Map change

can be. Because the image is a sunrise, the colors are limited to mostly warm colors (reds

and yellows). The stops and adjustments noted in the following exercise will work only on

this image. Applying the color with gradients is an art more than a science. Results of this

sort are steeped in trial and error. I created the result here by placing and adjusting mark-

ers, knowing only approximately where they would fall: brighter colors in the lighter half of

the tone. You will need to experiment a little when placing stops to adjust other images—

even when attempting the same effect—because tone in each exposure will be different.

When you click a stop to activate it, diamond-shaped markers appear to either side of the

stop, between it and the next stop. These midpoints can be adjusted to affect the application

of the gradient. Shifting the midpoint to the left increases the influence of the right stop;

shifting the midpoint to the right increases the influence of the left stop. Adjust the color

markers while viewing the image to get the best results.
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In the following exercise, you will use Gradient Maps for tone and color adjustment in

separate steps. First you’ll want to darken up the image a little so that the image will accept

some more saturated colors (remembering that tone and color work together). Once

you’ve darkened the image, you can apply color to get a dramatic color result. You’ll need

to make sure existing stops in the gradient are the correct color and add some stops. When

you get to the color, you’ll make light areas of the image yellow, and deepen that color

toward red to imitate the effect sunrise lighting produces. Darker areas of the image will

reflect blues from the water.

Adjust the Contrast and Darken the Image

1. Create a Gradient Map adjustment layer by choosing Layer ➔ New Adjustment Layer ➔

Gradient Map. Click OK on the New Layer dialog box. This opens the Gradient Map

dialog box.

2. Open the Gradient Editor by clicking the gradient bar in the Gradient Used For

Grayscale Mapping preview section.

Figure 2.9

The colors in the
original sunrise are

dulled yellows,
oranges, and grays,

but the results can
be made more dra-

matic by using a
Gradient Map.
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3. Double-click the 0 percent color stop (at the bottom left) to open the Color Picker

dialog box, and change the color to black (R = 0, G = 0, B = 0). (In this example

image, it should already default to black.) Click OK to close the Color Picker.

4. Add a color stop to the gradient by clicking below the gradient preview bar. Set the

position of the stop to 40 percent by typing 40 in the Location field.

5. Double-click the new color stop to open the Color Picker dialog box. Change the

color of the stop to H = 0, S = 0, B = 33 (33 percent bright). (HSB is an alternative

color scheme representing hue, saturation, and brightness.) Making this change will

darken the tones at the 40 percent position from 40 percent to 33 percent bright.

Click OK to accept the changes and close the Color Picker.

6. Add another color stop to the gradient by clicking below the gradient preview bar. Set

the position of the stop to 60 percent by typing 60 in the Location field.

7. Double-click the new color stop to open the Color Picker. Change the color of the

stop to H = 0, S = 0, B = 55 to change the tone 5 percent darker at this point, from 60

percent to 55 percent. Click OK to accept the changes and close the Color Picker.

8. Double-click the 100 percent color stop (at the bottom right) to activate it and open

the Color Picker.

9. Change the color of the stop if neces-

sary to white R = 255, G = 255, B =

255 or H = 0, S = 0, B = 100 (your

stop may already be set to these set-

tings). Click OK to close the Color

Picker. At this point the Gradient

Editor should look something like

Figure 2.10.

10. Click OK on the Gradient Editor to close it and accept the changes to the gradient.

11. Click OK on the Gradient Map dialog box to close it and accept the changes for the

new layer.

At this point, the image should be notably darker, and it will change visibly from color

to black-and-white. The result should resemble Figure 2.11. The selected settings will

darken and convert any image to black-and-white, but they are used specifically in this

image to change the tone. The goal here was specifically to darken the midtones. Toggle

the visibility for the Gradient Map layer to see before and after.
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The change in the
gradient increases
the influence of the
darker tones.
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Recolor the Altered Tone

12. Create another Gradient Map adjustment layer (Layer ➔ New Adjustment Layer ➔

Gradient Map).

13. Click OK in the New Layer dialog box to open the Gradient Map dialog box.

14. Click OK in the Gradient Map dialog box to close it and create the new layer.

15. Change the layer opacity to 50 percent by using the Opacity slider on the Layers

palette. This enables you to intentionally apply strong colors rather than muted ones

to achieve your result. You can adjust the opacity again later to make the color

stronger or weaker, as desired.

16. Change the layer mode to Color by using the Mode drop-down list. This will apply

the color in the gradient rather than forcing adjustment of tone and color—which

may be much harder to control.

17. Double-click the layer thumbnail for the active layer on the Layers palette. This opens

the Gradient Map dialog box.

18. Open the Gradient Editor by clicking the gradient bar in the Gradient Used For

Grayscale Mapping preview.

19. Double-click the 0 percent color stop (at bottom left) and change the color to dark

gray (R = 40, G = 40, B = 40). Click OK to close the Color Picker. The color can be

Figure 2.11

The gradient map-
ping has adjusted

the tones according
to the stops placed

in the gradient.
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changed in the Color Picker by typing the values into the RGB boxes after opening the

picker by using any of the methods described earlier.

20. Add a color stop to the gradient by clicking below the gradient preview bar. Set the

position of the stop to 25 percent by typing 25 in the Location field.

21. Double-click the stop and change its color to R = 25, G = 30, B = 90. This is a deep

blue that will be used to keep a bluish tone in the water and in the darkest parts of the

clouds. Click OK to close the Color Picker.

22. Add a color stop to the gradient by clicking below the gradient preview bar. Set the

position of the stop to 40 percent by typing 40 in the Location field.

23. Double-click the stop and change its color to R = 145, G = 115, B = 120. This is a

muted red that helps serve as a transition between blue and orange. Click OK to close

the Color Picker.

24. Add a color stop to the gradient by clicking below the gradient preview bar. Set the

position of the stop to 60 percent by typing 60 in the Location field.

25. Double-click the stop and change its color to R = 255, G = 90, B = 0. This color begins

the more dramatic color highlighting by saturating the brighter portions of the image

in orange. Click OK to close the Color Picker.

26. Add a color stop to the gradient by clicking below the gradient preview bar. Set the

position of the stop to 85 percent by typing 85 in the Location field.

27. Double-click the stop and change its color to R = 250, G = 250, B = 20. Yellow will be

used to add some spark to the somewhat drab highlights in the original. Click OK to

close the Color Picker.

28. Double-click on the 100% (white) stop and change its color to 

R = 245, G = 245, B = 200. This is not quite white, and can

stop the sun from looking too burned in and bright in the

image. Click OK to close the Color Picker to activate it. At

this point the Gradient Editor should look something like

Figure 2.12.

29. Click OK on the Gradient Editor to accept the changes to the

gradient.

30. Click OK on the Gradient Map dialog box to close it and

accept the changes for the new layer.

31. Adjust the opacity for the Gradient Map 2 layer on the Layers

palette to make the effect pleasing on-screen.

The result of the changes made in steps 12 through 31 can be

seen in the color section. Your result should show a golden-orange
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Positioning of the
stops should look
like this after you
have completed
step 28.
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sunrise, with quite a bit more color than the original. The changes you made here reflect

the idea of making changes in separated components of the image: The first gradient map

changes tone, affecting the luminosity of the image; the second gradient map targets the

color. Although you haven’t specifically made a luminosity and color separation, the func-

tion of the correction is the same as if you had.

One of the great advantages of using layered corrections is not only the ability to sepa-

rate the components of the image that you are adjusting, but the ability to adjust after the

fact. Setting color markers is obviously the most involved step in the process—and easily

the most arbitrary. It will be useful to go back and experiment by adjusting the color and

position of the gradient stops to see the effect each adjustment has on the image. You may

want to use additional stops to create changes you may prefer and experiment with Gradi-

ent Map opacity. Leave this image open for now; you’ll need it for the next procedure.

To add more control, you might want to experiment with separating control of the sky

and sea. In the example, you can control the effects in the sky separately from the effects in

the sea. A simple masking of image areas can enable you to adjust the colors in each with

different gradients to improve the realism of the result. Because the horizon is flat, select-

ing one image area can be done quickly by using the Polygonal Lasso.

Creating a Mask for Gradients

The selections outlined in this procedure are very much specific to this image. Your selec-

tions should be made on an image-to-image basis, according to the content you want to

apply effects to. Begin this procedure by using the image from the previous procedure,

with the contrast adjusted and tones altered. Then follow these steps:

1. Commit the grayscale changes by merging Gradient Map 1 with the Background layer.

2. Duplicate Gradient Map 2 and change the name of the duplicate layer to Sky Gradient.

3. Click and drag the lower-right corner of the image window to reveal the image matte,

as shown in Figure 2.13. You may have to zoom out from the image if you are in close

to make the image smaller before attempting to view the matte.
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4. Choose the Polygonal Lasso tool; then select the Anti-Aliased option and change the

Feathering to 2 pixels on the options bar.

5. Click the Lasso tool to the left of and just outside the image, right at the horizon line

on the image matte.

6. Move the cursor to the right of the image and click just outside the image on the

image matte, right at the horizon line. This should make a selection line along the

horizon.

7. Complete the selection by clicking three more times: outside the image at the bottom-

right corner, at the bottom-left corner, and then back at the point of origin, as shown

in Figure 2.14.

8. Change the foreground color to black.

9. Choose the Paint Bucket tool. Be sure the Sky Gradient layer is active, and click the

Paint Bucket tool in the selected area on the image. The mask for the Gradient Map

layer will fill with black in the selected area. This masks out (hides) the gradient effect

on the sea for this layer; the layer effect applies only to the sky.

10. Select the inverse of the area that is currently selected (Select ➔ Inverse).

11. Activate the Gradient Map 2 layer by clicking it. Change the name of the layer to Sea

Gradient.

12. Fill the sky area of the mask by using the Paint Bucket tool. The fill will hide the gra-

dient effect of this layer over the sky.

This will effectively mask the sky separately from the sea by using the same gradient

map with two complementary masks, allowing a 2-pixel blend where the edges of the

mask meet. After the masking has been completed,

making adjustments to either of the gradient maps

will affect the sky and sea separately. In the image

used for this example, the masking provides an

opportunity to use completely different gradient

maps for the sky and sea, if desired. Changes can

also be subtle, like removing any residual blue from

the clouds in the sky without affecting the color 

of the sea. Try removing the dark blue stop (at the

25 percent location) from the Sky Gradient gradi-

ent map and raise the opacity of the layer to 65 per-

cent. As the clouds would tend to be a warmer color

(red to yellow), rather than a sea blue, this change

will enhance the color of the clouds and intensify it.
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By using masking and multiple gradient layers to apply gradients, and by working with

layer modes and opacity, you can achieve complex results. Of course, this example is only

the tip of the iceberg when it comes to applying color to tone. Combined with a variety of

other tools you will use for enhancing and replacing color (which we will explore in later

chapters), your ability to control the result is limitless.

A few points should be clear: The foundation for color application is tone. You must be

able to control tone as a basis for image color. Targeting areas of change—with separation,

layer properties, or masking—can help you confine your correction to specific areas or

components of your images so you can achieve better results.
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Chapter 3
Correcting Image Tone

Manipulating tone with confidence makes all the difference in getting the results you want

in black-and-white and color. Adjusting tone starts with evaluating the image to define

what you want to do, and moves through steps to make changes based on that evaluation.

Two points to keep in mind:

• For every action, there is a reaction.

• You might have to break it to fix it.

The first point is an adaptation of one of Newton’s laws of physics. Every general adjust-

ment you make will affect what you are adjusting as well as other tones. The second is based

on my experience with “fixing” appliances by disabling broken functions. In images, a fix

doesn’t always make everything in an image better, but it should improve the appearance of

the image. Sometimes you must do something destructive to an image to enable a repair.

Doing Minor Cleanup First

Evaluating Image Tones

Redistributing Tone with Levels

Snapping and Fading Contrast with Curves

(Un)Sharpening and Boosting Contrast

Managing Image Noise

Masking with Image Tone
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Doing Minor Cleanup First
Before adjusting an image, it is often good to do a quick once-over to evaluate image prob-

lems. This quick evaluation can involve first cropping the image and then removing, or

touching up, other damage. Care in touch-up at this point permanently removes unwanted

elements so they will not be present later no matter how you use the content of the image.

Two simple, direct methods of taking care of minor damage are cloning and duplicat-

ing image areas. With cloning, you sample information from one part of an image and

then apply that information to another part of the image that might be damaged or miss-

ing. Cloning covers up the problem with other, problem-free image information. It can

solve any type of minor damage, including dings, dirt, digital noise, and tears, as long as

you have something to clone from that is a close match to the spot you are fixing. You can

also use simple duplication to select an area of an image and copy it to another area to cor-

rect damage. Careful cloning or duplication can enable you to patch an image seamlessly

without creating noticeable patterns or replacing damage with image flaws.

Image areas with tone and color complexities (such as skin tones) require careful selec-

tion of replacement areas in order to make unnoticeable repairs. Substitutions can come

from within the same image or from another image with similar qualities. All cloning and

duplication corrections follow the same basic steps:

1. Define the damaged area.

2. Locate a suitable replacement.

3. Obtain a sample of the replacement.

4. Apply the replacement to the damaged area.

D O  S O M E  D A M A G E  C O N T R O L  B Y  P L A N N I N G  A H E A D

You can avoid a lot of trouble with your digital images before you create them. Don’t get into the habit of just

thinking, “I’ll clean it up later digitally!” A quick wipe with a clean, lint-free cloth can clear troublesome debris from

an image you are scanning, or from the scanner glass, just as you might wipe crumbs from a chair before you sit

down. The same idea applies to taking images with a digital camera; be sure your lens is clean before you point it at

anything, wipe off dusty or dirty objects that will be in your images, and be sure you take the time to focus so your

subject is as crisp and clear as possible. Taking these steps can save a lot of detail work later.

Obviously you can’t expect anything to be pristine. Dust and finger smudges can appear at any point where the

image makes a physical rather than electronic transfer (on the subject, on your lens, on the scanner glass, on the

surface of a print or negative, and so forth). But once you’ve taken the image or scanned it, any minor nagging

defects that worked their way into your image will remain until you remove them.

The more time you spend preparing to create an image, the cleaner the image will be and the fewer problems

you will have to correct, which saves lots of time at the computer.
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Correcting By Using the Clone Stamp Tool
The Clone Stamp tool samples from a spot that you define in the image and copies image

information in the shape of the brush you’ve chosen for the tool. This will help you take

care of dust, flecked dirt, scratches, and many other minor image problems.

To select the area you will be cloning from, hold down the Option/Alt key with the cursor

directly over what you will be cloning, and then click the mouse to set the area for the sample.

The sample can be taken from the same image or another image, or from a different layer in

the same image. Release the Option/Alt key and place the cursor over the target (the damaged

area to be repaired). When you click the mouse again, the sample area will be applied to the

target area. The distance and angle between the sample and brush will lock in with that rela-

tionship until you change the sample. To change the sample angle and distance, hold down

the Option/Alt key and create a new sample. Both the clone-from and clone-to areas show 

on the image while you hold down the mouse button to apply the tool. This way, you can

monitor accurately what area will be copied as well as the result. See Figure 3.1.

b

c

a

d

Figure 3.1

Identify a damaged
area (a), sample the
replacement (b), 
and apply it (c) to
achieve a repaired
image (d).

Images can be cropped to remove damage, but also to improve composition. Composition is

discussed along with the tools in Chapter 7.
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A practice image called wavedirt.psd is supplied on the CD. It is a scan of just the cor-

ner of an image that was apparently taken with a dirty lens. The changes you have to make

may look simple, but correcting while paying close attention to the patterning and shading

can prove to be tricky. The entire process of correction is as follows:

1. Choose the Clone Stamp tool (S).

2. Change the image view to 200 percent–300 percent. This size ensures that you are

viewing all of the pixel information on-screen to make accurate applications.

3. Choose a brush. Brush size for dust correction should be somewhat larger than the

width of the damage. In most cases, use a slightly soft brush (85 percent–95 percent

hardness) so that corrections feather slightly into the surroundings as they are applied.

4. Choose a clone-from area, using the Option/Alt key to define your sample. The area

you clone from should be clear of damage and dust, or you will copy that damage to

the spot you are trying to fix.

5. Apply the Clone Stamp tool to the spot you would like to repair by releasing the

Option/Alt key, positioning the cursor over the damage, and clicking the mouse. This

sets the cloning angle and distance and applies the correction. Holding down the

mouse button and dragging will apply the cloning over the area you drag across,

maintaining the angle and distance between the sample and application points.

Your setting for Painting Cursors on the Display & Cursors preferences (Edit ➔ Preferences
➔ Display & Cursors) will determine the way the Clone Stamp tool appears on your screen.

Standard shows the tool icon during application, Precise shows a crosshair , and

Brush Size shows the shape of the brush being applied . All three tool display options use

the sample icon when you hold down the Option/Alt key to sample the image.

For the best results, hold down the mouse button only as long as you have to; click over

the damage and release. Click new sample points as often as necessary, but try to do so fre-

quently. Changing the angle between the sample and application point can help reduce

the possibility of creating undesirable patterns and obvious duplication of image areas.

For most corrections, choose the following options for the Clone Stamp tool:

• Aligned cloning (clones from sample point to application point by using a set dis-

tance and angle)

• Use All Layers

• A soft brush (85 percent–95 percent hard)

The screen view percentage refers to the percentage of information in the image that you are

viewing, not the print size or some other physical delineation. At 100 percent, each pixel is

displayed on-screen.
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• Brush spacing set to 1 percent

• Normal mode

• 100 percent opacity

You will most often use the Clone Stamp tool in Normal mode, but in some instances

other modes can serve a purpose. For example, to correct black specks, use Lighten mode

and stamp from a slightly darker portion of the image. This will lighten the specks without

darkening lighter areas. If you are stamping with the tool in Lighten mode to lighten dark

spots in a light image area, clone from an area a little darker than the area you are cloning

to. If you are trying to fix light specks, clone from an area a little lighter than the area you

are cloning to using Darken mode. The corrections will tend to affect only the specks

while keeping the general tone of the area unchanged.

Making corrections can be easier if you apply them to another layer. To use another

layer to hold corrections, create a new layer above the one where you want to apply the

correction, and then make your sample and apply it to the new layer. You can view before

and after by toggling on and off the view for the layer. Making corrections on a separate

layer also enables you to make other adjustments (such as applying filters or changing layer

modes) while preserving your original image.

Correcting By Duplication (Patching)
It is sometimes advantageous to make corrections by copying and pasting larger areas of

an image rather than painstakingly removing each speck of dust one at a time with the

Clone Stamp tool.

Preselecting to define the shape and size of a large area of damage that you want to cor-

rect will enable you to find the best available replacement area and make quick work of

repairs. The order of your approach and some basic techniques will remain the same when

compared to cloning:

1. Identify the problem area in the image and the intended replacement.

If your brush has a soft edge, the actual effects of the brush application extend outside the

brush size shown on-screen.

Brush options can be set only when using the Brush tool. To get the brush you want, choose

the Brush tool, set the options (by clicking More Options on the Options bar), and then save the

brush by clicking the brush preview and choosing New Brush from the pop-up menu. After

the brush is saved, you can use it with other tools.
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2. Click on a selection tool. The Lasso tool is often a good choice because it will make

irregular selections, and irregular patches tend to blend in less noticeably. Set the tool

to feather the selection; this will soften the edge of the sample. Usually you have to

feather only a few pixels (2–5), depending on the resolution of the image and the

detail in the content of the patch.

3. Make a selection with the selection tool around the general area of the image you

want to replace. Making this selection will ensure that you get a patch that is sized to

cover the damage—like a template. Make the selection a bit larger than the damage so

you can have some leeway in blending pasted areas.

4. Move the selection tool over the selection created in step 3, and the icon will change

to the selection move icon . Click and drag the selection over to the area of the

image to be used as a replacement. Choosing exactly where to place the selection can

require rotating, flipping, or carefully sizing the selection. You may want to note any

changes you make so you can reverse them after you paste the replacement. The

options bar will show these changes.

5. Copy the selected area.

6. Paste. This creates a new layer containing the image area you are using as a patch.

Because the patch is on its own layer, you can size and position it (by reversing the

changes made in step 4), or use the Eraser tool and a slightly soft brush to blend the

patch with the area being covered. Layer modes can also be employed (for example,

Lighten and Darken).

7. Repeat steps 1 through 6 as needed to create more patches and repair the image.

If time permits and you have more than one option for making the correction, you

might want to try several different solutions for the same problem area—especially if the

area that you are patching is large or important to the image. Make the first patch and

then turn off the visibility for its layer. After making the next patch, you can compare the

two by turning the layer views on or off. Don’t be afraid to mix patches, using more than

one, if that works.

Using Healing Tools
Photoshop Elements 3 adds one of the functions from Photoshop most requested by Ele-

ments users: the Healing Brush tool . Adobe didn’t stop with the Healing Brush; they

It is often best to work on an image area in stages, first removing smaller problems and then

working up to larger ones. By first removing minor problems, you can then use those cor-

rected areas to repair larger areas without duplicating old damage and problems.
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added the Spot Healing Brush tool as well. These are “smarter” cloning tools that

help users make changes by “intelligent” substitution between the sample and target areas.

The key difference between the tools is that the Healing Brush enables the user to choose

the sample area, and the Spot Healing Brush decides for the user where the sample will

come from. Especially with smaller corrections, these tools can help you swiftly correct

damage without a lot of fuss in matching tone and pattern.

The Healing Brush

The Healing Brush is a very close relative of the Clone Stamp tool. You have to define a

sample area to clone from and then apply the tool to make the repair. The better your

selection of the clone-from area, the better your result will be. The real difference between

the Clone Stamp and Healing Brush is that when you release the mouse button, the heal-

ing function takes over after you release the mouse to compare the sample with the target,

saving you many steps of blending, comparison, and blurring that achieve the final result.

The Healing Brush is great for some types of damage (such as dust) and for minor repairs

(such as removing wrinkles from a forehead). Use this tool on isolated damage: areas of the

image that are not too close to extreme changes in image tone or color. Using the tool too

close to areas of transition in contrast and color can lead to unexpected blending: the color

or tone from surrounding objects can bleed into the clone patch. In other words, you should

use the tool on a stray eyelash on a cheek rather than a hair at the hairline.

To avoid any problems using the Healing Brush tool, use the following guidelines:

• Use a hard brush; the tool takes care of blending sample edges.

• Use a single application of the tool to cover the damage with a little to spare (use a

brush that is 1.5 to 2 times the width of the damage).

• Avoid application of the tool near edges that contrast in tone or color.

• Be sure the source can replace the tone/texture of the target area—color isn’t prima-

rily important.

The application of the tool is almost identical to the Clone Stamp tool. Just choose a

brush size, choose the clone-from (or sample) area, and apply the tool to cover the dam-

age. Application of the tool can be made to a separate blank layer by creating the new layer

and choosing Use All Layers in the Options bar. You will almost always use this tool in

Normal mode with the Sampled option selected instead of the Pattern option. Pattern will

While it is true these healing tools can help users make corrections, overreliance on them can

damage images and create undesirable results. Don’t always reach for the Healing Brush tool

before the Clone Stamp or before considering manual patching—it isn’t magic.
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be used in repairs only if you have created a source to use for repair, or if you are doing

more creative enhancement.

The Spot Healing Brush

The Spot Healing Brush, a variation on the Healing Brush, attempts to make it easier to

make spot corrections quickly. The tool decides for the user where the sample will be

taken from (with the Proximity Match option selected for Type) or synthesizes the sample

(with the Create Texture option selected for Type), automatically replacing the area of the

image that you select by using the brush. It is meant to be used for spot correction—ergo

the name—meaning that you should consider it for tasks such as picking dust out of scans

rather than making larger damage corrections.

Because the Create Texture option synthesizes replacement information by some form

of averaging, you will most likely get better results by using the Proximity Match option.

However, unless the sample selection doesn’t matter, even the Proximity Match option is

somewhat suspect because the randomized behavior of the tool makes the result impossible

to predict. Unless you are using the tool in an area of flat color and tone (a sky) or where

patterns will blend in (grass), the Healing Brush, Clone Stamp, and manual patching tech-

niques discussed earlier will almost always produce a better result than using Spot Healing.

Evaluating Image Tones
Evaluating the tone, color (in its component tone), or other qualities of an image can help

you make better corrections. At times you’ll need to make precise measurements of image

information, and at others you’ll have to evaluate the general appearance of the image.

The Eyedropper tool (used in conjunction with the Info palette) and the Histogram fea-

ture can provide just about all the image information you’ll need to make adjustments.

Using the Eyedropper for Evaluation
The Eyedropper, located in the toolbox, makes it easy to gather information about indi-

vidual pixels or small pixel groupings. Simply click the Eyedropper tool and put the cursor

over the image area you want to measure, and the Eyedropper will sample the composite

of the visible layers and display the information in the Info palette (Figure 3.2). Such

measurements can be helpful in evaluating an image periodically throughout the correc-

tion process. For example, comparing grayscale values for sample and target areas before

cloning or duplicating can give you a good idea whether those areas are a good match

before you make the clone or patch.

From the drop-down list on the Options bar, you can select a sample size: Point Sam-

ple (samples the pixel at the tip of the tool icon), 3 By 3 Average, and 5 By 5 Average.

These options are also available by pointing the Eyedropper at an image and clicking the
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Info palette enables
you to choose color
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(luminosity), RGB,

Web Color, and HSB.
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right mouse button (PC), or holding down the Control key and left-clicking (Mac). The

Average options look at a square of pixels (with the tip of the tool icon as the center pixel)

and then average those to determine the result. If tone is noisy—for example, in skin

tones— it is better to use a broader sample size to get a better average reading of the tones

you are measuring. If you use a sample size that is too small when measuring a noisy area,

it might make for confusing samples: values between one pixel and the next might change

too rapidly to make sense or provide anything meaningful in the way of a reading.

To make a sample measurement:

1. Select the Eyedropper tool (I).

2. Choose the sample size from the drop-down list on the options bar.

3. Bring the Info palette to the front by selecting it from the Window menu or by click-

ing the tab in the palette well.

4. Spot-check with the Eyedropper by passing the cursor over various areas of the image

while noting the values in the Info palette.

Evaluating Images with Histograms
The Histogram feature (Window ➔ Histogram) displays a graph of image information. The

height of each column in the graph represents the number of pixels with a particular lumi-

nescence throughout the entire tonal range of the image. If a specific channel is selected in

the Channels drop list, the graph displays only information for that channel. A histogram is

also available in the Levels dialog box (Enhance ➔ Adjust Lighting ➔ Levels). A histogram

can help describe the tonality and integrity of an image, pointing out both image qualities

and abnormalities that may need to be corrected.

For example, a histogram graph can tell you whether an image is naturally bright (high-

key) or dark (low-key), whether the contrast is neutral or high. If the qualities are desirable,

histograms can help you maintain those qualities by reevaluating the image later in the cor-

rection process. Although image qualities such as high- or low-key may be apparent to the

naked eye, histograms also help you determine whether an image has been damaged in pro-

cessing or whether it shows some other limitation, such as not taking full advantage of tonal

range.

Aberrations in the image information can present themselves as uncharacteristic shifts,

lack of balance, or gaps in the graph. A histogram that contains many peaks and valleys,

gaps in information, and/or clipping (spikes in information that run off the chart) may rep-

resent some form of image damage, limitation, or loss of image information. If the damage

appears extreme, the image might need correction or be essentially beyond repair: The

graph can show insufficient tonal range for manipulation, correction, and use.

Evaluating a histogram is as easy as looking at it. Characteristics become obvious in a

quick visual evaluation of the graph. The following examples show a basic blueprint for
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specific image types, such as high-key, low-key, high contrast, low contrast, and images

with damaged information.

A histogram that is weighted toward the black or dark end of the graph—and that does

not show gaps in tonality at the light end of the graph—represents a low-key (dark) image.

These are often images taken in low light, such as around a campfire or birthday cake. Fig-

ure 3.3 shows an example of a low-key image and the histogram that represents it.

A histogram that is skewed to the light (right) end of the graph represents a high-key

(light) image, such as the one in Figure 3.4. Beach shots with lots of light sand or snowy

winter scenes are good examples of high-key images.

A histogram that peaks in the dark and light areas while having lower pixel density in

the middle of the graph (like the one in Figure 3.5) represents a high-contrast image.

Harsh lighting in direct sunlight can create a chasm between lights and darks, which is a

typical example of high contrast—although not necessarily a desirable one. A silhouette,

in which a figure is shown lit from behind, is another example.

©
 2004 ph

o
to

sph
ere, w

w
w

.ph
o

to
sph

ere.co
m

Figure 3.3

A low-key image

You can evaluate a section of an image by selecting it with the selection tools and then looking

at the histogram. The histogram charts results for only the active or selected portion of an image.
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© 2004 photosphere, www.photosphere.com

Figure 3.5

A high-contrast
image

© 2004 photosphere, www.photosphere.com

Figure 3.4

A high-key image
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A histogram that shows a peak in the center (Figure 3.6) is low contrast and medium-

key. These images are dominated by midtones. Images shot on an overcast day can often

have a low-contrast appearance.

An image with a mix of global and local contrast displays as a flattened graph in a his-

togram with few peaks and valleys; see Figure 3.7 for an example. Images with full tonal

range can have quite a bit of local contrast as opposed to high total contrast.

The histograms in Figure 3.8 represent an image that has been altered by limiting the

number of tones it contains (for example, by using the Indexed Color mode). Gaps

between tones and a spikey appearance on the histogram suggest that the image has limi-

tations. These types of gaps can be symptomatic of other damage, such as poor scanning.

© 2004 photosphere, www.photosphere.com

Figure 3.7

A full toned image

© 2004 photosphere, www.photosphere.com

Figure 3.6

A low-contrast,
medium-key image
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Histogram graphs should have some information for every level from the right to the

left of the graphing, or else the tonality is not covering the potential dynamic range.

Abnormalities might not always represent problems, but they are certainly good indica-

tions of unusual conditions and potential problems. If the histogram shows a gap, it sug-

gests that image information is missing or damaged. Intermittent gaps (like those in the

histogram created by reducing colors in Figure 3.9) can suggest a cause or origin of the

image damage. Anomalies can result from capture problems, such as bad scanning (faulty

techniques or equipment), incorrect image exposure, filter use, or unusual lighting condi-

tions. Anomalies can also be the result of image processing: mode conversions, color man-

agement issues, corrections, poorly applied filters, and so forth. While it is possible for

gaps in tone to be a natural state for the image, it is unlikely.

The most common tendencies in image histograms that help identify an image that can

be improved are shortened tonal ranges and clipping.

Shortened tonal range is represented by a histogram that does not have information

across the entire range of the graph, with a gap at either the light or dark end of the graph

or both. A shortened tonal range indicates that the image is not taking full advantage of

the shades of gray available (0 percent to 100 percent black) in individual color compo-

nents or brightness (depending, again, on the information being displayed—which is

based on channel selection).

The histogram for the image in RGB The histogram for the image in 64 colors

Figure 3.8

These histograms
represent the origi-
nal tone and a con-
version to 64 grays.

evaluating image tones ■ 83

4385c03.qxd  11/5/04  4:35 PM  Page 83



The image in Figure 3.9 is a good example of shortened tonal range. The image shows

some potential for stronger contrast. The histogram displays a shortened tonal range, con-

firming the visual inspection. The tonality of the image could be adjusted to make the

image more dynamic.

Clipping occurs when image detail gets combined. For example, this can happen when

an image is overexposed and a range of highlight detail gets recorded in an image as pure

white, or when an image is underexposed and a range of shadow details are recorded as

pure black. Wedding images, for instance—in which the groom is in black and the bride

in white—can easily be prone to over- or underexposure problems and a resulting loss of

detail in either shadows or highlights. Some of the extreme highlights or shadow details

may be lost, and this is reflected in the histogram by a spike at the extreme right or left of

the graph. Clipping may be caused by any number of processes that occur in obtaining,

opening, or resaving an image.

The key to using histograms is: when the histogram confirms image damage, it may

point toward a course of correction. In the case of clipping, the histogram may suggest

that you have to retake or rescan an image to capture the detail that was clipped.

You should never look at only the histogram, shout “Aha!” and make an image correc-

tion regardless of how the image appears on-screen. Be sure to visually assess the image as

well, and use the two assessments in tandem. The visual assessment should override the

digital one, especially if you get good results in tests and can trust the view of your monitor.

Even if you evaluate an image and feel you need to make corrections, that doesn’t tell

you where to begin or how to make the corrections. The next task is to define what you

want to do and how to accomplish your ends.

Although drastically altering tonal range is sometimes a mistake, shifting the range—

even radically—can work to the benefit of the image by improving contrast and dynamic

© 2004 photosphere, www.photosphere.com

Figure 3.9

Potential problems
with this image are

revealed through its
histogram.
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range. While correction may temporarily skew an image’s key and/or contrast, several cor-

rections can be made in succession to achieve the desired result, or corrections can be

blended between the original and corrected versions. In the following sections you’ll look

at making specific corrections to images by using Levels and Curves, and you’ll evaluate

how each of these tools affects tonal correction.

Redistributing Tone with Levels
Tonal correction will often give black-and-white images broader tonal range and stronger

overall contrast. After you correct minor flaws and evaluate the image both visually and

with histograms, the next step in correction will often be to open the Levels dialog box to

make a general tonal correction. Proper use of levels can quickly fix tonal range and the

general brightness and contrast of an image. First we’ll look at the steps and then how

these steps might apply to a particular image:

1. Open a black-and-white image for corrections.

2. Complete dust corrections, cropping, and minor alterations.

3. Create an adjustment layer for adjusting levels (Layer ➔ New Adjustment Layer ➔ Levels).

4. Inspect the image both visually (on the monitor) and by using the histogram, noting

the image qualities (the image key, contrast, and potential damage). If you have no

concerns about the histogram and image damage, skip to step 6.

5. If the histogram seems out of character with the image or shows hints of damage,

consider rescanning, replacing the image, or weeding out the source of the trouble.

6. Correct shortened tonal range by adjusting the Levels sliders.

7. Adjust the midtone slider on the Levels graph to manipulate the overall brightness of

the image.

Of these steps, all but steps 6 and 7 have been covered previously. To understand the

effects such changes have on an image, it will be best to look at an example. Look back at

the image and histogram in Figure 3.10. The image was originally in color, and the warm

tones in the color made the low-key appearance interesting. However, once converted to

black-and-white, the image became dark and murky. This is confirmed by the histogram,

which shows a decided skew toward the dark end of the graph and a gap between mid-

tones and highlights.

Moving the Levels sliders to the left lightens the image; moving them to the right dark-

ens the image. Where exactly to place each slider is a matter of what you want to accom-

plish. Changes can be conservative or quite radical. To correct a shortened tonal range,

move the end slider on the outer side of the gap in toward the graph, and position it until

the graph information becomes solid (see Figure 3.10). Open the silhouette.psd image

on the CD and try this to see how it works on this image.
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When you commit your changes by clicking OK, Photoshop Elements redistributes the

tones over the total available range (0 to 255 levels of gray). Redistribution of the tonal

information in an image from a thinner to a broader range will necessarily create some

gaps in the presentation of the image information (see Figure 3.11).

This Levels change is one you can make strictly by looking at the appearance of the his-

togram and adjusting accordingly. The purpose is to take full advantage of the tonal range.

The change will intensify overall contrast and broaden the dynamic range of the image. It

may, however, affect the apparent key or contrast of the image.

Figure 3.11

Gaps can suggest
that image informa-
tion is adjusted, but

can also signify dam-
age (or just that you
have the Use Cache

For Histograms pref-
erence selected in

the Image Cache
preferences).

Figure 3.10

The Levels sliders
let you quickly rede-

fine the white and
black points in 

an image and 
redistribute tone.

One possible means of smoothing inconsistent tonality caused by redistribution is to apply a

slight (less than 1-pixel radius) Blur or Sharpen filter to the image. This will, however, change

fine detail and distort edges depending on the severity of the application of either filter. In

most cases you will want to leave well enough alone and not blur the picture just to enhance

the histogram graph.
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It may be possible and desirable to go even further with this Levels correction. When a

histogram presents a tail toward the shadows or highlights, it can often be clipped in part

or whole. Tails on the histogram often represent scattered highlight or shadow informa-

tion—generally attributable to image noise rather than image detail. Snipping the infor-

mation turns it to absolute white for a highlight, or absolute black for a shadow.

Generally, you will want to cut an entire tail when the graph represents scattered pixels;

however, it is sometimes desirable to eliminate none, some, or all of a solid tail, depending

on the image and the length of the tail.

As a general rule, the longer the tail, the less (proportionally) you should cut off. For

example, whereas you may completely remove a tail that covers 15 levels, you might trim

half or less of a tail that covers 50 levels, or 33 percent of one that covers 100 levels. Cut-

ting proportionally in this way will help retain image integrity and character.

Don’t feel that you have to crop a tail in an image just because it is there. If the results

seem too drastic after cutting a tail, then they are. Put simply: do crop a tail that improves

the image; don’t crop a tail that compromises the image.

After adjusting tonal range, images can be adjusted for overall brightness as well by

using Levels. A black-and-white image that appears too dark or light can be corrected by

using the middle slider in the Levels dialog box. Moving the slider to the left lightens mid-

tones, whereas moving it to the right darkens them. This may seem slightly counterintu-

itive, because you might think that moving the midtone slider toward the light range

would lighten the image, and moving it toward the dark would darken it. However, the

results actually make a lot of sense. The idea is that you are moving the median of the

graph representation, and not the tone of the image. In moving the median of the graph,

more levels of tone fall within the lighter or darker half of the tonal range, brightening or

darkening the image.

Be careful not to abuse this tool—there are other, and perhaps better, ways of control-

ling the midtones (such as using Curves, as described in the next section). As a guide, try

not to move the midtone slider more than 25 levels in any direction when making correc-

tions. This keeps the redistribution small and more forgiving. You can always come back

and lighten or darken an image later.

Although Levels adjustments can be made automatically, automated tools will not make

your best corrections. Automated tools may get it right sometimes, but for many images

personal judgment should prevail. Auto-corrections have no means to determine what

“looks good.”
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Snapping and Fading Contrast with Curves
The Curves tool is the ideal tool to help fine-tune and reshape the tonal distribution of an

image. Whereas Levels has only three slider points to change, Curves can have many, and

those additional points allow you more control and the ability to control different tonal

levels separately. Curves is both a more versatile correction tool and a more dangerous

one than Levels because of its power. However, using Curves can help remove steps in

corrections because you can make numerous corrections to various parts of image tone in

one application.

Because the Curves tool is powerful, applying it requires a little savvy. It also requires

installing the Hidden Power tools, because normally you can’t get to Curves by using the

Photoshop Elements interface. If you haven’t installed the tools yet, do it now. After

installing, apply Curves by using the following steps:

1. Open an image and determine through inspection and measurement what needs to

be altered.

2. Click the uppermost layer on the image to highlight it. It is fine if this layer is the

background.

3. Open the Styles and Effects palette.

4. Choose Effects from the drop-down list at the left, and then PowerTools1 from the

drop-down list to the right.

5. Double-click Curves. This opens the New Layer dialog box.

6. Click OK. This opens the Curves dialog box and creates a new Curves adjustment

layer in the Layers palette. See Figure 3.12.

7. Set points on the curve to redistribute image information. (See the following sections,

“Using the Curves Interface” and “Manipulating Curves,” for more information.)

8. Click OK to accept changes and close the dialog box.

Steps 3 through 8 create a Curves layer for the image. You will be able to manipulate

the curve until you accept the changes in step 8, at which point the curve will become

uneditable. To make further changes, you can either add another Curves layer or delete

the layer and replace it. Shutting off the view for the layer temporarily shuts off the curve

and allows comparison of before and after.

If the gradient at the bottom of the graph runs from white on the left to black on the right,

rather than black to white as shown in Figure 3.12, click the arrows in the center of the gradi-

ent. This will switch the mode from a percentage readout to levels of gray.
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Before learning how to make Curves corrections, you need to look

briefly at the interface and how to manipulate the curve.

Using the Curves Interface
Open a Curves dialog box by following steps 3 to 6 in the previous exer-

cise with any image open. When opened, the Curves dialog box looks like

a simple line graph. In essence it is, but the graph accepts your input so

that you can make changes to the image. The line represents tonal

response. On the initial screen there will be two points, one at black and

one at white. When you alter the line (which you’ll do in a moment), you

alter the tonal response of the image.

If you move your cursor over the graph, you’ll note that the Input and Output num-

bers below the graph change according to the position of the cursor. These numbers rep-

resent the vertical (Output) and horizontal (Input) positions on the graph. When you roll

the cursor above the line, the Input number will be lower than the Output; if you roll the

cursor below the line, the Input number will be higher than the Output. As you roll the

cursor on the line, Input will equal Output.

The Curves graph can be in two modes, percentage and levels of gray. Percentage meas-

ures the percentage of black (0–100 percent), and levels of gray measures the number of

levels of brightness (0–255). The percentage graph runs from light to dark: a higher per-

centage means more black. The levels graph runs from dark to light: more levels means

brighter tone. You can switch between grayscale in levels and grayscale in percentages by

clicking the arrow button in the center of the gradient bar below the graph. Photoshop

Elements will remember this setting for the next time you use the Curves dialog.

Change to levels display and move the cursor around the graph until you are at an

Input/Output reading of 128,128. This is the center of the graph. Clicking the mouse at

that point will place a new point on the line, and will change the Input/Output readings to

fields that represent the position of the current point. If you click on the same point and

drag (holding the mouse button down), you can move the point. As you move the point,

the curve moves with it. As you move the curve, the tonality of the image shifts according

to the change in position of the curve. When viewing the dialog box in levels mode, the

image will get lighter as you shift the arc of the curve upward and darker as you shift the

arc of the curve down (see Figure 3.13). When viewing percentages, the relationship is

reversed.

You can manipulate the position of points by typing numbers into the Input and Out-

put fields. If you highlight the Input and type 63, and then press Tab and type 63, the

response of the curve will flatten, and the point will move to the 75 percent black hash.
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Without closing the dialog box, move your cursor over the image. Your cursor will

become the Eyedropper tool. Look for a place in the image that is close to 50 percent gray.

When you have located the spot, hold down the Command/Ctrl key and click the mouse.

A new point will be created on the curve, representing the tone sampled in the image.

To add a point:

• Hold Command/Ctrl and click to sample the image.

• Move the cursor over the curve and click.

To move a point:

• Click on the point and drag.

• Highlight the point (by clicking it) and change the Input/Output numbers.

• Highlight the point (by clicking it) and press the keyboard arrows in the direc-

tion you want to move the point. Hold the Shift key to move 10 levels in the

arrow direction.

To remove a point:

• Position the cursor over the point, hold Command/Ctrl, and click.

• Highlight the point (by clicking it) and press Delete.

• Click and drag the point off the dialog box.

Although there are a few other features in the Curves dialog box, these are all you need

to understand to make specific adjustments.

You can toggle the number of hash marks on the graph display (four lines or ten) by

Option/Alt+clicking anywhere on the graph.

Figure 3.13

When the curve is
displayed in levels 

of gray (rather than
percentages), reduc-

ing the volume
under the curve

darkens the image
(left). This relation-
ship reverses when

the curve displays
percentages (right).
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Manipulating Curves
Specific tonal distribution changes that you make with Curves can be far more flexible

than changes you can make with Levels. If Levels is considered as a tool to adjust the tonal

range of the image, Curves can be considered the tool for adjusting image contrast.

A simple way to look at curves is that contrast increases in the tonal range between

points where the curve is steeper, and contrast decreases in the tonal range where the

curve flattens out. The curve in Figure 3.14 will increase contrast in the image midtones

(between 25 percent to 75 percent black) and decrease contrast in the highlights (0 percent

to 25 percent) and shadows (75 percent to 100 percent).

Figure 3.15 shows a curve that will decrease contrast in the midtones over the same

range as the curve in Figure 3.14. Note that the increase in contrast over the midtones in

Figure 3.14 decreases the contrast in the highlights and shadows; in Figure 3.15, decreas-

ing the contrast in the midtones (25 percent to 75 percent) increases the contrast in the

highlights (0 percent to 25 percent) and shadows (75 percent to 100 percent).

All points that you put on a curve will not necessarily be for moving the curve. At times

it will be useful to place anchors on the curve to keep the tone in that area of the image

from changing, or to act as a pivot for adjustments. For example, anchors set in the high-

light and midtone can keep the tone in the highlight from changing while you adjust shad-

ows (see Figure 3.16).

Corrections in contrast over shorter ranges should be evaluated with the Eyedropper to

help target the correction to that range. For example, if shadows seem somewhat flat or high-

lights lack detail, there might be a reason to strengthen the contrast just in those ranges. To

measure the range, measure the brightest and darkest areas of the tonal range you want to

include by dragging the Eyedropper through the image area. Test samples in areas near the

light and dark side of the range, and note what the values are. When you determine the 

Figure 3.16

Anchoring the curve with extra points
that just hold the curve in place can
reduce the equal and opposite reaction 
of your changes.

Figure 3.15

Decreasing midtone contrast increases
contrast in shadows and highlights.

Figure 3.14

A steeper rise in the curve between Input
values of 25 percent and 75 percent makes
contrast sharper through the midtones.
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range, set anchor points either by using samples directly from the image (Option/Alt+click to

sample) or by clicking the curve and entering values you sampled as Input values. Sample val-

ues will be shown in grayscale percentages on the Info palette (K as percentage), so they will

have to be converted to levels. To make the conversion from percentages to levels, you can

multiply a percentage by 2.55. You can also set one of the readouts to RGB and take the levels

reading from there, if the image is being viewed in black-and-white rather than color at the

time of the measurement.

The image used in the following procedure (see contrastfix.psd on the CD) was taken

in direct sunlight, making for a high-contrast exposure. Your goal is to slow the transition

from highlight to shadow, as well as lighten the image. Follow these steps:

1. Open the image you want to correct (see Figure 3.17).

2. Set the options for the Eyedropper tool and Info palette. For this example I chose a sample

of 3 by 3 for the Eyedropper and changed one of the Info palette colors to K (Grayscale).

3. Open Curves by double-clicking Curves in the PowerTools1 category under Effects

on the Styles and Effects palette.

4. Click OK when the New Layer dialog box appears.

5. Sample the bright end of the range you want to correct (see Figure 3.18) and create a

curve point by whatever method you choose. See “Using the Curves Interface” earlier

for more information on creating points.

Figure 3.18

The highlight area of the cheek is the lightest portion of the
area that will be changed.

Figure 3.17

This image was taken in direct sunlight
and shows harsh shadows.

The Sample Size setting for the Eyedropper tool determines the size of samples used with curves.

In most cases, you should use a sample of 3 or 5 pixels rather than a point sample. Control+click /

right-click the image when using the Eyedropper tool to bring up the Sample Size menu.
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6. Sample the dark end of the range you want to correct (see Figure 3.19) and create a

curve point.

7. Adjust the position of the curve points to create the desired change. In Figure 3.20,

the 51 percent (134 levels) point was

changed to an output of 33 percent

(171 levels).

8. Repeat steps 5 through 7 to continue

adding points and adjusting other

tonal relationships.

9. Click OK to accept the changes in the

curve.

10. Add additional curves by using steps

3 through 9 to make further modifi-

cations to the tone as necessary. 

See Figure 3.21.

Figure 3.21

The result of several
curve applications
has improved the
tonality of the image
by lessening the
harsh contrast
between light and
dark while enhanc-
ing contrast in
selected areas.

Figure 3.20

The changes in the
curve lighten the
image and reduce
contrast in the mid-
tones while improv-
ing contrast in the
highlight and
shadow detail.
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Figure 3.19

Measuring the
shadow at the edge
of the transition
from highlight to
shadow marks the
darkest part of the
range that will be
changed.
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Keeping a curve as a smooth cascade is more likely to create good results than using

radical changes. Jagged curves tend to be unpredictable and will more likely produce spe-

cial effects than corrections. If changes seem extreme or become difficult, make the

changes over the course of several applications of Curves (adding Curve adjustment lay-

ers) rather than just in one shot. This will enable you to compare adjustments by toggling

layer views, as well as enabling you to fine-tune.

(Un)Sharpening and Boosting Contrast
The sharpening filters in Photoshop Elements are not magic. They will not take a wildly

out-of-focus image and snap it back into focus or replace detail in an image that is lost by

poor focus or camera/subject movement. This is not to say that it is impossible to use fil-

ters to improve the appearance of an image; however, you should not expect a miraculous

recovery of any image—no matter what method you use or how intense the settings you

choose.

Although sharpening tools can help the appearance of sharpness in the image, they

actually have several uses aside from re-focusing an image. Sharpening filters—specifically

the Unsharp Mask filter—enhance local contrast. The filters strengthen local contrast in

an image based on the difference between adjacent tones and the filter settings you select

(Amount, Radius, and Threshold). These filters are useful not only for improving the

appearance of slightly blurry images, but also for adjusting images after resizing and for

increasing contrast between image elements. Sharpening can also be used as an adjust-

ment tool to enhance images that are going to print, in an attempt to offset dot gain and

ink absorption, which can change the definition in an image. In other words, although the

filter can help with sharpening, it can also be used as an “intelligent” tool for enhancing

image contrast and improving the appearance of images.

The Unsharp Mask Dialog Box
The Unsharp Mask dialog box (Filter ➔ Sharpen ➔ Unsharp Mask) has three sliders:

Amount, Radius, and Threshold (see Figure 3.22):

Amount The Amount can be between 1 percent and 500 percent. It determines how much

neighboring pixels will influence one another. The setting is affected by choices for Radius

and Threshold: the higher the percentage entered as Amount, the greater the sharpening.

Although other sharpening tools are included with Elements besides Unsharp Mask (the free-

hand Sharpen tool, and the Sharpen, Sharpen Edges, and Sharpen More filters), I find them

somewhat less valuable because they lack controls. They do nothing that you can’t do using

the Unsharp Mask filter.
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Radius The Radius can be from 0.1 to 250 pixels. Radius works similarly to a feather

radius: the farther out from the center of the radius, the weaker the effect. The distance

affected in the image is actually greater than the

Radius (about 2.5 times), as the value is plugged into a

calculation rather than limiting the range. The inten-

sity decreases over the range.

Threshold The Threshold option controls the way pix-

els work against each other based on their relative dif-

ference. The threshold notes the number of levels by

which neighboring pixels must differ to be included in

the calculation. For example, a low threshold (0)

would allow neighboring pixels to freely influence one

another if there is a difference; a high threshold (255)

keeps pixels from influencing one another.

The dialog box offers a preview option and zoom buttons in addition to the sliders.

The goal of sharpening is to improve, not reclaim, an image. The sharpening will be

more or less effective depending on the content of the image.

Generally, you will want to choose a setting with a low threshold, which is measured in

levels. This means Photoshop Elements will look at the number of levels of difference in

the surrounding pixels, and if the number of levels is greater than the threshold, it will

apply sharpening based on the settings for Radius and Amount.

You should usually keep the Threshold setting between 0 and 5—toward the lower end of

this range. In fact, you will often want to use zero tolerance. Low tolerance levels (1 or 2) can

keep Photoshop Elements from sharpening what is otherwise image noise. Sharpening noise

will only make the image noisier. With that in mind, a good rule of thumb is to raise the

threshold more for images with more image noise. This will keep you from enhancing image

noise. The only time you will set the threshold higher than 5 is when you want to limit the

filter’s effect to high-contrast areas of the image to play up existing contrast and separation

of image elements.

Radius and Amount might be set quite differently depending on what you are trying to

achieve and the ppi and content of the image. In many cases, you might apply the filter

twice: once with a low radius for general sharpening, and once with a higher radius for

broader enhancement of image contrast.

The name Unsharp Mask comes from the traditional darkroom process in which an inverted,

blurred (unsharp) duplicate of the original image was sandwiched to mask the exposure dur-

ing printing. This helped target and adjust (sharpen) contrast differences.
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Figure 3.22

The Unsharp Mask
dialog box (Filter ➔
Sharpen ➔ Unsharp
Mask)
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Affecting Sharpness with the Unsharp Mask Filter
Sharpening an image with the Unsharp Mask filter depends on Elements recognizing and

enhancing existing edges in an image. In other words, if the image is too blurry to recog-

nize, the filter can’t tell where the edge is, so it can’t tell what to enhance. This is why the

filter works best on images that are already characteristically sharp.

Although settings can vary depending on the type of image and desired result, you 

will normally maintain the following settings in images that have average busyness and

contrast:

Radius: 0.5 percent to 1.5 percent of the ppi

Amount: 50 percent to 100 percent

For example, a 300ppi image would have a target range for the Radius of about 1.5 to 

4.5 pixels; a 72ppi image of the same size and similar content would have a Radius of about

0.35 pixel to 1 pixel. Note that these are rough guidelines, but they work for a variety of sit-

uations. If the content of the image is not busy, lacks focus, and/or is lower-contrast, you

can tend toward the high end of the ranges; if the image is busier, is relatively sharp, and

has high contrast, you would probably tend toward the low end.

Figure 3.23 shows an image before and after sharpening. Before sharpening, the image

appears slightly soft and perhaps a bit lacking in contrast. A single application of the

Unsharp Mask filter in the midpoint for the suggested range increases the contrast and

boosts the sharpness (see Figure 3.23).

A halo effect occurs when the Unsharp Mask is applied too strongly over areas where

flatly dark portions of an image meet flatly light portions, forming a high-contrast edge

(see Figure 3.24). Often a halo effect is more apparent when the applied Radius is short—

or not long enough to dissipate the edge of the sharpening effect without being obvious.

Not only will the halo tend to blow out (or clip) areas of images, but the image will also

distort and the effect will become unpleasant.

Figure 3.23

Sharpness and con-
trast in this image

improve with an
application of

Unsharp Mask.
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You can reduce halo effects by first undoing the Unsharp treatment and then reapply-

ing it with either a broader Radius, lower Amount, a combination of these, or by blending

the result. Methods of blending are discussed throughout the rest of the book. One quick

method is to flatten the image (Layer ➔ Flatten Image), duplicate the Background (Layer ➔

Duplicate Layer), apply the Unsharp Mask filter, and reduce the Opacity of the Back-

ground copy layer in the Layers palette.

Staying within the guidelines helps you avoid oversharpening and creating halos in

high-contrast areas of your images. Better to sharpen a little several times, sharpen a

duplicated layer, or try other measures than to sharpen hastily and heavily and damage 

the image.

Raising Local Contrast with Sharpening
Sharpening with the Unsharp Mask filter has a much different effect on an image than

applying Curves or Levels, because the effect actually compares adjacent pixels, rather

than adjusting based on a more predictable scheme. It does less to sharpen the details than

it does to enhance differences that already exist in the image. This effect works well with

low-contrast images, or images that seem to lack dynamics that increasing dynamic range

(with Levels) or contrast (with Curves) doesn’t fix.

Another option for blending the sharpening effect is to use the Fade tool in the Hidden

Power tool set. You can find the Fade tool in the PowerBonus category under Effects on the

Styles and Effects palette. Just undo the sharpening (press Command/Ctrl+Z) and double-

click the Fade tool. Instructions will appear on-screen.

Figure 3.24

The original image
and an oversharp-
ened counterpart:
Although some
sharpening may be
desirable, a halo
effect probably will
not be.
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When you are adjusting local contrast with the Unsharp Mask, the Radius might be

much higher than suggested for normal sharpening (15 percent to 40 percent or more of

the ppi), and the Amount much lower (between 10 percent and 35 percent). Again, these

are just suggested ranges. The goal of the settings is to increase the radius beyond the dis-

tance where a halo is noticeable, and to keep the effect from causing damage (hence the

low intensity, or Amount).

Figure 3.25 shows a somewhat low-contrast image of a ship (a) and corrections using

the Unsharp Mask filter (b and c). Although it looks okay in color, the image lacks a little

pop in black-and-white. By using Unsharp Mask to raise the local contrast, the image ele-

ments have more separation from one another. Two applications of Unsharp Mask—one

to build local contrast (b), and one to sharpen (c)—make quick work of what would oth-

erwise be an arduous task in masking to separate this boat from its surroundings, creating

a result based on existing image differences.

Figure 3.25

The original boat is a little dull (a). After raising the local contrast with the Unsharp Mask (using a broad radius and
low percentage), the boat stands out better from the surroundings (b). The filter is then applied again (c), but this
time to sharpen the image (using a short radius and higher percentage).
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b c
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The third image (c) includes slight Levels and Curves adjustments. Curves was used to

enhance the contrast that Unsharp Mask brought out, and Levels was used to adjust final bright-

ness. Some tone was replaced quickly by duplicating the original, moving it to the top of the

stack, setting it to darken, and lowering the Opacity to 10 percent; this filled in areas that sharp-

ening had forced to clip (go to 0 percent gray). So you see that techniques of using Levels, Curves,

and Unsharp Mask work together—rather than separately—to produce enhanced results.

Managing Image Noise
Having noise in an image can mean a number of things, from having many objects in an

image to something more akin to random digitized information—like you might get when

turning your TV on without a cable connection or antenna. The concepts in this section

will help you to reduce or eliminate undesirable patterning, digital image noise and tex-

ture in an image by increasing or decreasing random noise.

At times you may want to edit out, reduce, or even add image noise to achieve particu-

lar results in your images. To do this, you will use Blur and Add Noise filters, often in con-

junction with other image editing functions, such as layer blending, selection, masking,

and perhaps a few Hidden Power tools.

The Gaussian Blur filter (Filter ➔ Blur ➔ Gaussian Blur) can blur images or image areas.

It does this by averaging the effects of pixels over a Radius, which you define by using a

slider on the dialog box: the greater the radius, the more intense the blur. As a result of

averaging pixels, blurring removes or lessens image noise by lowering the contrast of adja-

cent pixels. This averaging softens image edges, smoothing hard lines between areas of

contrast, and can mitigate or obliterate image details. Essentially, this is the opposite of

sharpening, which enhances existing contrast.

The Add Noise filter (Filter ➔ Noise ➔ Add Noise) generates image noise by randomizing

color assignments for pixels. There are several choices in the Add Noise dialog box for con-

trolling the filter. The Amount is related to Percentage, and defines the range of variation pos-

sible in creating the noise distribution. As the Amount goes up, the application of the noise is

potentially more radical. Very strong applications of noise, like blur, can obliterate detail—in

this case by wiping it out with random behavior rather than averaging. Noise applications can

swiftly become something of a special effect, depending on the ppi of the image. An image

with a higher ppi will be able to withstand stronger applications of the filter.

Generation of noise is affected by the Distribution Type. A Uniform distribution

changes the values of individual pixels by selecting a random number within the range

defined by the Amount. This number can be the original value plus or minus the amount

for each channel of color. For example, applying an Amount of 25 to a 50 percent gray

image (128 levels) in Grayscale will result in values between 103 and 153 levels of gray for

any pixel, each value generated at random. You can see this effect by creating a new image,

filling with a 50 percent gray background, and applying the Add Noise filter.
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A Gaussian distribution changes the values of individual pixels by selecting a random

number based on a Gaussian function. The function creates a tendency to select from the

center of the range, but can also deviate more strongly from that norm. While the quanti-

tative effects to each pixel can extend beyond what is dictated by Amount, the total effect

is the same—just with greater peaks and valleys in the deviation. Because deviations can

be broader, Gaussian noise can appear to be a stronger effect than the Uniform distribu-

tion with the same Amount setting, as shown in Figure 3.26. Compare this to the Uniform

effect by creating another gray image of the same size, applying the Add Noise filter using

the Gaussian setting, and comparing the images side by side.

The Monochromatic option applies the filter to only the tonal elements in the image

without changing the color. For example, this would keep an RGB image that has been

desaturated from generating color noise when the filter is run.

So far, neither adding noise nor blurring may sound desirable, because either could be

damaging (or at least compromising) to an image. However, used in a controlled fashion,

both can enhance an image and make results look more realistic. For example, an image

or image area that is damaged by JPEG compression can be restored, somewhat, by selec-

tive blurring. In this case, blurring could potentially dissipate artifacts generated by com-

pression. In a similar way, some types of digital noise can be lessened or removed, as

might be effects of film grain, halftone printing, and paper texture. Selective blurring can

also help in isolating image subjects by imitating effects of focus, such as depth of field.

Gaussian noise distribution

Original, flat gray

Uniform noise distribution

Figure 3.26

A magnification of a
25 percent gray area
shown with Uniform

and Gaussian noise
distributions of 10

percent. The his-
tograms show the
flat application of

noise in the Uniform
distribution and the
bell-shaped applica-

tion in Gaussian
distribution.
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On the other side of the coin, most image tones that look natural in an image are not

completely flat when you look at them close up. When you attempt to add new elements

to an image, such as by painting them in with flat tones or creating an area with blends

(for example, to replace a sky), the elements can tend to look too perfect. The result is that

the repair will look like a repair: skin tones will look more like a mannequin or caricature.

Applying noise can mimic a more natural look by randomizing and effectively dithering

image information. Additionally, you can use Add Noise to create texture or graininess

(for example, to mimic film grain).

As strange as it may seem, sometimes when blurring won’t solve a problem that you

may have thought required noise reduction, applying noise can. Even more often, apply-

ing both blur and noise can do the job, adding variation while mediating extremes.

Blur and Add Noise filters can be used along with other functions to produce the best

results. For example, you might make a selection of a particularly noisy area of an image to

isolate it before applying a blur. After using Blur, you may need to use the Add Noise filter

to fix the blurred areas so that they don’t seem flat. You also might use a layer mode,

mask, or other features to isolate the application so the fix is applied only to the areas

where it is intended.

Both Add Noise and Blur are best if applied lightly and in combination. Figure 3.27

shows a repair in which noise was used to make an image correction blend better, after a

blur was applied. The skin on the subject is not bad in the original, but it could appear

much more youthful with gentler pores.

A selection was made of the subject’s face (mostly using the red channel as a mask—a

technique we will look at more later). With the selection loaded, the area of the subject’s

skin was copied and pasted to its own layer to isolate it. Once isolated, the copied skin was

blurred. The results smoothed the skin, but left it too flat. Noise was added, using Uni-

form distribution with the Monochromatic check box selected. This returns some of the

texture to the skin without leaving it looking too flat and fake. The appearance of the

pores is softened first, using the Blur filter to remove noise. Next, the Add Noise filter is

used to gently replace some of what was lost in the texture. The result is much smoother

skin, and a somewhat more youthful smile.

Several techniques, including erasing information on the new layer or masking, could

have been used to bring back the details that were getting covered. However, Blend Mask,

a Hidden Power tool, was applied to the layer to enable the character of wrinkles to blend

through based on tone. Again, combinations of tool applications and functions generally

work best in achieving goals in an image because no one tool can do it all. You’ll see more

of Blend Mask in the following section.
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Masking with Image Tone
Masks are very much like selections, in that they can help you isolate image areas and

work on them without changing other parts of the image. You saw how masking can help

you target image changes by isolating the sky from the water in the gradient map example

in Chapter 2. One frustration with using Photoshop Elements is that it allows you to use

masks only in conjunction with adjustment layers, and does not freely allow you to mask

any layer in an image. It also doesn’t allow you to work fluidly with alpha channels, which

are places the full-version of Photoshop can store masks and selections. Although you can

save a selection in Elements 3, you still can’t attach a mask to any old layer.

Hidden Power tools to the rescue!

c

d

b

a
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Original image (a)
and the image

blurred (b), then
noise added (c), and

Opacity adjusted (d).
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The Hidden Power Blend Mask is a unique solution to this problem based on layer

clipping and layer transparency. It enables you to make white areas of a layer transparent

with a single click. It leaves black solid and turns levels of gray to semitransparent pixels—

the darker the pixel, the less transparent it is. These semitransparent layers can then be

grouped with other image content to be used as high-tech cookie cutters to reveal only

what you want to see from the original image in a separate layer.

Because it is based on tone, the Blend Mask tool gives you the power to mask exact areas

of an image based on any image quality that you can isolate as tone. Clever manipulation of

tone by using Curves can enable you to target specific image areas based on particular qual-

ities. These qualities can influence an image whether the image is color or black-and-white.

So what does Blend Mask do for you? Well, say you have a color image that looks a lit-

tle flat in the shadows. You know there is image detail there, but you can’t seem to coax it

out no matter what you try: every time you make a change that helps one area, the other

image areas go sour. Creating a mask for the shadows (75 percent–100 percent black)

would allow you to isolate the dark portion of the image so you can make changes there

without affecting anything else. Blend Mask helps you to make those masks. It would also

help you make a mask to target other specific tone ranges, specific colors, or color ranges.

Figure 3.28 shows an image that could benefit from correction in just the shadow area.

To mask just the shadow, you use the Blend Mask Hidden Power tools. Several power

tools converge in this exercise to create your image editing advantage.

1. Open the sample image (horsehead.psd) from the CD.

Figure 3.28

This image of a 
giant bronze horse
was taken with the
sun as a backlight,
leaving the detail of
the shadow flat and
dark.
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2. Create a luminosity layer: choose Effects in the Styles and Effects palette and then

choose the PowerSeparations category. Double-click Add Luminosity in the Pow-

erSeparations list. Change the name of the Luminosity layer to Masking Tone.

3. Create a new layer above the background and name it Mask.

4. Turn off the visibility for the Background layer.

5. Activate the Masking Tone layer and double-click Curves under the PowerTools1 cat-

egory of Effects. Be sure to click the Group With Previous check box when the New

Layer dialog box opens.

6. Click the center of the curve graph to create a new point on the curve. If the curve is

displaying as levels (rather than percentages), click the arrow to change to percentage

display.

7. Change the position of the current point to 75,100 (Input/Output) by typing these

values in the appropriate fields, as shown in Figure 3.29.

8. Create another point on the curve by clicking near the center of the graph.

9. Change the position of the point to 73,0 by typing the values into the Input and Out-

put fields, as shown in Figure 3.30.

10. Accept the changes to the curve by clicking OK.

Figure 3.29

The image darkens
as you begin to cre-

ate your mask.

The Curves dialog box will not allow the point in step 9 to be at 74,0, so 73,0 is selected as the

next best position.
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11. Merge the curve with the Masking Tone layer (Layer ➔ Merge Down) to commit the

curve changes.

12. Double-click Clear Grayscale in the PowerTools1 category of Effects. This removes

the white and grays from the Masking Tone layer to reveal the transparency grid.

Only portions of the image that are 75 percent to 100 percent black based on the

image luminosity will be opaque.

13. Merge the Masking Tone layer with the Mask layer. This commits the transparency of

the layer.

14. Turn on the visibility for the Background layer.

15. Duplicate the Background layer and name it Isolated Shadows.

16. Move the Isolated Shadows layer to the top of the layer stack.

17. Group the Isolated Shadows layer with the Mask layer.

Grouping the layers creates layer clipping: only the 75 per-

cent to 100 percent area of the Isolated Shadows layer is vis-

ible. Confirm this by toggling the view for the Background

layer off. This completes the masking. The layers should

look as they do in Figure 3.31.

The Mask layer will be dark in the areas that are masked (if the relationship is inverted,

you probably had the Curves dialog box in the wrong mode when working through the

procedure). If you turn off the visibility for the Background layer at this point, the shad-

ows will show without the nonshadow portions of the image. You can adjust the color or

tone in the shadow area by applying changes—either grouped layer adjustments or

Figure 3.30

Shifting the posi-
tion of this point
will create stark
contrast between
the shadow (75 per-
cent–100 percent
black) and the rest
of the image (0 per-
cent–73 percent
black).
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Figure 3.31

When steps 1 to 17
are complete, your
masking should
show the Isolated
Shadows layer
grouped with the
Mask layer.
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changes directly to the layer content—to the Isolated Shadows layer. Commit the changes

by flattening the image. The Blend Mask Hidden Power tool will perform steps 2–17 for

you, but you won’t always want to just run full speed through this masking process.

Knowing how to do the technique manually will help the tool make more sense, and can

offer other opportunities when making other types of corrections.

Masks and black-and-white representations can be created to target and exclude all

sorts of image information. The key to targeting your masked information is the Blend

Mask tool, which affects the layer transparency and the application of the curve. For more

straightforward masks that are based on highlights or shadows, you can use the Transpar-

ent Grayscale Hidden Power tool. To base the mask on shadows, all you would do is create

the luminosity layer and click Transparent Grayscale. To base the mask on highlights, cre-

ate the luminosity layer, invert it (Filter ➔ Adjustments ➔ Invert), and click the Transparent

Grayscale tool.

Curves can help you create complex masks based entirely on tonal components. For

example, if you wanted to mask only the middle tones in an image, the curve would look

like Figure 3.32.

Not only can you work with components separated from your original image, but you

can also combine the results to target even more specific image areas. For example, say

you want to adjust color in the midtones for a particular color component. Using a mid-

tone mask alone, you could shift the color, but that would affect all other colors in the

image that fall in the midtone range; you could use Hue/Saturation set to a component

color, but that would limit you to using only Hue/Saturation for the correction.

Figure 3.32

This curve applied to
luminosity will

enable you to isolate
midtones.
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Using the midtone mask with a specific color component separated from your image

could help you isolate the midtones in that specific component. First isolating the compo-

nent and then applying the mask gives you more freedom to make corrections in a specific

area of the image. All you have to do is create the mask, make the separation, and apply the

mask to the component that you separated. In the following example, you will isolate the

midtones on the blue component of the RGB separation.

1. Open the image you want to correct as a flattened RGB image.

2. Double-click Blend Mask in the Hidden Power tools and set the curve to look like

Figure 3.33 when it appears. Allow the masking to complete. This creates the mid-

tone mask.

3. Duplicate the background to a new image (using Duplicate Layer in the layers pop-up

menu), and separate the image by double-clicking the Split RGB w-Preview tool in

the PowerSeparations category of Effects. This gives you the separated color compo-

nents for the original color.

4. Activate the original document and duplicate the Mask layer to the separated image

two times. Name the duplicates Layer 1 and Blue Midtones. These layers should be

created at the top of the layer stack. They will be used to create distinct representa-

tions of the blue in the midtones and the blue in the highlight/shadows.

5. Activate the new document and create a new layer below Layer 1. You can create the

layer anywhere and drag it to where it should be in the Layers palette. Fill it with

white and name it Blue Mask.

6. Merge Layer 1 and the Blue Mask (this makes the Blue Mask a solid layer represent-

ing the midtones); then drag it between the Blue layer and its Fill layer. Change the

mode to Multiply. This will blot out the influence of the Blue layer midtones. If you

shut off the Blue Midtones layer, the midtones should appear to pitch toward yellow

at this point.

7. Duplicate the Blue layer and change the duplicate layer’s name to Blue

Highlight/Shadow. The Blue Highlight/Shadow layer will remain grouped with the

Blue Mask and Fill layers. This grouping represents the highlight and shadow areas of

the Blue component.

8. Change the mode of the Blue layer to Normal and drag it above the Blue Midtones

layer. Change the mode of Blue Midtones layer to Screen.

9. Duplicate the Fill layer grouped with the Blue Highlight/Shadow layer and drag the

duplicate above the Blue layer.
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10. Link the Blue Midtones, Blue, and Fill copy layers by clicking the link indicator on the

Layers palette for the Blue Midtones and Blue layers. Group the layers by pressing

Command/Ctrl+G. This grouping represents the blues in the midtones.

Once you have completed these steps, the masking will have been used to isolate the

blue midtones. The layer stack will look like Figure 3.33, and the image will look exactly

the same as the original. However, if you add a Levels adjust-

ment layer above the Blue layer, you’ll be able to adjust the

blue midtones in isolation from the rest of the image color—

without changing the highlight and shadow. In other words,

you are free, at this point to replace just that portion of the

image with any tone or color that you want. In a similar way,

you could create masking for highlights, shadows, and any

combination of color and tone to accurately target an image

area for change. All you need to do is create the masks and

apply them by defining the desired tone and color ranges.

These changes and more are possible, and they become

important when attempting more complicated color separa-

tions and application. We’ll implement some interesting uses

of this type of masking in the next few chapters.
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Multiple mask appli-
cations enable you

to accurately target
changes in your

images.
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Part III
Serious Color Correction

The term color correction suggests that there is a correct color in

your images to shoot for in the first place. You may consider

“correct” to be what you saw with your eyes when capturing an

image, but what you see isn’t a measure that you can duplicate.

Your eyes can adjust to color and lighting conditions, so they are

not good at judging the quality of color in a scene—it may actu-

ally have looked better to you than it was.

It would be nice if there were a quantitative measure of “cor-

rectness” that would guarantee the best color, because that

would make correction easier. You can match color by measur-

ing with sophisticated devices. However, what looks best won’t

necessarily match the original color, and in some cases matching

color will not be what you’ll want to do at all. In this section

you’ll look at ways to apply color correction for both technical

and artistic success by using techniques that expand on those

you learned in Chapter 3.

Chapter 4 General Color Correction: Applying Levels

and Curves

Chapter 5 Specific Color Enhancement
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Chapter 4
General Color Correction: Applying Levels and Curves

If you look at RGB components as the basis for image color, color is just a slightly more

complex version of black-and-white. The difference ends up being that three grayscale

images are sandwiched together to make a color representation. If you consider the three

black-and-white RGB components of your color image separately, and make basic correc-

tion to the tones, it is interesting to note that correction for color follows. The Levels and

Curves manipulations and techniques from Chapter 3 can be applied to the RGB compo-

nents of a color image in order to adjust image color. Correcting color this way will adjust

many color saturation and brightness problems and can often balance color to compen-

sate for color shifts caused by lighting. In this chapter, we’ll look at the techniques for per-

forming this type of correction as well as the reasons why the techniques work.

Minor Cleanup for Color Images

Levels Correction for Color

Curves Correction for Color
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Minor Cleanup for Color Images
The place to start in doing minor cleanup of your color image is to get rid of what absolutely

should not be in the image. Cleanup for color images is similar to the techniques already

described for cleaning tone and black-and-white images. You use the Clone Stamp tool to

clear out spots and minor debris by stamping over them with good replacements. Because

you are trying to match red, green, and blue tones all at the same time, you have to be careful

in selecting the source for replacement color. Making the corrections in a new layer can help

by enabling you to fine-tune any changes. The Use All Layers option for the Clone Stamp

tool should remain turned on. You may want to experiment with other modes for the Clone

Stamp tool, such as using Color or Luminosity instead of Normal mode to adjust color or

tone separately.

Other options for cleanup can present themselves in separated components, some-

times more readily than on a color composite. Looking at RGB tones or Luminosity and

Color separations may reveal color-specific noise or other damage (such as stains on

scanned prints). All you have to do is split the channels by using Hidden Power tools and

then examine the separations individually to see whether there is any damage.

To view the grayscale for a specific component in a separation, make the separation

and then turn off the visibility for the other components and the color fill associated with

the component, if any (see Figure 4.1).

The Prokudin-Gorskii images from Chapter 1 (Gorskii.psd) are a great example of how

correcting in separated tones may be useful. The glass plates in Gorskii’s images have unique

information because they were taken as distinct captures through different lenses to occupy

distinct areas of the film. Because they are distinct captures, each color plate has unique

damage from dust and scratches, as the red plate shows in Figure 4.2. In that case (certainly a

rare one), it is better and easier to correct much of the damage in the separated tones as RGB

because the damage will stand out more clearly than it will in the full-color preview.

Figure 4.1

To view the blue
channel, turn off the
visibility for the red
and green channels

as well as the blue
color fill.
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Once you have stamped out damage in the channels—and as long as you have made

each correction carefully, so it is undetectable in each of the individual tones—the result

should appear undetectable in the composite image as well. When the changes are com-

plete, you can merge the separated components back to a single layer by flattening the

image before moving on to other corrections. Although you can switch back and forth

between working with the separations and the composite without harming the image, you

should avoid making a lot of separation changes at this point because it wastes time. This

stage of cleanup should usually be simple and quick before getting on to the main course

of correcting color.

Quelling Color Noise
Digital noise can be a problem in images and is something else that you might want to

clean up at this point, before moving on to other corrections.

Figure 4.3 shows a close-up of an image that was not taken in the best conditions. JPEG

compression settings were not high, but they were high enough to accentuate the noise.

Although the image isn’t bad, it could be much better. The separation into RGB for this

image clearly indicates that you have mostly color noise on your hands. (You can see the

original image as vince.psd on the CD, as well as before and after corrections in the color

section.)

Splitting out the channels is often useful for removing color-related problems, such as stains

on scanned prints or colored blemishes. We’ll see more of the advantages when looking at

more intensive color correction later in this chapter.

Figure 4.2

A defect in the red
plate shows up
prominently in the
original scan of the
Gorskii image.
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Figure 4.3

This image shows
digital noise even in

black-and-white.
Separating the chan-

nels of the image
into RGB (by using

the Split RGB Hidden
Power tool) makes it
apparent where the

damage is. The
worst of the chan-
nels is the discour-

aging blue channel
(e).

Although you might want to clean up or improve such obvious problems at this point,

you might instead wait to do it after Levels correction. Doing too much before basic cor-

rections can potentially cause even greater problems later.

There are many more things that you can do in addition to the few steps we will pres-

ent here for correcting the color noise. For example, you might mask skin tone areas to

apply smoothing to some of the tone or sharpen the image. But that type of complex cor-

rection is a good example of one that might be better accomplished later, after initial color

(e) Blue Close-up

(a) Close-up

(b) Red

(c) Green (d) Blue
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correction with Levels. You will be able to better judge when to flip-flop your basic correc-

tion steps as you gain additional experience with correction.

1. Open vince.psd from the CD.

2. Split luminosity and color by double-clicking the Split Luminosity Hidden Power

tool in the PowerSeparations category of Effects.

3. Activate the Color layer by clicking it in the Layers palette.

4. Apply a Gaussian Blur (Filter ➔ Blur ➔ Gaussian Blur). This blurs the color informa-

tion in the image while keeping the tone intact.

These steps have a dramatic impact on the RGB components of the test image. Figure 4.4

shows the result after flattening the image and reseparating the RGB components.

(e) Blue Close-up

(a) Close-up

(b) Red

(c) Green (d) Blue

Figure 4.4

A great improve-
ment can be seen in
the color channels if
you flatten the
image again and
separate the RGB.
Note the dramatic
change in the blue
channel (e), and, sur-
prisingly, you do not
lose sharpness or
detail.
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Because the tone holds the detail in place, the color can be smoothed out without soft-

ening the appearance of the image. When you are finished, flatten the image and save it

with a different name before continuing any other corrections. This will keep you from

saving over the original if it turns out that you want to go back and see what happens if

you don’t correct the noise first.

You can use other filters to reduce the noise after the color is separated. You may want

to experiment with the advantages of the Median filter and the Dust and Scratches filter

applied to the Color layer. Each will handle the color adjustment in a somewhat different

fashion.

There is a Hidden Power tool that will perform the noise reduction steps for you while

enabling you to choose how much blur to apply. Just click Reduce Color Noise under the

PowerTools1 category in Effects. This tool will automatically flatten and commit the

changes in the image so that you will be ready for additional corrections.

Levels Correction for Color
Object color is a result of light. Brightness of 100 percent indicates a 100 percent intensity

of red, green, and blue light components. Brightness of 0 percent indicates a 0 percent

intensity of red, green, and blue. If the color in a scene runs from white to black (a full

dynamic range), all of the tones must have a full range as well. Levels corrections for each

component of RGB will optimize the dynamic range of your image, and correcting with

Curves can fine-tune the quality of color.

If you followed the discussion of correcting tonality with Levels in Chapter 3, making

the leap to correcting color with Levels is a small step. It brings together the concept of

components and separations from Chapter 2 with the corrective steps for Levels in Chap-

ter 3. You want to apply Levels corrections to the separate red, green, and blue compo-

nents, treating each component as you would a black-and-white image.

The Levels dialog box makes it easy to apply corrections to the separate components

and saves you the step of separating the colors into tone. All you have to do is open 

the Levels dialog box and separately correct the red, green, and blue components—as

selected from the Channel drop-down list (see

Figure 4.5). Select the channels one at a time

from the drop-down list, make the correction

according to the histogram, and then choose

the next channel. Adjust each channel just as

you would for a grayscale correction. Don’t

bother correcting the RGB composite; this will

be taken care of by completing the Levels cor-

rection properly.
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Selecting a channel
from the drop-down
list in the Levels dia-

log box reveals the
histogram specific to

that channel and
confines the effects

of your adjustments
to that component

without making 
separations.
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To apply corrections to separate color components:

1. Open the image you want to correct.

2. Complete minor cleanup.

3. Choose Enhance ➔ Adjust Lighting ➔ Levels. This opens the Levels dialog box.

4. Select Red from the Channel drop-down list. This reveals the histogram for the red

component.

5. Make a Levels correction for the component by using the guidelines provided in

Chapter 3 for making grayscale corrections with Levels. The correction should be

done by evaluating the histogram.

6. Repeat steps 4 and 5 for the green and blue components. Do this by selecting Green

and then Blue from the Channel drop-down list, instead of Red.

7. Accept the changes in the Levels dialog by clicking OK. This closes the dialog box.

When the correction is complete, the image should show increased dynamic range,

stronger saturation, and a better likeness to realistic color (color balance)—as long as

there was something to correct. Again, this correction may not get you entirely where you

want to be. You’ll probably have additional corrections to make.

When making a Levels correction for color you must remember the following:

• Making a correction might remove a desired color shift.

• To retain existing color characteristics, make similar adjustments to histogram tails in

the red, green, and blue components.

At times this type of Levels correction doesn’t improve an image. Examples include

extreme lighting conditions or adjustments that were made intentionally—such as in a

sunset, or when an effect was achieved by color filtering (to purposely shift color in the

image at the time it was taken).

Using a color version of the same image we worked with in the example for Levels cor-

rection of tone in Chapter 3, the Levels adjustment would probably look something like

the sets of screens shown in Figure 4.6. (The result for the color image can be seen in the

color section of this book.) The Levels correction in RGB will also improve the result

when making conversions from color to black-and-white: increasing the dynamic range

for color extends the dynamic range for the image, and the extended dynamic range

enhances the image contrast. Make the corrections to the image yourself by using the

boat.psd file included on the CD.
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If you make a Levels correction by using the guidelines for correcting tone in Chapter 3,

the color in this image will spring back to life on your screen. In effect, all you are doing is

redistributing the black-and-white tones in the red, green, and blue components to achieve

a better dynamic range. Because light in the most dynamic image will run from white to

black, your correction in Levels is just enabling the image to look its most dynamic. In the

corrections for Figure 4.6 the rules are pretty clear-cut. Because the image doesn’t have a

decided skew, and there is a reasonable similarity in the quality of the histograms for red,

green, and blue, the common rules hold.

Half clipping

Full clipping

Original image After full clipping
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The corrections on
the top row remove

half the tail from
each channel; the
corrections below
remove the entire
tail. Color balance

results from using a
consistent approach
to correcting image

components.
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In Figure 4.7, however, the histograms for the RGB channels differ from one another

and require some unusual treatment. The image, a close-up of a rose, is decidedly skewed

toward reds. The first application of Levels is just a straight cut of the histogram tails, treat-

ing each channel as if it were a black-and-white image. However, a better result is achieved

by doing an additional adjustment to the RGB. Because the first adjustment makes the

shadows seem pale, the image requires a shift in the midtones to compensate—thereby

pushing more image information toward the shadows. Once that’s accomplished, the tone

of the image seems more natural and balanced. See the result of these Levels applications in

the color section. Use the image rose.psd on the CD to work the results for yourself.

After adjustment

Midtone adjustment

Clipping adjustmentClipping adjustment

Clipping adjustment

Original image
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Figure 4.7

Visual evaluation of
the results suggests
an additional
change in the com-
posite level.
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Levels adjustments can be used to manipulate tones in your images, as well as the bal-

ance of color and brightness. Coupled with other functions in Elements, Levels can be a

powerful tool for correction and change. For example, if you mask areas of the image or

components, you can target Levels redistributions to those areas and create specific

changes, such as lightening midtones while leaving highlights and shadows unchanged.

For more complicated alterations, you may want to consider using Curves, which we’ll

look at in the next section.

Curves Correction for Color
Color casts in an image can result in flatness or unnatural color. A cast might be the result

of poor image processing, varied lighting conditions (photos taken under fluorescent

bulbs, for example), aging of the original medium (such as paper yellowing), or any num-

ber of other factors. Basic color correction with Levels often takes care of a lot of these

problems. However, color casts and shifts between the lightest and darkest parts of an

image are often a little more complex than looking at a histogram or doing a linear color

correction in Levels. Curves have an added level of complexity that makes them perfect for

fine-tuning color. In this section we will use the same monochromatic Curves Hidden

Power tool we used in Chapter 3 and apply curve corrections to separated components of

a color image to make complex color corrections.

The problem with using curves on color images lies in knowing exactly how to employ

them to make effective corrective changes. It is difficult to look at an image and envision

how a correction curve should look to fix problems in the image. While it may be easy to

determine what looks wrong, correcting it can remain a puzzle.

For example, say you are looking at an image and the color of the subject’s skin just

looks wrong. If the skin tone looks wrong, the image will look wrong. If there were a refer-

ence that you could use to correct skin tone perfectly, everything else in the image would

also fall in line. However, there is no absolute reference for skin tone. There are ways to

estimate and approximate, but if approximations were good, you could just put your trust

in the image you have on-screen and correct completely by eye. The difference in skin

tones is vast. Not only does skin tone have many colors and shades in general, but the

same person can have different skin tones at different times (for example, when the person

has a tan, or when looking pale or flushed). This being the case, there is no value that can

be used as an accurate reference for skin tone, no matter what chart you look at.

The best references to use in your image when you are considering correcting color are

grays. Grays can act as references because they are easy to measure: they will always have

even amounts of red, green, and blue. When you measure with the Eyedropper, the R, G,

and B values displayed in the Info palette should all be the same—or very nearly so.
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In a perfect world, you could find areas of your image that would be grays of exactly 

25 percent (64,64,64), 50 percent (128,128,128), and 75 percent (192,192,192) black when

corrected. You could then take measurements from these areas of your digital image to

use as references for correction. All you’d have to do is set accurate white and black points

and then correct the areas that should be gray by manipulating them. As a result, your

images would color balance nicely. However, it usually isn’t too easy to find gray refer-

ences unless you place them in your image. Although you can do this using a reference

card (a gray card, usually 18 percent gray, but anything of a standard flat tone will work),

it is not something that everyone will take the time to do.

In many cases, grays that already exist in the image can be used as reasonable substi-

tutes for a reference card. If you look closely, you may find something that should be a flat

shade of gray, such as a steel flag pole, chrome on a car, asphalt…anything that should be

flat gray can be useful for color evaluation. White and black objects (such as paper or car

tires) can work, too, as long as they are not over- or underexposed, respectively. While

objects can also vary in color to some degree and sometimes drastically (such as the mossy

side of a tree), they will be easier to judge and correct for than skin tones.

Once you determine a target gray in your image, Curves can help you easily manipulate

the targeted areas. All you have to do is measure the RGB values of the gray object, and

then adjust the curves to flatten the color response. Flattening the color response can be

done by shifting the curves to correct the sample toward gray while ignoring everything

else in the image. When the changes are complete, the image color will be fixed as a by-

product of normalizing the grays.

To determine the values for a gray object to use in correcting an image, do the following:

1. Examine the image to locate an object that should be closest to gray.

2. Be sure the Info palette is visible and that one of the sample types is set to RGB 

Color (RGB).

3. Select the Eyedropper from the toolbox. Select a sample option depending on the 

size and resolution of the image. Larger images with more resolution can usually

stand broader sample areas.

4. Point the tip of the Eyedropper at the gray reference area in the image.

5. Note the grayscale and RGB values shown on the Info palette.

6. Make an RGB separation (using Split RGB w-Preview in the PowerSeparations cate-

gory of Effects).

7. Adjust the Red, Green, and Blue layers with Curves so that the color tones reflect an

average of the RGB values sampled at the reference area.
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For example, say there is a flagpole in your image and you will be using it to make your

color correction with Curves. You sample the tone and find that the area is 41 percent gray

(looking at the Grayscale, or K value in the Info palette) and that RGB values in that area are

170,150,160. To get the gray to be flat (no color) in that zone, you’ll want to make the RGB

values equal. You do this by adjusting curves the same way you did when correcting tones—

you’ll use measured targets to correct your curve points. You can add points to the curve to

make the corrections to separated components accurately acording to the measurements.

Because you want the gray to be flat, you can average the RGB values to find a target

(170 + 160 + 150 = 480; 480 / 3 = 160). Once you have the average of the components,

you change the values so that the components match the average. Figure 4.8 shows what

the curves would look like. Here are the values for the curves:

Color Input Output

Red 170 160

Green 150 160

Blue 160 160

Figure 4.8

Adjustments would
be made by chang-
ing the numbers in

three Curves dialog
boxes, one for each
component of your

separation.
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To make the correction, you will add curves—one at a time, grouped to the split and

layered RGB components—to change the value of the tones according to the numbers you

have measured. Because of this level of control, your choice in the selection of a gray refer-

ence is important to the outcome of your color correction. For example, if you choose a

gray that in reality is supposed to be slightly green and you don’t allow for that in the cor-

rection, your final corrections will end up somewhat warm as a result. Again, visual

inspection must work hand in hand with the numbers to achieve the best result.

Because you are making an assumption about the gray (that it is indeed a flat gray

rather than one with a slight tone), you may want to make an adjustment by using only a

percentage of the change. Doing so may keep you from overadjusting. This concept is sim-

ilar to not cropping off all of a large tail in Levels. If the difference in the colors is broad, or

skewed to one of the channels, it may be preferable to average 50 or 75 percent of the dif-

ference. The more positive you are that the value you are measuring should be gray, the

stronger the percentage of change you should apply. If you are positive the object is gray,

make the change 100 percent of the difference. Scaling back to 50 or 75 percent respects

some of the color measured in sampling the gray area of the image.

Using the previous example, take the difference between the measured and average

value, multiply that figure by the percentage, and add it to the measured value:

target value = measured value + ([average value – measured value] × percentage)

In the case of the red channel, which measures 170, your equation would look like the fol-

lowing if using 75 percent of the difference (the average value is still 160):

target value = 170 + ([160 – 170] × 0.75), or 170 – 7.5 = 163

Using an Output value of 163 makes the red change only 75 percent of the way, leaving

some respect for the value you originally measured in the image. The following list shows

the target values for making the change with 75 percent strength (respecting 25 percent of

the original measurement):

Color Input Output

Red 170 163

Green 150 158

Blue 160 160

Gray measures are given in percentages, and RGB measures are given in levels. The levels graph

can work in either levels of gray or percentages. You can toggle between the two, and even use

the curve to make the calculation for you (by placing a point on the curve and then clicking the

percentage/level toggle on the bar below the curve graph). If you want to convert gray per-

centages (P) to levels (L) manually for your calculations, subtract the percent from 100 and mul-

tiply by 2.55: (100 – P) × 2.55 = L. To convert levels to percentages, use 100 – (L / 2.55) = P.
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The more gray points you measure, the more accurate your balance in the resulting

color corrections will be. If you measure several key gray spots, you should make the cor-

rections all at once by placing as many points on each curve as you have key spots. Do this

instead of returning to the process several times,

as shown on the curve in Figure 4.9. This ensures

that you are changing the measured spots relative

to one another; if you change the values sequen-

tially on separate curves, the changes will occur

independently and simply won’t work right.

When measuring one level of gray, try to 

make it a midtone; if you are measuring two, use

a lighter and darker gray; if you are measuring

three, use quartertones (25 percent, 50 percent,

and 75 percent, or 63, 128, and 191 levels). The

more evenly you divide the gray levels used for the correction, the better. The more levels

of gray you correct for, the more accurate your correction will appear.

The following example uses the image from Figure 4.10 that was photographed by

including a homemade 25 percent, 50 percent, 75 percent gray card in the image. The

image was opened as a digital image and corrected for Levels. The gray card was then

measured, and those measured results were applied as curves to make a correction. Use

the bleedingheart.psd file on the CD to follow along.

Figure 4.10

The gray card
(shown to the right)

can help balance
color at three levels

of gray.
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If using several sam-
ple grays, place

them on the curve
for each component

in one step. This
shows a Red correc-
tion for three meas-

ured values at 25,
101, and 205 levels.

4385c04.qxd  11/5/04  4:35 PM  Page 124



Use the following steps to adjust the curves according to your gray selection:

1. Measure the gray. Because there is a gray card in the example, there is an absolute ref-

erence. These are the original measurements:

Color 25% 50% 75%

Red 228 129 43

Green 210 151 91

Blue 209 143 78

2. Average the gray value for each tone (add the RGB values at each percentage and

divide by 3). The results are 216 levels at 25 percent, 141 levels at 50 percent, and 71

levels at 75 percent. These averages are your target, or Output values.

3. Determine the target values for each component curve. Each curve will have three

points, with the input reflecting the measured tone and the output reflecting the

desired (averaged) result. Table 4.1 plots the points.

C O M P O N E N T I N P U T O U T P U T

Red 228 216

Red 129 141

Red 43 71

Green 210 216

Green 151 141

Green 91 71

Blue 209 216

Blue 143 141

Blue 78 71

4. Separate the image into its RGB components by using Split RGB from the Hidden

Power tools located in the PowerSeparations category of Effects.

5. Activate and view only the Red component in the layers.

6. Double-click Curves from the Hidden Power tools located under the PowerTools1

category of Effects. Click the Group With Previous Layer check box in the New Layer

dialog box and click OK.

Table 4.1

Example Curves Set-
tings for the Sample

You can make your own gray card by making an image with scaled tones (for example, 25, 

50, and 75 percent gray) and then printing that image with black ink only on your printer.

This won’t be entirely accurate, as black ink can have color and color can be influenced by

the whiteness of the paper, but it can certainly work well in many situations—better than

guessing what should be gray in your image. You could try experimenting with paint swatch

samples from a hardware or paint store as well.
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7. In the Curves dialog box that appears, add three points to the curve: either hold Com-

mand/Ctrl and click once on each of the card swatches in the sample image, or click

on the curve itself.

8. Ensure that the Curves dialog box is in levels mode, not percentages (you can change

between levels and percentages by clicking the toggle switch on the bar below the

curve graph). Click each of the points one at a time and change the Input and Output

values to match those in the chart. Do this by entering the values from the chart in the

Input and Output fields.

9. Repeat steps 6 through 8 for the Green and Blue layer components, viewing each layer

individually by turning off the visibility for the other layers.

After all the corrections are performed using the card, you will have corrected for white

and black, as well as 25 percent, 50 percent, and 75 percent gray. This gives you five refer-

ence points that should result in some pretty accurate color. This technique should be

more accurate than using just one reference point, and can account for complex lighting.

For example, if you take a picture in a royal blue room where there is incandescent light-

ing, ambient light (reflected) might tend to be blue, while direct light would be warm (or a

little red). Highlights would tend toward red, while shadows would tend toward blue.

Making multi-point corrections enables you to compensate for color difference and shifts

at more points, leading to color that is more correct overall.

At this point, click Preview RGB from the Hidden Power tools in the PowerSeparations

category under Effects to add color back to the image without flattening the layer chan-

nels. The preview should show improved color. Check it by toggling the visibility for the

correction layers on and off.

When you are finished correcting the color, the image can be corrected for luminosity

as well. You can correct tonal shift based on new black (K) measurements, or by using the

RGB averages. If using measured percentages, you will take new samples of the gray card

by using the K measurement in the Info palette; if you are using the averages (as in the fol-

lowing steps) you just use the RGB averages you already determined. Use the following

steps:

1. Activate the Background layer for the RGB-separated image by clicking it.

2. Click Add Luminosity from the Hidden Power tools in the PowerSeparations cate-

gory of Effects. This creates a Luminosity layer. Move this layer to the top of the stack.

3. With the Luminosity layer active, click Curves in the PowerTools1 category of Effects.

Click the Group With Previous Layer check box in the New Layer dialog box and

click OK.
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4. Determine the values you will be using. You are adjusting to 25 percent, 50 percent,

and 75 percent (191,128,63) for the card swatches based on the average RGB values

(216, 141, and 71). So your value chart would look like this:

Color Input Output

Luminosity 216 191

Luminosity 141 128

Luminosity 71 63

5. Adjust the tone. Add three points to the curve by holding down Command/Ctrl and

clicking on the three card swatches or by clicking on the curve. Then change the Input

and Output values to the numbers determined in step 4.

The result of this correction will darken the image. Although it is based on measure-

ment from the original, you may or may not want to keep that change. Click the view

toggle for the Luminosity layer to compare before and after. To go somewhere in between,

change the Opacity of the Luminosity layer by using the Opacity slider on the Layers

palette.

You can split the RGB and Luminosity to make your corrections all in one separation

by clicking Split RGBL (another Hidden Power tool) in the PowerSeparations category of

Effects before making any adjustments. RGBL stands for red, green, blue, and luminosity.

Making this separation will enable you to correct the luminosity separately from color

while controlling both color and tone. It is a somewhat unique separation that cannot be

provided even by Photoshop channels.

Although Levels and Curves are excellent correction tools, and making corrections

absolutely by the numbers may seem pretty accurate, it may not produce the most pleas-

ing color. If you have no idea where to start your correction, the techniques described here

for basic color correction are definitely a fine start that will get you moving in the right

direction. Because of other considerations (such as the limitations of the CMYK color

space), you may get better color by replacing colors and tones, or by making corrections

not so strictly tied to measurements, or in some cases by altering color completely. Mak-

ing targeted and selective tone and color corrections can help with these additional

changes, and we’ll look at those approaches in the next chapter.
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Chapter 5
Specific Color Enhancement

After making general color corrections with Levels and/or Curves, it is time to get specific

about color. You can make changes with Levels and Curves in combination with later

steps in corrections, but chances are that any additional changes you make will need to be

targeted to a specific image area. Splitting image components out is helpful for general

color correction and grayscale conversion, but there are other ways that separations can

help you work with color and tone in images to get the best result. Separating components

helps enable color adjustments, but components can also empower you to target even

more specific areas of an image. This chapter looks into these possibilities in more depth

by introducing tools, toning, calculations, and CMYK color.

Using Hue/Saturation for Color Adjustments

Saturation Masking

Adjusting Color Balance

Painting in Color Changes: History Brush 

Application

Making Duotones

Calculations and Channel Mixing

Separating CMYK Color

Using CMYK Color
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Using Hue/Saturation for Color Adjustments
Hue/Saturation (Enhance ➔ Adjust Color ➔ Adjust Hue/Saturation, or Layer ➔ New

Adjustment Layer ➔ Hue/Saturation, or press Command/Ctrl+U) is a powerful but easy-

to-use color-correction tool. It enables you to adjust color based on hue, saturation, and

brightness (HSB). HSB measurements are used on the Color Picker along with RGB, and

are used to mix color—often in painting. Hue adjusts colors as if you were selecting color

from a 360-degree color wheel. Saturation controls the density of the color; greater satura-

tion means that the color in an image has the potential to be richer (the actual appearance

of color is influenced by tone). Brightness (or lightness) affects the tone in the image.

Hue/Saturation can affect all the color in the image or it can be confined to affecting only

a specific range of color, using the Edit drop-down list in the Hue/Saturation dialog box

(see Figure 5.1).

The Hue/Saturation feature can help with color corrections by

providing visual feedback and a relatively easy interface. When

using the Hue/Saturation dialog box, all you have to do is adjust

the sliders and use the image on-screen as a preview to watch what

happens as a result of your adjustments. For the most part, as long

as you have made proper Levels corrections, you won’t have many

additional color changes to bother with because Levels adjustments

will have corrected for some issues of saturation, hue, and lightness

(brightness).

Although it may not be the best use of the feature, you can open

the Hue/Saturation dialog box and play with the sliders to see if you happen to stumble on

an adjustment that improves the image. Testing adjustments by using Hue/Saturation can

yield pleasant surprises. Unless you use selection or masking to target a color change,

global adjustments to hue, saturation, and brightness will tend to require only a slight

movement of any of the sliders—unless you are looking to achieve a special effect. You

might be a little wilder with your experimentation if the subject in the image is something

like a flower that may not have a specific color reference (unlike, for example, skin tone—

skin has real-world limits and can’t be, say, green or purple unless painted).

In making straightforward changes with Hue/Saturation, adjusting Hue will often

throw the color out of balance swiftly, and adjusting Lightness may provide too drastic

and primitive a change in tone for color correction (it has other uses as we will see). Light-

ness is the least attractive adjustment for most images when used by itself: far better to

make these types of changes with Levels and/or Curves. However, you can occasionally get

some pleasant results from increasing Saturation in some images.
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To make a correction using Hue/Saturation:

1. Select the appropriate portion of the image to target your corrections. You can do one

of the following:

Target the whole image. Flatten your image (choose Layer➔ Flatten Image) or

select the top layer in the stack if adjusting the whole image (press

Option+Shift+] / Alt+Shift+] to activate the top layer, or just click it).

Target a layer. Activate the layer you want to correct by clicking it in the Layers

palette, if making a selective change based on layer content.

Target a specific image area. Create a selection or mask to define a specific area

of the image. This targeting can be done by using selection tools or masking tech-

niques, or by making a selection from the Edit drop-down list in the dialog box.

Any active selection will become a layer mask for the Hue/Saturation layer,

masking nonselected areas.

2. Open the Hue/Saturation dialog box by creating a Hue/Saturation adjustment layer.

Choose Layer ➔ New Adjustment Layer ➔ Hue/Saturation. If targeting a specific layer

for change, be sure the Group with the Previous box is checked in the New Layer dia-

log box.

3. When the Hue/Saturation dialog box is open, attempt to adjust the Saturation by

moving the slider a few points to the right of the center position to see if greater satu-

ration improves the color dynamic.

Admittedly, this procedure isn’t terribly exciting. The result is that you will get more

saturated color, and either prefer it, or not. One other option on Hue/Saturation is the

Colorize option. The Colorize option is like applying a layer filled with a single color set to

Overlay mode (at 50 percent Opacity). The difference is that you can adjust the Color, Sat-

uration, and Lightness sliders on the Hue/Saturation dialog box to achieve the color effect

you want rather than selecting a color from the Color Picker.

You needed this introduction to the Hue/Saturation function because the tool also

offers some unique opportunities for selective correction when used in combination with

other features and tools. Snapshots and Luminosity separations in the Hidden Power tools

help make selective corrections, and selective correction is where the real power of Hue/

Saturation lies. That’s what we’ll look at in the next section while making a saturation-

based mask.

Saturation Masking
If you want to make a selective color change (if you have a specific color or color range

that you want to change or isolate from change in a shot), you may target those colors by

using Hue/Saturation to help in creating a mask. You can make more drastic changes after
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targeting than you could with general adjustments because the rest of the image won’t

change. Clever use of the Saturation slider in the Hue/Saturation dialog box can help you

quickly create masks based on hue. These masks can help you target image areas based on

color so you can make corrections and changes by using other features and tools.

The image in Figure 5.2 has several distinct colors that might be adjusted independ-

ently. (You’ll have to take a look in the color section to see the color detail.) The image

(bottle.psd) is provided on the CD for your experimentation and so you can follow along

with the masking procedure. In the example, the color of the bottles is already a rich blue.

If you want to keep it that way while making other changes, you can target other areas by

freezing (masking out) the color of the bottles. This will enable you to alter color in the

other parts of the image without changing the bottles. Just a warning: as we go along, this

image will look quite awful before it begins to get better, because of what you are doing to

build the mask.

Figure 5.2

This image offers
several opportuni-
ties for hue-based

color isolation.
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The process of creating a mask based on color and saturation is basically the same for

any image. You have three tasks to complete in order to make the saturation mask:

1. Prepare the image for making a color range choice by adding some key layers that

help you create the mask.

2. Choose a color range. Select the color range you want to either change or keep from

changing by using Hue/Saturation functions.

3. Use the color range selection and preparations to create a useful color mask.

The following three sections expand on the details for each step in the process.

Preparing the Image
To prepare this image, you’ll need to set up a few layers that will help you make the mask.

You create these layers for the sole purpose of being able to commit changes you make

when using layer blending options. Some of the layers depend on modes or calculations

for the result that is displayed. Until you commit the changes by merging layers, the

changes are only an appearance. You need to commit the changes to use them.

1. Open a flattened image, or flatten an open one. For this example, I used bottle.psd,

found on the CD.

2. Duplicate the background. You’ll use this layer to select the target colors for masking

and to create the mask. Name the layer Saturated Colors.

3. Activate the background (press Option+Shift+[ / Alt+Shift+[).

4. Create a new layer. Name it Mask. This layer should remain transparent until the

final steps of the exercise, and then it will become the mask.

5. Create another new layer and fill it with gray. To create the gray fill, choose Edit ➔ Fill

Layer. When the dialog box opens, set the Contents to 50 percent Gray, Blending

Mode to Normal, and Opacity to 100 percent (Mode and Opacity are set to these by

default, so you may not need to change them). Name this layer Commit Mode 2.

6. Duplicate the Commit Mode 2 layer created in step 5. Name this Commit Mode 1.

There are two changes to commit using layer modes, and this upper layer will be the

first in line, even though you created it second.

Choosing a Color Range
Now that you have prepared the image, you can choose the colors to be excluded, or

masked out, and made safe from change. You will temporarily desaturate the area of the

image that you want to keep as it is, leaving only the color that you plan to change visible.

The remaining saturated colors will be used to create your mask.

7. Activate the Saturated Colors layer by clicking it.
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8. Choose Layer ➔ New Adjustment Layer ➔ Hue/Saturation. This initiates the creation

of a Hue/Saturation adjustment layer at the top of the layer stack. Select the Group

With Previous check box in the New Layer dialog box when it appears, and click OK

to continue. The Hue/Saturation dialog box opens.

9. Select the Blues option from the Edit drop-down menu. The object of this step is to

enable the color sliders at the bottom of the Hue/Saturation dialog box. You can do

this by selecting any color other than Master from the drop-down list. I suggest Blues

for this example, because it is closest to our target range for mask-

ing the bottles. We’ll adjust the range in a moment. When making

changes in other images, try to choose the color that best matches

the color you want to mask. When you make the selection from the

drop-down list, note that the eyedroppers become available in the

dialog box and that the color bar at the bottom reveals sliders as in

Figure 5.3. The sliders on the color bar represent the color range

that will be affected by changes made to the Hue, Saturation, and

Lightness.

10. Drag the Saturation slider in the Hue/Saturation dialog box all the way to the left. If

you have selected a good representation of the color you want to work with, the color

will desaturate. Don’t let that worry you; it is starting to build your mask, which will

be based on desaturated areas of the image.

11. Adjust the range of color that you want to keep from change—in other words, sample

the color(s) that you want to add to the mask. In this image, use the Add To Sample

eyedropper and click on anything left in the image that is blue. Most blue objects

should have been included already, but there may be areas such as in the vase that you

would like to include (see Figure 5.4). If you make a mistake, you can clean it up by:

changing to the Subtract From Sample eyedropper, adjusting the sliders manually to

contract the range by clicking and dragging them, or just starting over by holding

down the Option/Alt key and clicking the Reset button. All color that you add to the

color range will appear to desaturate in the image; any colors removed from the range

will turn back to the original color. Color range adjustment can be accomplished in

any of the following ways:

Use the Add To Sample eyedropper. Click the plus eyedropper icon and use

that to sample colors from the image that you want to add to the range, as shown

in Figure 5.4.

Use the Subtract From Sample eyedropper. Click the minus eyedropper icon

and use that to sample colors from the image that you want to remove from 

the range.
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get for masking the
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sliders automatically
set to that range.
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Adjust the sliders manually. Click directly on the slider at the bottom of the dia-

log box and drag it to move it. The close-up of the color range slider in Figure 5.5

shows some details of the slider. The color bar above the slider shows the range 

of color being affected, and the color bar below the slider shows the resulting

color spectrum. The dark gray area between the absolute markers (the rectangu-

lar markers on the inside) shows the range that will be

affected 100 percent by changes. The gray area between the

absolute markers and the fade point markers (the triangular

markers on the outside) shows where the color range will be

affected in decreasing intensity (100 percent to 0 percent).

Everything outside the range of the markers will not be

affected.

Figure 5.4

There are blues in
the vase that you
may want to include
as well. Dragging
the Add To Sample
eyedropper over the
vase will include
these blues (actually
cyan) as well.
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12. After the range is set (see Figure 5.6) and the colors you want to mask are desaturated,

accept the changes for the dialog box by clicking OK.

You can imitate my result by changing

the color range to match the settings

shown in Figure 5.6 by moving them man-

ually if your sample doesn’t achieve the

same effect. However, the point is to create

the mask—not necessarily to match my

results exactly. Depending on how you

made the color selections, your range may

be slightly different, and that’s okay.

Creating the Mask
With the color range you want to mask desaturated, you can use the image color satura-

tion that is left to create the mask.

13. Merge the Hue/Saturation change with the Saturated Colors layer below by activating

the Hue/Saturation layer (if it isn’t already) and pressing Command/Ctrl+E. This

commits the changes and shows the original image with the selected color range as

desaturated.

14. Change the mode of the Saturated Colors layer to Color (select Color from the drop-

down mode list at the top of the Layers palette). This shows image color saturation

against a 50 percent gray background. The gray represents unsaturated image areas

and image areas you want to mask, as well as other areas that previously were not sat-

urated (white, gray, and black).

15. Merge the Saturated Colors and Commit Mode 1 layers by pressing Command/Ctrl+E.

This commits the changes. The name of the layer should be Commit Mode 1.

16. Change the mode of the Commit Mode 1 layer to Difference. Difference mode com-

pares the pixels in the current layer with the pixels below. If there is no difference, the

result will be black. The greater the difference, the lighter the result will be. The desat-

urated areas of the image and blue bottles will appear as black; anything that is not

completely black means there is some saturation in that area—the lighter and

brighter the result, the greater the saturation.

17. Merge the Commit Mode 1 and Commit Mode 2 layers to commit the changes. To 

do this, activate Commit Mode 1 and press Command/Ctrl+E. The resulting layer

should be named Commit Mode 2.

18. Open the Levels dialog box (Enhance ➔ Adjust Lighting ➔ Levels or Command/Ctrl+L)

and make a Levels adjustment by pushing the white RGB Input slider to 128. This

intensifies the brightness of the saturated areas (everything that isn’t black).
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custom color range.
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19. Double-click Drop Black from the Hidden Power tools. Drop Black is found on the

Styles and Effects palette. With Effects selected in the drop-down list to the left,

choose the PowerTools1 category and double-click Drop Black. This function makes

black in the current layer transparent, revealing the blue from the bottles and other

unsaturated areas of the image below.

20. Merge the Mask layer and the Commit Mode 2 layer by activating the Commit Mode

2 layer and pressing Command/Ctrl+E. This commits the Drop Black changes and

leaves part of the mask layer transparent. The resulting layer should be named Mask.

21. Duplicate the Background layer. Change the name to Unmasked Color.

22. Move Unmasked Color layer to the top of the layer stack.

23. Group the Unmasked Color layer with the Mask layer by pressing Command/Ctrl+G.

In the end, the Layers palette should look like Figure 5.7.

Steps 21 to 23 recolor the masked image area. It will look like

the original image, but you have successfully masked your target

area, as we’ll see in a moment.

If you turn off the visibility for the background at this point,

you will see the area that you have isolated in original color with

a hole where the color portions of the bottles were. Chances are that the complexity of the

area is nothing you would have wanted to select manually. You can make changes to the

areas outside the bottles freely by grouping any new adjustment layers that appear above

the Unmasked Color layer in the Layers palette. This targets change to everything but the

bottles. You can make changes to the bottles isolated from the rest of the image by group-

ing changes with the Background layer.

For example, if you want to make a Hue/Saturation

adjustment layer change to the blue bottles and a Color Bal-

ance change to the rest of the image (Unmasked Color), the

placement for these adjustment layers is shown in Figure 5.8.

Saturation masking enables you to mask any color in any

image so you can work on distinct colors separately—in this

way using image color as a means of selection, masking, and

targeting a specific area of the image for change. Saturation

The Drop Black function makes pixels between 0 and 2 levels (or 100 percent to 99 percent

black) completely transparent, and then fades the opacity of dark pixels between 3 and 31

levels (or 99 percent to 90 percent black). This helps blend the saturation masking.
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Many changes result
in just these few lay-
ers. The mask result
is very powerful and
useful.

Figure 5.8

This Layers palette
shows how to set 
up Hue/Saturation
adjustments made
to the masked color
range and Color 
Balance for the
Unmasked Color.
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masking is different from working with separated color as you do when separating RGB

tones, because you are isolating colors that may have information in red, green, and blue

components all at the same time. Not only can this method be used to isolate specific col-

ors, but it can also be used to make selections of objects based on color—or lack of it.

Masks you create can be loaded as selections by pressing the Command/Ctrl key and click-

ing the Mask layer. If the mask is loaded as a selection when you create an adjustment

layer, changes in the layer will be reflected in the layer mask for the adjustment layer.

A function is provided in the Hidden Power tools to quickly work through the previous

procedures and create a saturation mask. Just double-click Saturation Masking under

PowerTools1 on the Effects palette and you will be walked through all the steps. Although

this tool enables you to make saturation masks with the click of a button, you should prac-

tice this manual technique first, and work through it several times in different variations.

For example, try isolating the red or yellow flowers in the image (the red is a challenge).

Understanding how this works is invaluable when working on other images that need iso-

lated corrections, or when working on complex separations such as creating the K (black)

component in CMYK (which we’ll be doing later in this chapter). You can do a lot more

with the concepts that are being mined here than just make saturation masks.

Adjusting Color Balance
Color balance refers to the balance of color between opposites. For example, green and

magenta are opposites; in order for image color to look right (not too magenta and not

too green), these colors have to be in balance. Color balance tools enable you to shift the

balance between these opposites to realign the color. Adjusting image color balance allows

you to compensate for color shifts that may have occurred in capture or correction, or to

add shifts that create a pleasing look.

The one problem with Color Balance is that, like Curves, it is apparently missing from

the Photoshop Elements interface. The Hidden Power tools included on the CD allow you

to access Color Balance by simply double-clicking Color Balance from the PowerTools1

category under Effects. This will open the Color Balance dialog box (see Figure 5.9) and

will create an adjustment layer. When the changes are accepted and the dialog box is

closed, the adjustment layer cannot be edited.

Color Balance is easier to work with when making color

adjustments than Hue/Saturation. It is also often more effective

at bringing out pleasing color by removing counter color—or

colors that effectively work against one another in your images.

It is great for finessing, rather than manhandling, color elements.

Color Balance enables you to balance highlights, shadows, and

midtones for cyan/red, magenta/green, and yellow/blue. This
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box, but the controls
produce different

results.
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provides an advantage when colors have gotten out of balance for whatever reason. For

example, if yellowish highlights have been tainted by blue, they flatten and muddy toward

green. Shifting the color back can make the color seem more vibrant. All you really have to

do is open the Color Balance function and experiment with application to pick the most

pleasing result.

To make adjustments, open your image, open the Color Balance dialog box (double-

click Color Balance in the PowerTools1 category under Effects), and use the following

steps. As you draw each slider back and forth, you will note the image tints to extremes;

your goal in these changes is to find the point where these extremes balance and leave the

slider at that juncture.

1. Starting with the Midtones radio button selected, make a radical shift in the top slider

(Cyan/Red). Slide from approximately –50 to +50 (more if you find it helpful) and

watch the effect on the image. This gives you an idea as to

whether a move with the slider makes a change that seems

visually pleasing in the color of the image overall, and

should give you a hint as to what the balance looks like for

that slider in the extreme positions. It is unlikely that an

extreme will look balanced.

2. Pick either –50 or +50 as the more pleasing. Compare as

many times as you need to make the decision.

3. When you have selected the more pleasing slider position,

compare it to the midpoint between the two original selec-

tions. In this case, that would be a comparison between the

center (0) and the point you found more pleasing (–50 to 0,

or 0 to +50).

4. Make a few such comparisons, picking the best of your two

choices, each time dividing the field in half until you arrive

at a final result. See Figure 5.10.

5. Repeat steps 2 through 4 for the Magenta/Green and Yellow/Blue sliders.

6. Repeat steps 1 through 5 for Highlights and then for the Shadows.

Feel free to experiment with the Preserve Luminosity check box. When it is checked, Ele-

ments will attempt to keep luminosity from changing. If you are trying to keep luminosity

intact, apply the Color Balance layer in Color mode—it will prove more predictable.
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was +50, your next
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+50. The winner of
that decision goes
against +38.
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7. To be reasonably sure you’ve made the best choices (you won’t be able to open the

dialog box again after you have closed it), run through steps 1 through 6 a second

time. This will help you to adjust for balance changes you made.

8. Click OK to accept the changes.

9. Compare the image before and after the correction by toggling the view for the Color

Balance layer.

While the application here may seem conceptually simplistic, as long as your monitor

can be reasonably trusted, you will find that this trial-and-error method can greatly

improve your images—in tone, contrast, and color. You’ll also get good rather quickly in

determining the best slider positions, and will spend little time doing comparisons and

cutting down your options. Once you gain confidence, you’ll pay very little attention to

the dialog box, and just watch the image as you move the sliders. This adjustment can be

used in conjunction with other tools to achieve targeted results as well. For example, you

might use it in combination with a hue-based color mask created with Hue/Saturation.

These types of combinations of tools and masking give you infinite control over targeting

image color results.

Painting in Color Changes: History Brush Application
Sometimes it is easiest to get the color you want in different portions of an image by using

different corrections. You may find that making one part of an image look good comes at

the expense of absolutely ruining the color in the rest of your image. This little dilemma

might make it seem that there is no way to make a compromise between the two without

compromising the image color or making complicated selections.

As it turns out, you don’t have to settle for a compromise. There is a way to make changes

to your image—even drastic ones—and store those changes so you can use them later.

Using some Hidden Power tools, you can then paint only a portion of the color back in.

Photoshop allows you to do this with something called the History Brush. The History

Brush lets you select a snapshot (a stored state of your image) as the source for painting so

you can apply that version of the image back into your present image by using a brush. It

enables you to do all sorts of things such as color changes or spot application of filters

(apply the filter, take a snapshot to use as a source, and then jump back to the original

image and paint changes in as desired).

Photoshop Elements doesn’t have a History Brush tool and has no way to take snap-

shots. But why should that stop you? Using Hidden Power tools, you can store a version of

your image in a way similar to taking snapshots by double-clicking the Snapshot tool. The

stored versions (or snapshots) are saved in layers, and the visibility is turned off so that

you can return to them as needed. Using layer masking will allow you to easily imitate the

History Brush: you can group the snapshot to an empty layer, turn on the visibility for the
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snapshot layer, and use brushes to fill in the mask. As the mask layer becomes solid, it will

look like you are painting back changes stored in the snapshot.

To take a snapshot of your image, be sure it looks like you want it to, and then double-

click Snapshot in the PowerTools1 category under Effects. When you take a snapshot, sev-

eral things will happen in the image. Whatever you see on-screen will be merged

(retaining transparency, if any), and a copy of that will be stored in a new layer. The snap-

shot layer will be stored at the top of the layer stack, above and

grouped with a Snapshot Mask layer. The snapshot content will

be hidden because it is grouped to the mask and the mask is

empty. Leave the snapshots in storage until you want to apply

them. The rest of the image will be left exactly as it was when

you made the snapshot. See Figure 5.11.

Between making different snapshots, you have several options for continuing to work

and make changes and corrections:

• Leave everything as it is and just keep making changes.

• Throw out the changes you made to achieve the snapshot by deleting those layers

(leaving the snapshot, of course) and then make new changes.

• Retain the changes and start with the original background.

• Retain the changes and start from the snapshot.

Your choice depends on how much information you really want to keep and how you

like to work. If you just keep going from where you are, you can retain information in lay-

ers you might want to use later. On the other hand, if you are sure there is nothing you

want to retain, tossing out the changes will keep the important information in the snap-

shot and make your image a little more lean.

You may want to retain some or all of the layers used in making the changes that lead up

to creating the snapshot so that you can make adjustments (for instance, if you want to

reshoot Snapshot 1 with additional changes or in a different style). You might also want to

retain the layers if you just aren’t done with the image yet (for example, if you have to go to

work and can’t complete what you are working on right then).

To retain the layers used in making the changes, just leave them

there. Use a duplicate of the Background or Snapshot layer 

and drag it just under the Snapshot layer at the top of the layer

stack. Duplicate the Background layer so you will be able to

return to the original image, or duplicate the Snapshot layer to

continue working from where you were. If the plan is to keep

the layered changes and return to working on the original, the

layers will look like Figure 5.12.
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Figure 5.11

After taking a snap-
shot of the back-
ground, the layers
look like this. You
can have multiple
snapshots.

Figure 5.12

With Background
Copy 2 blotting 
out the changes
made earlier, you
can step back to the
original image with-
out losing previous
corrections.
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Technically, you can save the image with all the layers and changes by using this snap-

shot method—saving snapshots is something even Photoshop doesn't allow. You may

want to thin the layers out as you go along to keep the file size small. Although retaining

snapshots and layers can be an important time-saver, it can also fatten your image

heartily. Be sure you need what you save.

The purpose and application of this type of change may be best looked at in an exam-

ple. We can run through an application of the tools in context, and you can see how 

they work.

Figure 5.13 shows a butterfly. In the color section you can see that this butterfly landed

on an object that was nearly the same color as itself. While the color is interesting, you

may prefer a little more variety to make the butterfly stand out. Because the color of the

background is similar to the butterfly, Hue/Saturation masking wouldn’t accomplish the

change, because it would select both the color in the butterfly and the background. And

while you could make some sort of complicated selection, there are much easier ways.

Start by making a general correction to the image to be sure you are starting with the

best representation of tone and color. With that complete, it is time to start exploring

opportunities to change the image. In this case we’ll change the color of the butterfly; you

could change the background by using the same technique.

Figure 5.13

A blue butterfly
rests on a blue back-

ground, but you
might want some
more interesting
color distinction.
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The process of making the change occurs in two stages, preparation and application.

Preparation First, do some exploring and experimenting. Instead of working with compli-

cated selections, you can simply adjust different versions of your image to create sources

for the color you’d rather see in specific areas of the image. Taking snapshots will store the

changes; then you can later use the snapshots to recall and apply the changes to your origi-

nal image.

Application Once the source color is all set up in the original image, you just paint the

color back into the original image by using brushes.

We’ll explore the preparation and application in more detail in the following sections.

Preparation
To prepare for changes to the butterfly, you will make some corrections to separate areas

of color and freeze those changes by taking snapshots. Each snapshot can focus on a dif-

ferent color or element that you will want to work back in later.

1. Open the butterfly image (butterfly.psd on the accompanying CD) and duplicate the

Background layer. You should work on this duplicate. Leaving the Background layer

alone will allow you to return to the original content later to adjust for different colors.

2. Adjust the color of the image so that the dark portion of the butterfly looks how you

want it to look. Don’t worry at all about what you do to the blue—or any other color,

for that matter. Don’t bother to use selection or other masking; just change the color/

tone. You can use any tools or filters that you want, but for this example use the Color

Balance Hidden Power tool (find Color Balance on the Styles and Effects palette

under Effects in the PowerTools1 category). I added yellows and reds to the shadow

to warm up the black.

3. Once the dark portion of the butterfly looks how you want it to look, take a snapshot

by double-clicking Snapshot from Hidden Power tools (also found under the Power-

Tools1 category in Effects). This will be your source for the dark portion of the but-

terfly. Name the snapshot Dark Portion. It will appear at the top of the layer stack.

4. Make changes to adjust the butterfly’s wing color to however you would like to see it.

This may require deleting and enhancing other changes that you made to create the

Dark Portion snapshot—and that is okay because you have achieved the objective of

those changes and stored them as the snapshot. Duplicate the Background layer and

drag it below the Snapshot Mask layer to give you a fresh starting point. This is a good

time to use Hue/Saturation to make the change, editing the default Master color set.

Again, adjust the color on the wings and ignore everything else. I chose to make the

wings look a vibrant lime-green.
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5. Make a snapshot of the image when you have completed the change for the wing

color. Name the snapshot layer Wings.

6. Make changes to the image to target just the color of the spots on the bottom of the

wings. Again you can duplicate the Background layer and remove other color

changes. I used Hue/Saturation, selected Red from the Edit menu, and fiddled with

the sliders to get a brighter, more saturated red.

7. Make a snapshot of the image when you have completed the change for the spots on

the wing. Name the snapshot layer Spots.

You could continue to make changes for other elements in the image, but these three

changes are enough to give you an idea of what you can do.

Application
Now that the snapshots are created, you are ready to apply them to make your changes to

the butterfly.

8. View the original image Background layer. This may require turning off visibility for

other layers you have created. As an option, you can duplicate the Background layer

and bring it up below the snapshots.

9. Click the Snapshot Mask layer for the snapshot source you want to apply. This acti-

vates the visibility for the Snapshot Mask. Start with the Wings snapshot, because the

resulting change will be the most dramatic.

10. Choose a painting tool (the Airbrush is a personal favorite) and a brush for the appli-

cation. I chose a brush size of 200 pixels that is fairly soft (30 percent hardness).

11. Although it doesn’t really matter, choose white for the foreground color. Any color

will work, but the idea of masking is usually based on black-and-white, where white

represents unmasked areas.

12. Paint over the wing area in the Snapshot Mask layer you selected by clicking and

dragging the paintbrush. The content from your snapshot source will fill in as you go.

To compare the change before and after, toggle the visibility of the Snapshot Mask

layer for the snapshot you are working with.

Brush selection and dynamics in step 10 matter, and should make sense for your application.

If you are going to be painting back image areas that are large and mostly open, select a

large brush; if you are painting back smaller areas, choose a smaller brush. Solidity also mat-

ters: an opaque brush will create an opaque mask, and a brush that is soft and/or applied

with less than 100 percent opacity will only partially apply the snapshot content.
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13. Choose the next source by clicking the Snapshot Mask for that snapshot. Repeat steps 10

through 12, choosing an appropriate brush size for the changes you want to make and

painting in turn on the Snapshot Mask layer for the Dark Portion and Spots snapshots.

After you have painted in information from the Dark Portion, Wings, and Spots snap-

shots, your butterfly should look significantly different. By the time you are finished, you

should have painted in some interesting color that you have from each snapshot source.

This is eons easier than making complex color selections and often a lot more fun.

You can adjust the results of applying any of the snapshots at any time by using the

Eraser tool to touch up the mask, and changing layer modes and opacity. When you do,

make the changes on the Snapshot Mask layer, not the snapshot itself. If you change the

snapshot, it permanently changes the content of the snapshot and/or reveals the content

of the mask (which would be white, if you took the suggestion I made previously). If you

really botch the application of a snapshot and want to start over, just activate the Snapshot

Mask layer for the snapshot you want to do over, Select All (press Command/Ctrl+A), and

press Delete on the keyboard. This will clear any painting you have done in the layer so

you can start with a clean slate.

Snapshots are simple in concept: all they do is store an image state and enable you to

apply that information later by using layer masking properties. Although they are simple,

they can enable you to paint in filter applications, and make other color corrections and

changes with the flexibility of a changeable layer mask. A snapshot can be used to spot-

apply any change and is a versatile tool for spot corrections.

Making Duotones
A duotone is an image in which two colors are applied as tone to create a colored effect.

The idea behind duotones is often to create a richer feel for black-and-white images, per-

haps to add a little color and maybe even increase the dynamic range of a printed image.

Duotone effects for photographic images have traditionally been achieved by chemical

processes for toning prints (sepia toning as well as other special processes). On the print-

ing press, true duotones are created by applying two or more inks based on image tone.

We’ll look at how to control duotone results digitally and in print. Although there is some

information on printing and halftones here, you may want to take

a look at Chapter 9 for more options on getting true duotone

prints from a home inkjet.

Creating a duotone effect digitally in Photoshop Elements can be

done a number of ways. For example, you can rather quickly emu-

late a sepia tone by opening Hue/Saturation, clicking the Colorize

option, and shifting the slider to achieve a duotone effect (see the

Hue/Saturation palette in Figure 5.14). When you print to an inkjet

printer, the result will often be satisfactory—though not optimal.
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Figure 5.14

Clicking Colorize
and setting the Hue
to about 10 will give
a decent sepia tone
to any black-and-
white image.
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You could apply a color in a fill layer that is set to Color mode, or you could also exper-

iment with colorizing by using gradient maps. Each of these methods may achieve the

effect of duotone color, and the image might print out just fine on your home inkjet, but

the methods do not produce a true duotone and may not be the best solution. Certainly

duotones can simply be pleasing to the eye, but true duotones pose specific advantages in

printing. Using more than one ink to print halftone images on a press can take advantage

of multiple screening angles, and can produce a better richness and depth in the intended

result. Other advantages to using duotone over black ink alone in prints include lessening

the appearance of printer dots and increasing ink coverage on the page. Duotone effects

can also help to correct and emphasize subtle tonal detail.

When duotone images are used in spot-color print jobs, the purpose is often to limit

color due to budget constraints. To create effective duotones for this purpose, you have to

be able to control the color separation for two inks (such as black and a spot color). If not,

you will have to pay a technician to do the separation for you, or worse, pay for four-color

work (CMYK printing) on a two-color job. Because there is no built-in duotone handling

in Photoshop Elements, there is really no direct way to save the separate plates for duotone

colors. Add to the difficulty the fact that there really isn’t a means to handle spot color in

Elements in the first place, and you have a problem. Luckily it is another problem that you

can solve with Hidden Power tools.

Solving the problem and understanding the application requires a little knowledge of

duotoning as well as working with separations and spot color. We’ll take a look at the

whole process, from how to break down and apply spot-color inks in preview to how to

get actual duotone print effects on your inkjet printer and on a press by using Photoshop

Elements alone.

Understanding Duotones
When you create a duotone, you replace the existing tone of an image with two tones. A

key to the difference between duotone color and four-color printing (CMYK) is that

CMYK color printing attempts to imitate color that already exists in the image or a scene.

Duotoning is different because it is often a means of adding color and richness to black-

and-white images to enhance the tone. Inks in a duotone are applied variations of existing

When printing halftones with two or more inks, using two black inks can improve a printed

image because the two sets of dots will be screened differently (the rows of dots applied at

different angles). The increased number of halftone dots can result in better application of

inks. (You’ll learn more about halftone dots in Chapter 9.)
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image tonality. The original tone is duplicated and altered to represent the density of

ink color components—something like using red, green and blue components to repre-

sent color in RGB. The mix of the inks is controlled in Photoshop using Curves. The effect

of duotoning a black-and-white image is more like colorization in that the tone of the

image is influenced by color rather than attempting to represent realistic color.

The duotone effect is controlled by selecting and mixing color successfully. Interplay

between the colors is often a subtle shift rather than a radical application. While other

tools can be used for creating the interplay between colors, Curves will give you the most

control. Setting curves without some sort of technique, method or understanding of what

you are trying to achieve might prove quite fruitless and frustrating. Likewise, problems

can result if you pick color you like rather than color that will be effective. Your plan

should be as follows:

1. Select inks that are compatible and that can accomplish your goal in duotoning.

2. Set up the image and apply curves to make the most of the inks you have chosen with

consideration for the tonal qualities of the image.

Although there is a little art to experimenting with color selection and application,

there is some pretty straightforward science as well. A 25 percent gray ink at 100 percent

strength will be 25 percent gray when printed; it just covers 100 percent of the paper (see

Figure 5.15). It can never get darker than 25 percent gray unless mixed with another color.

With this in mind, any color affects an image mostly in tonal areas that are lighter than the

100 percent strength of the color. That is, a 25 percent gray ink will be able to more effec-

tively influence tonality in 1 percent–25 percent grays—although it will affect darker col-

ors that it mixes with, it will be less effective in manipulating the image over that tonal

range. A dark color can represent lighter tones, but the opposite can never happen. A rule

of thumb should be to use at least one color that is dark or black for your duotone so you

can maintain the dynamic range in the image.

When choosing color, work with color that is harmonious and sensible. Select color

that can blend effectively to produce a smooth white-to-black gradient (see Figure 5.16).

You will most often want to use colors with distinct tone rather than all dark or all

medium-toned inks. In a simplistic view, the lighter colors you use will emphasize the

contrast and tone in the brighter or highlight/midtone range of the image, and the darker

colors will emphasize the shadow details. If you select a light color and a dark color for a

duotone, the light color can be run with a greater density in the lighter image areas and the

dark in the shadows. This will help you to most effectively work with (rather than against)

image tone. For example, for a straightforward duotone you might choose black and light

orange, or black and sky blue.
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Whatever colors you choose, the emphasis of the colors in the duotone should be in

their tonal range where the ink is most effective. Harmony between colors will make it

easier to set up blends that work with the image tones. If you choose difficult color combi-

nations or have unrealistic expectations, you can make much more work than necessary in

getting the blends to work—or you may simply make it impossible.

Curves serve as translators for how ink is to be applied. The curves are used to influ-

ence the tone of an image to increase or decrease the strength of an ink in a specific range.

Throughout the tonal range, the inks blend to form shades and tones, which are finessed

to the advantage of the image. A rule of thumb is that if you want to apply a 25 percent

gray ink, curves should show high intensity at 25 percent on the curve

graphing for that ink (as shown in Figure 5.17).

Deciding how to set the curves is part art and part science. Darker inks

are often steeply graded in the shadow tones, whereas lighter inks are

more steeply graded in the lighter tones. This will use the ink in its most

effective area and help it to render the tone dynamically. If you remember

back in Chapter 3, the steepness of the curve affects image contrast over

the range where the curve is steep. This same theory works here: by mak-

ing the curve steep over the effective range of the color, you are enhanc-

ing the potential contrast.

The colors used in duotones are often called spot colors, although commercial color book

names are also used (such as PANTONE, TRUMATCH, Focoltone, and so on). These colors are

standards and can be matched by your printing service. To use specific colors for duotones

that we will create in Elements, you’ll have to get an RGB equivalent from a color book or a

printing service.

Figure 5.16

Unrealistic expectations can yield bad results in your
duotones. You want blended tones to be able to
flow evenly from light to dark (a). Bad choices can
limit tonal range (b) or lead to color being applied
inappropriately (c).

Figure 5.15

Magnification shows black ink—100 percent black—
printed at 25 percent gray (left), and gray ink—
25 percent black—printed at 25 percent gray in
halftone printing (right)

a

b

c
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Depending on 
the color, desired

effect, and image,
the curve can be

even steeper than
shown here.
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If you use two shades of black or two dark inks, you should de-emphasize the density of

the inks or you will darken the image; however, when using two dark inks, setting both

curves the same way may not take advantage of potential dynamics in the image. Figure 5.18

shows a sample of curve settings used in a scenario with two dark inks.

Experimenting with curves for application of color can yield some pleasant and subtle

toning effects. Using some of the ideas here can help you apply the colors in a way that

makes sense. Now let’s look at creating a duotone effect in Elements.

Applying Duotone Effects
To build a separation-ready duotone in Photoshop Elements, you have to use an image’s

tonality along with some tricks that we’ve seen hints of both in using curves and in making

RGB separations. Curves are used to enhance the tone for the separate inks, and preview

techniques like those used for RGB separations are used to look at the results of how inks

will combine. When the preview looks the way you want it to look, separations can be

provided to your printing service as grayscale images or you can print actual duotones on

your home printer.

Follow these steps to create a duotone in Elements:

1. Open an image that is black-and-white, or convert a color image to black-and-white

by the methods described in Chapter 2. Be sure the image tone is corrected—you

won’t want to do this afterward because it will change the look of the duotone. 

See the sample image shown in Figure 5.19. This image is available on the CD 

(duotoning.psd).

2. Copy the flattened image content by duplicating the Background layer two times. If

you were creating a tritone (three inks) or quadtone (four inks), you would duplicate

as many times as there are inks you want to apply.

Figure 5.18

The curve with the
hump (left) is used
to emphasize con-
trast in a small por-
tion of the highlight
area so those tones
don’t flatten out.
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3. Rename the layers to identify the colors/tones you expect to apply. I simply called

them Black and Spot 1.

4. Change the mode of the layer at the top of the layer stack (Spot 1) to Multiply. This

will ensure that the application of the upper color makes the result darker, as it would

when printing.

5. Create a new layer and fill it with the color you want to apply. Name the layer accord-

ing to the color you are applying. This way if you come back to it several years later,

you’ll know what you did without a lot of analysis. In the example, to create some-

thing of a sepia tone I used an RGB close to Pantone 472 (R = 255, G = 155, B = 125).

This layer will be used to apply a color to the Spot 1 layer.

6. Change the mode of the color layer to Screen and group it with the Spot 1 layer.

Using the Screen mode will lighten the Spot 1 layer in accord with the color you have

selected. Because you have started with a grayscale image, the color of Spot 1 will

technically be black. Because any color you pick will be lighter than black, using

Screen mode will lighten the result.

Figure 5.19

People are often
good subjects for

duotones.
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7. Activate the Black layer by clicking it.

8. Double-click Curves in the PowerTool1 category of Effects to initiate the creation of a

Curve adjustment layer. Be sure the Group With the Previous box is checked in the

New Layer dialog box before continuing.

9. Apply a curve to adjust the results. See Figure 5.20 for the curve used in the example.

The idea here is to lower the influence of the black overall, while using it to emphasize

contrast in the darker half of the image.

10. Activate the Spot 1 layer.

11. Double-click Curves in the PowerTool1 category of Effects to initiate the creation of

another Curve adjustment layer. The Group With Previous box should be checked

already.

12. Apply a curve to adjust the results. The lighter ink should have stronger influence and

contrast in the lighter tones, and this is reflected in the use of the curve pictured in

Figure 5.21.

Figure 5.20

The curve for the
dark ink lightens 
the influence so 
that later ink adjust-
ments will interplay.

When stacking colors, arrange them from darkest at the bottom to lightest at the top. This

will help your organization and the application of color as well.
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The final result of this procedure can be seen in the color section. Your Layers palette

should look like Figure 5.22 when you are finished. As far as layer order, the curves should

be immediately above the tone they are adjusting and between the tone and color. Should

you need more adjustments, add another curve layer or replace it (delete and create a new

one). You can add as many adjustments as you want and test different combinations by

toggling the visibility for any of the Curve adjustment layers. If

you want more spot colors (to create a tritone or quadtone),

duplicate the setup for Spot 1. If you want the black to be a spot

color, add a color layer above the curve for the Black layer (you

may want to change the name for the Black layer as well). The

adjustments may require some fiddling before they look just

right.

Again, this type of work on individual color separations can

serve many purposes: achieving the effect of adding color to a

black-and-white image, working within the limitations of a

Figure 5.21

The curve for the
light ink strengthens

the influence in the
lighter tones.
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Figure 5.22

The result of the
example should look

like this in layers.
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two-color print job, enhancing printed results by using two inks and screens rather than

one, and gaining the opportunity to enhance image tone by influencing ink coverage and

ink contrasts. If you are just colorizing an image to get a duotone effect, you probably

won’t have to go through the trouble; if you want a true duotone that can be separated

into specific inks, this is the way to go.

Hidden Power tools provide functions for creating duotone images. Just start with a

flattened RGB image that has been converted to black-and-white (use any of the methods

discussed in earlier chapters), and double-click the Duotone Setup (in the Separations cat-

egory of Effects). The power tool will lead you through the process of setting up the layer

stack. Be sure the black-and-white image is in RGB color mode, not Grayscale, or you will

not be able to apply color.

Be sure to try to blend inks so that the influence of one ink can pick up where the

next leaves off. As part of the process, you may want to use a gradient bar to judge the

quality of the gradient you are creating when combining the colors. I have provided a

sample gradient bar (Duotone_Preview_Bar.psd) on the CD. You can use this to check

how smooth your mixing is or to develop curves for application in duotones. To test

your duotone curves, just open the preview image and drag the curves and colors to it

from the duotone you are working on. You will have to arrange and group the layers to

match what you created. To use it to develop curves, create the curves right in the pre-

view file and then drag them to the duotone you are creating. The gradient should

appear relatively smooth and even—unless you are using the duotone for some type of

image correction or special effect. The bar is more useful for seeing where the curves

may be failing (and need adjustment) than in generating effective duotones. To test the

duotone directly in the image you are working on, double-click Duotone Bar tool in the

PowerSeparations category of Effects. This will create a duotone preview bar right in

your image.

Even when applying the same duotone color scheme to different images, you can’t

always apply it with the same curves. The result really depends on the image. What works

fine for normal and low-key images may not work as well for high-key images, which

would probably suffer from the attention to shadow detail. Curves need to be created

dependent on the overall tonality of the image on an individual image basis—otherwise it

could just be a push-button effect. Generally, high-key images should be set to emphasize

detail in the highlight areas, and low-key images should be set to emphasize detail in the

shadows. Experimentation and experience with setting the curves will make creating duo-

tones easier and more intuitive.

making duotones ■ 153

4385c05.qxd  11/7/04  11:33 PM  Page 153



Printing Duotones
To print your duotones, you could just flatten them and send to the printer, but you’d

have done all the extra work in the previous section for nothing. What you have in the lay-

ers by the time you are done with the duotone procedure is a bona fide separation. You

should treat it that way. This means using the inks separately and applying them to the

paper as separate inks.

A great home experiment is to print the separated colors one at a time to see the duo-

tone results. To do this, leave one of the duotone color layer sets on (see Figure 5.23), flat-

ten the image, and save it as an RGB image (you can use Grayscale mode for black ink)

with the name of the color. Save a separate flattened image for each color in your duotone.

When you are finished, print these to your printer one at a time on the same sheet! Print

light colors first, and follow with darker. You should use photo-quality paper and allow

sufficient drying time between printing each ink. If you use lower-quality paper, the paper

will likely not handle the ink well and the result might be murky and oversaturated. In

putting down the colors one at a time, you will build your print similar to the way it

would be created on a printing press. As long as your printer has reasonably accurate

paper gripping, you’ll get a pretty refined result.

Blacks will probably be richer and darker when printed in this multiple-pass style

because the inks will go on heavier than they would if printed in a single pass. The printed

effect of multiple passes is a greater tonal range, because the blacks will be darker—even

though you are using the same number of grays in the image and same number of inks in

the printer. This works somewhat like putting on multiple coats of paint.

For use with an imagesetter and for making film or creating printing plates, you’ll want

to make grayscale images from your duotone layers. Leave one duotone component visible

in the layers, shut off any coloring for it, flatten the image, and save it as a grayscale with

the name of the color. Do this for each component in the duotone. You’ll note that the

“light” layers become dark when you do this (see Figure 5.24), and that’s what is supposed

to happen. What you are seeing is how the application of the

color ink will look in grayscale—as density of the ink, rather

than color. The tonal representation is a percentage of ink

(0–100 percent).

As long as you tell your printing service which file is

which, they can create film for printing or impose the image

without a lot of trouble. There is one other way to put these

files together to avoid problems when submitting them: by

turning them into EPS DCS files. We’ll take a closer look at

that technique in the “Using CMYK Color” section later in

this chapter.
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Using Duotones for Tonal Corrections
Duotone curves can be used to make subtle changes and corrections in difficult black-

and-white images. Although the images will not retain the richness of duotoning or the

effect of multiple inks, creating duotone effects to correct grayscale images can help

strengthen subtle detail, and some of this may be retained in the grayscale result. Consider

the duotone curves to be an important part of your grayscale correction arsenal.

b

a

c

Figure 5.24

Shutting off the
color (a) and other
layers (c), and then
flattening gives you
grayscale depic-
tions of the Spot 1
color plate. (b) is the
Spot 1 plate and (c)
is the black.
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For example, if you have an image with subtle highlight detail (such as a wedding pic-

ture in which dress detail has become somewhat washed out or faded due to harsh flash

lighting), you can create a duotone to change the image emphasis in different tones. Just

open the image in black-and-white and then create a duotone. For the wedding picture

example, you’d pick a black and light-gray ink for your colors. Use the light gray to

emphasize the highlight area of the image. This can work in images where tones seem to

flatten too much, as in Figure 5.25.

Calculations and Channel Mixing
In Photoshop, calculations and channel mixing are ways to adjust color or tone based on

image components. What the two features have in common is that they play components

against one another to create a result.

Calculations create a result by using components as parts of an equation, much like

adding, subtracting, multiplying, and so forth. The simplest calculations can be a way of com-

bining selections to create a different result. For example, say you see a situation where you

can easily make two selections separately, but you want to somehow combine the selections

by subtracting one from the other. Calculations would let you make the separate selections,

save them as channels, and then combine them by using layer functions. See Figure 5.26.

– =

Figure 5.26

Calculations let you
add selections

together or subtract
them (as shown

here), but far more
complex calcula-

tions can occur.

Figure 5.25

This image had flat
medium tones (left),
but applying a duo-

tone helped make
an adjustment that
better defined the
contrast and light-

ened the result
(right).
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Channel mixing is an adjustment in which you change one component based on com-

bining it in percentages with other components. For example, say you have an image of a

bright red flower appearing over a lush green background. The problem with the image is

that in real life, the flower is purple. Assuming this is a problem with the image, if you

separate and look at the RGB channels, you’ll find that the red channel is white (satu-

rated) where the flower is and the blue channel is dark or black (unsaturated). You could

mix some of the red channel into the blue to lighten the blue channel, increasing the blue

saturation in the flower. The result will, of course, shade the color of the flower toward

purple—although you may have to exercise other control (such as masking) to get the

result you want.

Calculations are usually a means of producing masks based on image color or content.

Therefore, you’ll handle them a little differently than you would normally handle channel

mixing. Channel mixing is often more suited to color correction and adjustments. The

functions allow you to render simple changes, complex image results, and fine adjust-

ments. The real advantage is that you use tone that already exists in the image; the tone

can act as a complex, natural selection to enhance your image in ways that would be much

more difficult if attempting selections manually.

What is the most frightening about calculations and mixing are the names and the

descriptions. If you have followed the concepts behind separations to this point, you have

applied some simple calculations. However, how to use calculations and mixing in layers

may not be entirely obvious. Once you’ve taken a look at how to do calculations and mix-

ing, they are really easier to control and they offer more options the Hidden Power way in

Photoshop Elements than if you were working with Photoshop. Because you work in lay-

ers, the results are more visual, and they simply make more sense to use because you can

see exactly what is happening as you make the changes. You are also not limited to using

just the few components available in the current color mode: you can mix and match com-

ponents in any way you find convenient to get your result. The key is the setup in layers.

We’ll look at calculations first, and channel mixing will fall right in line. When we’re

finished, we’ll look at an example of how calculations work by building an unsharp mask

using traditional darkroom techniques that you can use on any image—in combination

with or as a substitute for the Unsharp Mask filter.

Calculations Setup and Application
Practically the whole problem in making calculations is the setup and deciding what to do,

and what you’ll want to do at any time depends on your image and purpose. Setting up

calculations requires that you have image components (or grayscale representations) that

you want to use in creating a result. Your source can be selections, masks, and/or separa-

tions. All you do is duplicate the parts you want to use for the calculations and use layer
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properties to create the calculated result. You’ll want the gray tone for each color compo-

nent you use in the calculation rather than the color version.

Use the following steps to set up your calculations:

1. Decide what you want to do to the image and which image components, selections,

and masks the calculation will use. The source layers should be converted to black-

and-white components.

2. Duplicate the components you will be using to a new image (choose New for the docu-

ment in the Document drop-down list in the Duplicate Layer dialog box). Duplicating

the first channel to a new image (see Figure 5.27) creates the image you will use to col-

lect the other components for the calculation. In the Destination panel of the Duplicate

Layer dialog box, name the new document something obvious, such as Calculation 1.

If you don't name the image in the dialog, the new image will be named Untitled-#

(where the octothrop represents a version number).

3. Duplicate the additional components to the Calculation 1 image by selecting the doc-

ument named in the previous step by name from the Document drop-down list in the

Duplicate Layer dialog box. Source components for the calculation can be from other

images (or other calculations), but they may need to be resized.

4. Arrange the component layers in order to create the calculated effect. For example, if

you want to darken one layer based on the other, put the layer that will be doing the

darkening on top, and change the mode to Darken. If you are looking to create other

effects, you would choose the appropriate layer mode. Most often you will use Darken

or Multiply to darken the result, and Lighten or Screen to brighten the result.

5. Change the mode of the upper layers to create the desired calculation. Adjust opacity

of the layers to moderate the effect. For example, if you want one layer to brighten the

lower layer by only 50 percent, change the opacity of the layer to 50 percent.

6. Flatten or merge the result.

Layer blending modes and their functions become important to calculations and channel mixing.

Knowing what each layer mode does can help you get the results you want in calculations. There

is a listing of the modes and descriptions of what they do in the appendix for your reference.
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The target for the
first channel is a new
image (left). The tar-

get for the second
channel can be the

image created in the
first duplication

(right).

4385c05.qxd  11/7/04  11:33 PM  Page 158



This simple set of steps opens numerous possibilities for using layer properties and

other tools in your calculations. Calculations can be corrected with curves or you can

exercise other correction options while the calculation is being created—all at the same

time. You can add masks to the layers, invert content, or make selective changes or other

tonal adjustments. Because of the staggering number of variations this procedure opens

up, you might see how this could quickly amount to a book of its own. This calculation

method can be used for masking and selection techniques as well as for making compli-

cated blends for spot colors and other separations (as we’ll see in the next section on

CMYK separation). You can use the result by loading it as a selection or by using it to cre-

ate masks.

When you have achieved the results you want, you’ll have to copy the layer back to

your image. To create masks from calculations, you can use various Hidden Power tools

to convert the content into layer clipping masks, or to create selections as a source for fill-

ing layer masks. For example, if you create a grayscale calculation and want to use the

result to mask your image, you can apply it like so:

1. Duplicate the calculated result to the image you want to apply it in. This requires first

making a composite layer in the Calculation 1 image. To do this, create a new layer at the

top of the layer stack, name it Layer Mask, and then press Command+Option+Shift+E /

Ctrl+Alt+Shift+E to copy flattened content to the new layer.

2. Double-click the Transparent Grayscale tool in the PowerTools1 category of Effects.

This drops out the white area of the Layer Mask layer so that it becomes transpar-

ent. You can see the effect if you shut off the view for all

layers except the Layer Mask layer. To reverse the

effect, you have to Invert the layer content (Com-

mand/Ctrl+I; see Figure 5.28) before using the Trans-

parent Grayscale tool.

3. Copy the Layer Mask layer to the original image (or the

image where you want to apply it as a mask) by using the

Duplicate Layer function.

4. Apply your mask by putting the Layer Mask below the

layer you want to mask; then group the two layers.

The Layer Mask layer can be loaded as a selection by holding down the Command/Ctrl

key and clicking the Layer Mask layer in the Layers palette. Layer Mask layers can also be

combined as part of further calculations.
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Channel Mixing Setup and Application
Channel mixing may be a little more concrete than calculations, and offers more opportu-

nity for straightforward color correction and color modification. The setup is similar to

calculations, but content will mostly likely be from separated components. The idea is that

there is no better means to adjust select areas of an image than by using the image itself. In

this case the image components act as masking and content at the same time.

You can mix channels directly in the current image with a full-color preview, or in

grayscale. The color preview lets you see how the change affects the current image; the

grayscale enables you to look at the mixing result separate from the current image. The

latter is helpful if you are making a mask or other grayscale representation from the

mixing.

To mix channels with a full image preview:

1. Separate your image into RGB by using Split RGB w-Preview in the PowerSeparations

category of Effects.

2. Choose a component that you want to target for the adjustment (either the Red,

Green, or Blue component) and activate it.

3. Move the target component to the top of the stack (press Command+Shift+] /

Ctrl+Shift+]). This moves the target component and the grouped color to the top of

the layer stack.

4. Duplicate the target component. Name the duplicate layer Source and move it

between the target component and its associated fill layer. Change the layer mode to

Linear Dodge. See Figure 5.29.

5. Duplicate the Green layer. Change the name of the Green layer to Green Mix and

rename the Green Copy layer Green. Move the Green Mix between the Source layer

and the associated fill layer. Change the layer mode to Linear Dodge.

6. Duplicate the Red layer. Change the name of the Red layer to Red Mix, and then

change the name of the Red Copy layer to Red. Stack the Red Mix layer directly above

and grouped with the Green Mix layer. Change the layer mode to Linear Dodge.

7. Duplicate the Blue layer. Name the Blue layer Blue Mix and then rename the Blue

Copy layer Blue. Stack the Blue Mix layer directly above and grouped with the Red

Mix layer. Change the layer mode to Linear Dodge. See Figure 5.30.

8. Adjust the Mix layers to reflect the desired mix of components/channels.

When a layer is duplicated in Elements, the original loses its association with any grouped

layers, and the copy retains them. It is easier to rename both layers than to juggle groupings.
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this after step 4.
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The Layers palette
shows mixing using

the Blue component
as the source.
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When making adjustments, add influence from a component by increasing the Opacity

for the component layer (Red Mix, Green Mix, or Blue Mix layers). The Source layer acts

as a placemark for the preview and should probably not be adjusted—though you may

choose to shut it off if using less than 100 percent of the original component. To subtract a

component, move the component to the top of the grouping (drag it in the Layers palette

to move the position), invert it (press Command/Ctrl+I) and then change the mode to

Linear Burn. Components set to Linear Burn need to be above the layers set to Linear

Dodge while remaining grouped, or they will not influence the result.

These steps for setting up a channel mixer in a color image can be accomplished by

using the Channel Mix effect provided in the Hidden Power tools. First you have to run

Split RGB w-Preview in the PowerSeparations category and then run Channel Mix, in the

PowerTools1 category.

What this type of channel mixing can do that Photoshop’s native tool can’t, is allow

you to change the blend modes of components and allow simultaneous application of a

component in more than one blend mode. The result is that you have a far more flexible

tool to work with.

To mix channels for a grayscale result, you should not use the color fill layers. While

you could just delete the color fill layers and juggle layers around, let’s start the setup from

the beginning:

1. Open and flatten a color RGB image.

2. Run the Split RGB tool in the PowerSeparations category of Effects.

3. Add a Composite layer filled with black above the Background layer.

4. Attach the word Add to the names of each of the component layers (Red Add, Green

Add, Blue Add), change the Mode to Linear Dodge, and lower the Opacity to 0 percent.

5. Duplicate each of the Add layers, change the layer copy names from Add Copy to

Subtract (Red Subtract, Green Subtract, Blue Subtract). Change the layer Mode to

Linear Burn and drag to the top of the layer stack (Opacity will already be 0 percent).

Invert the Subtract layers (press Command/Ctrl+I)

6. Activate the Red Add layer and change the Opacity to 100 percent.

The layers should now look like they do in Figure 5.31. The Red component will be

showing at 100 percent. Mix the components by changing the opacity of the various layers

to add or subtract influence.

The mode and opacity you use depends on what you are trying to accomplish. You will

often just use Linear Dodge and Linear Burn as the setup indicates, but other modes can

be used, such as Screen or Lighten to brighten the mixed result, and Multiply or Darken to

darken it. This flexibility is something that Photoshop’s Channel Mixer tool doesn’t allow.
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Steps 3 to 6 can be accomplished using the Channel Mix Grayscale tool provided with the

Hidden Power tools in the PowerTools1 category of Effects. First run the Split RGB tool

and then the Channel Mix Grayscale tool.

Mixing can be used to make many kinds of color corrections, but it is often most useful

in replacing image tone or qualities in image areas that have been ravaged by saturation or

by exposure extremes that distorted or clipped image information. Channel mixing can

also help make complex conversions to black-and-white (with everything from an

infrared to ultraviolet flavor). A very practical application of calculations and mixing can

be seen in making custom CMYK separations, as we’ll do later in this chapter. A great

example of the power of components used in calculations and channel mixing is creating a

manual unsharp mask, as we’ll do in the next section.

Manual Unsharp Masking: Calculations in Action
There are many adjustments you can make with calculations and channel mixing, and not

all of them will be obvious immediately. One of my favorites is manually creating unsharp

masking effects. Unsharp masking, as mentioned earlier, was a darkroom process before it

was a filter. The photographer doing the developing would sandwich a blurred film nega-

tive copy of the image with the original to burn in (increase exposure of) the image shad-

ows. The blur would target the contrasty edges, and the result after the application would

be increased shadow detail and a sharper look to the image. This application of unsharp is

a little different, but builds on the same concept.

You can imitate this modified darkroom sharpening effect by using the following steps:

1. Open a flattened image that you’d like to apply an unsharp mask calculation to.

2. Duplicate the Background layer.

3. Invert the Background Copy layer (press Command/Ctrl+I or choose Filter ➔ Adjust-

ments ➔ Invert) and rename the layer Unsharp Mask.

4. Blur the layer. The size of the blur will depend on the resolution of the image and the

amount of detail. The more detailed the image, the less blur; the higher the resolu-

tion, the greater the blur. Start with 5 pixels for a 3×5 image at 300 ppi.

5. Change the Layer mode to Overlay.

6. Reduce the opacity of the duplicate layer to 50 percent; adjust the opacity as desired.

The Unsharp Mask layer you have created ends up working much like the sandwiched

negative in the darkroom process. It enhances edge contrast, albeit in a different way

than using the Unsharp Mask filter. You may want to apply a curve to adjust for contrast

changes or apply the Unsharp Mask filter after using the manual technique to enhance

the results.
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Unlike the Unsharp Mask filter provided with Photoshop Elements, this sharpening fil-

ter has less of a tendency to produce halos. It also has the interesting side effect of decreas-

ing contrast, whereas the Unsharp Mask filter increases contrast. Because the effect is the

opposite of the Unsharp Mask filter, the two sharpening effects can often be used together

to greatly intensify image sharpness. The result you get is brought about by a masked cal-

culation: the inverted “negative” acts to mask the highlights and applies the Overlay calcu-

lation more intensely over the dark portion of the image, resulting in contrast edge

enhancement.

The best results for the unsharp masking calculation will often be had by applying the

change to the image luminosity. If you use the Split RGBL or Split Luminosity Hidden

Power tools in the PowerSeparations category of Effects, you can separate the luminosity

component and then apply the sharpening to the Luminosity layer. Color won’t be

altered, and you may achieve better results than applying sharpening to tone and color at

the same time.

Two tools called Sharpen and Sharpen Plus are provided with the Hidden Power tools.

Sharpen will run through the basic process described in the preceding steps, enabling you

to select the intensity of the blur. Sharpen Plus will enable you to run through the sharp-

ening process and adds an Unsharp Mask filter application as well that you can control.

To use these tools, click the layer you want to sharpen to activate it (this may be the image

background or any layer, but using a luminosity layer is suggested) and double-click the

Hidden Power tool. You will be able to adjust the intensity of the sharpening application

by using layer opacity after the tool runs you through the process.

Separating CMYK Color
One Image mode that Photoshop Elements supposedly does not handle at all is CMYK

color. CMYK stands for cyan, magenta, yellow, and black, the four colors that are the tradi-

tional standard for ink printing. Even though Elements doesn’t have a CMYK image mode,

there are ways to extract CMYK components, just as there are ways to extract RGB compo-

nents, or luminosity and color. CMYK is just a little more complicated. The procedure for

separating CMYK color is probably not something you will need to use every day. You will

use this only in situations where CMYK is a must, or when you want control over the sepa-

rations you make on a printer that will not allow you to make your own separations.

Even with the ability to create a CMYK image, many home printers would take an

image you created in CMYK and print it without directly using the CMYK data. These

printers would look at the CMYK file, interpret it as RGB, and then use that information

to print by using its CMYK inks. In effect, what happens is that you don’t really get from

the printer output the CMYK that you put in. We’ll take a look at how to get around that

potential problem later in this section.
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To fully understand what’s going on here, you need to have a decent understanding of

just about everything that we’ve discussed up to this point in the book. Because CMYK

separation can be a complicated topic, we’ll first look at the process of how to separate,

and then discuss some additional theory. This topic could fill a book on its own, so we’ll

just give you enough to get started with here. You can learn more from experimentation

and discussions on the Hidden Power website and in the Hidden Power newsletter (find

information about the newsletter on the website: www.hiddenelements.com).

With the following techniques, you can create your own separations and not only use

them in four-color print jobs, but force your printer to make a CMYK print to your

specifications.

Making the Basic CMY Separation
The easy part of this separation is filtering out the CMY. Although it isn’t as straightfor-

ward and easy as making an RGB separation, the process for separating is similar.

In the RGB additive color scheme, cyan is a combination of pure blue and pure green;

magenta is a combination of pure red and pure blue; and yellow is a combination of pure

red and pure green. Screening an image for blue and green will reveal cyan, screening for

red and blue will reveal magenta, and screening for red and green reveals yellow. If you

look at a color wheel, the relationship between these colors may become more evident.

The target CMY color falls between the two RGB components. In other words, the cross

product of mixing equal amounts of blue and green light is the RGB equivalent of cyan.

Combining red and blue lights creates magenta. You can see this result by opening the

RGB.psd file on the CD.

What we will be doing with the CMY separation is using the understanding of these

combinations to apply the same type of color filtering we applied when extracting RGB.

Completing the separation will give you basic CMY image information. This separation

information works to represent your image on-screen, and in a perfect world. When we’re

finished with the CMY separation, we’ll look at why it doesn’t work in real-world printing

and what we have to do to offset that shortcoming. We’ll work through the CMY separa-

tion in three parts:

Preparation Set up the colors for separation by duplicating the original image. Once the

image is duplicated, you are ready to start making the real separations based on existing

color.

CMY Separation Screen each layer by the RGB color components to reveal the CMY color

separation and simultaneously create the preview for the color. This state is temporary,

because to make this a really useful separation you’ll have to convert each channel to

grayscale—just as you did with the RGB components.
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Conversion of Colors to Tone Adjust each color to display tone. There is no way to repre-

sent the intensity of component color other than by using its tone. The leap here is that

you have to remove the color that it seems you have already separated, and then re-create

it to get a usable result.

Preparation

All you will be doing here is creating some source layers to use in helping to make the

separation:

1. Open gorskii.psd (found on the CD), duplicate the Background layer, and name the

new layer Cyan.

2. Change the Mode of the duplicate layer to Multiply.

3. Duplicate the Cyan layer and name the new layer Magenta.

4. Duplicate the Magenta layer and name the new layer Yellow.

5. Activate the Background layer.

6. Create a new layer and name it Composite.

7. Fill the Composite layer with white.

The image will look awful at this point, but that doesn’t mat-

ter. These are only the initial steps, and you’ll be taking quite a

few more to complete the separation. The layers should look as

they do in Figure 5.32. Steps 1 through 7 can be completed by

double-clicking CMY Setup in the PowerSeparations category

of Effects loaded with the Hidden Power tools.

CMY Separation

Just like separating the RGB components, we’ll add some screening layers to filter out

CMY color from the image:

8. Activate the Yellow layer by clicking it or by pressing Option+Shift+] / Alt+Shift+].

9. Create a new layer, being sure that Group With Previous is checked. You can name

the layer Red Screen if you want, but it is only a temporary layer, so naming is

unnecessary.

10. Fill the layer with pure red (R = 255, G = 0, B = 0) and change the mode of the layer

to Screen.

11. Duplicate the Red Screen layer. Fill the layer with pure green (R = 0, G = 255, B = 0 ).

Again, this is a temporary layer, but you can name it Green Screen. The red and green

combine to filter out the yellow component from the image. This completes separa-

tion of the yellow component from the image.
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12. Select the Magenta layer.

13. Create a new layer, checking Group With Previous.

14. Fill the layer with pure red (R = 255, G = 0, B = 0) and change the mode of the layer

to Screen. Rename the layer Red Screen if desired.

15. Duplicate the Red Screen layer from the previous step. Name the layer Blue Screen if

desired.

16. Fill the layer with pure blue (R = 0, G = 0, B = 255). The red and blue combine to fil-

ter out the magenta component from the image. This completes separation of the

magenta component from the image.

17. Select the Cyan layer.

18. Create a new layer, checking Group With Previous.

19. Fill the layer with pure green (R = 0, G = 255, B = 0) and change the mode of the layer

to Screen. Rename the layer Green Screen if desired.

20. Duplicate the Green Screen layer created in the previous step.

21. Fill the layer with pure blue (R = 0, G = 0, B = 255). Change the layer name to Blue

Screen if desired. The green and blue combine to filter out the cyan component from

the image. This completes separation of the cyan component from the image.

If you have completed these 21 short steps without a hitch, you’ll be looking at the

same image you started with and the layers will look like Figure 5.33. If you turn off the

visibility for any two of the three component layers, you’ll see the separation named in the

remaining layer. Hidden Power tools will take care of steps 8 through 21 if you double-

click the CMY Color tool in the PowerSeparation category of Effects.

Converting Color to Tone

Although you could work with this image to some extent at this stage of the separation, it

is still a color representation rather than a real separation of component color. You really

have to have grayscale representations of a color as tone for it to be useful as a separation.

In this segment we’ll convert the color to tone.

22. Activate the Cyan layer by clicking it in the Layers palette.

23. Link the screen layers (blue and green) to the Cyan layer by clicking and dragging

your cursor over the link boxes.

24. Merge the linked layers by pressing Command/Ctrl+E. This merges the three layers

into a single layer named Cyan. It is a color representation of the cyan component for

the image.

25. Activate the Magenta layer by clicking it in the Layers palette.
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26. Link the screen layers (blue and red) to the Magenta layer by clicking and dragging

your cursor over the link boxes.

27. Merge the linked layers by pressing Command/Ctrl+E. This merges the three layers

into a single layer named Magenta. It is a color representation of the magenta compo-

nent for the image.

28. Activate the Yellow layer by clicking it in the Layers palette.

29. Link the screen layers (red and green) to the Yellow layer by clicking and dragging

your cursor over the link boxes.

30. Merge the linked layers by pressing Command/Ctrl+E. This merges the three layers

into a single layer named Yellow. It is a color representation of the yellow component

for the image.

31. Create a new Hue/Saturation adjustment layer by choosing Layer ➔ New Adjustment

Layer ➔ Hue/Saturation. When the New Layer dialog box opens, be sure the Group

With Previous box is checked.

32. Change the Edit selection from Master to Yellows.

33. Move the Lightness slider all the way to the left (see Fig-

ure 5.34). This removes the color from the Yellow and

enhances the tonality to make tonal representation of the 

density of the yellow component.

34. Click OK to close the Hue/Saturation dialog box.

35. Shut off the view for the Yellow layer and activate the Magenta

layer by clicking it in the Layers palette.

36. Create a new Hue/Saturation adjustment layer by choosing Hue/Saturation from the

New Adjustment Layer submenu under Layers. Be sure to check Group With Previ-

ous to target the adjustment to the Magenta layer.

37. Change the Edit selection from Master to Magentas.

38. Move the Lightness slider all the way to the left. This removes the color from the

Magenta and enhances the tonality to make a tonal representation of the density of

the magenta component.

39. Click OK to close the Hue/Saturation dialog box.

40. Shut off the view for the Magenta layer and activate the Cyan layer by clicking it in the

Layers palette.

41. Create a new Hue/Saturation adjustment layer by choosing Hue/Saturation from the

New Adjustment Layer submenu under Layers. Be sure to check Group With Previ-

ous to target the adjustment to the Cyan layer.
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42. Change the Edit selection from Master to Cyans.

43. Move the Lightness slider all the way to the left. This removes the color from the Cyan

and enhances the tonality to make a tonal representation of the cyan component. See

Figure 5.35 for the result of the steps to this point.

The result of these steps has the desired effect in creating the color components as tone,

but it also removes the color so that there is no preview. The preview can be added back by

repeating the steps for CMY separation. The only difference in those steps is that instead of

choosing the color component to add the screens to, you select its grouped Hue/Saturation

adjustment layer instead. You can merge the Hue/Saturation layers back into the plates,

and you’ll end up with layers that look like Figure 5.36.

Hidden Power tools will perform all of the steps in this section (22 through 43) as well

as merging the Hue/Saturation adjustment layers and adding back the color if you double-

click the CMY Separation tool in the PowerSeparations category of Effects.

Though you have the separate CMY components, this is only part of the CMYK separa-

tion. The next part is adding black. Black is added to the CMYK separation to make up for

the fact that in the real-world process inks (and ink mediums) are not as efficient as light.

Combinations of printed CMY inks can’t absorb all the light that strikes them, so black is

added to boost potential light absorption. We’ll look at one way to define the black com-

ponent in the next section.

Handling Black Separation
CMYK separation from RGB requires separation into CMY, and then generation of ele-

ments and masks to implement black (K). Black implementation can vary depending on

preferences. We’ll look at one style, and that should give you the information you need to

make variations that you find pleasing. You have the basic CMY components, and you will

use the information from these to determine saturation and luminosity. You’ll use the sat-

uration and luminosity to determine where the black is most useful. Like the duotone use

of inks, black will be most effective in the darkest portions of the image, and usually where

there is less saturation (that is, grays).

We’ll be continuing the separation into CMYK by using the CMY separation and pre-

view you have created from the gorskii.psd image in the previous sections. You’ll have to

know how to create saturation and luminosity masks to create the black component. The

following steps give you the basics for completing the black separation:

1. Make the saturation mask.

2. Make the luminosity mask.
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The Hue/Saturation
layer for each

component should
be positioned

directly above and
grouped with the
color component.

Figure 5.36

A complete CMY
color separation

should look like this
with all the layers.
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3. Apply the Black in the separation.

4. Remove color under the black.

We’ll step through each part in the following sections.

Making the Saturation Mask

Making a saturation mask similar to the one used in the earlier saturation masking exam-

ple will enable you to target gray (and nearly gray) areas of the image. You will then be

able to substitute black in those areas. This will help make sure ink does not oversaturate

or shift color, which can cause problems in printing.

1. Duplicate the Background layer by activating it and choosing Duplicate Layer from

the Layers palette pop-up menu. Choose New as the Destination Document in the

Duplicate Layer dialog box. This opens the duplicate in a new image.

2. Split the Luminosity and Color components in the image by using the Split Luminos-

ity tool in the PowerSeparations category of Effects.

3. Turn off the visibility for the Luminosity layer and move it to the top of the layer

stack.

4. Duplicate the Composite layer.

5. Merge the Composite Copy and Color layers. This commits the color layer information.

6. Set the result to Difference mode. This shows a comparison between the image color

saturation and unsaturated areas. Lighter areas are more saturated.

7. Merge the layer result from steps 5 and 6 with the Composite. This commits the satu-

ration comparison.

8. Create a Hue/Saturation adjustment layer (Layer ➔ New Adjustment Layer ➔ Hue/Sat-

uration). Move the Saturation slider all the way to the left to set the Saturation to

–100 percent. Click OK.

9. Create a Levels adjustment layer (Layer ➔ New Adjustment Layer ➔ Levels). Set the

sliders to adjust tonality by moving the white slider to 128. This adjustment can vary

depending on the image and what you want to accomplish, as well as how you want

to control the separation. Making a stronger change will confine black generation to

areas with less color saturation.

10. Merge the Composite, Hue/Saturation, and Levels layers. This will give you your sat-

uration mask, and it should look something like Figure 5.37. It represents a mapping

of color in the image from the most saturated (lightest) area to the least saturated

(darkest) area. Rename this layer Saturation.
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Making the Luminosity Mask

A luminosity mask will help you target the darkest areas of your image, where the black

can best influence the color range. This will enable you to make the most of black’s effec-

tive range while reducing ink saturation.

11. Add a new layer above the Saturation layer. Name the new layer Black and fill it with

50 percent gray (R = 128, G = 128, B = 128).

12. Activate the Luminosity layer.

13. Make a levels correction by opening Levels (press Command/Ctrl+L) and moving the

white input slider to 128. This changes the mask so only 50 percent grays or darker

appear as gray. It is your luminosity mask and should look like Figure 5.38. Making

less of a correction will cause your black component to influence more of the image.

14. Activate the Saturation layer, change its mode to Lighten, and move it above the Black

layer. This helps reduce the black influence in dark but highly saturated areas of the

image.

15. Merge the Saturation layer with the Black layer. This commits the calculation in step 4.

The result will be your black component.

Figure 5.38

The dark portion represents the darkest half of the
image (50 percent–100 percent black).

Figure 5.37

The saturation mask shows lighter in areas where
the color is most pure (has the least gray).
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Applying the Black in the Separation

Once the black component separation is complete, you have to move the black compo-

nent back to the original image with the CMY separation and then apply the black to

adjust the other color components. Where black is used to influence the image, you

reduce the influence of other colors—again, to avoid oversaturating the areas.

16. Duplicate the Black layer completed in “Making the Luminosity Mask” back to the

original CMY separated image (use the Duplicate Layer function by activating the

Black layer and then selecting the original image as the target). The layer name should

remain Black.

17. Move the Black layer to the top of the layer stack in the original image. Change its

mode to Multiply.

The steps of the black separation covered in the preceding three sections (“Making the

Saturation Mask,” “Making the Luminosity Mask,” and “Applying the Black in the Sepa-

ration”) can be taken care of by using the CMYK Black Hidden Power tool located in the

PowerSeparations category under Effects. That tool will make the saturation mask and the

luminosity mask and apply the separation to the original image. The result will look a little

dark. The next step is the adjustment to the other color components: removing color

under the black to balance the addition of the black component.

Removing Color under Black

To keep ink use lower, to get better results on a press and in your

printer, and to balance the effect of adding the black component,

you will want to reduce the amount of color in the CMY compo-

nents where the black ink was added. This reduction can keep the

ink from oversaturating, streaking, and drying poorly in print, as

well as improving the look of the image on-screen. This procedure

continues on from the point where you added the Black layer back

to the CMY-separated image in the previous section.

18. Duplicate the Black layer and Invert it (Filters ➔ Adjustments ➔

Invert). You can name the layer Gray Color Adjustment

19. Open Levels and change the white Output slider to somewhere

between 128 and 191 levels. This change will determine how

much of the color below the black you will be taking out. The

layer will look like Figure 5.39. I used 128 for the example. The

less the change, the less color will get removed, and the greater

the final ink outlay at the printer.
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20. Select the Gray Color Adjustment layer and move it to just above the Yellow layer.

21. Change the Gray Color Adjustment layer’s mode to Screen. This reduces the gray val-

ues in the Yellow layer by the intensity/density of the black component.

22. Duplicate the Gray Color Adjustment layer and drag the copy to just above the

Magenta plate. This reduces the gray values in the Magenta layer by the intensity/den-

sity of the black component.

23. Duplicate the Gray Color Adjustment layer grouped with the Magenta plate and drag

the copy to just above the Cyan plate. This reduces the gray values in the Cyan layer by

the intensity/density of the black component. Your layers should look like Figure 5.40.

That’s it. What you have now is a complete separation that shows the cyan, magenta,

yellow, and black with color removed under the black to reduce the density of inks so

there won’t be over-inking on press. The results appear in Figure 5.41 as gray components,

and the printed result is shown in the color section. The steps in

“Removing Color under Black” can be taken care of by double-

clicking Remove Black Color in the PowerSeparations category of

Effects.

The entire process from setup through applying color removal

can be completed by using the CMYK Process Effect in the Hidden

Elements tools (under the PowerSeparations category of Effects).

You will be required to make adjustments to levels and/or curves

to complete the processing. You may see the potential here for

manually adjusting the performance of your images, in that there

are many other variations you can consider. For example, cyan

(traditionally a weaker, less efficient ink) is left stronger than yel-

low and magenta during under-color removal. The under-color

removal is also often processed using Curves. An option for using

curves is included as part of the automated CMYK Process tool

included with the Hidden Power tool set. Use either the Curves or

Using 128 for the white levels input slider position will remove 50 percent of the color under

the black ink, and 191 will remove 25 percent of the color. At 25 percent removal, your maxi-

mum ink outlay in blacks will be 325 percent (C75 + M75 + Y75 + K100), which is a little higher

than what is usually suggested for press work. At 50 percent removal, the maximum ink out-

lay is 250 percent (C50 + M50 + Y50 + K100). We are just making a flat change here, because

this can get really intricate. For example, you may choose to use Curves for creating the

adjustment, and you could adjust those curves separately for each ink.
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the Levels tool for adjustments, not both. You will

need to make separate reduction layers for each of

the colors if you want the removal to be different for

each component color. All of this will require a little

testing to get the best output. There are an infinite

number of variations.

With the separation in place, you can make

changes to the image in CMYK, just as you would

adjust an RGB image. In other words, if you feel

that there is a little too much or too little of any

color, you can reduce this imbalance by inserting a

Curve or Levels layer just above the component

layer and then making adjustments. The changes

will be previewed directly in the image as you make

them, so you can see the result on-screen.

Once you determine settings that work, you can

reuse that method over and over again to create

your custom separations. For example, if you note

your prints are all a little magenta heavy, you can

add a curve to the Magenta layer as part of your

process to reduce the magenta influence. At the

same time, you are not subject to automatic con-

versions. You have the advantage of making correc-

tions to your CMYK content that you simply can’t

control otherwise in Elements—or Photoshop.

Using CMYK Color
Once you have a viable separation, you’ll want to be able to use it, right? You can merge

the Gray Color Adjustment layers with the plates to accept the changes. This will leave you

with the components and their color preview (screening) layers. To print any of the plates,

you follow the same procedure you used for printing duotones. That is, you can flatten the

layers individually to get C, Y, M, and K components in color, and then run the sheet

through your printer four times, once for each color. Your other option is to throw out

the color screening layers and save the component layers as separate files, and provide

these to be used to output film. While these are viable options, the best option may be to

build a real CMYK file with them.
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The only problem with making a CMYK file is there is no direct way to save the file 

as CMYK, since Photoshop Elements won’t handle CMYK channels. However, using a

DCS file template, it is possible to save your custom separations for use in a PostScript

environment and create a viable CMYK file from Elements—even though there is no

CMYK mode.

Printing with DCS EPS Files
The method of creating your CMYK file may be a little bit of a horse-and-buggy approach

in our modern digital image world, but it is the only method that Photoshop Elements

seems to allow, and it does let you at least complete the process and apply the image.

What we’ll do is hijack the components of a DCS EPS file. You will take your CMYK

layers and split out the individual components, and then insinuate your content into the

DCS file. You’ll have to know a little about DCS files and what to do with the template,

but that part is relatively easy—and we’ll look at how to do it all in this section.

DCS files can come in several types, but the one we’ll be using here is a five-part file. The

file has a preview (a low-resolution image that you can use for placement in layout pro-

grams that handle PostScript information), and separate grayscale files for each of the com-

ponents (cyan, magenta, yellow, and black). The placement file is essentially a resource fork

that points to the other files. When the file is encountered by a PostScript device, it will ref-

erence the high-resolution information in the separately saved component files. As long as

you don’t change the name of the file that is being referenced, a PostScript device can be

fooled into thinking that the content in those files will be what it needs to print…and there

it can reference your cleverly substituted component separations.

All you will be doing to create the file is opening the DCS EPS template parts included

on the CD with the book, and then replacing the content:

1. Copy the CMYK template folder from the DCS folder on the CD to a new

directory/folder. The directory should have a name that describes the image. Be sure

to copy the entire folder—all five parts of the template should be retained.

2. Open an image that is color-separated into CMYK components or open an image and

create the separation by double-clicking CMYK Process in Hidden Power tools in the

PowerSeparations category in Effects.

3. Change the format of the file to Grayscale and do not flatten the layers. Be sure that

you have merged the color components with their Gray Color Adjustment layers.

4. Open the Image Size dialog box to check the size of the CMYK separated image.

Record the number of pixels. If the image is not already 300 ppi, change the ppi of the

CMYK image to 300 ppi. As you are adjusting the ppi, the content of the image
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should not change. Be sure Resample is not checked (see Fig-

ure 5.42). Close the dialog box and accept the changes if you

have adjusted the ppi.

5. Select All (Command/Ctrl+A), activate one of the component

layers, and choose Edit ➔ Copy.

6. Open the corresponding template file (for example, for the

Cyan component, open [template].C).

7. Resize the file to the size noted in step 4. Check the Resample

option. Don’t worry about image distortion of the template, as

the template information is unimportant.

8. Choose Edit ➔ Paste. The image of your plate should get pasted to a new layer.

9. Flatten the file or merge down (Command/Ctrl+E).

10. Save the file (Command/Ctrl+S). Don’t use Save As, because it may change your file

and make it invalid.

11. Close the template file.

12. Repeat steps 5 through 11 for each of the color components, selecting the appropriate

template file for each: [template].M for magenta, [template].Y for yellow, and [tem-

plate].K for black.

13. Go into the folder/directory where you saved the compo-

nents, and rename the placement file (it will have an .eps

extension) to whatever you want. Do not rename the compo-

nent files. Renaming components will cause the image to fail.

When you have completed these steps, you will have saved the

CMYK components of your image so that they can be placed in

layout programs such as QuarkXPress or Adobe InDesign. These

programs will recognize the DCS file, and will reference the high-

resolution components when it is time to print. The placement

file will look like Figure 5.43 as a preview. The preview is meant to

help with placement of the image. Be aware that the preview will

not resize automatically to the new size of your components; it

shows a set 1000-pixel square for a 300 ppi image, no matter what

you do in resizing the component files.

Be sure not to save more than one image (the five parts are one

image) to a folder or you will save over other image information.

Using separate folders for each image will keep your files from

overwriting one another. If you have a lot of DCS files to work
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The 1200×1761
dimension is what
you’ll want to note
in this image. Each
image can be
different.

Figure 5.43

The preview in the placement file is meant to help
place the image in an image box—you will not be
able to preview the image. The box for a 3×3 inch
300 ppi image (900×900 pixels) should be aligned 
to the 900 pixel hash marks. If using a 2×3 image
(600×900 pixels), it would be aligned to the 600
pixel hash in width and the 900 in height.
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with, place the separate folders for each image in a main folder (such as My CMYK Images, as

shown in Figure 5.44).

Templates are also provided on the CD for duotone, tritone, and quadtone images so

that you can use your duotone, tritone, and quadtone images

as DCS EPS files. These files use a generic name for the addi-

tional colors (that is, Spot Color 1, Spot Color 2, and Spot

Color 3). The generic colors can cause some mismatching

when processing components, but it is possible to find solu-

tions for output. Alert your printing technician to the generic

names in the spot color files before processing.

If you have digested even most of what has happened in

this chapter, you are pretty much a color guru at this point—

well beyond the scope of what most Photoshop users know.

There is almost nothing you can’t do with a color image com-

ing out of Photoshop Elements. Now we can move on to

working on the composition.
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by using filenames
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Part IV
Rebuilding Images

The previous parts of this book have roughly tackled the broad

topic of manipulating color and tone. The next area of attack is

the objects and shapes in your images. While the title of this part

may sound like we’re going to discuss image overhauls and

sweeping changes, that isn’t quite the point. The idea is to work

with what exists in an image, and improve it as possible. Exam-

ples of concrete changes will give you the tools to make all the

wild changes you want. Understanding a little about composi-

tion can give you a good idea (or at least a hint) as to how you

might improve an image by placement of the objects. Knowing

how to extract and work with objects gives you more freedom to

place them however you want to in the composition. Once

you’re able to separate color and separate objects in a scene, you

have more or less ultimate control over how an image looks.

This part looks at image objects in two sections:

Chapter 6 Altering Composition

Chapter 7 Reshaping Image Elements
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Chapter 6
Altering Composition

Before just changing parts of your images around, you need a plan. An image can become

infected with a lot of simple composition problems. If you treat the infection, the image

will improve. Composition problems come in three types:

• Problems inherent in an image

• Problems born of careless composition

• Personal vendettas

Problems inherent in the image are those that just couldn’t be fixed when taking the

image. Careless composition results when something sneaks into the frame unnoticed, or

when you haven’t paid enough attention to what is there. The “vendetta” category is full

of making certain changes you simply like or dislike; you might want to change a perfectly

good image. There’s no accounting for taste. There are guidelines to better composition,

but the rules aren’t rock-solid. Understanding composition can help you achieve better

images both with your camera and by making better corrections.

Problems in Composition (Ten Tips for Better Images)

Cropping as a Tool for Composition

Isolating Image Elements

Compositing Image Elements
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Problems in Composition (Ten Tips for Better Images)
All good images have at least one thing in common: they usually flatter and enhance the

subject. Chances are when you look at a good image, the subject stands out in a pleasing

way. Good images also always start in the camera (or in your scanner), but you do have

the opportunity to fix problems and make compositional alterations later in Photoshop

Elements. The changes you make can be simplified by the understanding of color and

masking that you’ve gained thus far, and mastered by fixing what is “broken” in the

image.

You’ve probably seen some of the most ridiculous composition faux pas in images

you shoot—regretfully this will usually happen after you’ve taken them and you are

looking at the image result. The problems in composition will almost always have to do

with placement of objects in an image, image clutter, lighting, and the perspective on

the subject.

For example, say you are at an awards ceremony where the governor comes to make an

award presentation at a local Moose lodge. You try to get a picture at the climax of the

evening, just as the award is handed off to the recipient. You’ve never stopped to look at

the background, and never considered another perspective but standing and shooting flat-

footed from wherever you happened to get placed in the seating lottery. Later when you

look at the image, you see the massive horns in the background. The mounted moose

head on the wall in the background makes the person getting the award look more like

Bullwinkle than a hero.

You could have saved the need for correction by doing a little more to anticipate the

image. Such planning ahead could have included trying to position yourself for a better

angle. By doing so, you could probably have avoided the moose head, and maybe you’d

have found a slightly more interesting angle on the subject as well.

• Look at every object in the viewfinder when framing your images, and eliminate what

you don’t need or want whenever possible.

• Take advantage of different angles that may reveal interesting perspectives on your

subject if it is appropriate, as shown in Figure 6.1.

Another common problem with composition is that it is often just boring. When you

take a portrait of friends who have come to visit from overseas, you line them up like cattle

and take pictures slightly more interesting than mug shots. And the only reason they are

slightly more interesting is that you’ve again forgotten the moose head on the wall—which

they probably don’t happen to have in the police station’s booking room.
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If you take an image with an on-camera flash of three static people standing and smil-

ing—perhaps even at the ultimate moment as they chorus the smiley phrase “cheese”—no

matter what you do, you are going to have three static people smiling flatly lit smiles. They

may be washed out in the exposure and in various stages of blinking, sneezing, scratching,

and so forth. For the next shot you could move them to the shade of a leafless tree, where

the branches cast a pattern of shadows that weave a complexity on their faces that you’ll

never remove (see Figure 6.2). It won’t matter if you change the backdrop to something

interesting—Egyptian tombs, the Eiffel tower, or a moose head—the

result will be about the same: an unflattering image of the main subject.

• Pay attention to sources of light and shadow—both artificial and nat-

ural. Use light to your advantage.

• Avoid the temptation to stagnate shots with posing and to always

shoot with the subject at the center of the frame.

• Consider taking multiple shots from one position even if you think

you got a good one; this can give you more image data to mine.

Many times composition problems—like bird droppings on a statue—

are just part of the “ambiance” of an image. Images can have clutter and

debris that is no more attractive than minor dust and dirt that you’d get

in a scan, and there is no way to anticipate or avoid it without missing the

shot. Taking an image of a play on a ball field with a $2000 lens will still

capture the garbage caught in the swirling wind behind as the play

unfolds—it just might get a better picture of it.

Figure 6.1

This chair can be
framed to fill the
entire image, or
moved to another
position in the
frame so the image
includes more of
the setting and
potential interest.
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The natural shad-
ows in this image
are complicated by
unnatural shade.
The result will be
nearly impossible 
to save without 
editing heroics.
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Zoom lenses, aperture, shutter speed…who needs that stuff? Just about any camera on

the shelf can be set to an auto mode that will correct the exposure. The catch phrase is “point

and shoot”: all you have to do is follow orders, right? The gizmo does something, and the

thingamajig does something else, and what the heck—you get a picture when it’s all done.

• No equipment will always take a better picture just because it costs more.

• Don’t depend on auto mode to know what you want. Know how to use shutter speed,

lens length, aperture, and exposure to control movement and depth of field when you

need it. See Figure 6.3.

Certain things can’t happen when you edit an image. You won’t ever take a picture of

the back of someone’s head and flip it horizontally and see their face. That may sound

ridiculous, but in a similar way select objects can’t often just be flipped right to left: you

may be somewhat frozen in orientations because of lighting, perspective, and content. A

stop sign flipped will not say POTS, it will say STOP, backward—that is, with all the letters

reversed in reverse order. In a similar way, an object captured with the light falling from

Figure 6.3

Lack of a more
extreme depth of
field effect in this

image fails to com-
pletely isolate the

subject from the
background.
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the left will look odd if flipped the other way because it will be the only object in the scene

where the light is striking from a different direction.

• Consider the image you are taking as the final product, even if you know you’ll be

editing it later.

• Be realistic in the results you expect from editing your images, and always start with

the best images you can.

• When flipping the orientation of objects, be sure that the lighting, shadows, and con-

tent all make sense.

So if you take all of these steps to make good images, why is it that you need Photoshop

Elements to fix your photos at all?

If you do advanced work with Photoshop Elements, you probably aren’t taking images

intending to spend a lot of time in front of the computer fixing them. Although there are

certain things you can do to your images in the computer that you can’t in the heat of a

flashbulb, you want to be going to the computer to enhance and flatter the images, just as

good composition flatters a subject. Unless you are doing restoration, you will generally

want to start with good images to make them even better, rather than spending a lot of

time editing bad images to make them okay.

Whether you are taking an image by looking through the camera’s viewfinder or evalu-

ating it for corrections, the same questions of composition can come to mind. Even with

your best effort on every image, there will often be compositional elements to adjust. The

trick to correcting problems is not always so much finessing the image as recognizing what

you consider a problem—then calmly stalking the problem like a hunter.

Cropping as a Tool for Composition
Cropping entails cutting away the edges of your image; you choose what to keep or eliminate

in the image while adjusting the orientation. You can crop to snip away image areas that

don’t matter or are distracting, to get the viewer’s attention back to whatever it is that you

want them to see. You can also use cropping to reorient images so the horizon is straight, or

so the composition is more interesting. Cropping is usually the first adjustment you will

make in a digital edit when it comes to composition: it reduces the image area that you have

to work on and helps focus the rest of your changes. Reshaping an image by cropping can

result in a significant change in composition and the feel of an image.

The Crop tool can be accessed by pressing C on the keyboard or by clicking its icon 

in the toolbox. To use it, all you have to do is click on the image and drag a cropping box.

Once the box is on the image, you can resize and rotate it by using the handles. Figure 6.4

shows two examples of how cropping can improve composition.
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Color and Opacity options for the Crop tool found on the Options bar (see Figure 6.5)

can help you visualize the result of your crops before you commit them. You can change

the color of the area outside the crop area to give you an idea of what the image looks like

cropped. I often use a 50 percent gray background at 90 percent opacity so I can barely see

the image area I am removing and can get a good idea of the result. Too little opacity gives

you very little idea of the final result as a preview; too much, and you can’t really see what you

are cropping out. Changing the color to white rather than the black default can help you

see what the crop will look like on white paper. You can change to other colors as a prefer-

ence or to preview how a crop will look with colored matting.

Cancel

OK
Figure 6.5

Set the color of the
cropped area to con-

trast your image, or
as a gray (or black)
so it behaves as an

image matte. Use
the Opacity to block

out any image area
that you will crop, to

give a good view of
the result.

Figure 6.4

Cropping can cor-
rect perspective,

remove unwanted
image area, and
help the viewer

focus on the image.
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You can practice cropping these examples by using the Crop1.psd and Crop2.psd files

included on the companion CD. These are simple examples of images that could use some

cropping. At times you may want to crop an image more than once: the first time to change

the orientation on the object, the next to restore the framing. Cropping outside the image

boundary (see Figure 6.6) will leave you with image areas filled with the background color.

Isolating Image Elements
Flattering the subject can mean complementing or isolating it in some way so the object is

clear in the image. Isolation is really a three-step process. First, you isolate an image area

by using selection or masking. This can be an involved process in which you use many of

the techniques that have been discussed prior to this point in the book (separations, mask-

ing, calculations, mixing, and so forth). Once your elements are selected, you can cut and

paste them to a new layer to isolate them from other image areas. With the area isolated,

you can apply effects focused on just that isolated area of the image. The digital isolation

of the image element is technical, and the image alteration that completes the visible sepa-

ration is more artistic. We’ll look at a few different solutions as we jump into an example.

The orchid.psd file (included on the CD) looks like Figure 6.7. When you first open the

image in Photoshop Elements, the background and foreground will show some difference,

but there could be more separation between this object and the background. We’ll strengthen

that separation by using a drop-shadow effect on the orchids and a blurring effect on the

background. Blurring will further obscure detail in the background, and the drop shadow will

serve to burn in (or darken) the area around whatever selection you make.

Figure 6.6

The cropping
boundary has
crossed outside of
the image frame. It
will take some con-
centrated effort to
fix the missing cor-
ners of the image.

The crop can be committed by clicking the OK button on the tool options bar or by pressing

Enter. Once the crop is accepted, you can undo it by clicking Undo, pressing Command/

Ctrl+Z, or stepping back in the Undo history.
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The three basic steps below will be expanded on over the next few sections as we go

through the exercise.

Select the Object You have a lot of options for making selections of the orchids, from

making a manual outline of them, to selecting by calculation, to making a selection with

the Hidden Power Blend Mask tool. We’ll look at more than one way to do this and 

save the selection.

Use the Selection to Isolate the Object Once the selection is made, you have the run of the

house. You can manipulate the elements separately—including color, tone, and any other

adjustment you can think of. All you have to do is get the image objects on their own lay-

ers, which we’ll do in short order by using the selection in conjunction with Copy and

Paste commands.

Make Separation Changes We’ll blur the background to reduce the detail there and then cre-

ate a drop shadow from the isolated orchids to add some separation from the background.

Figure 6.7

These unusual 
flowers can be 

made even more
distinct from the

background.
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Making a Selection of the Object (Manual)
One way to make your selection is by manually defining the selection area. There are

many ways that you can do this, including using the Lasso or Magnetic Lasso tool, or con-

verting a stencil that you make by painting on a new layer. Here we’ll use the Selection

Brush tool. The section that follows, “Making a Selection of the Object (Calculations),”

presents an alternative set of steps for accomplishing a similar selection with far less man-

ual intervention.

1. Open the orchid.psd file included on the CD if you haven’t already.

2. Choose the Selection Brush tool (press A). Set the Options for the tool as follows: 

Size = 15 Pixels, Mode = Mask, Hardness = 95 percent, Overlay Opacity = 60 percent,

Overlay Color = red (R = 255, G = 0, B = 0).

3. Change the colors on the toolbar to the default colors by pressing D on the keyboard.

4. Zoom in to 200 percent–300 percent (this will make sure you can see all the pixels in

the image).

5. Using the Selection Brush, trace the outline of the orchids (outside), staying as close

as possible to the edge of the petals and stems. If you hold down the Shift key and

click, you can create short line segments; using a series of these when navigating

around petals will work on all but the toughest curves. After outlining with a larger

brush, you can change the brush size to get into tight areas, and hold down the

Option/Alt key to erase. Complete the circuit of the selection, making an edge all the

way around the orchids. Be sure to get the areas between the flowers. The completed

outline will look something like Figure 6.8 but will be in red on your screen. You

could continue to use the Selection Brush here to fill in all the areas of the image that

you don’t want to select, but we’ll speed this up and make it more accurate by com-

bining a stenciling technique using layers.

6. When the outline is complete, choose the Magic Wand tool. The mask you have cre-

ated will turn into a selection. Invert the selection by pressing Command+Shift+I /

Ctrl+Shift+I. Set the Magic Wand to 0 Tolerance, Contiguous, and uncheck the Use

All Layers option.

7. Create a new layer (Command+Shift+N/Ctrl+Shift+N) and fill the selection with

black (Edit ➔ Fill Selection; use the Foreground Color, Normal Mode, and 100 percent

Opacity). Name the layer Orchid Selection.

The Selection Brush can be used in either Mask or Selection mode. Mask mode is used for this

example. You can switch back and forth between modes by changing the Mode while using

the tool.
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8. Deselect (Command/Ctrl+D).

9. Using the Magic Wand, click in each of the areas outside the orchids while holding

down the Shift key to add to the selection.

10. Expand the selection (Select ➔ Modify ➔ Expand) by half the diameter of the brush

used in step 5 to compensate for any softness at the edge of the area you filled previ-

ously (step 7). This should make the selection fall across the center of the outline cre-

ated in steps 5–7.

11. Fill with the foreground color. At this point you have completed the basic shape for

the selection of the flowers. Figure 6.9 shows the result.

12. Change the opacity of the layer to 0 percent or shut off the view. No kidding. This will

hide the layer whether the visibility is on or off and will essentially store the selection.

It is one of two ways we’ll use to hide selections in your images.

The black fill in the Orchid Selection layer should not cover any of the flowers, and

should have a slightly soft edge. Later we will use this content to load a selection and make

short work of the image adjustment.

Making a Selection of the Object (Calculations)
This is a second way to make the selection of the orchids—this section does not follow

from the previous one but substitutes for it. You may find a number of ways to do some-

thing similar to what is suggested here in using calculations. The idea is to take whatever

advantages you see in the image and successfully enhance them to get the result you need.

Figure 6.9

The black area of this figure shows the area that
should be filled when you have completed step 8.

Figure 6.8

The outline is made dark here for emphasis; your
outline will look red in the same shape.
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The orchids are the brightest elements in the image, and that makes them a pretty easy

target for this kind of selection. In a similar way, the darkest, most saturated, least satu-

rated, or most color-defined image areas can all provide the information you need to

make a calculated selection—depending on the separations you choose to make, the image

you are working on, and what you want to achieve.

1. Starting with the orchid.psd image, make an RGB separation by using the Split RGB

tool under the PowerSeparations category in Effects.

2. View, and then delete, the Blue component layer. You won’t need it for this calcula-

tion, because it offers very little practical distinction in the object you are trying to

separate. However, take a look at it to see why it isn’t helpful.

3. Duplicate the Green component layer and set the duplicate to Screen mode. Doing this

will take advantage of the information in the green channel and emphasize the brightness

that already exists there. Light areas will get much lighter, while dark areas remain dark.

4. Change the Red component layer to Color Burn mode. The red is more consistently

dark around the flower, and setting it to Color Burn will darken the perimeter. This

should help darken the area around the flowers to black. This will result in a pretty

good outline of the orchids in black-and-white. See Figure 6.10.

5. Merge the layers used in the calculation (Green, Green Copy, and Red), and rename

the result Orchid Selection. It is not yet a selection, but you will use this layer just 

like the Orchid Selection layer in the manual technique.

Figure 6.10

While this selection
is not perfect, it uses
existing image infor-
mation and is much
quicker than manual
selection.
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6. Get a brush and touch up the rough outline of the flowers made with the calculation.

To touch up, fill in any areas you don’t need to select by filling in those areas with

black. Use white to remove black areas to add to the selected part of the mask. The

center part of the petals will have left the most for you to clean up.

7. When you are done with the touch-up, double-click Clear Grayscale and then double-

click Commit Transparency in the PowerTools1 category of Effects in the Hidden Power

tools. This will first create the appearance of the mask and then commit the transparency.

It creates a mask based on the black-and-white content of the Orchid Selection layer. The

white areas will be transparent.

8. Change the opacity of the mask layer to 0 percent, or turn off the visibility.

This series of steps should create a layer filled with black that is nearly identical to the

manual selection made in the previous set of steps. You can use the result from either

method and continue with the process in the next section.

Using the Selection to Isolate the Object
Whether you made your selection manually or through calculations, you can now use the

Orchid Selection layer to load a selection that will enable you to manipulate elements in

the image.

1. Load the Orchid Selection layer as a selection by holding down the Command/Ctrl

button and clicking the Orchid Selection layer in the Layers palette.

2. Activate the Background layer.

3. Copy and paste. This will paste the orchids into a new layer. Change the layer name to

Orchids.

4. Load the orchid selection again by Command/Ctrl+clicking the Orchids layer.

Choose Select ➔ Invert (Shift+Command+I / Shift+Ctrl+I) to invert the selection.

5. Activate the Background layer.

6. Copy and Paste the background to create a new layer. Name the layer Orchid Back-

ground. Figure 6.11 shows a breakdown of the layers in detail and in the Layers palette.

190 ■ chapter 6: Altering Composition

Figure 6.11

The layers you have
left will be the origi-
nal Background, the
Orchid Background,

and the Orchids
neatly stacked from

the bottom up in the
Layers palette.
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Your layers should be in the exact order shown in the figure. Isolating the background

might have taken you one step further than you expected to go. However, you’ll need the

Orchid Background on its own layer. The reason for this is that the color from the orchids

would bleed into the background when you blur if the objects aren’t separate. Treating

them as separate objects keeps the reactions separate. You might try the blur on a copy of

the Background layer when we get to that point just to see the difference.

Making the Isolated Changes
Now that the image elements have been isolated into their own layers, you can edit them

individually by blurring the background and creating a manual drop shadow:

1. Activate the Orchid Background layer.

2. Apply a Gaussian Blur (Filter ➔ Blur ➔ Gaussian Blur). The radius should be broad

enough to significantly blur the background, but the setting is your choice. If you

click the Lock Transparent Pixels option for the layer before the blur, solid pixels on

the layer will remain solid.

3. Load the Orchids layer as a selection by Command/Ctrl+clicking it in the Layers

palette. Create a new layer and drag it below the Orchids layer. Name the layer Drop

Shadow. The selection will be used to create a drop shadow on the new layer.

4. Adjust the selection. You may want to both Expand and Feather the selection (find

these on the Select menu). Expanding will give you a broader base, and Feathering

will blend in the effect of the shadow at the edges. The stronger you want the effect to

be, the broader you should make both. Try Expand and Feather settings of 10 pixels.

These can be redone later by throwing out and replacing the Drop Shadow layer.

5. Fill the selection with black. Set the layer mode to Multiply to ensure that areas of the

image below the shadow darken. You can control the intensity of the effect by using

layer opacity. Figure 6.12 shows the original, the drop shadow, and the result.
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While this shows
shadowing to
enhance separation,
using white for the
shadow could add
separation between
a dark object and its
dark background.
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S E L E C T I N G  F L Y - A W A Y  H A I R ?

A common request in user forums on the Internet is the ability to quickly select a subject’s fly-

away hair. This can usually be challenging: there is no guaranteed way to make that kind of

selection, and no one-size-fits-all methodology. If the hair is photographed against a distinct

color (such as a blue or green screen), it may be a better idea to apply the advantage posed by

the background color to create a mask rather than attempting to make an absolutely nutty

selection based on the thin wisps of hair. Similar to the techniques used in “Making a Selection

of the Object (Calculations)” you might build a color range mask either using Hue/Saturation

or Blend Mask. If you target the mask correctly to the color range of the background, you can

use it to drop in whatever background replacement you wanted, or use it to create a selection

that enables you to isolate the wisps to their own layer.

Placing the drop shadow increases the local contrast around the orchids and enhances

the separation from the background. At this point, you may want to try painting in some

highlights or working with other effects and correction, but the basic purpose of isolating

these image objects has been accomplished.

Compositing Image Elements
In times of image trouble one of the greatest options to have is the availability of more

than one source image to work with. If you take several shots of the same scene, you are

really safeguarding yourself for any corrections you might have to make. For example, if

you are taking one of those artificially posed group shots (we all do it at some time or

another) and you take one shot, you may find that Bessy blinked, and Billy had a finger up

his nose. If you pause a moment and take the same shot, Billy and Bessy might be fine

while Uncle Dom is fending off a bee, and one of the twins ran off. Neither of the shots is

good by itself, but since they were taken at the same time, you can use elements from each

to create one good image. It is probably more time-efficient to go find the twin and try

one more shot, but in a pinch, you have the information you need for the completed

image. Just copy Bessy without the blink and the more flattering pose for Billy from the

second shot to fix the first.

This same philosophy works to help you fix any number of other problems. Say you go

out and shoot a great picture of a balloon race starting off in the early morning as they

float up the hillside at the peak of fall foliage. The image is perfect, except for that one ugly

balloon, or the billboard ad you can’t crop out, or the electrical wires, or a water tower... If

you wait a moment and snap another image, the balloons will have moved and you’ll have

a whole new set of autumn leaves to make any necessary patches with, or you can mix and
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match the positions of the balloons as you’d prefer. If you wait till the balloons are above

the hillside, you can take a clean shot of the hill by itself and then place the balloons wher-

ever you want. More source material in the same light, from the same angle, can be far

better than just repeating information in the image. As long as the images are good, you’ll

have more freedom to use different parts of different images to create the image you were

looking for in the first place.

This type of multi-image thinking can be turned right on its head to help you make

better shots and solve creative problems. You may set up shots that you take in parts on

purpose to get a better result.

For example, say you are taking a product shot of the teapot in Figure 6.13 to sell on a

website. There is a little more than meets the eye because there are several internal parts,

and you’d like to show them all in one image. Lighting multiple objects in a scene can get

tricky: objects in close proximity can block lighting and cast shadows over one another.

One way to rid yourself of the lighting problem is to shoot each part that you want to

include and then assemble the shots into one final image. This enables you to make the

best of each part and simplifies the process: you make one lighting setup, shoot each of the

parts so you can easily extract it from the background—perhaps even take a picture of just

the background—and then make a composite of the parts.

If you take pictures of the parts of the pot separately, all you have to do is compile them

in a single image. Simple, right? You may have to create a background, unless you take an

image to use for that separately. You can spend a lot of time with this one depending on

how meticulous you are.

Take the Image Parts I’ve already shot the image parts for you, and the files are included

on the CD in a folder called Teapot. There are five: the glass, the harness, the insert holder,

the top, and the basket.

Extract the Image Parts Isolate each image part, and copy/paste the element into a new

image that will be large enough to hold all of the objects. Use whatever method you want

to use to isolate the parts—you may even want to mix techniques. The previous section

with the orchids may provide some guidelines for accomplishing selection and isolation.

In some instances, calculations can prove to be pretty easy because the blue parts of the

pot will provide an easy target. However, the glass and basket have highlights and a lack

of color, which may be a bit more challenging. To make this a little more interesting, I

didn’t color-correct, so you might want to do that. You can match the color across the

pieces either by making an adjustment to each image according to the background, or 

by correcting the background to gray. I’m not sure how it happened, but one of these

darned objects got shot in slightly different light. See how even the best-planned images

can easily go awry?
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Figure 6.13

This teapot opens
up into several dif-

ferent pieces.
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Create the Background You can use a totally flat

background, or you can add a little interest and

make it seem more realistic with a slight gradient—

perhaps multiple gradients—and a touch of noise.

The background you create is up to you, but it

should be at least twice as wide as the widest object,

and twice as tall as the tallest, with the same ppi.

The background I used is pictured in Figure 6.14.

You’ll have to remember one additional challenge:

that glass stuff on the pot is supposed to be trans-

parent, so whatever you end up with as a back-

ground has to somehow make sense with what you

can see through the glass. You might want to take

care of that with color masking.

Arrange the Image Parts and Create Effects You can arrange the objects however you want

to within the image and then apply effects to add realism or separation. A few steps to take:

• Create drop shadows for each of the objects. Often just a simple, soft, semi-

opaque shadow outlining the base of the object will do. This helps to blend the

elements and make them interact—rather than seeming like disparate pieces of a

puzzle that were pasted into an image. You may want to create these shadows

manually by using black, a feathered brush, and a layer with the mode set to Mul-

tiply just below the object (similar to what we did with the orchids).

• Be conscious of areas where elements cross. For example, if you overlap the glass

onto the harness, part of that harness should probably show through the glass.

Your adjustments will have to reflect that.

When you are all finished, the image should look something like Figure 6.15.

Alpha Channels in Elements Images
Because making the selection to isolate the objects is the least important part of the com-

positing exercise, I left alpha channels in each image. You can use the alphas to make

selections of the objects. An alpha channel is just a means of storing a selection; it is stored

in the same way color is stored (as a component), but the alphas don’t affect image color.

When they are loaded, they re-create the selection that was stored… exactly.

One of the improvements made to Photoshop Elements in version 2 was the ability to

save, load, and delete alpha channels by choosing Save Selection, Load Selection, and

Delete Selection functions, respectively. (For those on Photoshop Elements 1, the Hidden

Power tools included a way to work with alphas.) The only problem with that is you can’t 
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This background
was made entirely
from simple gradi-
ents and should
serve as a fine place
to insert my objects.
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see alpha channels in Photoshop Elements, so you have to work a little blind. If you store a

lot of selections in any one image, there isn’t a quick way to purge them from your images.

(If you’re still on either version 1 or 2, see my website, www.hiddenelements.com, for the

appropriate Hidden Power tools.)

For version 3 of Elements, I’ve provided two Hidden Power tools to help you work

with selections: Delete Selections and Alphas, and Preview Selection. Delete Selections and

Alphas will help you purge selections from your image without having to delete them one

at a time. Removing the alphas will help keep your images trim in file size. Preview Selec-

tion will provide a brief preview of any of the saved selections you choose. You’ll need to

be able to work with alphas to save your selections, so we’ll look at doing that briefly first.

To practice loading a selection, you can use one of the sample images from the teapot

example:

1. Open one of the images from the example set for the teapot.

2. Choose Load Selection on the Select menu. When the dialog box appears, select Alpha

1 from the Selection drop-down list (it should be selected for you because it is the

only alpha).

Figure 6.15

The composite of
the parts will show a

clear rendering of
each component

without the trouble
you’d otherwise

have with shadows.
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This will load the Alpha 1 channel from the image as a selection. The subject of the

image will be selected; that’s all there is to it. The only reason this works is because the

alpha channel was saved with the image. You can use the Save Selection function for 

storing your own selections as alpha channels. All you have to do is the following:

1. Open an image.

2. Create a selection by using whatever tools you like.

3. Choose Save Selection from the Select menu.

4. Type a name for your selection/alpha channel.

5. Click OK to accept the changes and save the selection by the name you entered.

To Delete a selection, just choose Delete Selection from the Select menu. When the 

dialog box appears, choose the selection you want to delete and click OK to accept the

change.

If you have an image where you’ve saved a bunch of selections and you want to purge

them all, the Delete Selections and Alphas tool in the PowerTools2 category in Effects can

help you out. All you have to do is double-click Delete Selections and Alphas, and the Hid-

den Power tool will separate all the channels and then ask you which you want to combine

to re-create your image. If the image was RGB, choose RGB to tell Elements what type of

file it should make; then choose the color channels. In an RGB image, the RGB channels

will be separated into filename.red, filename.green, and filename.blue (where filename

stands for the name of the image before you split it; if you are splitting a file you hadn’t

saved, the filename will be Untitled with a number: Untitled-#). The image will be

reassembled from the sources you choose.

A selection is represented on-screen by the selection outline. This selection outline tells

only part of the story about what is actually selected. The outline shows only where the selec-

tion is at least 50 percent effective. If there is grayscale in your selection, or feathering, the

only way you’ll know exactly what total area will be affected is by previewing the selection.

Hidden Power tools provide a preview for any saved selection. Be sure you’ve saved the

selection you want to preview and then double-click Preview Selection in the PowerTools2

category of the Hidden Power tools on the Effects palette. This tool will prompt you to

select a saved alpha. When you have made the choice, the selection will preview automati-

cally and then fade. When the preview disappears, a message will appear telling you the

preview is complete. Do not interrupt the process.

These few tools should add powerful selection storage and selection management fea-

tures to your repertoire.
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Chapter 7
Reshaping Image Elements

There is a whole lot to pay attention to when you are looking to “fit” an object into a new

image. You must consider light, shadow, detail, perspective, tone, and color. It becomes a

balancing act as you have to make objects fit not only as part of the composition, but also

as part of the color and texture of the image. In other words, at this point you need to pull

together all that you have in your toolbox and everything you’ve learned so far.

There are simple transformations, and then there are those that radically reshape an image

element, in essence re-creating it in a form that didn’t exist before. This kind of transforma-

tion may require isolating elements based on color or tone, and then altering the shape of the

element itself. We’ll look at both reshaping and creating image elements in this chapter.

Transformations and Distortions

Shaping Image Elements with Light and Shadow

Creating Image Elements
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Transformations and Distortions
Transformations and distortions are usually looked at as a means of bending an image or

making something look, well, demented. People tend to have fun with tools such as Trans-

form or Liquify, and that is all well and good, but distortion tools can be used for repair as

well. You might want to distort things to make them look more natural, or simply better.

Images taken with a wide-angle lens may exaggerate the size of objects at the center of

the image; tall objects can sometimes show an exaggerated perspective because of the way

light comes through a lens. Sometimes you will want to enhance this effect, and at other

times you may want to minimize it. You may simply want to display some creativity and

change the appearance of an object or reshape it to make it fit where you want to see it in

an image.

Take a look at the example image in Figure 7.1. There’s nothing really wrong with this

image; however, there are some things you might want to improve or change. For example,

the window seems a bit skewed, and the wall does, too. The horizon (where the wall meets the

floor) isn’t flat. The image looks as though the picture was taken with a lens that distorted the

whole scene.

Say you are a perfectionist and just

need to have that window square. You can

use the Transform command (Image ➔

Transform) to bend and stretch the image

until the window looks right—or has the

perspective that you’d prefer. All you do is

either make a selection around what you

want to reshape and transform that selec-

tion, or have a layer active and then trans-

form the whole layer. Click and drag the

handles on the bounding box to reshape

the image. The image information inside

the box changes to fit the new shape of the

box. Pressing the Enter key or clicking 

the OK button on the options bar com-

mits the changes. Pressing the Escape key

will undo the transformation before it is

committed. The modes for Transform are

described in Table 7.1 and are demon-

strated in Figure 7.2.
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Figure 7.1

An interesting
image as is, it can

also be a good study
for perspective.
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M O D E D E S C R I P T I O N

Free Transform Enables you to rotate, scale, skew, distort, or change perspective without having to
switch tool modes via the menu. Move the cursor outside the bounding box to rotate.
Click any handle and move to scale the box; hold down the Shift key to scale propor-
tionally; hold down Option/Alt+Shift to scale proportionally on center. Hold down
Command/Ctrl+Shift to skew; hold down Command/Ctrl to distort; hold down Com-
mand+Option+Shift / Ctrl+Alt+Shift to change perspective.

Skew Enables you to reshape the bounding box by moving any handle along a current axis
(side). Hold down the Shift key to switch the tool to Perspective; hold Option/Alt to
skew opposite handles (corners or sides) on center.

Distort Enables you to reshape the bounding box by moving any point freely. Hold down the
Shift key to restrict movement to a current axis (side).

Perspective Enables you to skew or reshape the bounding box by moving handles. Moving the
center handle skews the box along any axis (side). Moving a corner handle resizes the
box in sync with the opposite corner: corners on the same axis (side) move in the
opposite direction from one another.

Figure 7.3 shows just how much of a transformation you have to make to change the

perspective of the image so that the window is square. And this change is fine—but only if

you want to ignore the rest of the image. The only area of the image that the change fixes is

the outside of the window frame, not the windowpanes—and the transformation throws

everything else in the image out of whack at the same time.

Changing perspective

The original 
selection

Rotating Scaling Skewing down Skewing right

Skewing on 
center

Skewing a 
center handle

Distorting

Figure 7.2

The Transform
options can skew,
rotate, scale, distort,
and change perspec-
tive of your selec-
tion. Note that the
cursor changes for
different actions.

Transformations that you make should often be slight. Larger changes will compromise

sharpness in a way similar to resampling.

Table 7.1

Transform Modes
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What you want to do to fix objects when using Transform is to isolate the problems.

Make selections of specific image areas or objects, move those image areas or objects to

their own layer, and then work on them in isolation from the rest of the image. In fact,

you can take the separate parts of the image and rebuild the whole image to make it look

the way you want it to. That’s what we’ll be doing with the image from Figure 7.1.

The image is available on the CD (perspectives.psd). In the following exercise you’ll

see how to use what’s in the image to separate out objects using selection, and fix the per-

spective problems. The key parts of the image are the tree, the window, and the back-

ground (sidewalk and wall). You’ll want to separate each object and move it to its own

layer, and then do adjustments as necessary.

On your way through the corrections you’ll be working with two more Hidden Power

tools: Make Guide and Clear Guides. These will enable you to place nonprinting lines

called guides on your image to help with alignment. Split RGB will be used in helping to

create a complex masking and selection. The process of adjusting this image is involved;

be sure to allot a good chunk of time at the computer when you are ready to test it out, or

save the image for the exercise in stages as you go.

The main parts of the exercise are divided as follows:

Prepare the Image There is some minor cleanup to do to the image. Note the spotting

and inconsistent color in some of the paint. You can remove the bleaching effect on the

windowpanes as well. What you decide to fix will depend on how picky you are. Once

you’ve done minor touch-ups, you’ll want to do general color correction. I’ll be leaving

all of this to your discretion as per instructions in previous chapters and won’t be includ-

ing it in the steps because it is covered elsewhere in the book. 

I hope it is enough warning to say: if you jump right into the

manipulation without prepping, you might make more work

for yourself rather than less. Failing to clean up may leave you

spreading existing problems around the image. For more

information, see “Doing Minor Cleanup First” in Chapter 3

and “Minor Cleanup for Color Images” in Chapter 4.

Re-create the Background By using the existing background

and some patching, you will create a fresh, new background to

build the rest of the image on, using information that already

exists in the image.

Add in the Sidewalk This will be a simple application of Trans-

form on whatever part of the existing sidewalk you can salvage.

Isolate, Fix, and Position the Window The window can be selected

using a variety of techniques that we’ve already discussed, from
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To transform a flat-
tened image, you

have to first convert
the background to a

layer by double-
clicking it in the

Layers palette.
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color and tonal techniques to manual selection. Another option is making a rough selection

that you can blend in later. This simpler technique is what we’ll be using. Once the window is

selected and copied to its own layer, the perspective can be adjusted with the Transform com-

mand. The transformation will require two separate adjustments: one to the whole window

to straighten the outside of the frame, and one to adjust the windowpane. Using Guides will

help keep the window in position. We’ll look at another possibility later in the chapter:

replacing the window entirely with an object made from scratch.

Isolate, Fix, and Position the Tree Adjusting the tree will require some fancy image editing

footwork. The tree will have to be selected a lot more accurately than the window because

the selection will be used to re-create the tree’s shadow. All those tiny branches can be diffi-

cult. Although the selection can be done in several ways, this solution uses a variety of tools,

including channel calculations, Levels, Threshold, Paintbrush, and Lasso in a new image.

You won’t have much to do with the tree itself. The pot will need some reshaping and

adjustment. The original image seems to have a shadow that was generated by something

off to the right of the frame, so the shadow will need to be replaced entirely.

Re-creating the Background
We’ll start by creating the background to rebuild the image on.

1. Open the image (perspectives.psd).

2. Make a large selection of the wall, including as much of it as you can, but excluding

the window, tree, sidewalk, and any shadows. This is probably easiest to do with the

Lasso tool. You are looking to encompass the largest patch of unadulterated wall that

you can find.

3. Copy and paste the selection to a new layer and name the layer Wall.

4. Activate the Background layer layer; then create a new layer and fill it with white.

Name it Canvas. You’ll be using the Canvas layer to block out the background; you’ll

need the Background layer as a source for the elements you’ll be isolating during the

process of making the changes. The canvas will also let you see how development is

progressing without constantly turning the visibility of layers on and off.

5. Use the Wall layer as a source for making patches to fill the rest of the image. This is

probably easiest to do by using layers. Duplicate the Wall source layer to create more

source material for the wall. Name the layers that you add Patch 1, Patch 2, and so

forth, so you know what you used them for. With the Canvas layer on, transform

(move, rotate, stretch, and so forth) the duplicates to patch the wall. All you really

want to do is fill any white areas that you see. Consider the following options:

• Duplicate the Wall layer. You can use the Duplicate Layer command.
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• Create feathered patches of the full layer. To create a patch, activate the Wall

layer by clicking it in the Layers palette, Command/Ctrl+click the Wall layer (

to load it as a selection), and then feather the resulting selection 10–20 pixels

(Select ➔ Feather). Copy and paste to make a new layer, and then rename it

Patch#.

• Create patches to fill specific image areas. To do this, make a selection over a

white area as a template, move the selection to a donor area that fits the selection,

and copy and paste the selection from the Background layer. Pasting will create a

new layer (that you can rename). Once the patch is created, reposition the new

Patch layer to fill the area where you defined the template selection. You can

expand the template selection (Select ➔ Expand) and feather it (Select ➔ Feather)

to help blend in your patches.

• Create patch selection shapes at random. Using a feathered selection tool, make

selection shapes, and copy and then paste these patches to create multiple, ran-

dom patch sources.

6. Once the wall is mostly patched, create a new layer above the Patch layers and make

spot corrections with the Clone Stamp tool to smooth any obvious seams, holes, or

other obvious inconsistencies. When you are finished, the result should be a solid wall

with no other objects, as in Figure 7.4.

7. Link all the Patch layers, click the Wall layer to activate it, and then merge them using

Layer ➔ Merge Linked. The resulting layer should be named Wall and will be the com-

posite of all the patches you created.

Adding in the Sidewalk
With the wall as a background, it is time to start building in other objects.

8. Turn off the visibility for the Wall and Canvas layers and then activate the Back-

ground layer.

9. Make a selection of the open part of the sidewalk by using the Polygonal Lasso tool.

Copy and paste the selection to a new layer. Name the layer Sidewalk.

10. Drag the Sidewalk layer above the Wall layer. Turn on the visibility for the Wall layer.

11. Use the Transform tool (for example, Distort) and multiple copies of the cement to

shape the Sidewalk layer as desired. The goal is to create a flat horizon, and to fill the

bottom of the image from left to right as in the original. You may want to re-create

the sidewalk with a single copy of the cement, or with patches, similar to what you did

with the wall. The result should look something like Figure 7.5.
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Isolating, Fixing, and Positioning the Window
The next step is to adjust the window’s shape to fit the new perspective of the image.

12. Turn off the visibility for the Wall layer (the sidewalk can remain).

13. Choose the Marquee selection tool (square) and make a selection around the window,

leaving a fairly generous amount of wall around the edges; then copy and paste the

window to a new layer and name the layer Window.

14. Drag the Window layer to the top of the layer stack.

15. The next two steps will help you create a guide for aligning the window. Place your cur-

sor halfway up the left side of the window and note the cursor position in pixels on the

ruler or Info palette. Turn on the ruler by pressing Command/Ctrl+R. To change the

ruler units, see Units & Rulers in the Preferences (press Command/Ctrl+K and then

Command/Ctrl+5). The vertical position on the Info palette is the X value.

16. Place a vertical guide at the position you noted in the previous step by clicking Make

Guide, a Hidden Power tool in the PowerTools2 category of Effects. Choose Vertical

Figure 7.5

The wall and sidewalk form a new background,
where you’ll place the other image elements as
you build the new image.

Figure 7.4

The new wall should have no other objects, and no
obvious rifts and/or duplications.
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for orientation of the guide, and then enter the value noted in the previous step in the

Position field.

17. Make measurements and place guides for the right, top, and bottom edges of the win-

dow by following steps 15 and 16, noting the center position for each side. Top and

bottom guides will use horizontal rather than vertical orientations, and are repre-

sented by the Y value on the Info palette.

18. When the guides are all in place, adjust the window by using Free Transform to fit the

window as closely as possible to the guides you created. See an example in Figure 7.6.

Accept the changes when you are satisfied.

19. Using a large, soft brush and the Eraser tool, erase the edge of the wall included with

your window selection to blend it in with the Wall layer.

20. The next few steps will help you reshape the window glass. Place new guides for the

right, left, top, and bottom of the window for the inside part of the frame.

21. Make a Rectangular Marquee selection somewhat larger than the window glass, about

midway between the inner and outer guides. With the selection in place, be sure the

Window layer is active and copy and paste the selection to a new layer.

22. Use Image ➔ Transform ➔ Free Transform (Command/Ctrl+T) to reshape the new

layer so that the inner frame of the window aligns with the guides you created. Your

results should look like Figure 7.7.

Figure 7.7

With the frame realigned, the unnatural effects 
of the original perspective should be all but 
eliminated.

Figure 7.6

Your transformation of the original should look
something like this. The actual change depends on
the shape of the selection you made of the window.
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Isolating, Fixing, and Positioning the Tree

23. Activate the Background layer and copy it to a new image by selecting Duplicate Layer

on the Layers palette pop-up menu. When the dialog box appears, choose New in the

Document drop-down list in the Destination panel.

24. Split the color into RGB by double-clicking the Split RGB Hidden Power tool in the

PowerSeparations category of Effects.

25. Create a new layer above the RGB layers and name it Tree Selection. Fill it with black

and drag the layer below the RGB layers (just above the Background layer).

26. Delete the Blue layer.

27. Set the Red layer to Difference mode in the Layers palette. You’ll note that the tree

becomes a bit darker than the shadow behind it. Choosing Difference is specific to the

content of this image—other images may work better using other modes (or color

separation techniques) to create masks and separation.

28. Apply a Levels correction to draw out the difference by making a Levels adjustment

layer. I used Input levels with sliders set to black: 0, midtone: 1.00, and white: 115 to

get the result shown in Figure 7.8. Once the difference between the tree and the sur-

rounding area is apparent, it can be enhanced in a number of ways.

29. Make another adjustment to turn the wall (excepting the shadow) white around the

tree. Use Threshold to measure the darkest point on the wall, by moving the slider

until just one pixel appears where there are no branches. Use the value from the

Threshold as the white slider position for a Levels correction (see Figure 7.9), and the

background will mostly vanish.

Before After

Figure 7.8

Increase the appear-
ance of separation
between the tree
and the wall by mak-
ing a straight Levels
correction to
increase the
dynamic range of
the tone.
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30. Merge the visible layers by choosing Layer ➔ Merge Visible (Shift+Command+E /

Shift+Ctrl+E).

31. With the area around the tree mostly clear, clean up the rest of the area around the

tree manually. See Figure 7.10.

32. Copy the selection made in Figure 7.10 and paste it as a new layer into the original

image. Name the new layer Tree Selection.

33. Activate the Tree Selection layer, set the Magic Wand Tolerance to 1, Anti-aliased,

and Contiguous, and then click in the white area of the selection layer. Reverse the

selection (Command+Shift+I / Ctrl+Shift+I), activate the Background, and then

copy and paste the selection. This puts the tree on its own layer. Name the layer Tree

and drag it to the top of the layer stack.

a b c

Figure 7.10

Use a paintbrush
and white to make a

clean area around
the tree and pot (a);

then use the Polygo-
nal Lasso to clear the

rest of the image by
making a selection

(b); then fill the
selected area with
white (c) after the
selection is made.

Figure 7.9

Use Threshold to
measure the darkest

point on the wall,
and use that value
as the white slider

position for a Levels
correction.
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34. Turn off the visibility of the Tree Selection layer. Don’t delete the Tree Selection layer;

you’ll need it later.

35. Touch up the tree. You may want to reshape the pot (copy it to its own layer and use

Transform), remove the shadow from

the rim on the right (use selection and

color and tone adjustments), and adjust

some of the branches. At this point the

image should look something like 

Figure 7.11.

36. Save the file and name it new_

perspectives.psd.

Everything has been replaced, but some-

thing still looks a little wrong. The missing

piece is the shadow for the tree. You’ll put

that back in, in the next section, after taking a

better look at light and shadow. Because

you’ve done quite a bit of work to this point

and don’t want to lose it (or you may need a

break), the last step suggests saving the image

as a PSD to retain all the work you’ve com-

pleted. Do that now if you haven’t. We’ll get

back to rebuilding that image in a moment.

Shaping Image Elements with Light and Shadow
Light and shadow affect the shape of objects and how they appear relative to one another.

Shading and highlighting can provide separation between objects as well, as we saw in the

orchid exercise in Chapter 6. It is light and shadow that affect depth and texture in an

image, and light that gives shape and color to everything in your images.

Making a raised button provides a good, simple example of how light and shadow can

create shape. The following steps will turn a flat gray square into a shaped button that

appears to be elevated from the background:

1. Create a new Grayscale image (File ➔ New) that is 500×500 pixels.

2. Make a marquee by using the Fixed Size option for the Marquee tool on the options

bar. Set the size to 300×300 pixels and click the tool at 100,100 (x,y). If you click

exactly on that point (use the rulers; if the rulers are set to inches, change the prefer-

ences to pixels), the selection will be centered exactly on the image. In this case it

doesn’t matter if you are off by a few pixels.
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When you’ve sepa-
rated the tree and
window, they’ll look
like this over the
Wall and Sidewalk
layers.
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3. Create a new layer named Button and fill the selection made in the previous step with

50 percent gray.

4. Select the Background layer. Create a new layer named Drop Shadow and set the

mode to Multiply. Creating the new layer just above the Background in the layer stack

will keep the drop shadow behind/below the button.

5. Feather the current selection 20 pixels and fill the selection with black. Change the

layer Opacity to 75 percent.

6. Deselect by pressing Command/Ctrl+D.

7. Offset the shadow layer down 20 pixels and right 20 pixels. To do this, choose the

Move tool, hold down the Shift key, and press the right arrow and down arrow keys

on your keyboard two times each.

8. Activate the Button layer by clicking it in the Layers palette.

9. Create a new layer and name it Highlight. Check the Group With Previous check

box, set the layer mode to Screen, and change the Opacity to 50 percent.

10. Reload the previous selection by pressing Shift+Command+D / Shift+Ctrl+D. Invert

the selection (Shift+Command+I / Shift+Ctrl+I) and fill it with white.

11. Create a new layer and name it Shadow. Check the Group With Previous check box,

set the layer mode to Multiply, fill the layer with black, and change the Opacity to 50

percent.

12. Choose Select ➔ Deselect.

13. Activate the Highlight layer, choose the Move tool, and offset the layer down 20 pixels

and right 20 pixels. To do this, hold down the Shift key and press the right arrow and

down arrow keys two times each.

14. Activate the Shadow layer and offset it up 20 pixels and left 20 pixels. To do this, hold

down the Shift key and press the left arrow and up arrow keys two times each.

This leaves you with a square button that appears to be slightly raised and is separate

from the background. Figure 7.12 shows the results: the flat square is transformed into a

shaped button with apparent contour. The drop shadow between the button and the

background creates distance between those objects; the Highlight and Shadow layers cre-

ate object shape by mimicking how a raised button might look if a light were coming from

the upper-left corner of the image. The more extreme the effects, the greater the depth or

distance appears.

Simple highlight and shadow creation of this sort happens when using layer effects. The

way you choose to handle shadows controls the shape of the object, but the final image has

to show some consistency with the scene to portray the desired result and the direction of
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the light. If you now move the Highlight up and left 40 pixels, and the Shadow down and

right 40 pixels, it inverts the highlight and shadow on the button. The button appears to

be concave—like a dish rather than raised. In this case you might also remove the shadow.

All this is to say you can create some cool effects with light and shadow, but you can’t

just drop a shadow into an image willy-nilly and have it look correct. You have to take

existing lighting into account and adjust for angle and direc-

tion. You also have to adjust the landscape to make the shadow

fall correctly.

When placing the shadow back in the image we were

rebuilding in the previous section, you’ll have to compensate

for light direction and the interplay between objects in the

scene. Depending on how you handle the shadow, you can also

adjust the distance between the pot and the wall. These consid-

erations affect realism in the result. Although Elements has

some very basic means of creating a drop shadow, knowing

how to create your own shadow enables you to have far more

control in applying a realistic one.

Making the Tree’s Shadow
Let’s look at a flat application and then a more realistic one and compare the results.

The Quick Way The quick way to make a shadow for the tree is to make minimal adjust-

ments for how the shadow might fall. It ignores all the possible nuances of light angle and

direction and just gets the job done. The results may not be optimal.

The Better Way A better way to make the shadow takes into account some distortion that

will occur because of the angle of the light and the position of objects where the shadows

fall. The result should appear more realistic.

The Quick Way to Make a Shadow
The first of two ways to create the shadow relys on techniques

for creating a custom drop shadow.

1. Open the new_perspectives.psd file saved in step 36 at the

end of the earlier section “Transformations and Distortions.”

2. Duplicate the Tree Selection layer two times. Set both of the

new layers to 50 percent Opacity and Multiply mode. Drag

both layers up below the Tree layer. The Layers palette

should look like Figure 7.13.

3. Change the name of the copied layers to Sidewalk Shadow

and Wall Shadow.
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A convex button A concave button

Figure 7.12

A flat area of color
can be both raised
from the back-
ground and shaped
with simple applica-
tion for highlights
and shadows.

Figure 7.13

Two shadows will be
used to create one
complete one.
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4. Activate the Wall Shadow layer. Use the Move tool to drag the Wall Shadow layer so

that it looks like the shadow is falling on the wall from the tree. Just look at the

shadow on the wall, ignoring the portion of the shadow that falls on the sidewalk;

we’ll clean that up later.

5. Activate the Sidewalk Shadow layer. Choose Image ➔ Transform ➔ Distort, grab the

top-center handle on the bounding box, and pull the handle left and down until the

tree trunk matches up at the base of the wall. You may have to zoom in and out of the

image (Out: Command/Ctrl+hyphen, In: Command/Ctrl+plus sign) to view the

changes and adjust the handle. The result of the adjustment will look something like

Figure 7.14.

6. Load the Sidewalk layer as a selection by Command/Ctrl+clicking the Sidewalk layer

in the Layers palette. Feather the loaded selection 1 pixel.

7. Activate the Wall Shadow layer and press the Delete key. This deletes the area of this

layer that falls over the sidewalk.

8. Invert the selection, activate the Sidewalk Shadow layer, and press the Delete key. This

deletes the area of this layer that does not fall on the sidewalk.

9. Make manual adjustments to the shadow layers by using a painting tool (with a

slightly soft brush). Using black will add shadow; using white will remove it. This

touch-up might include making the trunkmatch up at the base of the wall and/or

completing and adjusting the shadow around the base of the pot. When you are fin-

ished, the result should look something like Figure 7.15.

Figure 7.15

This isn’t bad for a few min-
utes of work, but it may not
be the most accurate shadow
you can make.

Figure 7.14

With both shadows visible, get the trunk of the tree to meet
at the juncture of the sidewalk and wall.
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The Better Way to Make a Shadow
A problem with the quick way that you might have noticed is that the shadow looks nothing at

all like the original shadow. There is no angle to the way the shadow falls on the wall, and the

shadow on the sidewalk represents a front view of the pot. In either case it is not very accurate.

The sad fact is that it is impossible to render an accurate drop shadow by using a single

image. The shadow that you see is accurate only from the perspective of the light source.

In other words, you have to take another image from the position of the light source or

shoot from the position of the shadow toward the light source to have a representation of

your object that matches what the shadow looks like. We don’t have that luxury here,

because we don’t have an image shot from those angles, and considering the proximity of

the tree to the wall and the angle of the sun, we may not have been able to anyway.

The next best thing we can do is to be a little more creative with what we do have to

work with in the image. Natural shadows will distort somewhat because of angles—how

the light strikes the object and how the shadow then drapes on the wall. You can use dis-

tortions and transformations to your advantage in re-creating a more realistic shadow

than the “Quick Way” method. Here are the steps:

1. Jump back in the Undo History palette to where you opened the

new_perspectives.psd image, or open the image again if you have closed it.

2. Make a selection of the Sidewalk layer and invert it.

3. Create a new layer named Wall Shadows below the Tree layer. Set the Opacity to 50

percent and the layer mode to Multiply.

4. Fill the Wall Shadows layer with white. Every shadow component you create in this

exercise for the wall will be grouped with this layer. All of these component layers will

be set to Darken and 100 percent Opacity.

5. Duplicate the Tree Selection layer and arrange it in the Layers palette so that it is

above and grouped with the Wall Shadows layer created in step 3.

6. Move the shadow into position, where you would like to see the top of the shadow fall.

7. Create a new layer and name it Light Angle. Set the Opacity to 60 percent and the

mode to Multiply.

8. Draw a straight line between the top of the tree and the top of the shadow. To do this,

choose any painting tool, and a hard brush with a diameter of 5–10 pixels. Click on

the tree. Then hold the Shift key and click the exact same spot in the shadow that cor-

responds to the spot you clicked on the tree.

9. Transform the layer by choosing the Transform function and scale it to five times its

size (500 percent) by using the numbers on the options bar. This will make the line

you drew thicker, longer, and more useful as a guide. At this point, the image and the

layers should look like they do in Figure 7.16.
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10. Choose the Lasso tool and make a selection of the top segment of the tree’s shadow.

This can be a rough selection. Copy and paste to create a new layer in the grouping with

the Wall Shadow layer. Set the layer mode to Darken and the Opacity to 100 percent.

11. Choose Image ➔ Transform ➔ Free Transform.

Change the Skew to match the Light Angle layer

by pressing Command+Option+Shift /

Ctrl+Alt+Shift and moving one of the side han-

dles on the bounding box.

12. Release the Skew On Center modifier keys and

press Shift; then stretch the box by moving the

top center handle and bottom center handle

until the box is 150 percent–200 percent of the

original size (watch the percentage in the H field

on the options bar, and it will show you the

result). The Transform box should look some-

thing like Figure 7.17 as a result of the changes 

in steps 11 and 12.

13. Accept the changes when the distortion seems acceptable and interesting.

14. Repeat steps 11 through 13, selecting segments of the tree from the top down. I used

nine distinct sections of the tree shadow. When you are finished, the result should

look something like Figure 7.18.

15. Duplicate the Tree Selection layer, name it Pot Top, and move it above the Tree layer.

Reduce the Opacity to 50 percent and use the Eraser tool to trim away everything but

the rim of the pot (as shown in Figure 7.19).

16. Duplicate the Pot Top layer and place the copy in the layer group with the Wall Shadow

layer; then follow steps 11 to 13 again to create the shadow that the pot top might cast.

17. Load the Sidewalk layer as a selection again by pressing Command/Ctrl and clicking

the Sidewalk layer in the Layers palette.

Figure 7.17

Skew using the
angled line as a
guide, and then

stretch the result.
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18. Create a new, ungroupedlayer named Sidewalk Shadow and fill it with white in the

selected area. Set the Opacity to 50 percent and the layer mode to Multiply. This layer

should be created above the Sidewalk layer and should not be grouped.

19. Move the copy of the Pot Top layer above the Sidewalk Shadow layer and group

them.

20. Stretch and position the pot top as desired. Be sure the edge of the shadow in this

layer aligns with the pot top shadow where it appears to come off the wall.

21. Shape and fill in shadows for the pot by painting on the Sidewalk Shadow layer man-

ually with black. The results should look something like Figure 7.20.

A comparison in the color section of the book shows the original image, the quick way

of making a shadow, and the better way. The idea is that creating drop shadows is not nec-

essarily as simple as choosing a layer effect. Realistic work often requires custom attention,

which means being able to apply custom shadows and highlights. With a little creative

adjustment, it is possible to produce more realistic fixes.

With everything separate, you also have more freedom to explore different composi-

tion options. Figure 7.21 looks at two other quick ways to rearrange the objects in your

image. Similar techniques can be used in other images to separate objects from their back-

grounds, re-create or fill in background areas, and adjust the composition.

Figure 7.20

The completed shadow should look
fairly natural, and perhaps a whole
lot neater than the original.

Figure 7.19

The dark area is the shape you
want; use the Eraser to trim away
everything else.

Figure 7.18

This shows more of a cascade of
shadow and better imitates what
the sun might produce as the
shadow falls on the wall.
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Creating Image Elements
At the far end of working with images is the option of creating absolutely new elements.

Consider how complex the shadow for the tree was, and then multiply that complexity by

all you’ve learned about color and tone. That’s not a very concrete equation, but it is rele-

vant in that creating something new requires creativity—and a few basic bits of under-

standing.

In the previous section, we looked briefly at how highlights and shadows could 

shape an image. In a similar way, highlights and shadows can help you make far more

complex adjustments, such as creating the appearance of texture. They can give shape to

an environment.

Making new elements doesn’t mean you’ll usually create an image from scratch. More

often, you’ll have something specific in your image that you want to replace. Or perhaps

you’ll need to patch what is in your image but won’t have sufficient sampling area to cre-

ate a patch, or you’ll be feeling a little creative and want to add an element to an image. It

is much more rare that you’ll absolutely create an image from scratch, unless you are

doing an original illustration. We’ll take a look at illustration in Chapter 9.

Figure 7.21

Being able to sepa-
rate elements can
give you ultimate

freedom over image
composition.
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In this section, we’ll take a look at some of the nuts and bolts of what you’ll need to cre-

ate image elements, and leave some of the rest to your creativity. You’ll need to know how

to work with patterns and texture, and how to create shapes by using tone. We’ll bring

together lots of techniques used throughout the book to create the result.

Creating Texture and Patterns
Say you have an image with a background wall painted a sort of pastel pink color, a weird

window, and a funky-looking tree that was casting an awful shadow. You take a look at the

image and decide you want to replace the wall rather than try to patch it together. Silly

example, right?

Although it would be easy enough to fill in color, the texture of the wall would proba-

bly be the most difficult image elements to deal with. We’ll look at two solutions. One is a

better solution for this example, but it is important to know how to do both. First we’ll

work with a little bit of what we do have to create a seamless pattern; then we’ll create tex-

ture by generating it completely from scratch.

Creating Seamless Patterns

A seamless pattern can be used to fill an image area of any size. Usually this type of pattern

is something that you want to replicate and repeat, rather than something you want to

seem random. For example, a wallpaper pattern, plaid, or bricks might be a fine pattern to

repeat (see Figure 7.22). Taking bricks as an example, all you’d have to do is create or copy

a small portion of the brick pattern, be sure it can be repeated without obvious seams, and

then use that pattern to fill an area.

With a little touch-up, you could remove any repeating patterns by changing the color

or tone of a few bricks. Just make a rough selection of four or five at random, and then

create a new layer and fill it with white or black. Set the layer mode to Screen (white) or

Multiply (black) and lower the opacity (see Figure 7.23). Depending on how you use and

manipulate other patterns, you can make them seem random as well, or use them as a

basis for creating less obviously contrived objects.

Sample area Sample used as a pattern

Figure 7.22

Using a sample as a
pattern is much eas-
ier than creating a
whole wall brick by
brick.
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To create a seamless pattern you need only a small swatch of an image area that you’d like

to replicate. All you do is offset that swatch (using the Offset filter), and then patch whatever

seam there is. We’ll use the old wall from the tree and window picture as an example.

1. Open perspectives.psd. Make a rectangular selection of a representative area of the

wall that is clear of shadows or distinct characteristics that would show in a pattern,

such as the area shown selected in Figure 7.24.

2. Copy the selection to a new image: choose Edit ➔ Copy, and then create a new image

(File ➔ New) and choose Edit ➔ Paste. After you create the new image, Elements auto-

matically sizes it to the area that you copied.

3. Flatten the image (Layer ➔ Flatten Image).

4. Adjust the sample in the new image by removing notable characteristics that might be

pronounced in a repeated pattern. For example, if there were a nail protruding from

the wall or a distinct marking of some sort, you would remove it. This should help

reduce obvious pattern repetition.

5. Now to make sure the pattern is seamless. Check the image height and width by using 

the Image Size palette, and remember those numbers. Choose Filter ➔ Other ➔ Offset (Fig-

ure 7.25). The offset amount you specify should be about half the height and width of the

image. Be sure that the Wrap Around option is selected in the Offset dialog box before

accepting the changes. This adjustment moves any seams from the image into view.

Figure 7.24

The selected area of the image has
very few characteristics that would
be a problem in a pattern.

Figure 7.23

By randomly selecting a few bricks and changing the tone by a
few levels, the pattern can appear to be random.
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6. Blend the seams of the image. You will probably want to use the Clone Stamp tool

and a soft brush. The goal is not to wipe out all the characteristics of the wall, but to

smooth out the transitions so that the seams are not apparent. You may need to

repeat the offset and seam blending a second time to be sure the sample is seamless.

7. Create a pattern by choosing Edit ➔ Define Pattern. Call the pattern Pink Wall.

Once you have completed these steps, you will have stored the portion of the wall as a

seamless pattern. Go back to the original image, deselect the sample area, and apply the

pattern by creating a new layer and using the Fill function. Choose Edit ➔ Fill, and in the

Fill dialog box, choose Pattern from the Contents drop-down list. Choose Pink Wall from

the Custom Pattern drop-down list. (See Figure 7.26.)

The pattern will fill the whole layer. It will look much like the wall, but it will be…a

pattern. And you can pretty much see that it is (see Figure 7.27). It’s a good start, but you

can do better. Because the wall seems more like cement or stucco that should have more of

a random nature, you will have to do a bit more work to get this to look right.

Creating Texture from Scratch

The limitation of making seamless patterns is obvi-

ously that the patterns represent only a small area of

what you are trying to depict. Because of that, filling

with a pattern can often look like a pattern. It isn’t

really a surprise. It might work if you are imitating a

brick wall, but something less defined or random,

such as the surface of concrete or stucco, would

seem to repeat when you really don’t want it to.

a b

Figure 7.25

Offsetting shifts
what would be the
seam of the pattern
into the center of
the image (a). You
can then clean up
the transitions to
make it seamless (b).
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When the pattern
was saved, it was
stored in the pattern
library. It can be
selected wherever
patterns are avail-
able and stays
stored until deleted.
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This is where you can be creative with layer and filter application to make the filled

background look unique—not at all like a pattern—or create the background entirely

from scratch. In fact, every time you make the application, you can get a different (yet

similar) result, if you use filters that help generate random image information. Once you

have generated the information, you can apply highlights and shadows to make the area

seem textured. You can use the texture to either enhance the existing texture created by

the filters you applied, or create new texture where there was none.

Working with filters is almost always a process of experimentation, unless you use a fil-

ter that has a specific behavior. You rarely can just reach into the pile of filters and pull out

one that will do exactly what you want without making adjustments—or without using fil-

ters in combination. Filters are usually best used to enhance an image rather than change

it, which is why it may often be wisest to use what exists in your image and adjust it.

Take a sample of the existing pink color of the wall. Then create layers pictured in Fig-

ure 7.28 and described in the following list, marked A through E.

A. A gradient, black to white (using the Gradient tool, draw a line from the upper-right

corner to the lower-left corner)

B. A Clouds filter application (Filter ➔ Render ➔ Clouds) on a 50 percent gray layer

Figure 7.27

You might get away
with this, but the

repetition in the pat-
tern is obvious and

can detract from the
image.

220 ■ chapter 7: Reshaping Image Elements

4385c07.qxd  11/7/04  11:41 PM  Page 220



C. A Difference Clouds filter application (Filter ➔ Render ➔ Difference Clouds) on a

duplicate of the Clouds filter layer, adjusted by choosing Equalize (Image ➔ Adjust-

ments ➔ Equalize)

D. A Note Paper filter application (Filter ➔ Sketch ➔ Note Paper) on a duplicate of the

Difference Clouds layer

E. An Emboss filter application (Filter ➔ Stylize ➔ Emboss) on a duplicate of the Note

Paper filtered layer

While this may look like a hodgepodge, the results are not entirely an accident. The

simple gradient can be used to darken the image slightly in the upper right. Next a series

of filter changes is made in steps—each step based on the previous one—to try to unify

the effects of the layers to be applied.

The trick to applying these layer results effectively is to give them each very little influ-

ence in the image. They are going to enhance, not take over, what is already there. The lay-

ers were applied to the background of the image by simply stacking them above it using

the following settings:

Layer Mode Opacity

A Luminosity 10%

B Luminosity 5%

C Color 3%

D Normal 0%

E Luminosity 5%

If you look at the layer settings, these changes affect the luminosity much more than

the color—and not all that much. The idea is to randomize some information and use it to

influence the tone to create texture. Influence is not an overhaul. The goal here is to create

two things: general shading, and larger, unpredictable changes in tone and color to affect

the apparent flatness of the wall.

I chose several of the filters for specific reasons. The Clouds filters introduce random-

ized behaviors. Emboss creates highlight and shadow depth based on existing image con-

tent that change the randomized tone areas into shapes. The highlighting and shadow

a b c d e

Figure 7.28

The grayscale ver-
sions of these filter
applications look
too extreme to 
help this image, 
but they will.
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created by the Emboss filter acts much like the highlights and shadows in the raised button

example earlier in this chapter.

You would probably think I was joking if I were to say it almost doesn’t matter what fil-

ters you run in between generating the random information and converting that to texture

by adding the highlights and shadows. You could spend hours exploring different combi-

nations and results. Part of the fun of filters is guessing which filter might give you an inter-

esting result. The effect of the Difference Clouds filter is to apply the Clouds filter as if to a

layer above and grouped to the current layer, set to Difference mode. This filter kept my

original clouds information and added some random color behaviors. Note Paper makes a

threshold-based gray and white texture effect that is often good for chipped paint, rust, and

similar effects. Here it is used as a source to create a patchy look to the cement/stucco.

The effect of the different layers is subtle, but a whole new wall was created by mixing

the results. If you open up the image on the CD (wallpattern.psd) and zoom in, it looks

pretty real. In a sense, the wall is: you retain some of the real part of the image and texture

by basing the color and texture of the wall on the pattern sample, and then enhance the

sample. Neither the real portion of the image (the seamless pattern) or the filter applica-

tions do it all on their own.

If you’re feeling adventurous, you might want to make a break from reality entirely and

create the whole wall from scratch. The only element you are missing is the sort of granu-

lar cement texture. Instead of creating big random information, you’ll want to create

flecks and then shape those by embossing. The Noise filter can provide the source for

those flecks by creating some random noise. Try the following on the wallpattern.psd:

1. Turn off the visibility for the added layers (A through E).

2. Duplicate the Wall Pink Pattern fill layer to a new image.

3. Resize the new image by using Bilinear resampling to 10×10 pixels (deselect Constrain

Proportions). This gives you an average tone and color for the wall.

4. Make a sample of the color by using the Eyedropper and then close the image. That’s

all you wanted the new image for—to get the color sample.

5. Create a new layer above the Wall Pink Pattern fill layer and fill it with the foreground

that you sampled. Call it Wall Pink.

6. Duplicate the Wall Pink layer and name the new layer Cement Texture.

7. Remove the color by using Remove Color (Command+Shift+U / Ctrl+Shift+U).

Then apply Noise (Filter ➔ Noise ➔ Add Noise; 10 percent, Gaussian, Monochrome).

8. Apply Threshold (Image ➔ Adjustments ➔ Threshold) to limit the noise. I didn’t change

the slider from the default (128). Changing the slider will influence the density of

bumps in the cement.
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9. Apply Emboss (Filter ➔ Stylize ➔ Emboss). I chose a 1-pixel radius, Amount 75 per-

cent, and Angle 45 degrees (about the angle of the original light source). When using

Emboss, you generally should use a radius that fits with the detail you are trying to

enhance: small details, small radius.

10. Apply Gaussian Blur (Filter ➔ Blur ➔ Gaussian Blur) to soften the embossing. Choose a

smaller than 1-pixel radius, again to retain the smaller details. At this point you’ll

have a somewhat bumpy-looking gray layer. You may want to zoom in to 100% or

more to have a good look.

11. Change the Opacity to about 15 percent and the mode to Luminosity, and look what

happens. The Pink Wall layer becomes textured with little bumps.

Add back the Clouds, Difference Clouds, and Emboss layers by turning the visibility for

those layers back on. If you compare the original to the result that you have created

entirely from filters, you’ll see that the texture is not the same but has a similar feel. To

make that comparison, drag the Wall Pink Pattern fill layer to the top of the layer stack

and toggle the visibility on and off.

You can make further improvements by adjusting the intensity of the bumps in the

Cement Texture layer so that they appear more random. Do this by adding a mask to 

the Cement Texture layer as in the following steps.

12. Duplicate the Wall Pink layer to a new image and flatten the image.

13. Run the Clouds filter.

14. Double-click the Blend Mask Hidden Power tool in the PowerTools1 category of

Effects. When you get to the Curves dialog box, set the curve as shown in Figure 7.29.

15. Duplicate the Mask layer back to the original image.

16. Duplicate the Cement Texture layer. You can leave the name as Cement Texture Copy.

17. Drag the Mask layer below the Cement Texture Copy layer and group the layers. To

group, you can link the two layers by clicking the link box on the Layers palette for

the Cement Texture Copy layer, and then press Command/Ctrl+G.

18. Change the Cement Texture Copy layer to Normal mode and 100

percent Opacity. This enables the texture to influence the mask at

100 percent.

19. Change the Mask layer to 20 percent Opacity and Luminosity mode.

You want to use the mask to apply the effect. Here again you are

influencing the result, not trying to overpower it. This adds 20 per-

cent more intense bumps over 50 percent of the image. Experiment

with the settings by adjusting the Mask layer Opacity only.
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This setting will
make sure the 
cloud layer has no
tone brighter than
50 percent gray 
(128 levels).
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This series of steps (12–19) masks the texture with some randomized behavior, again

using the Clouds filter. As a result, some of the texture is softer and some more pro-

nounced: the filters acting together create a more randomized effect.

You can do still more with this, but you can also play with filters forever, refining and

adjusting. Combinations of filters enable you to create innumerable textures that can be

helpful in patching missing image areas or creating entirely new objects.

Making an Object
Creating an object from scratch is the extreme test of everything we’ve been through thus

far. You would have to make the basic shape of the object using tone and color, and then

give it depth and fit it into an image. The exercise is tricky and challenging, with varying

levels of difficulty. If you created those little cement bumps in the last part of the preced-

ing section, then you created a simple, photo-realistic element. There should be nothing to

stop you from going further.

Say you took a look at that picture of the tree and window and decided that the window

was the wrong one for your wall. You wanted something a little cuter…a double-hung win-

dow, and maybe some blue curtains rather than that black empty space. You could take a

picture of another window and manipulate it so it fits in the space in the image. This might

require hours, hunting down something similar to what you were looking for, so that you

could take a picture of it. Or you could make a window from scratch.

It may sound easy to make a window. It’s just a rectangle, maybe with a few little criss-

crossed doodads (muntins, they’re called). To some extent, it is simple. But to do it you

will have to use just about every darned process you’ve gone through thus far in the book,

and learn a few more little tricks.

Making the window will require a couple of Hidden Power tools and a lot of small

adjustments, from shaping the molded look of the muntins to dropping the muntin shad-

ows on the wavy curtains. We’ll look at those changes in detail here, using a lot of images

to keep you in step. There are a lot of steps to this exercise—so allow yourself plenty of

time to complete it. Be patient and save in intervals so you can retrace steps if they seem to

go wrong. We’ll take the project on in four parts:

Make the Window Creating the box shape for the window sash is just the beginning.

We’ll add detail to the woodwork of the sash and muntins, using curves to alter gradi-

ents. When the first sash is done, it can be duplicated to save some work and then shaded

to create depth.

Make the Curtain Curves can be employed again to create wavy curtain pleats; then employ-

ing a little transformation can make the way they fall seem unique. After the curtain is cre-

ated and colored, it will be placed behind the window.
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Make Shadows for the Window and Curtain Once the curtain is where it belongs, the image

will look a little flat. Adding a shadow from the window falling on the curtain will give it

some depth. The angle of the shadow will have to approximate the source in the destina-

tion image. The real kick is trying to weave that shadow in and out of the pleats. We’ll do

that by using an application of the Displacement filter.

Place and Fit the Window with the Wall With the double-hung window complete, it will

have to be fit into place where the current window is. This will require more transforma-

tion, some feathering, and the incorporation of still more shadows.

Making the Window

1. Open a new RGB image at 10×10 pixels with a white background. The resolution

doesn’t matter, so 72 ppi will work fine.

2. Press D to restore the default color for foreground and background, and then press X

to switch black to the background.

3. Change the canvas size to 12×12 pixels (Image ➔ Resize ➔ Canvas Size). This creates a

black frame around the image.

4. Resize the image to 400×400 pixels (Image ➔ Resize ➔ Image Size) by using Bilinear

resampling. This increases the size of the image and adds an evenly stepped gradient

to the edge of the frame.

5. Open a Curves dialog box by double-clicking the Curves Hidden Power tool in the

PowerTools1 category of Effects. Shape the tone of the gradient area by adjusting the

curve as shown in Figure 7.30. Choose Layer ➔ Merge Down (Command/Ctrl+E).

6. Copy/paste or duplicate the Background layer and name it Frame.

Figure 7.30

The frame is going
to give you a rough
look at the final
bevel. We’ll reshape
this in the coming
steps to sharpen the
corners.
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7. Turn off visibility for the Background layer, and then clear the center of the image

(click the center with the Magic Wand tool and press the Delete key).

8. Deselect (press Command/CTRL+D), then make a selection of a segment on one of

the sides of the frame by using the Polygonal Lasso. Miter one of the ends to a 45-

degree angle (hold the Shift key while making the angle).

9. Copy and paste the segment to a new layer and name the new layer Miter.

10. Turn off the visibility for the Frame layer.

11. Using the Move tool, position the segment in the Miter layer so that the point of the

shape falls exactly in the upper-right corner.

12. Duplicate the Miter layer. Rotate the duplicate layer (not the canvas) 180 degrees, use

the Move tool to position the new segment in the lower-left corner, and use Merge

Down. The result should look like Figure 7.31.

13. Duplicate the Miter layer, rotate the duplicate 90 degrees in either direction, and use

Merge Down.

14. Duplicate the Miter layer, Flip Horizontal, Merge Down. At this point, you see just

the corners of the frame. Turn on the visibility for the Frame layer to see the whole

frame.

15. Make a new layer, check the Group With Previous box, and fill the layer with yellow

(R = 255, G = 255, B = 0).

16. Make a new layer (not grouped) and then make a selection of the black part of the

frame (use the Magic Wand with Use All Layers and Contiguous checked). Expand the

selection by 2 or 3 pixels, and fill the selection with yellow. Name the layer Sash Frame.

17. Duplicate the Sash Frame layer three times and call the layers Drop Shadow, Bevel 1,

and Bevel 2, bottom to top in the layer stack.

Figure 7.31

The identical seg-
ments should be 180

degrees different
and in opposite cor-

ners, tucked neatly
so the point is right

in the corner.
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We’ll need to add some effects to the frame to give it some shape. For more control you

can create the effects manually, but we’ll do it using Layer Styles. There are not a lot of

controls for Layer Styles, so we’ll use them a little creatively by using layer modes and

opacity to mix the effects.

You’ll need to change some effect settings after applying the Layer Styles. To open the

Styles Settings dialog box, you have to apply the Layer Style and then double-click the

layer styles indicator in the Layers palette. Steps 18 to 20 demonstrate some of what

you might do in applying styles.

18. Add a Soft Edge drop shadow to the Drop Shadow layer by using Layer

Styles. To apply the style, open the Styles and Effects palette, choose

Layer Styles in the drop-down box on the upper left; then choose Drop

Shadows in the categories. Click the Soft Edge thumbnail. When the

style is applied, the effects indicator appears on the target layer in

the layers palette dialog; double-click the indicator to open the Style

Settings dialog. Be sure the Global Angle check box is checked, and adjust the style to

a 45-degree angle and 5 pixels. Adjust the strength of the effect by changing the Opac-

ity of the layer. I used 30 percent.

19. Add a Simple Inner Bevel to the Bevel 1 layer. Bevels will be found by selecting the

Bevels category for Layer Styles. Once the style is applied, open the Style Settings dia-

log by double-clicking the effects indicator for the layer in the Layers palette. Reduce

the Bevel Size to 2 or 3 pixels by using the Style Settings dialog box (see Figure 7.32).

Select the Use Global Light check box on the Style Settings dialog box, and then

change the layer Opacity to 30 percent on the Layers palette to reduce the intensity 

of the effect.

20. Add a Simple Inner Bevel to the Bevel 2 layer by

using Layer Styles. Reduce the Bevel Size to 2 or 3

pixels, uncheck the Use Global Light check box,

change the Angle to 135 degrees, group the layer

with Bevel 1, and change the mode to Darken. This

puts the bevel edge all around the frame. At this

point the result should look like Figure 7.33 in the

image and in the Layers palette.

There are a lot of other adjustments you can make if

you’d like, such as add effects to the frame to give it tex-

ture. We will not be concentrating on those details here,

but feel free to add them in. The next series of steps

moves on to creating the muntins.

creating image elements ■ 227

Figure 7.32

Limited controls in
styles leave most
manipulations to
layer properties.

Figure 7.33

By unchecking the
Use Global Light
check box, the user
can choose a new
angle. Using an
angle that is 180
degrees different
completes a 360-
degree effect.
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21. Make a selection down the center of the image, create a new layer, and fill it with

black. Duplicate the layer.

22. Rotate the duplicate layer 90 degrees and then Merge Down. You’ll end up with a

cross over the image. Name the layer Muntin Source.

23. Duplicate the Muntin Source layer and then blur the new layer (I used 3 pixels).

24. Create a new layer below the Muntin Source Copy layer and name it Muntins. Fill it

with white and merge the layers.

25. Use Curves to shape the beveling on the Muntins layer. I used the curve shown in Fig-

ure 7.34. Merge the curve with the Muntins layer when you have it as you want it.

26. Load the Muntin Source layer as a selection by Command/Ctrl+clicking it in the Lay-

ers palette; then expand the selection by 3 to 5 pixels. Invert the selection, activate the

Muntins layer, and press Delete to trim the muntins. When you are finished, delete

the Muntin Source layer.

27. Create a new Hue/Saturation adjustment layer and group it above the Muntins layer.

Check the Colorize check box and make adjustments to Hue and Saturation sliders to

match the color of the bevel on the frame.

28. Place guides at 200 px horizontally and 200 px vertically by using the Make Guide

Hidden Power tool in the PowerTools2 category of Effects (you will have to switch

the selector in the Styles and Effects palette from Layer Styles to Effects).

29. Choose the Rectangular Marquee and make a square selection from the exact center

of the image (use the rulers to locate the exact center; hold down Shift+Option+Alt

when dragging the cursor to make a square). Then select Transform and rotate 45

degrees by using the options bar. Figure 7.35

shows the selection and the rotation.

30. Hold down the Shift key and use the key-

board arrows to move the selection about 80

pixels to the left (press the left arrow key

eight times).

31. Activate the Muntins layer, and then copy

and paste three times. You’ll use these seg-

ments to fix the bevel where the muntins

cross.
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Figure 7.34

You can create far
more subtle effects

with a little patience
and a few more

curve points.
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32. Activate the bottom copy layer, rotate it 90 degrees, and center the segment in the

image by using the guides and the Move tool (press V). This segment should align

perfectly with the vertical muntin and should overlay the intersection.

33. Use the other two copies to adjust the bevel to the right and left of the vertical. The

bevel may not look exact, but a little imperfection might look more realistic.

34. Remove the guides by using the Clear Guides Hidden Power tool in the PowerTools2

category of Effects.

35. Merge the Muntins, Muntins Copy,

and Hue/Saturation layers. To do

this, link the layers, activate the

Muntins layer, and press Com-

mand/Ctrl+E.

36. Select the Eraser tool and use a hard,

round brush to miter the muntins to

the frame. See Figure 7.36.

37. Activate the Sash Frame layer and

then choose Merge Visible.

You now have a complete sash. You

could run through those steps a second

Figure 7.35

When making this
change, the Hue/
Saturation layer
should be activated.
It will keep you from
making unexpected
changes in any of
the image layers.
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Figure 7.36

A round brush at the
right size for the
Eraser tool can cre-
ate a miter that fol-
lows the curve of the
frame quickly and
convincingly.
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time to create a second sash, but duplicating the

sash you have already created will be easier. In the

following steps you will duplicate it in a new layer

above the other sash in the layer stack. The upper

portion of a double-hung window runs on the

outside, and such a detail is important to remem-

ber in imitating real objects.

38. Change the height of the canvas from 400 to

800, anchoring the bottom of the image by

clicking the appropriate anchor box, as

shown in Figure 7.37.

39. Duplicate the Sash Frame layer and name the

new layer Upper Sash. Change the name of

the Sash Frame layer to Lower Sash.

40. Choose the Move tool, hold the Shift key,

click in the image, and slide the upper sash

into place. It should snap to the image frame.

If not, turn on the Snap To Grid feature

(View ➔ Snap To Grid; it should be checked

in the menu).

41. Duplicate the Upper Sash layer and group the

duplicate layer above the LowerSash.

42. Create a Soft Edge drop shadow for the

Upper Sash Copy layer, using layer styles at

90 degrees and 20 pixels. Change the layer

Opacity to lighten the effect.

43. Trim the image down to just the window 

(use the Marquee tool to select the whole

window, and then choose Crop from the

Image menu). Your result should look like

Figure 7.38.

Although you might want to do more at this

point, you can consider yourself finished with the

window framing. If nothing else, this procedure

may have given you a better appreciation for
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Figure 7.37

Anchor the canvas at the bottom.

Figure 7.38

The complete double-hung window as
seen from the outside of the house.
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carpentry. You can still make a number of adjustments to this image, but the techniques

you have seen here should give you a pretty good idea of how to shape objects and details.

Additional details are up to you. Now let’s move on to the curtains.

Making the Curtain

1. Duplicate the Background layer of the Window image to a new image by using Dupli-

cate Layer.

2. In the new image, create a new layer and name it Curtain. Fill the layer with a black-

to-white gradient from right to left.

3. Shape the gradient by using a wavy curve that looks something like the curve in Fig-

ure 7.39.

4. Commit the changes made by the curve by choosing Layer ➔ Merge Down, and then

resize the layer to 50 percent width.

5. Move the resized layer to the left. If you have Snap To Grid on, the content should

snap to (align with) the edge of the image.

6. Duplicate the resized layer, and then flip the new layer horizontally and move the

content to the right until it snaps to the right edge of the image. Use Merge Down to

get the two halves of the curtain on the same layer. The result of steps 5 and 6 should

look like Figure 7.40. The resulting layer should be named Curtain.

Figure 7.40

The basic cascade of the
curtain takes shape.

Figure 7.39

The shape of the curve will be similar to the shape that you could
trace with a pencil on the floor where the pleats fall—an even,
wavy line.
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7. Activate the Curtain layer and choose the Perspective Transform tool. Use it to alter

the fall of the curtain somewhat by expanding the curtains at the bottom, as in 

Figure 7.41.

8. Add a Hue/Saturation adjustment layer above the Curtain layer.

In the Hue/Saturation dialog box, check the Colorize check box,

and adjust the curtain to an interesting color. I chose blue, but

you can use whatever you like (remember, it will be combined

with a yellow window sash, a pink wall, and a green window

frame).

9. Turn off the visibility for the Hue/Saturation layer, flatten 

the image, and save it somewhere that you can locate easily as 

curtainmap.psd. (We’ll get back to the curtainmap.psd file in the

next section to help shape a drop shadow for the curtains). Don’t

close the current document.

10. Step back in the history by clicking Hue/Saturation 1 Layer on the Undo History

palette (Figure 7.42). This will bring you back to just before the save so you can keep

working.

11. Merge the Hue/Saturation 1 layer with the Curtain layer and then duplicate the Cur-

tain layer back to the Window image.

12. Position the Curtain layer below the Sash layers if necessary. The result should look

like the image and layers stacked in the Layers palette in Figure 7.43.

Making Shadows for the Window and Curtain

A lot of the reality of the object will depend on the reality of the details. Creating the drop

shadow for the curtain is critical to the realism of the result.

1. Turn off the visibility of all layers but the Sash layers, and use Merge Visible. Change

the name of the merged layer to Window.

2. Load the Window layer as a selection by Command/Ctrl+clicking the layer in the

Layers palette, and then invert the selection.

3. Create a new layer and name it Inner Shadow. Group this layer above the Window

layer, set the mode to Multiply, and fill the selection with black.

4. Deselect, blur the layer a little (5-pixel radius using Gaussian Blur), and offset it up

and right (5 pixels up, 5 pixels right).

5. Change the opacity until it looks pleasing. The idea is to give a little depth to the inner

portion of the window. You may want to turn on the visibility for the Curtain layer while

making this adjustment. Your Opacity will probably be between 30 and 50 percent.
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Figure 7.42

Stepping back in the
history restores the

layers that you  
flattened.

Figure 7.41

This is a simple dis-
tortion. Other filters

and more complex
behaviors (as we’ll

see with Displace in
a moment) can add

other touches of
realism.
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6. Load the Window layer as a selection again.

7. Create a new layer between the Curtain and the Window and

name it Curtain Shadow. Fill this layer with black.

8. Offset the Curtain Shadow layer 35 pixels down and left. Your

result will look something like Figure 7.44.

9. Turn off the visibility for the Window layer and fill the area out-

side the window shadow frame with black by using the Paint

Bucket tool. See Figure 7.45.

10. Choose the Displace filter (Filter ➔ Distort ➔ Displace). Set the

Offset to 0 percent Horizontal and 30 percent Vertical; select

Stretch To Fit and Repeat Edge Pixels. When the Open dialog box

appears, choose the curtainmap.psd file you created in the previ-

ous procedure. Your result should look like Figure 7.46.

Figure 7.45

Touching up behind the scenes here makes
sure that you can reshape the shadow dra-
matically without having to fill in later.

Figure 7.44

This is just quick posi-
tioning for the
shadow; we’ll soften
and shape it in the
coming steps.

When using Displace, the Vertical setting tells Elements you want the effect to be adjusted up

and down only. Stretch To Fit resizes the map you use—because it was created from the same

size file, you could choose Tile in this instance and get the same result. Repeat Edge Pixels will

use the black border you have if the shadow stretches too far; setting to Wrap Around could

send pixels that go off the bottom of the screen to the top.
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Figure 7.43

This looks a little
flat, but we’ll add
some depth with
shadows in the next
section.
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11. Blur the Curtain Shadow layer by about 3 pixels, set the Opacity to between 30 per-

cent and 50 percent, and adjust the position of the layer (vertically) as desired.

12. Create one more new layer at the top of the stack. Choose a small (5 pixel), soft brush (0

percent Hardness), and draw a line across the bottom of the upper sash in black. Adjust

the Opacity setting. This should appear to add some beveling or rounding to the bot-

tom of the sash. When you are finished, the window should look like Figure 7.47.

Figure 7.48

Lower the opacity
temporarily to make

the initial fit, and
then transform to

shape the space.

Figure 7.47

With the shadow in
place on the curtain,
the window has some
more realistic depth.

Figure 7.46

The Displace filter will use the tonality of the selected file as
a map to offset the content of the layer.
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Placing and Fitting the Window On the Wall

At this point, you need to flatten the window, copy it to the image with the wall and the

tree, and shimmy it into place (see Figure 7.48). It will be the wrong size, and you will have

to shape it, trim it, create a shadow for the window frame, and perhaps alter some color,

sharpness, and texture.

Since you already know how to do all that stuff, I will leave the details of fitting the

window up to you. My result (complete with generated wall) can be seen in the color sec-

tion and in Figure 7.49.

What I’ve probably been most successful in showing here is that you can spend the

good part of a weekend on what is already an interesting image. But hopefully the tech-

niques presented for shaping and adjusting have given you tools you can use to make

many creative changes and additions to other images.

Figure 7.49

A new wall, a new
shadow, and a new
window make a
new, less distorted
image.
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Part V
Images in Print

Once you’ve spent a whole bunch of time making an image look

just how you want it, selecting Print and sending the image to

your home printer may not always achieve the results you want.

Printing images to get the most out of them may require just a

little bit more fancy dancing.

You may need to consider using some special tools such as

vectors to control the shape of your output. Understanding your

printing options (for hardware, software, and images) and how

those options control output can help you achieve better results.

Chapter 8 Vectors

Chapter 9 Options for Printing
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Chapter 8
Vectors

For the most part, Photoshop Elements is a pixel-based image editor. However, vectors

are another means of controlling image content. You may have seen vectors in action if

you’ve used Shape tools in Elements. Vectors define image areas as mathematical outlines,

independently of the pixels and resolution of the image. They have a number of different

(shall we say hidden?) uses. Vectors can be used to make shapes, sure, but they can also be

used as clipping paths that redefine the actual boundaries of an image. They can be used to

store hard-edged selections. They can be used as clipping layers in order to shape image

layer content. They can be used to create artwork (such as logos) that can be scaled infi-

nitely. We’ll look at all these possibilities in this chapter.

Making Vectors

Creating Scalable Vector Art

Applying a Clipping Path
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Making Vectors
The basic way to make vectors in Photoshop Elements is to select any one of the Shape

tools, select a shape, and apply it to your image. Shape tools include the Rectangle tool,

Rounded Rectangle tool, Ellipse tool, Polygon tool, Line tool, Custom Shape tool, and

Shape Selection tool. The Shape tool can be accessed by clicking the shape tool icon in the

toolbox; this icon will vary depending on which of the Shape tools you used last. After the

tool is selected, there are numerous options for selecting shapes on the Options bar (see

Figure 8.1), including custom shapes . You apply the shape by clicking and dragging

the shape tool cursor on the image. When applying the tool, Elements responds by

creating a new layer for your shape. That’s that. Custom shapes are somewhat limited by

the sets you have available in the Presets/Custom Shapes folder in Elements.

Slightly more complex shapes can be created by using shape modes to combine shapes.

These shape modes are Add To Shape Area, Subtract From Shape Area, Intersect Shape

Areas, and Exclude Overlapping Shape Areas. They are used like calculations between dif-

ferent shapes that occupy the same layer.

Add To Shape Area

Subtract From Shape Area

Intersect Shape Areas

Exclude Overlapping Shape Areas

Using just these standard shape modes, you can make some interesting and complex

shapes. Try the following:

1. Create a new image (File ➔ New) with a white background that is 1000×1000 pixels.

Simplify Shapes

Intersect Shape
Exclude IntersectionCustom Shape Tool

Custom Shape Options

Shape Selection Tool

Custom Shape Selector

Rectangular Shape Tool

Rounded Rectangle Shape Tool Elliptical Shape Tool

Polygonal Shape Tool

Line Shape Tool

New Shape

Add Shape

Subtract Shape

Shape Layer Style

Shape Layer Fill Color

Figure 8.1

The Options bar
offers possibilities

for selecting differ-
ent shapes and con-

trolling how they
combine.
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2. Make a new shape layer. To do this, choose the Shape tool, select the custom shape

option on the options bar, choose a custom shape from the drop-down list on the

options bar, choose any color other than white, and begin drawing the shape by click-

ing and dragging on the image.

3. Choose a shape mode from the Options bar (Add, Subtract, Intersect, Exclude). This

mode choice will determine how the next shape that you draw interacts in the image.

4. Change the custom shape you have selected (if desired), and draw the next shape.

The vector component that you add in step 4 is added to the layer that you created in

step 2. The shapes combine to display a result based on the mode(s) you have selected for

each component. That result is displayed in the color selected in step 2.

To take a look at the effect shape modes have on the result, highlight the second shape

that you drew using the Shape Selection tool, and change the mode on the Options bar.

The result should change in the image based on the mode you select. You can add more

shapes to the layer by repeating steps 3 and 4.

You can combine the shape components that you have drawn in your layer into a single,

complex vector shape:

• To combine shapes into a single vector component, create the shape components and

then double-click the Combine Hidden Power tool in the PowerTools2 category of

Effects.

• To combine shapes into a single non-vector shape in its own layer, create the shape

components and then double-click the Simplify button on the Options bar. This

option will lose vector advantages.

• To combine shapes that you have created on separate layers, you will have to move

them to a single shape layer. Use the Shape Selection tool to highlight the component

you want, and then cut and paste shapes you have created to the shape layer, where

they will be combined.

• To highlight a component, just click it with the Shape Selection tool (click right on

the vector line).

After you combine or simplify your shapes, you will no longer be able to adjust their posi-

tions individually. You may want to duplicate the shape layer and hide it (shut off the view for

the duplicate) before combining components so the components will be available separately

without having to re-draw them.

Press the spacebar as you draw to move the position of the shape you are drawing.
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• To highlight more than one component on the same layer, you can click and drag the

Shape Selection tool over multiple shapes, or hold the Shift key while clicking individ-

ual shapes.

Say for some reason you want to make a custom shape—for example, a fishhook—that

you can’t find in the shape libraries and can’t imagine how to construct by combining

shapes from these libraries. One task you can’t do with standard Photoshop Elements

Shape tools is to make freehand shapes. You could spend most of the day using the exist-

ing shapes that are supplied—adding, subtracting, and combining—but creating a custom

shape this way will probably prove a little tough.

Hidden Power tools add some functionality that can help you change any selection to a

shape, and this gives you the power to make any custom shape you need.

All you have to do is make a selection (any shape or size, using tools you have), and then

double-click Shape From Selection in the PowerTools2 category of the Hidden Power tools

on the Effects palette. This will turn the selection you made into a custom shape on its own

shape layer. Once the selection is a shape, you can use it just like any other shape created

with the Shape tool: copy and paste the shape to other shape layers, and size and combine

the shape with others. The difference is that the shape you make can be your own.

One of my favorite ways to create shapes is by making a rough sketch with a painting

tool and then creating a refined selection by using the Polygonal Lasso. Figure 8.2 shows

how a very rough sketch of a hook is turned into the final hook illustration.

Once a shape is created, you can store it in an image and use it as you might use one of

the shapes from the shape libraries. The process is a little more manual in that you have to

copy and paste the shape, but this gives you much greater flexibility with vectors than

using shape libraries alone. For an example of how to store shapes in a library image, see

hiddenlibrary.psd on the CD.

If you have shapes that you want to store, follow these steps:

1. Create a blank image. It can be any size, but 500×500 pixels at 72 ppi will cover most

of what you will ever need the file for.

2. Save the file with a name that reflects the shape types you expect to save there.

Tolerance settings on the Make Work Path dialog that appears after you click the tool allow

you to choose how closely you want the vector to conform to the pixels. Higher numbers

simplify and smooth the vector while sacrificing accuracy; lower numbers add vector anchors

and may make for a blockier result. Shooting for a balance between the two extremes will get

the best results. It is sometimes best to increase the image size to create the vector if you

want to retain smooth vector results.
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3. Choose the Shape Selection tool.

4. Click on (highlight) the shape you want to store to activate it. The shape can be from

any open image.

5. Copy the shape.

6. Activate the library image.

7. Create a new shape layer.

8. Paste in the shape.

9. Name the layer something meaningful so you will know what it is in the description.

When you need to use it, you can just locate it and copy it to the image you want to

use it in.

Another way to store shapes in a library is to save all the shapes as separate files in a

directory (for example, named MyShapes) and then use Photoshop Elements’ Create Web

Photo Gallery function (discussed in Chapter 10) to create a preview of all the shapes in

the folder. This will be easy to update and will enable you to scan previews of many shapes

quickly in your web browser or in the Elements File Browser.

a b c d e

f g h i j

Figure 8.2

A very rough sketch
(a) is used as a simple
guide for creating a
more refined selec-
tion (b) made with
the Polygonal Lasso
tool. The polygon
selection is refined
and smoothed by fill-
ing with black (c) and
using Gaussian Blur
(d) and then Thresh-
old (e). Additional
selections (f) are
used to make alter-
ations (g), and the
final selection (h) is
converted to a shape
(i). Once the shape is
in a layer, layer
effects can be
applied (j).
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Another handy tool provided with the Hidden Power tools is one that will make a

shape from any text you’ve created. The Shape From Text tool is located in the Power-

Tools2 category of the Hidden Power tools on the Effects palette.

Converting text to vectors may not seem to be much of an advantage when I tell you

that you won’t be able to edit the type anymore. However, converting type to vectors can

save you from having to worry about transferring fonts with your Elements images; vec-

torized fonts will show up correctly even on computers that don’t have the same fonts

installed. Changing the fonts to vectors locks the shape of the font and makes it a graphical

part of the image, while still allowing you to scale the image and not have a fuzzy font

result. Vectors will produce sharper type results than rasterized type when used correctly.

Converting to vectors also puts to rest some potentially annoying font errors.

The application of these Hidden Power vector conversion tools should become clearer

in the following example, where we’ll use shapes to create scalable vector art.

Creating Scalable Vector Art
Pixel images are normally trapped by their content in that pixel content is inflexible, and

must be interpolated to be resized. Using vectors can help you create art that can be scaled

to any size while retaining sharpness in the shape of objects. Although you can’t turn all

elements of a standard photograph into vectors, you can create artwork as vectors so it can

be scaled to suit your needs.

Captain Hook’s Bait & Tackle is the name of an imaginary tackle shop. Let’s say the

owner wants a logo and asks you to make it. He wants to use the logo on his letterhead,

business card, and website, and on promotional items such as caps and T-shirts. One

other thing the logo will be used for is a little 10×16 foot billboard next to the Fishingtown

exit from the I-1000 freeway. The only answer you get when you ask how big the logo will

be on the billboard is: “Big.” So it’s safe to assume that the logo will run about 9 feet tall.

A 9-foot-tall image in Photoshop Elements at 100 ppi would be almost 11,000 pixels

square. That’s about 333 MB. It isn’t a file that you’ll want to transfer over the Internet

even if you have a fast connection. Interestingly, if you are careful, you can probably cre-

ate the file you need and do it in less than 1000 pixels square (technically, even smaller

than that!).

Shapes can be another means of storing selections—as long as you want to store the selec-

tion without anti-aliasing, feathering, or other grayscale manipulations. Such hard selections

can be converted to shapes by using the Hidden Power tools, and the visibility can be turned

off. To create a selection from the stored shape, Command/Ctrl+click the layer where the

shape is stored.
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Follow these steps to create the logo:

1. Open a new, blank 1000-pixel-square image. Set the resolution to 72 ppi.

2. Click the Shape tool on the toolbar. Then on the Options bar choose the Ellipse Shape

tool. Create a new shape layer by drawing a circle to fill the square image. Start draw-

ing at the center. You can find this center of the image by opening the Info palette,

setting the measure to pixels, and then watching the coordinates change as you move

your cursor in the image window. The center will be at 500,500. When you have

located the center, hold down the Shift and Option/Alt keys and drag your shape; the

shape will constrain to a circle and draw from the center point, where you first

clicked. Leave 100 pixels or more at the edge of the image all the way around—you

may need some space to maneuver your shapes and artwork.

3. Click the Subtract From Shape Area button on the options bar, locate the center of

the image again, and then draw a second circle from the center, about half the diame-

ter of the first. This will give you a torus—a donut shape—as a result of the two

shapes you created that inhabit the same layer. You should not have to adjust this, but

if you do, use the Shape Selection tool to click on the shape component you want to

move. When the component is highlighted, you can move it freehand by using the

Shape Selection tool or change to the Move tool and use the keyboard arrows to posi-

tion the shape.

4. Create a hook by sketching it and then converting it to a shape—the technique

described earlier in “Making Vectors.” Alternatively, you can copy in the hook you

made during that exercise, if you’d like.

5. Create the type to be placed in the donut. This is the toughest part of the exercise,

because Elements does not offer a lot of type controls. All you really have to work

with are the Create Warped Text function , point size, and Transform. It might be

easiest to set one word or phrase at a time.

I used the Arc setting on warped text at 100 percent for the top text (and –100 percent for the

bottom text) with about 30 percent Vertical Distortion. I added spaces before and after the

text evenly to shorten the arc and control horizontal distortion caused by the arc. To add

spaces at the beginning of the text, you have to add an extra junk character (I use a period)

before the spaces, or the spaces will just move the text to the right—but don’t forget later

that the junk character is there, or it will show up in your final image. Once the type is close

using Arc and spaces, use Transform to fit it in place if it still needs adjustment. See Figure 8.3

for a quick approximation of these steps.
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6. Convert the type to shape layers by using Shape From Text on the Hidden Power

tools, found in the PowerTools2 category of Effects. You may want to duplicate these

text layers and hide them before the conversion, in case you need to come back and

make changes.

7. Create the worm. Roughly sketch in its shape as it would appear wrapped around the

hook, using a soft brush (0 percent hardness) on a new layer. Merge with a new white

layer (created below the worm), and use Threshold to tighten up the edge. Load the

hook as a selection by Command/Ctrl+clicking the Hook layer (created in step 4).

Use the selection to erase areas of the worm that would wrap around the hook by

using a hard brush (100 percent). You can’t just hit Delete because you would remove

the parts of the worm that appear in front of the hook as well. See Figure 8.4.

Figure 8.4

Sketch the worm
roughly and remove

parts you don’t 
need by using the

hook as a selection
and guide.
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Make the arc on the
bottom of the text

match the hole of the
donut, and then

rotate the type into
place. You may have

to make other tweaks
to the position.
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8. Convert the worm to a shape layer. To do this, make a selection from the worm you

drew (Command/Ctrl+click the Worm layer), and then double-click the Shape From

Selection tool in the Hidden Power tools under the PowerTools2 category of Effects.

9. With all the elements in place, apply layer effects and color to achieve desired depth

and effects. You can apply manual effects as long as you want the edges blurred in the

result. If you need a tight edge on any effect (such as a hard drop shadow), you can

duplicate a shape layer and adjust the color or effects. I used strong bevels on the

worm, hook, and donut, along with inner shadows and drop shadows.

At the end of this exercise, you should have something that looks like Figure 8.5.

Keep the layered version of the image and store it safely. It is possible to change the size

of the image as necessary and correctly target the file for different types of output.

Because your image is essentially composed of all vectors, you can retain sharpness in

your image at any size. You can also temporarily shrink the image for moving it from

one place to another; as long as the person receiving the file has Photoshop Elements (or

Photoshop), they can expand the image again. The important edges remain defined by

vectors. Any blends and/or effects you used for coloring and shading will simply blur

more without damaging the result so long as you resize by using Bicubic or Bilinear

interpolation. There will be some difference between these two interpolation types

depending on the content of the image.)

Figure 8.5

Separate layers were
used for each effect
by duplicating the
shape to which the
effect was to be
applied. See cap-
tainhook.psd on
the CD and in the
color section.
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If you wanted to add other details (for example, to define the worm segments), you

would have to do so by using an additional shape layer so that the effects would not blur

during resizing. When you resize, you will probably need to adjust layer effects to re-create

what you had. This is far easier than re-creating the entire image. And far better than just

resizing an image by upsampling dramatically.

“Oh, what’s the difference in using vectors!” you say? The difference is a quality image

rather than a soft one. Look at the comparison in Figure 8.6; these are depictions of the

same image. Image A was created at 1000×1000 pixels , flattened, and then resized to fit

our billboard. Image B was created at 1000×1000 pixels and then resized to fit the bill-

board by using the advantage of vectors: the image was resized with layers and vectors

intact, and then flattened.

It should be apparent from the comparison that the vector image can be resized with-

out losing image quality, whereas pixel images will lose some definition. You can now take

your vector logo and happily resize the image for use on a billboard or business card with

equal success.

Vectors don’t only shape the content of layers; they can actually harness the shape of

your entire image. Read on about applying clipping paths that you create from vector

shapes.

Applying a Clipping Path
Say you want to create an image that isn’t constricted to the rectangular shape of your

standard digital image. Suppose you want the image itself, and not just a layer, to be star-

shaped, or circular. An easy way to do this is to make a selection of what you want to keep,

and then invert the selection and delete the area of the image that you don’t want. As long

as the background color is set to white, the image shape will appear to be a shape other

than a rectangle when printed. White areas of images don’t print with color (unless you

are printing with a spot white ink, and you’d know if you were doing that).

a b

Figure 8.6

This small segment
of the billboard was
magnified. Note the
softness, pixelation,

and lack of defini-
tion in the upsam-

pled image (a)
compared to the

vectors (b).
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This easy solution is okay if you don’t have anything in the background below the

image. If you are printing your easy-shaped image over another image or other content in

the background of the digital file, using white won’t work. One thing a white background

will do in your rectangular image is whitewash anything behind it. If your image is like our

Captain Hook logo, and you want to bring it into a layout program to print over a back-

ground image, you might want to import just the shape of the logo rather than the whole

image. What you really want to do to the image is clip it out of the background and paste

it into the layout—as though you were making a collage.

Clipping paths do exactly what you want. These are vector shapes that redefine the

boundary of your images. They enable you to “float” an image over a background in lay-

out programs and clip the edge of the image with vector accuracy, just as if you’d used

scissors. This technique can work best with images that you create with shapes in mind

(like the Captain Hook logo) and type. All you have to do is save a vector in the image as a

path, and then assign that path as the image-clipping path.

Again, the problem with clipping paths in Photoshop Elements is that the program

doesn’t let you work with them. You can’t save a path, and you can’t assign a clipping path.

At least, you can’t without the help of Hidden Power tools.

To use a clipping path with our Captain Hook logo, follow these steps:

1. Prepare the image by creating the shape that you want to use for the clipping path.

This requires combining the separate paths for the hook, the worm, and the donut.

Use one of these two ways to do this:

• Make a combined selection by holding down Command/Ctrl+Shift while click-

ing each shape layer in turn on the Layers palette (Figure 8.7). This will combine

the selections of each shape as you go.

• Use the Shape Selection tool to highlight the shapes, copy them all to a single

shape layer, change the shape modes of each component to Add, and then double-

click Combine Vectors in the PowerBonus category of Effects, or the Simplify but-

ton on the options bar (Figure 8.8).

Figure 8.7

You can multiple-
select your shape
layers…

applying a clipping path ■ 249

4385c08.qxd  11/5/04  4:36 PM  Page 249



To combine the shapes, you’ll need to duplicate one of the shape layers, choose the
Shape Selection tool (part of the Shape tool set), and then click the components
you want to copy. When the shapes are highlighted (you can click and drag a box to
highlight the parts of the worm), you can copy, paste, and then set the component to
Add by clicking that option on the options bar.

2. Assign the clipping path by double-clicking Make Clipping Path from the Power-

Tools2 category of Effects in the Hidden Power tools.

At this point you’ll be ready to place your Elements image in the layout program. Fig-

ure 8.9 shows what your Captain Hook billboard might look like. Be sure to save your file

in a format that is compatible with clipping paths, such as EPS or TIFF.

Figure 8.9

The clipping path
cuts away the white
portion of the logo

when the image
goes to print by

considering the clip-
ping path as the

absolute boundary
of the image.

+ + =

Figure 8.8

…or you can copy
them all to a single

shape layer and
combine them.
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You may have noticed that this will remove your drop shadow in the printed result

because the shadow lies outside the boundary of the clipping path; even though you can

still see it in the image, it won’t show up in the result. If you want the shadow, you can cre-

ate it by using a little trick that will also enable you to place the shadow manually in the

layout.

1. Copy the clipping path to a new grayscale image that is the same size and resolution

as the final print file.

2. Make it a fill layer—filled with 75 percent black. (You may need to increase or

decrease the percentage of black to get the results you desire. The greater the percent-

age, the darker the shadow result.)

3. Change the image to a bitmap by selecting Bitmap from the Color Mode menu.

When prompted, change the resolution to the output/printer dpi. Use the maximum

capability of the printer.

4. Save the file as a bitmap (BMP) file by using Save As.

This file can be placed in your layout program below the clipped image (how you do

this depends on the layout program you use). You will be able to manually move it sepa-

rately from the clipped image. It may not look very pretty in the layout preview, but the

result should look just fine on a high-resolution imagesetter or PostScript printer.

The success of printing images that have clipping paths depends on two other factors:

you have to save the file in a format that will respect the clipping path, and you have to

print in PostScript. The leap here is that most home printers are not PostScript. We’ll look

at a solution for testing PostScript output without a PostScript printer in Chapter 9.
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Chapter 9
Options for Printing

You shouldn’t just buy a printer and a ream of paper and assume you have every weapon

you will ever need for your printing arsenal. First, you have to know what to expect from

your printer’s capabilities and the type of paper you buy. Knowing about the process can

help you make better decisions that lead to better results. While there are ways to get bet-

ter results at home, at times you might need to print an image with a different process to

get the best output. There is a reason why some printers cost thousands of dollars while

standard home inkjets are much less expensive. Some of your best options for printing are

just not practical for home use, but that doesn’t mean you can’t use them. In this chapter,

we’ll look at getting better color results in print.

Understanding Printers and Printer Resolution

Making Prints at Home

Printing to the Edge

Using Other Printing Options
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Understanding Printers and Printer Resolution
There are really only a few practical options when buying a printer for your home. Though

not the only options, generally you are limited to a photo-quality inkjet printer—which is

inexpensive and not a bad choice at all—or a laser printer. The latter is often quite a bit

more expensive and doesn’t necessarily deliver superior results. The main advantage of a

laser printer is genuine PostScript printing, which you may or may not have a use for,

depending on what you are printing and what your workflow is.

Different printer types handle the same image information in somewhat different ways.

Understanding how each works can give clues as to how to prepare an image for printed

output.

Both inkjet and laser printers put tiny dots (of ink or toner) on paper that represent the

absolute resolution of the printer. These dots have fixed measurements for each printer.

The shape and intensity of each of the printer dots cannot be altered: they are either 100

percent on or off. The dots per inch (dpi) rating of a printer represents the number of

these tiny dots that the printer can make in one linear inch on a page. It is essentially

measured the same way whether the printer is a laser or an inkjet. The dpi of a printer can

be considered its maximum resolution—the finest building block of the printer’s ability 

to represent an image. The maximum resolution of a printer is the lower of any two num-

bers reported as the resolution by the manufacturer. A 1200×600 dpi rating, for example,

is really 600 dpi with a half-step for the rows (the half-step allows the dots to overprint).

The dpi rating for a printer never changes—though there are other options you can use to

control the output and how those dots are used.

The different dot patterns used by laser and inkjet printers accounts for the difference in

their printed result. The dots used on a laser printer form larger dots in halftone screens;

dots on an inkjet form an array or tonal density (as used in stochastic printing). By defini-

tion, halftone screening uses dot shapes (diamonds, circles, and so forth) of different sizes in

rows to create tone and color in halftone screens (the arrangement of halftone dots and

angles); stochastic printing uses randomized printer dots (not shaped dots in halftone rows)

to create arrays of tone and color. A stochastic printer can print with a lower resolution (dpi)

than a laser printer and appear to create finer results because of the randomized behavior of

the dots.

If you can understand halftone screening, it isn’t a big leap to understand stochastic

printing. We’ll look at halftone printing first, in a little more detail. If you know some

printing theory, it can help you understand how your images are represented in print,

and you’ll better understand how to achieve the best results. Different image content

(vectors and pixels) controls printer information in different ways. Controlling that

content starts with understanding print theory.
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Halftone Printing
Halftones are printed images that are composed of

halftone screens. Halftone screens are composed of two

types of printer resolution simultaneously: printer dots

(also known as printer elements and dpi) and halftone

dots (known as screening frequency and lpi, or lines per

inch). Printer dots are the smallest unit of ink the

printer can print (the dot in dots per inch). Halftone dots

are the screening dots (the size of the halftone dot or

the line in lines per inch). The halftone dot is made up of

the smaller printer dots, which then create the halftone

dot shape. See Figure 9.1.

A set number of printer dots is assigned to each

halftone dot based on the halftone dot size. The printer

dots are turned on or off in patterns on a PostScript

printer to represent the shape of the halftone dots. In fact, halftone dots, unlike printer

dots, can vary in size from one dot to the next. The greater the tone, the larger the halftone

dot, and the more printer dots are turned on inside the halftone dot grid. For example, if a

halftone dot has 256 printer dots in it, 50 percent gray will use half the black printer dots

in the halftone grid, or 128 out of the 256 printer dots.

During the process of describing the image to the printer, the shape, color, and tone of

the image is converted into rows of halftone dots based on the lpi and screening angles

selected in the printing options (if nothing is selected, the printer will use a default). These

dots are arranged in screens similar to the appearance of a window screen, one screen for

each ink. The goal of applying the screen is to minimize the visibility of the individual dots

and maximize ink coverage on the page so that images appear as continuous tones to the

naked eye—whether you are using one ink (black) or more (usually CMYK or some varia-

tion of that). The printer is then told which printer dots to print and which to keep off in

order to create the halftone pattern and represent the image.

You can specify the size of the dot by choosing a line screen in the printer settings when

going to print (using a PostScript or PostScript-compatible printer). The line screen setting

tells the printer the number of halftone dots that will be put down in an inch. The size and

orientation of the halftone dots can be controlled by the halftone screen size and screening

angle that you choose. The screening angle tells the printer how to offset the rows of halftone

dots so they don’t all land on one another, which results in less obvious patterning of the

dots. We looked at these concepts briefly when discussing duotone printing in Chapter 5.

Knowing what the trade-offs are in selecting line screens and screening angles can help you

optimize the use of the printer resolution to get the best printed result.
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Halftone dot

Printer dot (off )Printer dot (on)

Figure 9.1

This shows a com-
plete printer dot
grid for a 16×16
halftone dot. The
black printer dots
are on; the gray
printer dots are 
off. This halftone 
dot uses 60 percent
of the printer dots 
in the grid, so it 
represents a 60 per-
cent tone.
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Printers have a set maximum resolution (printer dots). The more printer dots that are

used to print a halftone dot, the larger the halftone dot will be, and the lower the fre-

quency of the lpi. The lower the lpi, the greater the number of printer dots that are in a

halftone dot, and the more tones the halftone dot can represent. Because a greater number

of printer dots in a halftone dot leads to a greater number of possible variations, the trade-

off to more shades in each dot is that dots have to be larger. The opposite is also true: if

you use fewer printer dots in a halftone dot, it will have fewer potential variations, but

smaller halftone dots. The larger the dot, the easier it is to see and the more likely the

halftone dots are to cause visible dot patterning (moiré patterns). The trick of halftone

printing is to keep halftone dots large enough so that the printer can represent many

image tones (by being composed of enough printer dots), but not so large that the

halftone dots are easy to see.

Keeping the halftone dot small while having enough printer dots to represent full

image tone requires maintaining a delicate balance. Dot size should be as small as possible

while representing the maximal number of tones. In other words, you want to increase 

the lpi as much as possible to make the halftone dots small, yet you want to keep the dots

large enough so they contain enough printer dots to represent all of the tone stored in the

image.

However, just as with other types of resolution, if you have more information in the

halftone dots than you can use, you waste it. There is no need to make a halftone dot with

more information than you can extract from the image source. So, there are better and

worse ways to use up the printer resolution by selecting the right lpi. You have to balance

the halftone screen frequency and size of the dot to get the best result.

Screening can be optimized for printing images that you have created depending on

the maximum resolution of the printer you are using. Say your printer has a resolution of

600 dpi. This means it can print a maximum of 600 printer dots of information in a lin-

ear inch. At the same time, Photoshop Elements is an 8-bit program, meaning it can store

256 tones for any pixel color. To be maximally efficient, any halftone dot would have to

be able to represent 256 possible variations to present the information correctly (or at

least potentially).

A 16×16 element halftone dot can have 256 variations (16 × 16 = 256), and can therefore

represent 256 shades of tone. A 20×20 element halftone dot could represent 400 shades of

gray—but it would be 25 percent larger, and an 8-bit source image would still provide only

256 potential variations. You would be printing halftone dots that can potentially represent a

lot more information (156 percent) than you have in your image. A 10×10 element halftone

dot will be smaller and less easy to discern, but it can have only 100 variations (10 × 10 = 100),

and will less likely be able to show the full potential of your image. The 256 variations in a
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16×16 dot will allow you to fully represent all of the

256 levels of tone possible with 8-bit color. Table 9.1

shows the size of various halftone dots and the num-

ber of shades of gray they can represent.

So, if the printer has a 600 dpi resolution 

and you want to run a halftone dot with 256

potential tones, then your lpi will have to be set to

38 (600 / 16 = 37.5). This is a low linescreen fre-

quency and a rather large halftone dot. If you step down to a lesser-size halftone dot with

fewer elements—say a 10×10—you can have smaller halftone dots and a higher lpi fre-

quency, and the printed result might end up looking better. A 10×10 halftone dot on a 

600 dpi printer would enable you to run a 60 lpi screen (600 / 10 = 60).

Regrettably, a halftone dot that can represent all 256 possibilities is not always the best bet

with a lower-resolution printer. Although a smaller number of elements per halftone dot

means that fewer potential colors/tones can be accurately represented by a single halftone

dot, this also means that there will be a less smooth transition between tones. When you step

down from a 16×16 element halftone dot to a 10×10, you go from 256 levels of tone repre-

sentation down to 100. If you further decrease the number of elements, the potential num-

ber of tones continues to lower. Each time you lower the number of tones you can create,

you increase the potential for color and tonal banding. You have to decide which trade-off

gives you the most pleasant result.

If you have followed the discussion up to this point, you may now understand why you

get noticeably better results printing to an imagesetter (with 2540+ dpi) than you do with

even good home laser printers. With at least 2540 printer dots at your disposal, you can

use linescreen values of up to 150 (158, really) and still get 256 levels of gray. Compare 

this result to using 38 lpi to get 256 levels of gray on a 600 dpi printer, as discussed above.

Running a higher lpi will limit the gray levels in output. The only way to get the full num-

ber of gray levels and shrink the screening dots is to have higher resolution in the printer

(higher printer dpi). This is why printer dpi makes a difference in the image result. Print-

ers with greater dpi (resolution) can show a greater number of tones than a lower resolu-

tion printer, while using the same size halftone dot.

With the halftone rows defined by the line screen, all that is left to do is convert the

image to dots that fit neatly in rows. If everything is set up correctly, colors are separated

into the CMYK components and converted to halftone dots. If there is only one color

(usually black), screening is fairly simple. The screen is converted to rows of dots at a spe-

cific angle. Often this angle is 45 degrees for black in an attempt to better fool the eye into

seeing tone rather than rows of dots (but it can be another angle of your choice).
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Table 9.1

Conversions of
Halftone Dimen-
sions to Gray Levels

E L E M E N T S  I N  S H A D E S  O F  

H A L F T O N E G R A Y

20×20 400

16×16 256

10×10 100

7×7 49

5×5 25

3×3 9

4385c09.qxd  11/5/04  4:36 PM  Page 257



Color generation is a bit more complicated because the angles of screening for each

color are offset, so the result doesn’t cause the inks to run in parallel. Default settings for

the screen angles might be something like C 108 degrees, M 162 degrees, Y 90 degrees, and

K 45 degrees. The colors in an area of the image are broken down into their CMYK com-

ponents and then individually rendered into dot screens at the different angle settings.

These screens are then printed over one another to create color and tone.

A most interesting fact about halftone dots and printer dots is that they can be con-

trolled by the presence of vectors. Clipping paths and clipping layers, as described in

Chapter 8, can be used to control and reshape halftone dots in a way that pixels cannot.

Vectors can essentially cut through halftone dot shapes and define how printer dots are

assigned. Vector shapes and type can retain sharp edges in halftone screening, but might

lose sharpness if converted to pixels.

Figure 9.2 shows how a shape printed with four colors (CMYK) would print when

using straight halftones and when using vectors to define the edge.

Stochastic Printing
If you can fathom all that is going on in printing a halftone in the previous section, sto-

chastic (inkjet) printing is comparably simple. Instead of being trapped into halftone dot

shapes, stochastic printing randomizes the use of printer dots so the printing seems

smoother and there is little possibility of creating moiré patterning and other potential

halftone-dot-related trouble. This is also why lower-resolution stochastic printing can

seem finer than much higher resolution halftone printing.

Vector edgeHalftone edge

Figure 9.2

The non-vector
halftone edge is

softer and far less
defined than the

vector-edged shape,
though both may

look almost identical
as digital images.

If you are printing with multiple passes, you may have to adjust screening manually.
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Figure 9.3 shows a rough approximation of how

halftone and stochastic printing of the same area may

compare.

While you won’t have to deal with lpi settings and 

the trouble that halftone dots can bring, you forgo some

of the refined edge sharpness you can get with Post-

Script vector printing. Your images printed with an

inkjet printer will look decidedly more like a photo-

graph than anything you print on a laser printer. Both

printing types have their advantages, and neither are

truly continuous tone.

Making Prints at Home
After you’ve made corrections to an image, you might look at it on the screen and it will

look just fine. But when you print it, the color might not seem as vivid as you remember

from the screen. This kind of outcome isn’t unusual, as the process of printing can sap

some of the strength from the color. It is a result of the necessary conversion from RGB

(the light you see on-screen) to CMYK (the ink you see on paper).

Image files created by a camera are recorded in RGB color. This is a fine way to record

visible color that will be projected as light—that is, just about any color that can readily be

reproduced on your camera LCD, your TV, your computer monitor, in digital projection

(using a digital projector), and in creating digital film (film recording). All of these RGB

processes play together fairly nicely.

Most printers you will use, on the other hand, use a straight CMYK process. By straight

I mean plain ol’ cyan, magenta, yellow, and black, with no additional inks. CMYK and

RGB are not very friendly with each other—CMYK can often make RGB look bad…or

much worse than it has to look. Specifically, vivid red, green, and blue areas of an image

can suffer in the conversion to CMYK because there are areas of RGB color that the

CMYK process just can’t imitate. Getting better results starts with that awareness. Adjust-

ing an image specifically for CMYK results—working with an image that you’ve converted

to CMYK or previewing the image as CMYK—can make a difference. We’ll look at both of

these options in this section.

What goes wrong between your image on-screen and the result in print can be hard to

track down. Problems can start with your monitor not being calibrated and can range to it

being improperly profiled, to having problems with color management in the image, to

needing adjustment to your separations, to having trouble with your printer, and even

printing on the wrong medium. We’ve covered all of these areas but the last one. Before

we get deeper into printing, we need to determine who is controlling your output.
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Figure 9.3

A halftone represen-
tation of an area
(left) can be com-
pared with finer
printer elements in
stochastic printing
(right) when printers
are capable of the
same resolution.
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Who Controls Your Output?
You can make a conversion to CMYK by using techniques from this book, but you can’t

always be sure that your separation setup is going to be used for the printing—unless you

test it. The reason for this is that many inkjet printers (printer drivers) like to make their

own separations. Instead of taking what you put together as a CMYK image, they might

convert the information from CMYK and then back to CMYK again. It’s a problem simi-

lar to what can happen behind the scenes with renegade image profiles.

You might guess that this double conversion—CMYK to RGB (or Lab) and back to

CMYK—is not desirable if you’ve already gone out of your way to make a CMYK separa-

tion. Printers and drivers don’t do this to be naughty; they are trying to help you get the

best results. The printer will not realize that you are a sophisticated user and have created

your own separation with a purpose in mind.

The first thing you want to do is find out what your printer is doing so you’ll know bet-

ter how to handle your images—at least with that printer. You’ll need to run a quick test

to see how your printer is handling color. All you have to do is run a rich black (a black

that combines black ink with cyan, magenta, and/or yellow ink rather than just using

black) to the printer. Once you evaluate the results, you’ll have to look at your possible

options. Unfortunately, you can’t print a CMYK image directly from Photoshop Ele-

ments. So that everyone can perform this test, I’ve provided another route using Adobe’s

Acrobat Reader (which is available on the companion CD).

Running the Test

Use the following steps to test your CMYK output.

1. Open CMYK.pdf from the CD by using Acrobat Reader.

2. Print using your usual printer and the print settings you usually use.

3. Evaluate the results in a well-lit room.

To evaluate the output, you have to know what you are looking for and what this test

print is supposed to be testing. The file is set up with a rich black bar (more than just black

This test will not work if you open the image by using Photoshop Elements, because Ele-

ments will have to convert the file to RGB. You need to print the image as CMYK.

Recall that in Chapter 1 I dismissed profiles. I don’t use them, I don’t need them, and neither

does anyone else. They can’t possibly tell a printing device what I can’t, and they can’t see

and correct to what I want as the result. Only I can do that.
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ink) across the top. The “black” bar should actually be

five colors—if your printer and driver are printing it

as intended. The first three boxes are a rich black with

cyan, a rich black with magenta, and a rich black with

yellow, respectively. The top half of the last box will be

black ink only, and the bottom half a rich black using

100 percent of all four inks. The next three bars in the

image will be cyan, magenta, and yellow at 100 per-

cent, 75 percent, 50 percent, and 25 percent. The 

separation of how that looks in color plates when 

separated right from the file I provided is shown in

Figure 9.4.

Examining the output in the light should make

apparent any differences between what you should

have gotten and what you did get. If the black looks

like a solid bar rather than several different blacks,

your printer (or the driver) is taking liberty with your

CMYK separation. Therefore, you may not be able to

use the printer as a reliable proofing device to see what

you will get when using another printing device or

service—unless you can find a solution.

If you want to get the CMYK out that you created, you will want to get the test image to

print by using the original color in the image. It isn’t so much that you want to be a con-

trol freak and never have image information change; you just don’t want it to change

without you knowing about it so that you can make proper adjustments and not waste

your time.

There is more than one solution to the problem, but you have to be able to live with the

result. Your solution could be as extreme as replacing your printer, but other options

don’t require making a decisive change in your current home setup. Your options include:

• Changing the output settings for printing

• Replacing your driver or using another method to get the right output

• Using a printing service when pre-separated output is critical

• Working in RGB and accepting whatever the printer and driver give you in the con-

version to CMYK

• Using a combination of the previous options
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Figure 9.4

The color in your
print should use
cyan (a), magenta
(b), yellow (c), and
black (d) in exactly
the patterns shown,
or your printer or
driver is getting in
the way of your
results.
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Changing Your Output Settings for Printing

Several settings that control how the printer will handle color can be hidden somewhere

on the various tabs of your printer driver settings (and sometimes in the program you are

using to do the output). These settings include the more conspicuous Convert CMYK

Before Printing type to the type that vaguely mention something about color management

(or profiles). There may be other options more cleverly disguised. There also may be no

options at all. Unfortunately, there are few standards.

If you look through all of your printer dialog box options when you are ready to print

and there are no color options, then you will have to look at another potential solution.

Don’t give up until you get out the printer manual or online documentation of the driver

interface and see what settings the driver has and what the settings affect. The documenta-

tion can point you in the direction of any settings that you might need to experiment with

when the settings are not obvious.

There is no profile in the CMYK.pdf, and the result of your printing should be that the

color is not manipulated by the color settings of your printer. However, some printers/

drivers may either insist that you have a profile or assume a generic profile, and this can

result in a conversion. Again, that will show up as a change in the black bar, and/or as influ-

ence to the pure CMYK color bars. Alternatively, you may choose to use a workaround

and/or replace your driver.

Replacing Your Driver

Most printer companies have a website for their products where you can download

upgrades to system software and sometimes hardware as well (firmware). Obtaining new

printer software from the website for your specific printer model can help give you func-

tionality that was added after the printer was manufactured—or that enough people com-

plained about to warrant an enhancement. When visiting such a website, don’t pass up the

option to complain, if necessary.

There may be third-party drivers that can do what you need. These will usually come at

an additional expense. Sometimes you can use other drivers, but this can require a lot of

trial and error, and is probably impractical for the most part.

One exception where you can find a free third-party driver is on the Adobe website.

Adobe makes drivers that are pretty much universal in helping create PDF files, and

these can be downloaded for free. There is also functionality on the site that will help

you convert files to PDF. Creating PDFs to print from is often a good solution for varied

applications (you’ll note that I used it for the test file). Using PDFs, you can often get

the equivalent of PostScript output from a non-PostScript printer (for example, clip-

ping paths won’t be ignored). All you do is use the driver option to Print To File. This
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will make a PRN (printer) or PS (PostScript) file, depending on your settings and the

driver used. This file can then be turned into a PDF and you can use that to print. PDF

files are also often small (depending on compression settings) and service friendly; they

can be lossless, and they can embed fonts.

Although it is not specifically changing your printer driver, exploring other options for

programs to print from can be another solution. For example, layout programs often have

capabilities that can help you get the output you want. For example, if you have QuarkX-

Press, Adobe PageMaker, or Adobe InDesign, printing from these programs can some-

times add options for output, or you can convert files to other formats such as EPS

(Encapsulated PostScript).

Another clever workaround is to print your CMYK process images one color at a time

by using multiple passes on the printer—as was outlined for making duotone prints in

Chapter 5. While this may improve the result, it will probably not work perfectly if your

driver is ignoring your separations. In other words, this only masks the problem rather

than fixing it. If you can’t control the settings, you still are not really controlling the result.

C R E A T I N G  P D F  F I L E S

Adobe Acrobat (Professional, Standard, and Elements) and Adobe Acrobat Distiller will

enable you to create PDF files from PRN (print) and PS (PostScript) files. These programs are

usually licensed by purchase, but may be included with other software packages or new

computer purchases.

As another option, Adobe will allow you to use their online tools at their site to create a

limited number of PDF files over a trial period. You can find the PDF creator here: https://

createpdf.adobe.com/ (look for the Try it for Free! link). Other free and inexpensive

resources are available as well, such as these:

• Ghostscript

http://www.ghostscript.com

• Pdf995

http://www.pdf995.com

• PS2PDF

http://www.ps2pdf.com/convert/convert.htm

• Docudesk (deskPDF)

http://www.docudesk.com

Information here is likely to change; please feel free to post questions to the Hidden

Power forum or search the Web for Create a PDF online.
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Using a Printing Service for Output

There are two ways to look at a printing service: 1) an expensive place that can be intimi-

dating, inconvenient, and smells like chemicals, or 2) a resource for equipment you don’t

want or can’t afford to keep at home. Services enable you to use sophisticated printers that

you would probably never buy. Different services may have different equipment, and get-

ting to know what is available—both locally in your area and through the Internet—may

give you some good options for other means of output. Options can include color laser,

LED (light-emitting diode), film recorders, offset printing, print-on-demand, and other

processes (both high- and low-tech). For the most part, you’ll know if you need a special

service. Several of these options will be looked at in more detail later, in the section “Using

Other Printing Options.”

Working in RGB

You may notice that the CMYK test gives you different results than you should get if the

printer is using the information you send, but another question you need to answer is

whether the results are good enough. In many cases they might be, and if they are, it saves

the problem of having to make and correct CMYK separations. There is nothing wrong

with sending an RGB image to your printer to be separated to CMYK if the results are sat-

isfactory. At other critical times (when you are making a specific separation, as I did to

create the CMYK test), you may need to explore more thoroughly how you can influence

CMYK output.

Using a Combination of Solutions

What the last few sections were obviously leading to is that not every image will warrant or

require the same process to get the result you need. I might use all of the discussed solu-

tions in a single day, depending on what I need to accomplish. Being aware of the options

is half the battle; the other half is realizing that using the right one at the right time saves

work, time, frustration, and possibly money as well. Be sensible about your choices; be

honest in your image evaluations; and be ready to change the processes you use most of

the time in order to get the right result in the end. The right result will vary, sometimes

from image to image.

Selecting and Testing Printer Paper
When eating soup, most sophisticated soup eaters use soupspoons. In a pinch, a teaspoon

or tablespoon could do; if you are the chef, a ladle may be used for tasting. However, there

is usually a reason why items we use every day have taken on slightly different shapes to

perform their jobs. The same is true of printer paper. In this section, we’ll discuss how to

select and then test printer paper to ensure the best results.
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Selecting Paper

Most people would tend not to run tissue paper through their printer in hopes of getting a

good print. The same goes for toilet paper, paper towels, wax paper, litmus paper, tracing

paper, shelving paper, aluminum foil, bubble wrap, plastic wrap, and so forth. What many

people never consider is that different papers that look essentially the same have different

qualities—and some of these qualities aren’t a lot different from some of the sillier sugges-

tions that you would quickly dismiss. Plain ol’ typing paper may be too absorbent, acting

more like a paper towel in absorbing the ink. It might have a texture or coating (such as an

easy-to-erase surface) that impedes ink absorption. It might not be white. It may not nec-

essarily be made for accepting ink from a color inkjet printer. Different inks in different

printers can be … different. Because they can be different, paper that works well in one

printer (such as a printer with an ink that dries quickly) may work less well on a different

printer (such as a printer with ink that is slower to set).

Manufacturers did not put expensive photo-quality paper on the market just because

they thought they could sucker in unsophisticated buyers to pay 10 to 20 times more for

paper they really didn’t need. Photo-quality paper was made specifically to do the job of

making the best-quality images from your inkjet printer. It is worth the extra money to

use it when printing your best-quality, final images.

You don’t have to use special photo-quality paper for every print, but you may need to

change printer settings to adjust for the paper type. When using plain paper, it should be

white. If not, the whites and lighter colors in your image will be influenced by the paper

color (usually decreasing the dynamic range of the image). You will find that some brands of

paper (even brands of the fancier photo-quality paper) will work better with your printer.

Sometimes this will have little or nothing to do with price.

Testing Papers

If you are going to use a plain paper to proof images before printing on better photo-qual-

ity papers, or if you will be using different quality papers, be sure to “waste” a few sheets

testing your output. Read the manufacturer’s suggestions for the settings to choose for

photo-quality and plain paper, and make prints of the same image on each. Make a few

prints with somewhat different settings; for example, if there are settings for different

grades of photo-quality paper, you might try more than one (especially if the paper you

are using is not noted specifically by the manufacturer). Try several prints with the plain

Although differences in paper can create different results when using a laser printer, it is usu-

ally much less of an issue because absorption is not part of the equation.
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paper as well. As you make the prints, note the settings used for each by writing those set-

tings directly on each print you make.

Compare the results of the photo-quality prints to the image on-screen first. Choose

the result that most closely resembles what you see on-screen. (It may not be the best

print!) Next, compare the print that looks the most like what is on-screen with the prints

on plain paper side by side. Make note of the settings that produced the best matches, and

use those settings when you print to those paper types. Retest whenever you switch papers.

If you like the quality of the prints you get with a certain brand of paper, you should stick

with it unless there is a good reason to change—and “because another brand costs slightly

less on sale” is not a good reason. Using the same paper simplifies your process and

ensures optimal results without having to retest.

Testing your paper and noting the settings that produce the best results can assure you

that what you see on-screen will most closely resemble what you will finally get in print.

Once you make this test, it should be unnecessary to make plain-paper proofs for every

image you print. With this test made, you have essentially completed the easier process of

color management that I suggested at the beginning of the book. If you do not change the

monitor settings or the paper you use, you can be assured every time of getting similar

matching to what you see on-screen.

Printing with a Profile
A second use for color management and profiling arises when you print your files.

Working-space color management is handled by your selection of a preference for Color

Settings (see “Color Preferences” in Chapter 1). What that selection does not handle is

the output profiling. Output profiling attempts to adjust for your printer, and hopefully

the paper used as well. The output profile can be used whether you have your prefer-

ences for the working space set to limited color management, full color management, 

or none.

Printing with your printer profile can be accomplished through Elements via the Print

Preview dialog box. Just choose Print from the File menu to open the dialog. Select the

Show More Options check box at the bottom left of the dialog. Under Color Management,

the screen displays the current Source Space (the profile embedded with your image per

your color management settings), Print Space, and Intent. Print Space is where you can

select your profile. Profiles should be printer or printer/paper profiles that you have saved

to the same place as your monitor profile (generally the Colorsync/Profiles folder on Mac

or the System32/Spool/Drivers/Color folder on Windows).

Intent is set to Relative Colorimetric by default; other settings include Perceptual, Satu-

ration, and Absolute Colorimetric. These options are described in Table 9.2.
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I N T E N T E F F E C T

Perceptual Attempts to maintain a view based on how we perceive color; actual color
may change.

Saturation Attempts to render saturated color in the new space, potentially at the
expense of color accuracy.

Relative Colorimetric Attempts to preserve as much of the original color as possible, while adjust-
ing color outside the target space to the closest possible match.

Absolute Colorimetric Does not attempt to preserve or adjust color that is out of gamut for the tar-
get color space.

Profiles that you will usually want to use for this will either be printer profiles provided

by your printer manufacturer (sometimes supplied with the unit, sometimes available

from the company website), or printer/paper profiles most likely provided by paper man-

ufacturers (in some cases, the printer and paper manufacturers may be the same). You can

also have custom profiles made, or try third-party profiles (often the latter are created for

specific combinations and purpose). Don’t just assign any old printer profile because you

have the opportunity to assign one.

CMYK Previews
It is not possible to preview CMYK printing in Photoshop Elements, so they say, because

there is no CMYK to work with in the first place. If one can’t create CMYK, there is, of

course, no way to preview it—and no reason to. There is also no Preview option. Why

should that stop you?

It is exactly because there is no CMYK that it is pretty easy to preview CMYK. That may

sound contradictory. But what a preview has to do is take your CMYK information and

convert it to RGB again. Because Elements won’t open a CMYK image as CMYK, the pre-

view is really automated (read: forced). As fate would have it, it is exactly the conversion

from CMYK to RGB that will show you what you should be getting in print and will let you

know—without printing—approximately what results you will see when you do print.

As I demonstrated in Chapter 5, you can build a CMYK image by making a custom

separation and saving to a DCS EPS template. To complete the process of previewing your

CMYK images on-screen, all you have to do is split out the CMYK channels from your

custom separation and merge them. You can do this manually by copying each channel

out of the file, creating the EPS, and then going back to open that file so it converts to

RGB. Hidden Power tools provide an easier way without having to save the image first. All

that is required is that you can complete a CMYK separation and get a reasonable preview

using output to plain and/or photo-quality paper. If you have accomplished this, you can

preview your result before even sending the image to print by proofing on-screen. This

can save paper, ink, and cost.

Table 9.2

Intent Settings for
Print Preview
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The preview that you will create is just a preview file and nothing more. You should

never save the preview. Just look at it, see if there is something you want to adjust, and

then throw it out. You can experiment with creating a curve set that makes the preview

look accurate, and you can then apply that to any image you are previewing. This will take

some trial and error (or testing), but once you have achieved an accurate preview adjust-

ment, you can use it over and over to preview the result of your separations.

1. Create a CMYK separation by using Hidden Power tools functionality. Double-clicking

CMYK Process in the PowerSeparations category of Effects will lead you through the

separation.

2. Double-click Make CMYK Split in the PowerSeparations category of Effects in the

Hidden Power tools. This will separate the C, M, Y, and K channels from the separa-

tion you created in step 1, leaving the original channels in the layers of the first image.

3. Double-click Preview CMYK in the PowerSeparations category of Effects in the Hid-

den Power tools. This will attempt to combine the separated channels created by the

split. Because Elements is an RGB program, it will stop you from viewing the image as

CMYK, and prompt you for a conversion to RGB (choose to convert by clicking the

Convert Mode button). This CMYK to RGB conversion is exactly what you need to

preview the CMYK result on-screen.

After you have completed this simple process, the image on-screen should represent

the CMYK you will probably get by printing the original CMYK separation (if your

printer respects your separation). I say “probably” because there can be some variation

specific to the printer, the inks, and the paper, as well as your setup for color management.

The solution to getting a more accurate preview is to make some adjustments to the pre-

view image on-screen. To adjust the preview, do the following:

1. Create a CMYK EPS separation by using CMYK Process in the PowerSeparations cat-

egory of Effects and then the CMYK template to create and save your DCS EPS. If 

you aren’t sure what to do, follow the instructions for “Separating CMYK Color” in

Chapter 5.

2. Open and print the EPS file by using a layout program or create a PDF; any process

that you have tested (using CMYK.pdf) that respects the separation you make is fine.

3. Open the CMYK EPS file in Photoshop Elements, and allow the conversion to RGB.

4. Compare the print to the screen and make changes to the preview image on-screen by

using adjustment layers (such as Curves, Levels, and so forth). Your goal is to make

the screen match the print as closely as possible. This may take some time. Look back

to Chapters 4 and 5 for color correction techniques.
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5. Create a preview file to store the adjustments you made. Name the adjustment layers

according to their purpose and/or placement. It may be a good idea to save a screen

shot of the Layers palette so you can duplicate the results.

6. Use the correction layers to correct the preview of other images. All you have to do is

drag the correction layers from the sample to the new preview.

You can make your adjustments by using separations to fine-tune the preview. RGBL,

explored in Chapter 2, may be a good choice.

Creating Custom Picture Packages
Picture packages are an easy way to fit images onto a printed sheet when you go to create

image prints. Packages can lay out one image in different sizes and combinations to fill a

printing sheet, or allow you to print more than one image. Photoshop Elements provides a

bunch of presets, and you might find one that meets your needs. I don’t know about you,

but most of my sheets of paper are standard 8.5×11 inches, and there are no presets for that

size. A good thing to know is that you aren’t stuck with the presets Adobe assigned.

Picture Package can be accessed directly by choosing Picture Package from the File

menu (File ➔ Picture Package), or it can be accessed by clicking the Print Layouts button

on the upper right of the Print Preview dialog box (Print Preview is accessed by choosing

Print from the File menu, or by pressing Command/Ctrl+P).

Say you want to print seven images on an 8.5×11 sheet—three images that are 4×5 and

four smaller wallet shots at 2×2.5. To create the Picture Package by using the measure-

ments from the example, all you have to do are the following simple steps:

1. Open Picture Package by choosing File ➔ Picture Package or by clicking the Print Lay-

outs button on the upper right of the Print Preview dialog box.

2. Click the Edit Layout button in the Picture Package dialog box. This opens the Picture

Package Edit Layout screen (see Figure 9.5).

3. Enter the name you would like the layout to appear under in the drop-down list on

the Picture Package screen under Layout. I named the layout (7): (3) 4×5, (4) 2×2.5.

This stands for the number of images on the sheet, and then the breakdown of the

number and size of the individual images.

4. Select the desired Page Size from the drop-down list. If the size does not already

appear on the list, add it by choosing Custom and entering the numbers in the Height

and Width fields. As an alternative, just entering a Width and Height will change the

Page Size setting to Custom automatically.

5. Click the Delete All button to clear the image boxes (called Zones).
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6. Click the Add Zone button, and change the Size and Position to the following: 

Width 4 in, Height 5 in, X 0.25 in, Y 0.25 in.

7. Duplicate the zone created in step 6 and reposition. To do this, Option/Alt+Click on

the zone, then choose Duplicate from the pop-up menu. Change the position to X

0.25 in, Y 5.5 in.

8. Duplicate the zone again, and change the position to X 4.25 in, Y 0.25 in.

9. Add a new zone that is 2×2.5 inches and position it at X 4.25 in and Y 5.5 in.

10. Duplicate the zone created in step 9 and change the position to X 4.25 in and Y 8 in.

11. Create another duplicate of the zone created in step 9 and change the position to 

X 6.25 in and Y 5.5 in.

12. Create another duplicate of the zone created in step 9 and change the position to 

X 6.25 in and Y 8 in.

13. Click the Save button to save your layout and return to the Picture Package screen.

You will need to select a name for the file you are saving.

Your layout will use your currently open image (if there are any). The example layout

will look like Figure 9.6. You can reuse the layout after it is created to print other files, a

folder of files, images from the Assets bin, or images in the File Browser. If you are not

automating printing of a folder or image group, you can change individual images in the

layout by clicking them in the Picture Package dialog box after the layout is set up (see Fig-

ure 9.7). If you are automating a folder or other image group, each image will be incorpo-

rated into a new package. Compiling the image for print may take Elements a few moments

Figure 9.5

This handy screen
enables you to con-
figure a new layout

and save it.
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to complete, as it will assemble the image(s) in a new document on-screen. Images will be

rotated automatically to take best advantage of the layout size. You can then save and/or

print the packages when the image(s) have been completed.

Figure 9.7

Select the image 
you want to replace
by clicking it and
choosing an alterna-
tive in the Select An
Image browser.

Figure 9.6

As long as you 
measure correctly,
you can create a 
Picture Package
template that will
arrange images on a
single sheet for you
so you don’t have 
to do it manually
every time.

In Windows, these layout files are stored in \Adobe\Photoshop Elements 2\Presets\

Layouts. On a Macintosh, they’re in \Adobe Photoshop Elements 2\Presets\Layouts.
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Printing to the Edge
Another layout problem that may confound a user is making images print to the edge of

the paper. On most printers, there is an edge area of the sheets you are printing that the

printer will not print on—if you use the right paper settings. It is commonly called the grip

edge. It is often a quarter to a half an inch broad, and may vary from edge to edge depend-

ing on how paper was designed to go through the printer. In most cases, you really don’t

want to print right to the edge of the paper if the printer was not designed for edge-to-

edge printing—and maybe you don’t even want to do it then. If the ink misses the page,

you could end up getting ink on the printer, rollers, or something else, and the edges of

the print could be smudged by handling.

There are two solutions to the problem of printing to the edge, which are really the

same thing: buy perforated paper that you print on and then tear away in the shape of the

print, or just do it the old-fashioned way and crop the paper.

For example, say you are creating a CD booklet and you want to make your image on

the front and back go right to the edge of the booklet. You wouldn’t start with paper that

was exactly the right size and then use your printer to print the image exactly to the edge;

you’d start with a larger sheet, print the cover, and then cut the paper down. Figure 9.8

shows a sample layout.

The image prints a bit beyond the crop edge—say, by an eighth of an inch. This provides

a margin of error for the cropping. If the cut doesn’t fall precisely on the crop mark, the

image will still come all the way to the edge of the cropped area. Extending the image beyond

the boundaries of the area you want it to occupy and then cropping the edges of the image is

called bleeding in printing terms. One eighth of an inch is a standard margin of error.

Bleed Fold

Crop or cut mark

Figure 9.8

All areas outside the
crop hash are cut off

and discarded.
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Using Other Printing Options
There are several other printing options for your images, and in this section we will focus

on higher-end possibilities. You can turn your images into negatives or slides for use in

photo printing or projection, and you can use other printing processes such as offset

printing and LED. You will have many more options than those mentioned here, but in

dealing with digital images and photography, these will be common and useful. Check

with your local services and on the Internet for more ideas.

Film Recorders
A film recorder is a means of generating film exposure from a digital image. Film recorders

can be used to create slides and negatives, which can then be used for slide presentations

and print exposures.

Within the film recorder, a CRT (cathode ray tube) is employed to project a thin beam

of light through a filter and onto film to expose it. Film is then processed and developed

by using conventional photo processing, resulting in an image on traditional analog film.

Film recorders come in varying resolution and quality based both on the number of

lines of resolution possible and the quality (and size) of the CRT. Cost for processing can

vary based on the quality of the film recorder and the available resolution. Usually it is not

cheap, but when you need slides or film and have an image with enough resolution, the

quality can be unsurpassed. Resolution of your images may have to be 650–1000 ppi at the

final size.

35 mm film is generally used with 2000- and 4000-line recorders. 8000-line recorders

can be used with 35 mm film, but this resolution begins to surpass the limitation of the

film grain. 8000-line recorders are usually used with larger film stocks (2.25 inch), and

16000-line recorders with 4×5 inches and larger.

A list of exactly what resolution to use would be meaningless, because the quality of

these various devices may require different sources. You’ll have to contact services both to

see if they have film recorders available and what they require for output.

Offset Printing
Offset printing is usually standard CMYK printing on printing presses, though it can also

be duotone printing or other processes such as six-color. Printing on a press may come in

handy for producing greeting cards, business cards, books (and covers), CD inserts, calen-

dars, posters, and the like—printed materials that you will want to produce thousands of

in quantity. While shorter runs may be available, this type of printing is almost exclusively

effective in volume. The result is top quality in both black-and-white and color printing.

Presses can be of varying quality. The better-quality presses will run upward of 133 lpi and

2540 dpi. All will use PostScript and halftone approaches.
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Light-Emitting Diode (LED) Printing
Light-emitting diode (LED) printers generate photographic results from RGB digital files.

Somewhat like film recorders, these printers enable your files to be printed without the

conversion to CMYK because the process used is light-based. Exposure is created on pho-

tographic paper in sizes up to poster size, directly from digital files. Exposures are then

processed as you would photographic paper, often right in the same machine.

While LED prints may be somewhat more expensive than traditional photo prints, the

gap isn’t very wide. The advantage is that you can use this process selectively with images

that you have had the opportunity to correct and improve digitally and still get photo-

graphic results. Unlike using a film recorder, which would take two steps (record to film,

then print) to get results, LED printing takes the digital file directly to print in a single

step. Because it cuts out having to pay for film and photo developing, it can end up being

much less expensive to process.

Again, quality can vary, but the color results will often be superior to home printing.

Files often require only about 250 ppi at final size. Check with your service to be sure, and

ask to see samples of prints to check the quality of resolution and papers before you buy.
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Part VI
Images on the Web

The only real difference between a web graphic and any other

graphic is that a web graphic is intended for display on a moni-

tor. This reduces some of what you need to know. For one thing,

you really don’t have to worry about CMYK separations or color

mode conversions—unless you will be using images across print

and web media and want to match business colors as closely as

possible. But web image work opens up some new challenges as

well as whole new arenas of image possibilities.
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Chapter 10
Creating and Using Web Graphics

Images you create can be used on the Web as well as in print. Although these can be the

same or similar graphics, there are some differences in how they are applied on the Web as

compared to in print. You use a different set of specifications as far as file type, color, and

resolution are concerned. We’ll look at how to apply those concepts to web images in

Photoshop Elements, as well as how to insert images into web pages and how to perform

image compression. A stark and challenging distinction between web graphics and the

static images you use in print is the ability to make web graphics interactive and animated.

We’ll take a look at creating rollovers and how to go about planning, creating, and imple-

menting animation.

Image File Types for the Web

Basic Guidelines for Web Design

Inserting Images in HTML

Making a Web Gallery

Creating Slices from a Whole Image

Creating Rollovers

Creating Animations

Looking beyond the Book
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Image File Types for the Web
Although you can transfer any file type through the Internet (as an e-mail attachment or

by downloading), your file type choices for web images that will be displayed on web pages

is limited to those that are supported by web browsers. If the file type is not one that the

browser will display, the image will not show up (with various errors or display anom-

alies). Although Elements supports many file types (see Table A.6 in the Appendix), and

although you’ll find many more still on the Web, generally you will want to stick with GIF

and JPEG images. PNG, TIFF, EPS, PDF, and SVG images are sometimes supported in

various browsers, or can be viewed with plug-ins.

Be aware of the advantages each file type offers, and don’t just dismiss the use of one

over the other in all cases. There will be times when using each format is both sensible and

desirable. The choice of which format to use is determined by the image contents of the

file being saved.

Generally, use the JPEG format with full-color graphics and use GIF for images with

limited color, such as type over a flat color background without a drop shadow. The fol-

lowing guidelines should give you a better idea of which format to use when saving.

Choose the GIF file format for saving if the image meets any of the following criteria;

choose JPEG if the image meets none of these criteria:

• The image must have transparent properties.

• The image is a simple RGB containing 256 colors or fewer.

• The image is currently in Grayscale or Indexed Color mode.

• The image is intended to be an animation.

Either of these image types can be used in rollovers, tables, backgrounds, or any stan-

dard image placement on a web page. Often, you will want to use them in combination on

a single page, and it might be advantageous to combine them in many circumstances. For

example, you might want to use GIF shims (blank images used as spacers) in a table to take

You can check whether an image you have saved is browser compatible by loading it directly

into your browser. Simply open your browser, choose Open (this option may be called some-

thing slightly different, such as Open File or Open Page, depending on which browser you

are using), and then select the file. Be aware that a plug-in you may have installed can affect

the functionality of a browser: if visitors to your images or website do not have that plug-in,

they may not be able to view the images. When you are unsure, view the images (and the

web pages they will be included in) in different browsers to be positive they show up as you

expect them to.
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advantage of transparency, whereas the table area itself is made up of JPEG slices to make

the most of a color image you are using as a button. In a more complicated scenario, you

might want to animate part of a rollover button that is a JPEG in the normal state (when

it’s not being rolled over or clicked). You would have to use a GIF to support the animated

image of the button and a JPEG to maintain the best color quality in the static image.

JPEG
Named for its developers, the Joint Photographic Experts Group (JPEG) format is the eas-

ier of the two web images to implement, because the file type can retain full RGB color.

Although there is an advantage to JPEG in its ability to retain image color, the image that

results from the save can be distorted by the format’s built-in compression. Compression

in a JPEG file simplifies image information by making estimates as to what is impor-

tant—based on a visual algorithm. The result of the compression can sometimes be

harmless (at lower levels), but more often shows up in the image as distortion known as

artifacts—which can often be devastating to image integrity. The compression may show

up only upon magnification of the image, but the potential for artifacts makes saving to

JPEG an option to use only when necessary for Web display, or when space (file size) is at

a premium.

Be sure to save as few times as possible—the more often you save to JPEG, the more the

compression distorts your images. JPEG compression gets reapplied each time the file is

saved. If you will be working on an image, save to a lossless file format (such as TIFF or

PSD) whenever possible; use JPEG for final images only.

JPEG compression runs on a scale of 0 to 12; 0 is the most compressed with the greatest

loss of image quality, and 12 is the least compressed retaining the most original image

information. The higher the compression in a JPEG file, the smaller the image files, but

the more the compression will damage the image information. This means that as the

quality of the image goes up (and compression is lowered), the size of the resulting file

increases.

GIF
CompuServe’s Graphics Interchange Format (GIF), often used for web graphics, is an

image compression format designed (specifically for the Web) to speed the transfer of

images. GIF conversions might require finessing the color because GIF files can display

only 256 colors. Mixing the 256-color palette with dithering can make it appear that there

are more colors than there really are.

Compression for GIF images is technically lossless, but conversion to Indexed Color is

not lossless: there are a maximum of only 256 colors in a GIF color table, so the 16 million
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potential colors in an 8-bit RGB image will be limited to fit in the palette. Conscious web

design that plans to incorporate GIF images will generally keep colors simple, as this fits

well with the idea of the GIF compression scheme from the side of image creation. If you

are creating a graphic image from scratch (such as a logo), it is more likely that you will be

able to make the color fit a GIF color table. For example, if you are running yellow text

over a blue background, there will be a limited number of colors in the image. The result

will probably be smaller as a GIF and may actually be represented better that way (there is

no generation of artifacts that would happen with a JPEG). However, color photographs

will be less likely to present well as GIF images. GIF cannot represent most of the colors in

a common color photograph, so it may prove to be a bad choice for normal photographic

images.

Web Image Resolution
In general, the resolution of all images saved for on-screen viewing should be set to

between 72 and 96 ppi, regardless of file type. This is true for web images as well as those

that are to be used in video applications. The reason for this is that 72–96 ppi matches the

common range for projection on a monitor. There may be exceptions (such as HDTV,

high-definition television), but the 72–96 ppi range will cover most computer applications

and will give you a good representation of the size that graphics will appear on most other

computers.

On screens with higher definition, web images appear smaller; the image information is

used up over a smaller area, rather than projecting the existing information at a higher

resolution. The result is that images fit the resolution of the display automatically, rather

than being used at a fixed size as in print.

Saving for the Web
With the Save For Web command, Photoshop Elements gives you the option to compare

two versions of the image, each using a different optimization method for compression and

dithering. This option enables you to make a visual comparison between the original and

the saved result before saving. In this way, you can select the smallest image file that still

maintains the image quality you need. You can use the Save or Save As commands to cre-

ate your web images, but you will have to do it without previews.

The Save For Web dialog box offers several combinations for comparing and optimiz-

ing images to be saved for Web use. Options include the following:

• File type

• Compression

• Resizing
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• Animation controls

• Browser preview

• View size

• Download rates

This is a very powerful feature for making the most of your web images by making the

least out of their file size.

The Preview panel of the dialog box enables you to make comparisons to the original

uncompressed version of the file. This will display the name and size of the original file,

and the current file type, saved size, compression and approximate load time of the file

that would be saved if changes were accepted. Neither image view can be edited or altered

directly, but you can zoom in and move the canvas to look at different areas by using

Zoom and the Hand tool. The previews for the saved image will alter with changes you

make in the options.

The Preset panel of the dialog box enables you to select a preset optimization type from

the Preset drop-down list or enter your own settings (Custom). Once the file format is

selected, options appropriate to that file type will display.

The Image Size panel offers options for resizing the image being saved. The options are

much like those in the Image Size dialog box (Image ➔ Resize ➔ Image Size), but the options

are more limited, although more apropos for web-image size changes. Dimensions are

changed in pixels only, and can be changed by percentage or dimension.

You can view the image directly in different browsers by clicking the Preview In

Browser button. The image is opened in the selected browser, and image statistics are

included in the preview. This enables you to see exactly how a specific browser displays

an image.

Use the following steps to save your images for the Web by using the Save For Web

command:

1. Choose File ➔ Save For Web. The Save For Web dialog box is displayed with a preview

of the current image and the most recently used save options (see Figure 10.1).

2. Select optimization settings for the image, and then consider options for file type and

compression. Each time you change any of the settings for optimization, look at the

preview to be sure the change produces an acceptable result.

3. When the optimized version is acceptable, click the OK button. This accepts the set-

tings and opens the Save Optimized As dialog box.

4. Choose a name for the file to be saved—be sure to use a different name than the origi-

nal to avoid overwriting. Choose a location and click OK to save.
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Basic Guidelines for Web Design
Although there is no right or wrong, there is better or worse in web page design. Better is

effective, and worse turns the visitor away. A few simple precautions can help limit the

potential for design problems. Use these guidelines as a checklist to keep within a safety

zone for your design. Of course, you can bend and break these guidelines, but they should

help steer you in the right direction.

Minimize Image Size
You should strive to create the smallest possible files when creating images for the Web

while still maintaining image quality. Smaller files load more quickly into a browser, and

therefore allow faster browsing of your web pages. Regrettably, there is a trade-off in con-

sideration of quality when shrinking file size.

The size of your image file is a matter of numbers. The more information an image file

has to carry, the larger the file will have to be. By reducing the pixel dimension to the min-

imum size (reducing the physical dimension), the image will be at its minimum effective

size. By reducing the size further using compression (in the case of JPEG images), or

Preview Option menu

Optimization settings
Settings panel

Image Size panel

New Size panel

Animation panel

Select Browser menu

Preview In Browser button

Progress barZoom level

Eyedropper tool
Zoom tool

Eyedropper color

Hand tool

Original image Web image preview
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reducing the number of colors (in the case of GIF images), images will be as small as pos-

sible and will transfer more quickly.

Following these guidelines will help keep your pages lithe and effective in design, and

they will be better apt to effectively transmit your content.

• Crop images as tightly as possible to keep file sizes small. If you need extra space

around the image, it is better to accomplish that with HTML code.

• Make images the exact pixel size that you want them to appear.

• Use 72 dpi for the final resolution. This will show you the effective maximum size of

the image (viewed at 100 percent).

• In GIF images, reduce the number of colors as much as possible without distorting

the image.

• Use JPEG format for images with more than 256 colors.

• Crop animation tightly to the area of motion. Keep the number of animation frames

(layers) to a minimum, and use animation sparingly—or eliminate it.

• Keep rollover states to a minimum by using only the states you really need—every

image state you use needs to preload, and that takes more time.

• Use repeating images on your pages to lower the number of elements that have to load.

Minimize Web Page Downloads
Having some general targets for code on your web pages can improve the look and speed

of the pages. While you won’t do this directly in Photoshop Elements, the following list is

good to keep in mind while implementing your images:

Remove comments and other empty, unnecessary code from HTML. Any unnec-

essary code, including blank spaces, adds time to loading pages—even if it seems

harmless.

Use short filenames and simple directory structures. A bulky directory structure,

with extra layers and long names, can add unnecessary code because nested files must

be renamed for each link. Use relative links, where possible.

Keep the total size of your entire page below 150 KB—including images. Keep it

much lower if possible. Lots of people have improved their connectivity these days,

but designing for the high end leaves much of the market behind.

Use a limited number of colors. Three to five colors will usually do. This helps main-

tain a unified look and can keep the design from becoming too busy. Another good

reason to limit colors in graphics is to keep their file size tiny.
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Sketch out the page before you make it. Knowing what you want will help you cut

corners in creating the elements that go with it. This can keep the pages small in file

size (KB) and speed the creation process.

Design pages that can be viewed with little scrolling. You may have a lot to say or

even a very interesting article to represent, but dividing it into parts will work better

on the Web and may be more intriguing for those with shorter attention spans.

Use simple HTML and GIF or JPEG images. Don’t depend on browser plug-ins to

deliver effects. Standard practice should not be to design with the newest standard

browsers as a target. There are many cool tools available for creating amazing web-

sites, but the simple fact is that when someone has to download a plug-in to see your

page, you risk that they will miss the effect—and if so it is wasted.

Create sites offline and test your pages before and after they are live. You might get

everything working fine offline and then when you set it up you might forget some-

thing or a link might be valid only within your directory structure. Always test your

pages with as many browser programs as possible, at least the two most popular ones.

If possible, test your pages on different computers and different operating systems.

Create page designs at a browser-friendly size. Designing for a 21″ monitor makes

assumptions that are probably unfounded about your visitors. If a page can’t be

viewed easily on a 17″ monitor, chances are that many visitors will have problems.

Some people still use 15″ monitors and low resolution.

Break up pages at logical points. Don’t cram so much on a page that it takes forever

to scroll through. Keep pages small so loading is quick, and add links to navigate to

organized information.

Make navigation simple and obvious. There is nothing worse than sitting on a page

and not knowing how to get to the next step or where to go—or if there is more to

get to. Good design should play a part in simplifying both the information and

access to it.

Choose common fonts for the page itself and be aware of potential for reflow.

Fonts used in page code (not in images) should be common, or you risk substitu-

tion. Fancy type should be set as images in Elements rather than hoping your visitors

have your fonts.

Inserting Images in HTML
The following is a terribly short primer covering just the basics for those who have never

tried to implement images on the Web. If you have already used the Web to display your

images, you might want to hop over this section and move on to “Creating Rollovers.”
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To place your images into web pages, you have to complete several tasks beyond simply

creating the right images. Online services exist that will help you display your images, but

they have simplified the way you display your images by automating the process and

doing the behind-the-scenes work for you. You may want better control of what appears

on your site, and for that you’ll have to delve into doing it yourself—unless you have a

budget for design.

If you are going to be a do-it-yourselfer, you have to do the following:

1. Secure a web host (server) or hosting service.

2. Get a URL.

3. Create web pages to display your images.

4. Upload the web pages to the server.

5. Tell people the website is there.

The web host keeps your files at the ready so that when a visitor puts your address in

their browser, the files can be accessed. You can buy your own web server (the most seri-

ous and expensive option), rent hosting, or engage in a free hosting service (free service

usually comes at the expense of forced advertising in the form of banners or pop-up ads).

Free services are excellent to practice with, and often can be all you need if you are just out

to display your images casually. The more serious you get about the Web, the more seri-

ous you’ll become about services.

Your URL is the web address, the widely recognized http://etc.com. Hosting services

sometimes offer a web address along with the services (for example, popular services such

as AOL and EarthLink offer free website space as part of their packages). This URL will 

be the address you “advertise” by telling people where to go. Web addresses don’t neces-

sarily have to be .com (for example, .net and .org are well used), and many of the less

expensive (and free) options won’t be a dedicated dot-com but a subdomain (such as myname

.exampleservice.com). Whatever the web address, they all pretty much work the same.

To display an image in a browser, you could just send people links to images (http://

www.mywebaddress.com/myimage.jpg), but this won’t allow you to put any text or descrip-

tion with it. To add text (and other links and descriptions), you have to create at least one

web page, and a website if there is to be more than a single page. To create a web page, 

you have to either write the code or use a program that will help write it for you (such as

Microsoft FrontPage, Adobe GoLive, or Macromedia Dreamweaver). The code will be in

Hypertext Markup Language (HTML), which is a series of tags that describe some param-

eters so the browser knows what it is supposed to do to display the page.

One feature in Elements will take a folder of images and create a website for you to display

those images. We’ll look at the Web Photo Gallery feature in a moment.
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An image is inserted into a page by using code that identifies the image and its location

so the browser knows where to look. The simplest code for inserting an image on a web

page is an image tag. Here is a sample of a simple web page with an image tag:

<html>

<head>

<title>My Image</title>

</head>

<body>

<img src=“myimage.jpg”>

</body>

</html>

To create this page, you would type it in exactly as you see here by using a text editor

(such as WordPad, SimpleText, or Notepad), and save the file as text-only with an .html

extension. The file would then be uploaded to the server, along with the image file.

When the URL is entered in a browser anywhere in the world, the image will display (as

long as the Internet connection is good and there are no limitations or restrictions to

display).

The html tag shows where the code for the page starts and stops. The head tag usually con-

tains some information about the page that mostly doesn’t display—except for the informa-

tion in the title tag, which appears in the title bar of the browser window. The information

that appears between the body tags is what displays in the browser window. The key to dis-

playing the image is the img tag, which tells the browser to go look for an image source in the

directory called myimage.jpg. If you were to type “Here’s a picture of me on summer vaca-

tion” above the img tag line, the text would appear in the browser window along with the

image.

While there is a lot more to explore as far as web controls and controlling page layout,

this is not a book on web design or HTML code. If the idea of using images on the Web is

new to you, you may need a beginning book on web design—or feel free to ask questions

on the Hidden Power of Photoshop Elements website and in the forum. Another great

way to explore code is to view the page source by selecting the Source or View Source

option in the web browser (often on the View menu). This option will show the page

code, and reading the code can give you hints as to how effects were achieved in design.

The following sections jump to more advanced implementations of images. The easiest

of these to implement directly from Elements is creating a web gallery.

Making a Web Gallery
The Photoshop Elements Web Photo Gallery feature helps the user create a website to dis-

play images. The site will display all of the images initially as thumbnails—smaller versions

of larger images. When you click a thumbnail, the larger version of that image will display.

286 ■ chapter 10: Creating and Using Web Graphics

4385c10.qxd  11/5/04  4:36 PM  Page 286



In this way, visitors to your site can “walk through” your gallery and look at the images

they want. Because the thumbnails are smaller versions of the original files, the thumb-

nails load more quickly than full versions would and speed your visitor through loading

your pages.

Elements will let you choose one of 15 predefined templates and will automatically cre-

ate web pages to help you display selected images. The result is a reasonably sophisticated

website—and the finished product can make you look like you know what you are doing,

even if you have no idea.

All you do is set up the images you want to include, choose File ➔ Create Web Photo

Gallery (see Figure 10.2), select your options, and click OK. Elements takes care of the

rest, automatically resizing and resaving the images from any Elements-friendly format

into thumbnails and display JPEGs. When you are finished, you don’t have to look at a

snippet of code or even know what happened; just post the content of the directory of

files Elements created to your web host, and the images will be ready for everyone to see.

To view the site after you upload to your web host, just enter the URL for the host in

your web browser. As long as you copy all the files correctly and use the proper URL,

you’ll see the result. When you do, you can send the same link to anyone you want to

share the images with.

You may need some details on setup and selection of options in the Web Photo Gallery

feature, so here is a step-by-step procedure to follow when creating your web gallery.

You’ll start with some preparation outside of Elements before you jump in and make the

gallery.

1. Gather the images you want to use on your photo

gallery website by copying them into a single direc-

tory. Use a new directory, name the directory some-

thing distinct, and note the location. These files can

be any file type that Elements will open. It may be best

to use uncompressed RGB images in most cases.

2. Create a destination directory where Elements can

save the processed website files. This should have a

different name than the image directory. It is prob-

ably best to give this directory a name having some-

thing to do with the purpose of the thumbnail site.

3. In Elements, open the Adobe Web Photo Gallery. To

do this on a Mac, choose Create Web Photo Gallery

from the File menu. In Windows, from the Photo

Editor or Organizer, click the Create button on the
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menu bar to open the Creation Setup dialog box; then double-click Web Photo

Gallery. You don’t need to have any images open to kick off the process.

4. Choose a Style from the drop-down list. The dialog box shows a preview of what the

site will look like, including a sample image.

5. On the Banner tab, enter your Title for the site (this appears on the browser window

bar and on the top of the web page), Subtitle, and Email Address. Choose the Font

and font Size. This information will be used to create the site and include an e-mail

link so that visitors can send e-mail to you. There are only four font choices available

because websites should use common fonts—your fonts won’t necessarily display on

someone else’s machine. You are essentially choosing to display serif, sans serif, or

monospaced type. Font size is not in points. These represent relative sizes. The larger

the number, the larger the size of the display font.

6. Click the Browse button in the Destination panel, and locate the destination directory

you created in step 2.

7. Click the Thumbnails tab. On this tab you will set up the display of the smaller images

used as previews for the large images. Thumbnail Size assigns the size that thumbnail

images will display. Font and font Size specifications are applied to the thumbnail

captions. Check boxes for Filename, Caption, and Date note what you want included

in the thumbnail display captions.

8. Click the Large Photos tab. Here you will define the parameters for resizing your large

photos, quality of the resizing, and captions. Check the Resize check box if you have

images of varying size that you want Elements to adjust for you, and then specify the

size that you want them all to be. Note that resampling will occur for images that are

not the size you select.

9. Click the Custom Colors tab. This enables you to select colors for the web page back-

ground (Background), the banner text (Banner), body text (Text), and links (Link,

Active Link, and Visited Link). Change the colors by clicking the swatch to open the

Color Picker. Active Link specifies the color for the frame and the name of the

thumbnail that is currently displayed (for templates that show thumbnails and large

images at the same time). Link shows the frame and text color for any link that has

not been visited (clicked); this includes the e-mail address. Visited Link will be the

frame and text color for links that have been used by the visitor.

The caption is taken from the Description that was previously entered for each file, which is

stored using the File Info dialog box (File ➔ File Info). If no file information was entered, noth-

ing will show for the caption.
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10. In the Photos panel, click the Add button to add images to the gallery. These can be

added by using the Photo Browser, by using the Entire Catalog, the Photo Bin (open

images), by Collection or by Tag. See Adobe instructions for working with the Orga-

nizer for more on how to manage your photos. Click the check boxes for images you

want to include; then click OK to accept the changes and close the Add Photos dialog

box. The photos you selected will appear in the Photos panel of the Adobe Web

Gallery dialog box.

11. Click Save to create your gallery.

When you have completed the process of creating your web gallery, you can preview

your site by opening the index.htm or index.html file with your favorite web browser. To

properly upload the files to a web host, upload all the files from the directory (do not

include the directory, or you will have to adjust the URL linking).

Creating Slices from a Whole Image
If you have traveled the Web at all, you have probably seen examples of images that load in

parts. These images are made from the original image cut up into smaller sections known as

slices. The sliced sections of the image are held together like pieces of a very simple puzzle by

the HTML code. When the web page is displayed, the code tells the web browser how to dis-

play the image parts, and they are arranged so that they show up in the right order. When

handled correctly, the image displays just as if it were whole.

There are some good reasons to divide an image into parts by using slices. First, if an

image is extremely large and takes a long time to load, the delay might cause a browser to

look like it has lost a connection. The person visiting the page might wait a long time before

anything starts happening and may get the idea that the page is missing, broken, or cor-

rupted. Using the image as arranged slices enables portions of the image to begin appearing

on the screen so the visitor at least has the sense that something is happening on the page.

A better reason to cut up a graphic is so that you can make parts of the image into links

and rollovers (we’ll look at rollovers in the next section). Cutting an image into portions

lets you work with the pieces of the web image as separate parts. You can then define any

behavior each part might have separately—similar to what happens when you isolate

image areas by selection, masking, or layering. You can use slices to help save load time by

deploying your images intelligently.

The resizing process is automated, so resizing can cause blurring and damage to images

because of resampling and compression. Be sure the target directory does not contain your

original images, or you risk saving the resized images on top of the originals.
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Cutting the Slices
Slices must be rectangular, and they have to be pretty accurately cut to make it easier to fit

them back together. To make accurately sized cuts, you could use grids or the Marquee

tool, but one of the most flexible and easy-to-use tools for measuring are Guides. Guides

enable you to set custom markers in your image to help define the shape of your slices.

Guides aren’t provided with Elements, and a slice tool isn’t either. However, Hidden

Power tools can help you along by giving you access to guides and automating the process

of cutting out and saving slices.

1. Open the image you want to slice. See Figure 10.3 for the image used in this example.

2. Decide how you want to cut up the image. Sketch a diagram of the slices (see Figure 10.4)

so that reassembling the image will be easier. No slices should overlap, and all should

be rectangles. Number the slices in the order that you will cut them up, from left to

right and from top to bottom. The simpler

you keep the pattern, the easier your job

will be later. This sketch can be done in

Elements on another layer if you’d like. If

you create the sketch in Elements, be sure

to shut off the view for the sketch layer

when cutting your image into slices to

keep sketch lines from being included in

the slices.

3. Place guides on the image to reflect the grid created by your sketch. To place a guide,

double-click the Make Guide Hidden Power tool in the PowerTools2 category of

Effects. Enter the pixel position for placement of the guide; you can move the guides

with the Move tool. Keep placing guides until the slices you need to make are all out-

lined with the grid. Do not place any guides that you will not be using (delete any

unused guides), but be sure that a guide aligns with every side of every slice. Some

guides will overlay other slices, and that’s okay (see Figure 10.5). Save your image

with the slice guides by using a different name.

If you choose the Move tool (press M on the keyboard), you can click on a guide and drag it

to change its position. Guides can be deleted by double-clicking them, again, with the Move

tool selected. They can also be dragged off the image by pulling them over the rulers. Man-

ual positioning may come in handy for fine-tuning the position of the guides on your image

before you start slicing.
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4. Choose the Marquee tool and drag a selection from one corner of your first slice (for

example, the upper left) to the diagonally opposite corner (for example, the lower

right), making sure the selection snaps to (automatically aligns with) the guides. The

Snap To option for the guides is on by default; to shut it off temporarily, press the

Control key on Mac, or right-click on Windows.

5. Crop the image (Image ➔ Crop). This cuts away all of the image except the slice you

are currently creating (don’t worry, we’ll bring the rest back in a moment).

6. Save the slice by using File ➔ Save For Web. You will be able to choose different set-

tings for each slice, if desired (including animation and rollover states as described in

the sections that follow). Save each slice with a distinct name according to the slice

number (such as slice1, slice2, and so forth, according to your sketch) and save them

to a directory you’ll use just for that set of slices. Be sure to name the files correctly, or

you’ll have trouble putting them together later. You may want to enter the filenames

for the slices on the diagram.

7. Jump back two steps in the file history by clicking the appropriate step in the Undo

History palette. The step you click will be just before Rectangular Marquee, near the

bottom of the history. If you have followed these steps exactly, the step will be called

New Guide, or Drag Guide if you moved it into position. This will return the image to

how it was after step 3.

8. Repeat steps 4, 5, 6, and 7 until all the slices are created according to the sketch you

made in step 2.

Figure 10.5

Guides placed over your image will create a grid
that you will use to cut up the slices.

Figure 10.4

This rough sketch shows six slices.
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The Save Slice Hidden Power tool will do steps 5, 6, and 7 for you. Once you’ve used

the Marquee tool to select an area, just double-click Save Slice in the PowerTools2 cate-

gory of Effects to crop and save it as its own image. (You will still have to name the files

appropriately.) The guides in the image will help keep your selections accurate so that the

slices you create will all fit together when they are reassembled in a web browser.

Positioning the Slices
Once you finish the previous steps, you will have all the slices you need, but they will be a

hodgepodge of separate files and you will have to create the HTML to reassemble them

properly.

Before you turn to creating the HTML, count the number of image rows (horizontals)

and columns (verticals) you have created by using the guides in the image. This informa-

tion will be important in helping you create the HTML easily.

The first step in assembling your images is creating an image table to place them in

using HTML code. A table can create an array of rectangles to fit your images into, so

you can arrange the way they appear for your visitor. To create your image table, you

can open up a text processor (such as Notepad or TextEdit) and then use the sketch 

you made as a reference for creating the code. This table will tell the browser how to

reconstruct the image in the original order and layout. The table is created by placing

table tags in the HTML to define where the code for the table starts and ends. You

insert td (table data) tags that represent slice columns and tr (table row) tags to repre-

sent slice rows.

Use the following steps to complete the code for the preceding example. At each stage,

the code you will type is bold-faced so you can pick it out from what you’ve already done.

1. Type in the following code exactly as you see it. This is the basic code to use to create

your table. (The slicetext.html file on the CD contains this starting code if you don’t

feel like typing it.) This sample HTML contains a table with one row and one column

(one set of tr and td tags):
<html>

<head>

<title>My Sliced Image</title>

</head>

<body>

<table border=0 cellspacing=0 cellpadding=0>

<tr><td></td></tr>

</table>

</body>

</html>
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2. Count the columns in your image and add a set of tags for each column to that line in

the code (see Figure 10.6). Just count the slice columns (vertical image columns)

made by the guides, and ignore the images. To add the code, highlight the column

tags (<td></td>), copy them, and paste them so that there are as many tag sets as you

have image columns. The following sample code shows what this would look like if

you had two columns, as in the example image:

<html>

<head>

<title>My Sliced Image</title>

</head>

<body>

<table border=0 cellspacing=0 cellpadding=0>

<tr><td></td><td></td></tr>

</table>

</body>

</html>

3. Count the number of rows in your image and add lines to the table code to reflect

that number. Just count the horizontal image rows made by the guides (see the

example in Figure 10.6), and ignore the images. To add the code, highlight the row

code (from <tr> to </tr>, the tags and everything inside them), copy, and then paste

that code until there are as many sets of row tags as you have counted image rows.

Here’s what the code would look like if you had five rows (and two columns), as in

the sample image:

<html>

<head>

<title>My Sliced Image</title>

</head>

<body>

<table border=0 cellspacing=0 cellpadding=0>

<tr><td></td><td></td></tr>

<tr><td></td><td></td></tr>

<tr><td></td><td></td></tr>

<tr><td></td><td></td></tr>

<tr><td></td><td></td></tr>

</table>

</body>

</html>
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4. Look at the first row on your diagram, and note all the images that are partially or

entirely in that row. Note the filenames. Enter the image reference for the first slice

(counted left to right) in the code between the sets of td tags. This is done with a sin-

gle img (image) tag, with the src (source) attribute providing the filename of the

image. Enter the second image in the second set of tags. Continue doing this until all

the images in the row are used. In the example, there are two images: slice1.jpg and

slice5.jpg. The result would look like the code here:

<html>

<head>

<title>My Sliced Image</title>

</head>

<body>

<table border=0 cellspacing=0 cellpadding=0>

<tr><td><img src=”slice1.jpg”></td>

<td><img src=”slice5.jpg”></td></tr>

<tr><td></td><td></td></tr>

<tr><td></td><td></td></tr>

<tr><td></td><td></td></tr>

<tr><td></td><td></td></tr>

</table>

</body>

</html>

5. On your diagram, cross out the slice images that were used in the previous step (see

Figure 10.7). You need to reference each image only once in the table, and this will

serve as your reference that an image has been used.

1 2

1

2

3

4

5

Figure 10.6

Count the rows and
columns according

to the number of
guides you place.
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6. If there are leftover td tags in the line of code that represents the slice row (<td></td>

sets with nothing in them), delete the extra tags.

7. For each image in the current row, count the

number of image rows and columns that the

slice covers. If there is more than one row

and/or column, go to step 8; otherwise, go to

step 9.

8. Enter the number of rows and columns for each

image by adding code that tells how many rows

and columns the image belongs to. This will be

done using span attributes (colspan for span-

ning columns, rowspan for spanning rows). You

have to add this value to the tags only if the

image covers more than one column or row:

a. For columns, add colspan=y to the td tag, where y equals the number of columns

that the image covers.

b. For rows, add rowspan=x to the td tag, where x equals the number of rows that the

image covers. Delete y <td></td> pairs in each line of code below the current line

for x – 1 number of rows. You subtract one because the current row you are on

counts as one, and you don’t want to count it twice.

For example, slice 1 from the example covers only the first row and first column, so
no tags are added. Slice 5 covers the second column only, but is part of four rows
(rows 1–4). For the slice5.jpg, you would have to add a tag for the columns it
spans: colspan=4. The resulting code would look like this:

<html>

<head>

<title>My Sliced Image</title>

</head>

<body>

<table border=0 cellspacing=0 cellpadding=0>

<tr><td><img src=”slice1.jpg”></td>

<td rowspan=4><img src=”slice5.jpg”></td></tr>

<tr><td></td></tr>

<tr><td></td></tr>

<tr><td></td></tr>

<tr><td></td><td></td></tr>

</table>

</body>

</html>
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slices you have used
will help you keep
count in the rows
and will make sure
you use images only
once in each table.
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9. Repeat steps 4 to 8 for all your slices. In step 4, when counting the images in the row,

don’t include any images that you crossed out. An image should be included in the

row count only if the upper-left corner of the slice is in the row.

10. When you have completed the code, save the file with a distinct filename (for example,

myslicedimage.html) in the same directory where you saved the image slices. Your

code will vary as you cut up images in different configurations, but for this example it

should look like the following:

<html>

<head>

<title>My Sliced Image</title>

</head>

<body>

<table border=0 cellspacing=0 cellpadding=0>

<tr><td><img src=”slice1.jpg”></td>

<td rowspan=4></td><img src=”slice5.jpg”></tr>

<tr><td><img src=”slice2.jpg”></td></tr>

<tr><td><img src=”slice3.jpg”></td></tr>

<tr><td><img src=”slice4.jpg”></td></tr>

<tr><td colspan=2><img src=”slice6.jpg”></td></tr>

</table>

</body>

</html>

If you open your web browser and load the HTML file, your image should appear

whole. If it doesn’t, something has gone wrong, and you’ll need to locate the problem—it

will most likely be caused by a code error or by saving the file in the wrong folder. Images

must be saved in the same folder as the HTML file in this example (not in a subfolder).

If your image loads successfully, you can use this image table in other web pages where

you want to use this sliced image. All you have to do is copy everything between and

including the table tags and paste it into another web page. Be sure you copy the images

to the same directory/folder as the new HTML file.

You can probably see that keeping the slices simple can help ease putting the image

back together and can simplify tracking the parts as well.

If you wanted to place the images in a subfolder, the folder has to be named in the src refer-

ence. For example, if you placed your slices in a folder named Images, the src reference

would look like this for slice1.jpg in the code: src=”Images/slice1.jpg”. A forward slash

separates the files and folders.
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Creating Rollovers
Rollovers are often used as buttons on a web page to help the visitor realize that a section of

an image is a web page link. Rollovers appear to change depending on the action of the

visitor and where they place their cursor when they view your web

page. The term rollover comes from the concept that when you roll

the mouse to move the cursor over the image, the position of the cur-

sor prompts the browser to change images, interactively. For example,

when a cursor is rolled over a button image, the image can appear to

highlight in some way, suggesting that the area of the page is live; if

you click the button, something else will happen (so long as the right

references are made in the code). Creating a rollover requires some

JavaScript, which tells the browser what to do. Rollover sections of an

image are often used in combination with slices so that you can create

buttons or simple highlighting, or reveal additional information.

You can do more than simple highlighting with rollovers, such as

creating complex interactive events that can be used for games or for

more complex control in display of page information. Six potential

actions, known as states, exist for any rollover: Normal, Over, Click,

Down, Up, and Out. They describe actions that the visitor can take

with the mouse (or other input device) to affect the rollover; these

states are defined in Table 10.1 and illustrated in Figure 10.8.

When creating a rollover, you don’t need to use all the states. In

fact, a rollover could technically have only one state—although that

isn’t much of a rollover if it does. Usually, you will want to have at

least one state in addition to Normal. Only one image state of each

kind can exist in the rollover, and the fewer states you use, the better.

Fewer states require less loading time because each state generates

more code and uses more images. If you are trying to create a mouse-

click event, it is best to use either the Down and Up combination or

Click, not all three or other combinations thereof.

There are more complex behaviors that you can accomplish with

rollovers. For example, you can use rollovers creatively to change page

contents, and you can even develop simple puzzles and games by hiding

and showing areas of the screen depending on where the visitor’s cursor

is. These more-complicated rollovers are put together by using different

slices to trigger different views. Perhaps we can talk about those on the

website and in the newsletter, where there is more opportunity for

demonstration. For now it should suffice to show you a basic rollover.
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This series shows the states as they were cre-
ated in order from top to bottom. Normal and
Out are the same because you usually will want
to return to the original state upon moving out
of the image area so that everything is as it was.
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To create a rollover, you have to create the separate image states that you want to use

and then insert the JavaScript code that will exchange the two images.

S T A T E D E S C R I P T I O N J A V A

C O M M A N D

Normal The initial state of the image when the page loads.

Over onMouseOver

Click onClick

Down onMouseDown

Up onMouseUp

Out The state of the image when the mouse exits the image area. onMouseOut

In a simple rollover, all you need is a snippet of Javascript to define the rollover func-

tion, and a few basic Javascript commands, as in the following example:

1. Open a new text file and type the following to start the page:

<html>
<head>

<title>Roll Over</title>
</head>
<body>
</body>

</html>

2. Add the JavaScript code to define the swap function and use a different type of image

reference. The script goes within the head tag. It defines parameters so your browser

knows what to do later when it encounters the onMouse and swap commands. To enter

the script, type the following:

<html>
<head>

<title>Roll Over</title>
<script language=”JavaScript1.2”>
<!--

function swap(img, changeto)
{document.images[img].src = changeto;}

//-->
</script>

</head>
<body>
</body>

</html>

The state of the image when the mouse button is released while the
cursor is hovering over the image area. Used in combination with Down
as one of two components in an option, instead of Click.

The state of the image when the mouse button is clicked and held
down while the cursor is hovering over the image area. Used in combi-
nation with Up as one of two components in an option, instead of Click.

The state of the image when the mouse button is clicked while the cur-
sor is hovering over the image area. Used instead of a Down and Up
combination.

The state of the image when the mouse cursor is hovering over the
image area.

Table 10.1

Rollover States
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3. Add a onMouseOver and onMouseOut swap commands, and a named image reference.

When the browser encounters the swap command attached to an action (for example,

onMouse), it knows to change an image. It can change the current image or another

one on the page, as long as they are named. Adding both commands will change the

images when the cursor rolls over, and then again back to the original a when the cur-

sor rolls off the area. The image will start out as 1.gif and change to 2.gif when the

mouse cursor rolls over. It will change back to 1.gif when the mouse cursor rolls out.

<html>

<head>

<title>Roll Over</title>

<script language=”JavaScript1.2”>

<!--

function swap(img, changeto)

{document.images[img].src = changeto;}

//-->

</script>

</head>

<body>

<a href=”#” onMouseOver=”swap(‘imagename’,’2.gif’);”

onMouseOut=”swap(‘imagename’,’1.gif’);”>

<img src=”1.gif” border=0 name=”imagename”>

</a>

</body>

</html>

4. To add other images to other rollovers, add unique image names. This shows a page

with two images, 1.gif and 3.gif. When you roll over 1.gif, it will change to 2.gif,

and when you roll out, it will switch back again to 1.gif. Roll over 3.gif, and it will

change to 4.gif, and back to 3.gif again when you roll out.

<html>

<head>

<title>Roll Over</title>

<script language=”JavaScript1.2”>

<!--

function swap(img, changeto)

{document.images[img].src = changeto;}

//-->

</script>

</head>

<body>

<a href=”#” onMouseOver=”swap(‘imagename’,’2.gif’);”

onMouseOut=”swap(‘imagename’,’1.gif’);”>

<img src=”1.gif” border=0 name=”imagename”>
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</a>

<a href=”#” onMouseOver=”swap(‘imagename2’,’4.gif’);”

onMouseOut=”swap(‘imagename2’,’3.gif’);”>

<img src=”3.gif” border=0 name=”imagename2”>

</a>

</body>

</html>

5. To make the rollover image into a link, just change the octothorp (#) in the hyper-

reference (href) to the URL you want to link to:

<html>

<head>

<title>Roll Over</title>

<script language=”JavaScript1.2”>

<!--

function swap(img, changeto)

{document.images[img].src = changeto;}

//-->

</script>

</head>

<body>

<a href=”page1.htm” onMouseOver=”swap(‘imagename’,’2.gif’);”

onMouseOut=”swap(‘imagename’,’1.gif’);”>

<img src=”1.gif” border=0 name=”imagename”>

</a>

<a href=”page2.htm” onMouseOver=”swap(‘imagename2’,’4.gif’);”

onMouseOut=”swap(‘imagename2’,’3.gif’);”>

<img src=”3.gif” border=0 name=”imagename2”>

</a>

</body>

</html>

6. You can improve the performance of rollovers by preloading the images. This will

place the images in the browser memory so that it doesn’t have to go out and look for

them during the behavior. If it has to go search, there can be a delay in the image

change and it’ll look clunky or perhaps be missed entirely if the visitor rolls away

quickly before the image loads. You’ll need to add a preload function in the script,

and reference that preload in the body tag so the browser knows to execute it. It looks

like this:

<html>

<head>

<title>Roll Over</title>
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<script language=”JavaScript1.2”>

<!--

function swap(img, changeto)

{document.images[img].src = changeto;}

function preload()

{image1 = new Image();

image1.src = “1.gif”;

image2 = new Image();

image2.src = “2.gif”;

image3 = new Image();

image3.src = “3.gif”;

image4 = new Image();

image4.src = “4.gif”;}

//-->

</script>

</head>

<body onLoad=”preload(‘image1’,’image2’,’image3’,’image4’)”>

<a href=”page1.htm” onMouseOver=”swap(‘imagename’,’2.gif’);”

onMouseOut=”swap(‘imagename’,’1.gif’);”>

<img src=”1.gif” border=0 name=”imagename”>

</a>

<a href=”page2.htm” onMouseOver=”swap(‘imagename2’,’4.gif’);”

onMouseOut=”swap(‘imagename2’,’3.gif’);”>

<img src=”3.gif” border=0 name=”imagename2”>

</a>

</body>

</html>

To add more images to the preload, insert additional images in the JavaScript in the

header and name them in the preload. You can substitute any name for the image variable

names, but they have to match in the JavaScript and the preload or the reference won’t

work. There are more complicated ways to do this.

This is just the beginning when it comes to using HTML and JavaScript with your

images on the Web. These tips on using slices and rollovers are meant to start you on your

way. If you have questions, feel free to bring them up in the forum (http://hiddenelements

.com/forum).

Many websites offer free code and further instructions on this type of JavaScripting.
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Creating Animations
Movement is an advantage unique to the web medium for most graphic artists not work-

ing in video or TV applications. Creating effects requires timing and consideration of

space and motion that offers different challenges than still art. Animations can be created

in Photoshop Elements by using the GIF format, image layers, and the animation export

check box in the Save For Web dialog box.

Animations work in an image by displaying a series of changes that appear one after the

other to make objects seem to be moving. If you’ve ever seen a flip book—where you flip

through the pages and an object seems to move—that is really the same idea. The same the-

ory is used in movies. Changes in position are recorded as steps in sequences that are then

displayed in frames—separate images captured on film. Usually many frames are captured

per second (for animation, 12 to 16 or more). The purpose is to show the images so quickly

that people can’t distinguish between the separate frames, so the objects give the appearance

of fluid motion. In capturing images for movies, many images are captured of objects that

are already moving and the images are simply played back in a timed sequence to re-create

the motion. In creating animation, images are planned to create the illusion of motion.

A specific number of frames is used to plan movement and timing. For example, if it takes

a cartoon character 3 seconds to walk across the screen at 16 frames per second, 48 separate

drawings would have to be created to complete the movement. These drawings would repre-

sent the sequential movement of the character in 16ths of a second. The more frames played

back per second, the tighter and smoother the resulting motion appears in the sequences.

GIF animation works in a similar way to cartoon animation, movies, or flip books. In

creating GIF animations, you need to create a series of sequential movements that accom-

plish the illusion of movement. You can control the timing of the frames, the series of

events, and the speed of the movement. The trick is to plan a smooth motion and to bal-

ance that against the number of frames you use.

Planning the motion requires deciding how long you want the motion to last, how

smooth you want it to be, and what distance or space you want the movement to cover. It

can also require planning for the limitations of your medium. As with most other web

concerns, you need to make your images as small as possible while still getting the results

you want. The more frames you use, the larger the resulting file will be, and the longer the

animation will take to download. So you will want to create  your animation simply and

effectively. This usually means reducing the number of frames to only the frames that are

essential.

Color is another limitation. Since animation is supported only in GIF files exported

from Elements, you will have to export files with a maximum of 256 colors. This may lead

you toward using subjects with limited color to obtain the best results, or planning that

includes using a limited color scheme.
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Planning Your Animation
To create an animation, it is best to approach the whole process tactically. To save time

and effort, knowing what your goal is from the outset will help save steps.

Use the following steps to plan your animation and develop parts of the motion. Very

simple animations such as blinking eyes or flashing lights that appear to travel around a

sign (often called a marquee) will go through these same steps, but the considerations will

be simple, and may not require in-depth planning.

1. Decide what you want your animation to look like. It might require making sketches

or taking notes to define exactly what you want the animation to do. Say you want a

man to simply walk left to right on-screen. You can do this many ways, and with dif-

ferent perspectives, such as full body, or just shoes and ankles—or shoes alone. You

could build your walking man with stiffly swinging legs, but a more complicated and

accurate motion will show the knee bending, the heel of the shoe lifting to bend the

toe, and then the toe straightening as the leg swings forward and straightens out

again. The amount of detail you want to include is important to later planning steps.

2. Roughly break down the animation into separate movements, so that each change in

direction or motion constitutes the end of one action and the beginning of the next.

Itemize cyclical or repetitive motions that you can repeat. For example, a walking fig-

ure will take a step first with the right foot, then the left, and then repeat. You may be

able to save “steps” by making the right-left cycle one time, and then repeat it as

needed. See Figure 10.9.

3. Decide how many seconds you want each of the movements in the animation to last.

For example, you might decide that each step should take 1 second. This calculation

helps you determine the number of frames you will be able to include for all of the

details you are interested in.

4. Determine the number of cycles required to complete your motion. Make a close

approximation of the distances you plan to cover by using a linear or pixel measure

for each movement. If the walking figure covers 100 pixels with each step, the anima-

tion is to cover your screen from left to right, and the animation is 800 pixels wide.

You’ll need to cover those 800 pixels. If each step takes 1 second, eight steps (four

right-left cycles), will cover the distance in 8 seconds total.

Although animations are cool, and can be fun and challenging to create, use animations with

purpose on a web page. If you just include animations in your pages willy-nilly because you can

or because they’re “neat,” you may not be doing it for the best reasons. Some animations can

be distracting instead of useful and might encumber and defeat the purpose of your site.
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Figure 10.9

This series 
of motions can be

used to repeat mul-
tiple steps by simply
repeating the series.
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5. Decide how many frames you want to use—either for each movement or for the

whole animation. This should not be an arbitrary selection, but should be based on

the distance of the movement, how smooth you need it to be, and the detail you need

to include.

Although using a high number of frames per second makes the motion smoother, it

also increases the file size. More than 32 frames per second (fps) is overkill—especially 

for the Web. Fewer than 16 fps might make the action a little blocky and rough, depend-

ing on the action. You’ll want your web animation to fall in the 8 fps to 12 fps range at the

very least if you are looking for smooth motion. You can use fewer frames and slower

frame speeds (depending on what is happening), but doing so can make the animation

chunky or hard to follow. Regretfully, you sometimes have to accept clunky as a trade-off

to file size. Table 10.2 lists some frame rates and suggested uses. These rates consider con-

tinuous motion as the desired result.

While it may make for a clunky result, using 5 frames per second for the eight-step

walking animation requires 40 frames to complete. Even that will lead to a large anima-

tion. You can see how higher frame rates become unwieldy—and pretty much become a

burden to deal with.

You should be able to see from the complexity of this that it is beneficial to keep ani-

mation movements simple unless you are interested in spending a lot of time animating.

The other side of this is that the more frames you use and the more time you spend, the

less likely that the result will be a usable GIF animation. It might end up more suited for

video or other applications, but that kind of application is not supported by Photoshop

Elements—at least not directly.

F R A M E  R A T E  F R A M E  D E L A Y U S E

( F R A M E S  P E R  S E C O N D ) ( S E C O N D S  P E R  F R A M E )

1 or fewer 1 or more Deliberate differentiation between 
frames; slide shows

2 0.5 Stop-action effects

5 0.2 Very chunky web animation

8 0.13 Chunky web animation

12 0.08 Minimum smooth web animation

16 0.06 Quality web animation; TV cartoon 
frame rate

24 0.04 Top-quality TV/cinema cartoon animation

32 0.03 Maximum move export rate; TV/cinema
film quality

Table 10.2

Typical Animation
Frame Speeds
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Building Your Animation
Now that you’ve planned your animation, you can begin creating it. First you should cre-

ate the animated parts or repetitive movements that will be part of the larger movements

in the frames. Depending on the complexity of the scene you are animating, you might

have to build many parts, and you might have to do it in separate images and combine

them. You should animate constants or repetitive actions first, or smaller movements

within larger ones; this will make it easier to combine elements into a larger movement.

You might find it easiest to build a few common or frequently used elements first and then

duplicate those as needed.

Once you have the image elements built, move them all into a single Photoshop Ele-

ments document and follow these steps:

1. Compile the animated image parts into corresponding frames, with each frame repre-

sented as a separate layer.

2. Stack the completed frames from the background to the front in the Layers palette.

The Background layer will be the first frame of the animation; Elements will generate

each frame in succession from the bottom of the stack on up.

3. Save the layered file in Photoshop native format (PSD). This will be your backup in case

you need to come back to the animation and adjust elements that are not flattened.

4. With the image still open, choose Save For Web.

5. Choose GIF as the File Type under Settings, and set the GIF options as desired.

6. Click the Animation box under Settings. This will make the Animation panel available.

7. Preview the animation by clicking the Play button to move through the successive

frames. This will help you to be sure you’ve layered the movement correctly. If neces-

sary, cancel out of the save and rearrange the layers.

8. Set the frame speed and looping according to the speed of motion you had planned.

9. Save the animation by clicking OK.

The animated GIF can be viewed by loading the file into a browser, or the file can be

viewed as part of a web page by using HTML code for placing a GIF, just as you would

place any other GIF image. The animation will be a single file.

There are numerous options for working with animation to adjust the results. You can

selectively apply changes to single frames, add and delete frames by adjusting the PSD that

you saved, and then regenerate the GIF.

To edit a frame individually, select the frame by clicking it in the Layers palette. If you

add or delete layers to edit, be aware that these will be added to or deleted from the frames

if you export the animation again. You have to merge all changes to the frame you want to

include them in so that they are not exported separately.
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Animating Image Elements
Animating elements requires attention to detail and an understanding of how motion is

handled. For example, objects can accelerate, decelerate, move at constant speeds, turn,

and so on, while you handle all the planning and execution of every movement. Here we’ll

look at how to make motion do what you want it to do.

Acceleration, Deceleration, and Constant Speed

When an image element appears to move faster as it goes, that is called acceleration. It is

the same thing that happens when you press down the gas pedal in your car to go faster.

Deceleration is exactly the opposite—like putting on the brakes. A spinning top that is

slowing down is an example of deceleration. Constant speed describes something moving

that is not accelerating or decelerating but continues to move at the same pace.

Acceleration is created during an animation by increasing the movement or distance

steadily between a series of frames. Decreasing movement steadily causes deceleration.

Even movements between frames in a series will represent constant speed.

The effects can be calculated by using some plain old good sense. Say you want to give 

a stationary car an acceleration of 6 pixels per frame over 1 second of movement using 

12 frames per second. By the 12th frame, that car would have to be moving at 72 pixels per

frame (6 × 12 = 72). All you need to do is move the car 6 additional pixels with each move-

ment: these movements would be 6, 12, 18, 24, 30, 36, 42, 48, 54, 60, 66, and 72 pixels for

each successive frame. Figure 10.10 illustrates accelerating and decelerating movement. By

the end of the 12th frame, the car will be moving at 864 pixels per second (72 × 12, or the

number of pixels per frame times the frames per second). To maintain that movement at

that point, you would keep the incremental movement at 72 pixels per frame.

You can certainly get more complicated and more accurate than this by applying an

acceleration rate according to a bell curve if you have a target. That is, acceleration will

gradually become 6 pixels per frame (say, 0.5, 1.5, 3, 4.5, 5.5, and 6, rather than immedi-

ately hitting 6). However, we are looking for only a reasonable approximation at this

point. The main thing to remember is that to make something move more quickly, the

distance between where it is and where it was will be less than the distance between where

it is and where it is going to be, and vice versa for deceleration. If you want a constant

speed, you are maintaining the current movement: move in even increments. If you want

to stop, duplicate the frame without moving any of the elements.

To elongate a pause in any action, simply duplicate a layer for the number of frames that you

want the pause to occur. As long as the layers are not altered in any way, this layer addition

will not contribute significantly to increasing the file size.
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Compiling Animated Parts

As suggested in the steps earlier, you will have simple and complex movements in your ani-

mations. In addition, some motions that seem simple are actually complex. For example, a

tire rolling is a simple form of a complex movement. Not only is the tire rotating, but it is

also moving forward. To animate the tire correctly, you will have to show the rotation of

the tire as it covers a distance, as well as moving the position of the tire. To get the right

effects from complex movements, you should attack the parts separately. This is best illus-

trated by an example. We will build an animated banner for a web page, including walking

shoes as an example of simple motion applied in a typical animation. We’ll do the anima-

tion of the shoes only, and then discuss a few possibilities at the end.

The first task that you would normally do is create constants. Constants are any image

elements—foreground or background—that will not change. For example, a constant

might be a floor for the shoes to walk on. Once the constants are created, they can be

duplicated to appear in every frame of the animation. We won’t be starting with any con-

stants in this example; there will be enough to keep track of with just the shoes, as simple

as they may seem initially.

For the example, the animation will have to fit within the banner. I’m going to assume

that 8 inches is a pretty safe width for display. The plan will be to use 5 frames per second,

and to make each step last 1 second. Each frame has a duration of 0.2 seconds, and the

total movement is 576 pixels (an 8-inch banner at 72 ppi). Each step will cover slightly less

than 2 inches, or about 120 pixels.

The motion of the shoes is somewhat complex: one shoe goes from being at rest to full

acceleration, then decelerates and stops again, and then the next shoe takes over and goes

through the same cycle. The full cycle for steps including the right and left shoes will cover

10 frames. You could take these images yourself with a digital camera, but to save you

some time and trouble, I have included the individual shoe images on the CD. To mimic

the desired motion, the images of the shoe are provided in five stages for each shoe: push-

ing off, swinging up, swinging down, landing, and at rest. The motion will look like the

shoes shown back in Figure 10.9, but it will be complicated by having both right and left

Figure 10.10

The figure shows 
an acceleration

toward the right 
and a deceleration
to the left. The tire

steadily accelerates
or decelerates by

moving the object
more or fewer pixels

between layer
frames.
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shoes. While the right shoe is moving, the left remains still; while the left moves, the right

remains still. Because of their proximity, the shoes cross in front of (right) or behind (left)

one another. You’ll see how this can lead to a pretty complex series of image layers.

The easiest way to attack this animation is to build the right step motion and then the

left step motion, and then combine them in alternating sequences. Once you have cre-

ated the simple right and left steps and combined them, the rest of the motion is pretty

simple: the shoes travel along in a straight line horizontally, repeating the same motion

three more times. The set of steps that you create can easily be duplicated (we’ll see how

in a minute) and then repositioned for each repetition, saving an absolute ton of work.

To apply this plan to creation of the animation, use these suggested steps:

1. Make a new RGB image that is the size and resolution of the animation you will be

creating. In this case, the image will be 576 pixels wide and 72 ppi. Make it 2 inches

(144 pixels) tall and crop it down later. Name the image Animation in the New Image

dialog box.

2. Open all 10 of the shoe images (provided on the Hidden Power CD) and duplicate

them into the image created in step 1. When duplicating the shoe images, it is prob-

ably best to use Duplicate Layer so you can name the target layer. You can also dupli-

cate the shoe images by dragging them with the Move tool from the source image 

to the image created in step 1. Name the layers according to the letter and number of

the filename

3. Arrange the layers so that they are in order, right series and then left series, from the

bottom up (see Figure 10.11). You will position the shoes in the layer after ordering

the layers, so don’t worry about where the shoes are positioned on the layer, yet.

4. Shut off the views for the left shoe and be sure all the views for the right shoe are on.

Although I provided original images for each change in position for the shoes, there may be

times when you will create motion by altering an original. When animation requires a trans-

formation or resizing rather than a straight copy, you should not create subsequent steps

from the previous one in order, as may seem natural. Always go back to the original, copy it,

and then apply the change. If you don’t, distortion will increase with each step. For example,

if you have something rotating at 45 degrees per frame, Elements will have to distort the

image at each step in the turn; each subsequent rotation will distort it even more. By the time

the object is rotated the seventh time, distortion in detail of the rotating object may become

apparent—just in time to cycle back to the original. This close comparison may make it evi-

dent that the images were not handled as well as they might have been. The best plan is to

have originals for each position; but when that isn’t possible, go with the best you can get

and always rotate from the original.
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5. Duplicate the Right 5 shoe layer and call it Right 0. Move the Right 0 layer to the bot-

tom of the stack, just below Right 1. You want the movement to end with the shoe at

rest, but you need to start the series considering the initial position of the shoe.

6. Position the shoes so they look somewhat like Figure 10.12. You may want to place a

guide near the bottom to help you with the alignment of the shoes. You’ll want Right 0

and Right 1 to be in just about the same horizontal position (match at the toe) and

aligned on the bottom. Right 4 and Right 5 will be in the same position as each other

horizontally (match at the heel) and aligned on the bottom, but about 120 pixels to the

right of Right 0 and Right 1 (measured toe to toe). Right 2 will be closer to Right 1 than

Right 3, suggesting acceleration between Right 2 and Right 3. Right 3 will be closer to

Right 4 and 5 than Right 3, suggesting deceleration between Right 4 and Right 5.

7. Turn on views for the left layers and duplicate Left 5. Rename the duplicate Left 0 and

place it below the Left 1 layer.

8. Duplicate Left 5, name the copy Left 0, and then position the left shoes. You can

either repeat the steps used for positioning the right shoes or use the Right shoes as a

guide. The latter is probably easiest if you turn on the view for the same number of

layers and align them. Alignment does not have to be perfect, but you’ll want it to be

pretty close. When you are satisfied that the layers are positioned, link them.

9. Choose the Move tool, click the image, hold down the Shift key, and slide the Left

shoes to the right (they should all move in unison) until Left 0 is centered between

Right 0 and Right 5. You can turn on the view for Right 0 and Right 5 and Left 0 to

make the image less distracting. Be sure the Left 0 image remains linked to all the

other Left images—they will move even though you can’t see them. This will be the

basic position for the alternation of the right and left steps.

With the basic movement created for each shoe, you have to create pairings of right

and left shoes and combine them in layers. If you created the animation now, you’d see

the right shoe move with no left on the screen, and then the left move with no right. The

shoes will have to be in pairs at all times. We’ll start with the shoes in a stationary position

and then take a step with the right shoe. You should save the image at this point using a

Figure 10.12

When all the layered
images are set in

place for one of the
shoes, the result will
look something like

this when all the lay-
ers are showing.
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name that will not be the same as the final one (such as SeparateShoes.psd). You may need

to come back to this image for adjustments.

10. Duplicate the Left 0 layer, call the layer Right-Left 0, and then shut off the view for all

layers except Right 0 and Right-Left 0.

11. Drag the Right-Left 0 layer directly below Right 0, activate Right 0, and then Merge

Down. Shut off the view for Right-Left 0.

12. Repeat steps 10 and 11 five more times, naming the duplicate of Left 0 in sequence

(Right-Left 1, Right-Left 2, Right-Left 3, Right-Left 4, and Right-Left 5) and drag-

ging the duplicated layer each time just below the number pairing for the Right shoe.

You should end up with 6 Right-Left layers numbered 0–6 (see Figure 10.13). When

you get to Right 5, duplicate it before merging with Right-Left 5. You’ll need the extra

copy of the Right 5 layer for the Left-Right shoe series. Name the Right 5 copy Right 0

and shut off the view.

These steps complete the right step, moving the shoe through the motion while the left

shoe is stationary in the scene. Next, the left shoe needs to be animated. The position of

the final frame for the right and left shoes is the position the shoes are in at the start of the

left shoe movement.

13. Be sure that all the Left layers are linked. Then turn on the view for Left 0 and drag

the left shoes so the Left 0 shoe is aligned with the left shoe on the Right-Left 5 layer.

Then shut off the view for Right-Left 5.

14. Duplicate the Right 0 layer. The duplicate shoe should fall where the Right 0 layer is,

directly between Left 0 and Left 5.

15. Throw out the Left 0 layer, and shut off the views for all layers except Right 0 Copy

and Left 1.

16. Drag the Right 0 Copy layer to just above Left 1 in the layer stack. This places the right

shoe visibly in front of the left.

17. Merge the Right 0 Copy with Left 1 and rename the layer Left-Right 1. Shut off the

view for Left-Right 1.

18. Turn on the view for Left 2; then duplicate Right 0 and drag the Right 0 Copy above

Left 2.

19. Merge the Right 0 Copy with Left 2 and rename the layer Left-Right 2. Shut off the

view for Left-Right 2.

20. Repeat steps 18 and 19 by turning on the next layer in the series (Left 3, Left 4, and

Left 5), duplicating Right 0, and dragging the Right 0 Copy layer above the next Left

shoe in the series. Then merge and rename the resulting layer Left-Right and num-

bered according to the sequence (Left-Right 3, Left-Right 4, and Left-Right 5).
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After combining the
Right 0 copy layers
with the Left layers,
your Layers palette
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21. Throw out the Right 0 layer. At this point the layer stack should look like Figure 10.14.

The initial right-left left-right series is complete. You need to duplicate it three times

and then align the duplicates to complete the step series. You could spend a long time

duplicating those layers and realigning, but there is a little trick that lets you duplicate

multiple layers to speed the process:

22. Create a new RGB image. Make it the same size as your animation image. Name it

Duplicator in the New Image dialog box.

23. Activate the original image and position it so that you can see part of the Duplicator

image window.

24. Link all of the Right-Left and Left-Right layers, choose the Move tool, click the Ani-

mation image, and hold the Shift key. Drag the cursor over the Duplicator image win-

dow and then release the mouse button. All the layers will copy to the Duplicator

image—they will have the same layer names, and they will be linked. The shoes will be

centered on the image.

At this point, you have the step sets in the Duplicator and the Animation images. You will

use the sets in the Duplicator to duplicate the sets of layers into the Animation as needed.

This process saves you from having to duplicate the sets of layers one layer at a time.

25. Activate the topmost layer in the Duplicator image, and then switch to the Animation

image and activate the topmost layer there. In both images this should be Left-Right

5. Activating the top layer ensures that the copies you make will stack on top of the

other layers in the image.

26. Activate the Duplicator image and position the window so that you can see the Ani-

mation window below.

27. Click the image, hold the Shift key, and then drag the cursor from the Duplicator

image to the Animation window.

28. Repeat steps 26 and 27 two more times.

You’ll now have 44 layers in the Animation image. These will be four complete sets of

the 11-step series.

29. Close the Duplicator window and don’t bother saving it.

30. Turn off the visibility for all the layers.

Trying to drag from the Layers palette will not work. You need to drag from the image win-

dow to successfully copy multiple layers.
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31. Hold down the Shift key and click the Right-Left 3 layer in the Layers palette closest to

the bottom of the stack. This displays the linkages in the Layers palette and you will

see only Right-Left 3 in the Animation image window.

32. Using the Move tool, drag the shoes so that the left shoe just exits the left side of the

screen.

33. In the Layers palette, turn on the view for the linked Left-Right 5 layer and shut off

the view for Right-Left 3.

34. Hold the Shift key and click the next Right-Left 0 layer up in the layer stack. This

shows all the layers linked to it in the Layers palette, and turns on the view for the

layer you clicked.

35. Drag the Right-Left 0 shoes and align them with the Left-Right 5 shoes.

36. Delete the active Right-Left 0 layer from the Layers palette.

37. Repeat steps 34 to 36 two more times.

When you are finished, you will have four full right-left series, and they should be per-

fectly aligned. The shoes will start off the screen at the left, and then traverse the image head-

ing toward the right. At this point, save the image (using a new name) and then run through

the steps for creating an animation by using the Save For Web option. This may take a few

minutes to generate, but you will end up with a 41-step animated GIF. This image can be

opened in a web browser, and you will see the shoes appear to walk across the screen.

There is more that you can do with this. You could, of course, keep going with the ani-

mation and just walk the shoes off the other side of the screen, or you could add other ele-

ments to the image. For example, if you were creating a website banner for shoe

deodorant pads, you might have the shoes walk across and stop, have the pads fly into

them, and then have flowers bloom out of the shoes. A slogan might pop up saying some-

thing like, “Leave ’em smelling like a rose.” Using the same shoes, you might create a ban-

ner for a health insurance company by having the shoes walk into an open manhole and

then displaying the words, “Don’t get caught in a hole uncovered,” and then roll in a man-

hole cover displaying the insurance company insignia and name. You could use it for a

graphic website that has tutorials by showing the shoes walking in and then displaying the

slogan, “Short steps to better images”; the shoes could stop their walk in front of an image

that could fill with color. You could also use them as shoes for a man walking to a barber-

shop… In other words, these same shoes can be reused for different purposes. You will, of

course, need to adjust the animation to make the shoes fall in a hole or stop.

The point is that the only limitation to animating objects is your creativity and ability

to envision the steps of the animation. By creating a series of controlled movements frame

by frame, you develop the elements necessary to make objects appear to be animated.
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Careful attention to image placement, movement, and timing in frames per second can

help you decide where image elements need to be placed and how to control them. Photo-

shop Elements can help do some complicated work in the compilation and creation of

frames, and can save a completed animation as a single unit in one file.

Looking beyond the Book
Throughout the course of this book, we have looked at a simple set of image tools and

how they have the power to do everything you need:

• You’ve looked at image color: how to take apart an image by using several color

models, and how to correct image color.

• You’ve extracted image elements from a scene, created new image elements, and

taken static image elements and made them appear to move.

• You’ve taken images and implemented them on the Web and in print after adjust-

ing them.

• You’ve gained control over Curves, snapshots, the History Brush, blend masks, chan-

nels, clipping paths, CMYK, and other Hidden Power tools.

Doing all of this in the relatively short expanse of this book might have seemed, at the

outset, impossible. Hopefully you now consider yourself able to do the impossible. If you

do, that means I’ve done what I set out to do by writing this book.

While that is an achievement, there is also more to talk about, more to learn, and more

image problems to tackle. In other words, this book does not end here. You can creatively

combine the information, tools, and techniques described and indulged in here in a myr-

iad of ways to make image solutions. You might occasionally need a helping hand from

another program, but the entire point is that Photoshop Elements is an enormously pow-

erful tool that can help you do anything you need to do with an image. Perhaps much

more powerful than you’d dreamed.

Please feel free to visit me at the book’s website, www.hiddenelements.com, and sign up

for the book’s newsletter. The site has additional information to specifically help readers

of this book. You’ll be able to ask questions, get answers, and communicate with other

serious Elements users. The information provided on the site is also my way of making

sure the book does not end with the last page, so that you can get help when you need it,

and it also ensures that this book is a jump-off point for your creativity rather than a static

tome that leaves you with no place to go. Please feel free to send me your comments and

questions (thebookdoc@aol.com), and I’ll do my best to get to as many as I can. I look for-

ward to hearing from you and helping you grow your abilities with Photoshop Elements.

314 ■ chapter 10: Creating and Using Web Graphics

4385c10.qxd  11/5/04  4:36 PM  Page 314



Appendix
Other Concepts and References

This appendix provides some background information that doesn’t fit a particular topic in

the book, but that might be handy to know when working with images. It is stuff I know I

struggled to find at one time or another. Topics such as these are sometimes buried in

obscure places if they are even documented. They may be presented incorrectly on the

Web, or they can be just plain too difficult to find when you really need them. Hopefully

you’ll find these topics come in handy.

The Toolbox

Resolution

File Types

Bit Depth

Blending Modes
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The Toolbox
Table A.1 describes the toolbox tools and shortcuts for selecting them. Figure A.1 maps

the tools as they appear on-screen. If you learn to use the shortcuts (from the map or the

table), you don’t have to waste time hunting for tools on the toolbar, and you can actually

hide the toolbar to give yourself some more workspace.

To remove the toolbox from your display, choose Windows ➔ Tools to uncheck the

option. To cycle through tools that have the same shortcut, press Shift and the shortcut

letter.

Hand Tool   H

Move   V

Cookie Cutter   O

Gradient Tool   G

Pencil Tool   N

Magic Wand   W

Zoom Tool   Z

Eyedropper Tool   I

Selection Brush  A

Crop   C

Red Eye Removal  Y

Paint Bucket Tool   K

Switch Foreground and Background Colors   XDefault Foreground and Background Colors   D

Set Background ColorSet Foreground Color

Figure A.1

An exploded view of
the toolbar
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T O O L  N A M E S H O R T C U T D E S C R I P T I O N

Rectangular Marquee M Makes a rectangular or square selection.

Elliptical Marquee M Makes a circular or oval selection.

Lasso L Makes a freeform selection formed by dragging the cursor with
the mouse.

Polygonal Lasso L Makes a polygon-shaped selection formed by clicking the
mouse to mark the endpoints of the polygon sides.

Magnetic Lasso L Makes a freeform selection formed by the selection lasso snap-
ping to the edges of contrasting tones or colors.

Selection Brush A Paints a freeform masked area based on brush size and dynam-
ics. The unpainted area is converted to a selection when the
user selects another tool.

Move V Moves active (and linked) image areas.

Magic Wand W Selects similar colors or tones based on a specified sample area
and tolerance range.

Crop C Resizes canvas (can result in a larger or smaller image than cur-
rent canvas).

Rectangle U Creates a vector rectangle shape. Creates a new shape layer if a
non-shape layer is currently active.

Rounded Rectangle U Creates a vector rectangle shape with rounded corners. Creates
a new shape layer if a non-shape layer is currently active.

Ellipse U Creates a vector ellipse (circle or oval) shape. Creates a new
shape layer if a non-shape layer is currently active.

Polygon U Creates a vector polygon shape with an even number of sides,
based on the number of sides specified on the options bar. Cre-
ates a new shape layer if a non-shape layer is currently active.

Line U Creates a vector line with a width in pixels specified by the
Weight field on the Options bar. Creates a new shape layer if a
non-shape layer is currently active.

Custom Shape U Creates a custom vector shape by using the custom shape
selected on the Options bar. Creates a new shape layer if a non-
shape layer is currently active.

Shape Selection U Activates or moves shape layer components.

Paint Bucket K Based on the tolerance and selections specified on the Options
bar, fills an area with the foreground color or a pattern. Colors
the image matte if used over the matte area while the Shift key
is pressed.

Brush B Paints with the selected brush using the foreground color and
brush dynamics (click More Options on the Options bar).

Impressionist Brush B Paints with the selected stylized brush using sampled color and
brush dynamics (click More Options on the options bar).

Eraser E Changes the erased area to the background color (when used
on the background) or to transparent (when used on a layer).

Background Eraser E Changes the erased area to transparent based on the settings
specified on the Options bar. Changes the background to a layer
if applied to the background (using color modes that support
layers).

Continues

Table A.1

Photoshop Elements
Tools
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Continued

T O O L  N A M E S H O R T C U T D E S C R I P T I O N

Magic Eraser E Changes the erased area to transparent based on sample point
and tolerance. Changes the background to a layer if applied to
the background (using color modes that support layers).

Horizontal Type T Places entered text horizontally using the font selection, point
size, and other dynamics selected on the Options bar.

Vertical Type T Places entered text vertically using the font selection, point size,
and other dynamics selected on the Options bar.

Horizontal Type Mask T Creates a selection based on horizontally entered text, font,
point size, and other dynamics selected on the Options bar.

Vertical Type Mask T Creates a selection based on vertically entered text, font, point
size, and other dynamics selected on the Options bar.

Gradient G Fills an area with a blend of one or more colors based on the
gradient, applied direction, and gradient type (Linear, Radial,
Angle, Reflect, or Diamond), selected on the Options bar.

Pencil N Creates a hard-edged freehand line based on the selected
brush.

Red Eye Brush Y Replaces the color of the brushed area with the replacement
color defined on the Options bar, according to a sample area
(the tool samples the initial click point).

Blur R Softens hard edges or areas in an image to reduce detail, based
on the brush size and dynamics selected on the Options bar.

Sponge Q Changes the color saturation or vividness of an area defined by
the brush selected on the Options bar. In Grayscale mode, the
Sponge tool increases or decreases contrast by moving gray lev-
els away from or toward neutral gray.

Dodge O Lightens areas where you drag the cursor based on the range
(Highlight, Midtones, or Shadows), brush size, and dynamics
specified on the Options bar.

Sharpen P Applies a sharpening calculation to the area where you drag the
cursor based on the brush size and dynamics specified on the
Options bar.

Smudge F Either smudges the existing colors in your image or smears new
color through your image based on the direction you drag the
cursor, the brush size, and the dynamics specified on the
Options bar.

Burn J Darkens areas where you drag the cursor based on the range
(Highlight, Midtones, or Shadows), brush size, and dynamics
specified on the Options bar.

Clone Stamp S Copies sampled pixels from one part of an image to another
based on the brush size and dynamics specified on the 
Options bar.

Pattern Stamp S Paints with a selected pattern based on the brush size and
dynamics specified on the Options bar.

Healing Brush J Copies sampled pixels from one part of an image to another
based on brush size and dynamics (like Clone Stamp), then
attempts to fit the correction into the target area by making
“smart” comparisons between the sample and target areas.

Continues
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Continued

T O O L  N A M E S H O R T C U T D E S C R I P T I O N

Spot Healing Brush J Clones like Healing Brush but selects clone source automati-
cally. Best used for correcting minor damage such as dust.

Hand H Enables the user to grab the canvas and scroll to navigate a
magnified image when all of the image cannot be viewed at
one time.

Eyedropper I Samples color from the image based on a single pixel or pixel
area (according to selected options). Places the color in the fore-
ground or background (when the Shift key is pressed). Often
used with the Info palette.

Zoom Z Increases (zooms in) and decreases (zooms out) the magnifica-
tion of image display on-screen.

X Exchanges the colors in the Foreground Color and Background
Color boxes.

Set Foreground Color Opens the Color Picker dialog box to allow the specification of a
color to fill the Foreground Color box.

Set Background Color Opens the Color Picker dialog box to allow the specification of a
color to fill the Background Color box.

D Restores the Foreground Color and Background Color boxes to
their default colors.

Resolution
Several resolution factors can affect your results in Photoshop Elements. These factors

include input resolution, monitor resolution, and output resolution. Understanding reso-

lution is imperative to getting the best results from your digital images.

Input Resolution
Input resolution is the resolution of images coming off of the device you are using for cap-

ture. Most commonly this will be a scanner (whether you scan your own images or have

them scanned for you) or a digital camera.

Scanners and Resolution

Scanner resolution is measured in dpi (dots per inch), based on the number of scanned

samples that occur during scanning, and how that is converted to image information.

Scanners are most often rated in optical and/or interpolated resolution—the latter some-

times disguised by other terms. You should pay attention to optical resolution only. Inter-

polated resolutions lead to the scanner creating interpolated (assumed) information, so

the results will usually not be much better than using interpolation to resize images in

Elements.

Default Foreground
and Background
Colors

Switch Foreground
and Background
Colors
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All scanner types are not alike, and for best results you should use them for the purpose

that they were made. You will generally not want to use a flatbed for scanning negatives—

even if they have a transparency adapter or other means of scanning slides. Flatbeds start

at an optical resolution of about 600×600 and can go much higher. They are generally best

for making reflective scans such as those you might make from prints. Negative scanners

will start with at least 1800×1800 and are better suited to making accurate high-resolution

scans from your negatives and slides. They are, however, usually fairly expensive. Services,

such as Kodak Photo CD scanning (this is different from Kodak CD, which is a lower-end

product), can provide high-resolution scans of your images inexpensively.

So long as you have the option when scanning, you should make a scan that fits your

targeted need. In other words, know the purpose of your scans before you make them, and

don’t just blindly scan to the maximum capability of the scanner. Scan to exactly the size

you need to cut down on the need for interpolation, unless you have a good reason to do

otherwise. The size you need can be determined by the print resolution and the target

range for image output that we looked at in Chapter 1, in the section “What Image Reso-

lution to Use.” Making your scans to the target size will require selecting options for reso-

lution, and perhaps other settings such as scaling, in your scanner software before making

the scan. These settings vary from scanner to scanner, so be sure to familiarize yourself

with the settings by reading the manual and exploring the scanner’s software.

Digital Cameras and Resolution

Digital camera resolution is weighted in pixel dimension, total pixels (megapixels), or

both. While that is useful as a comparison between cameras, it doesn’t tell you how big the

resulting images will be. Table A.2 offers a brief overview using common camera abilities

and maximum output size (in inches).

M A X .  N E G A T I V E /

C H R O M E  O U T P U T

( 6 5 0  D P I )

640×480 307,200 6.7×5 3.2×2.4 1×0.75

1024×768 786,432 10.7×8 5×3.75 1.5×1.1

1280×960 1,228,800 13.3×10 6×4.75 1.8×1.5

1600×1200 1,920,000 16.7×12.5 8×6 2.5×1.8

2048×1536 3,145,728 21.3×16 10×7.5 3.1×2.3

2400×1800 4,320,000 25×18.75 12×9 3.7×2.8

2500×2000 5,000,000 26×20.8 12.5×10 3.9×3.1

3072×2048 6,291,456 32×21.3 15.4×10.3 4.7×3.1

4536×3024 13,716,864 47.3×31.5 22.7×15.1 7×4.7

M A X .  F I N A L

S I Z E  F O R

P H O T O - Q U A L I T Y

( 2 0 0  D P I )

M A X .  F I N A L  

S I Z E  F O R  W E B /

M O N I T O R  ( 9 6  D P I )

T O T A L

P I X E L S

C A M E R A

R E S O L U T I O N

Table A.2

Common Camera
Resolutions
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When using your digital camera, pay attention to the resolution rather than the num-

ber of images you can get onto your memory card. Some people make the mistake of sac-

rificing image resolution to get more pictures on their card. It’s better to buy more cards.

Unlike using a scanner, your capture of a scene with a digital camera may be your only

opportunity to make the capture; unless there is a specific reason to use a lower resolution,

leave the camera set to the maximum pixel dimension or highest resolution.

Monitor Resolution and Settings
Monitor resolution affects how images appear on-screen. Most people will set monitor res-

olution to the highest setting suggested by the manufacturer and assume that it is cor-

rect—or assume that it doesn’t matter. If you set your monitor resolution too high

(greater than the monitor was built to handle), you can lose detail rather than improve it,

and images can appear too small. If you set the resolution too low, objects on screen will

appear larger than they should, and you won’t take advantage of the viewing landscape on

your monitor.

The maximum monitor resolution setting is dictated by the monitor’s viewing size and

dot pitch. Viewing size is simply the monitor area; dot pitch is, essentially, the resolution—

the number of image dots that can be represented. The greater the viewing size or the

lower the dot pitch, the more information the monitor can show. A larger monitor 

will tend to have a higher dot pitch than a smaller one. Monitors with lower-dot-pitch will

tend to look sharper.

There are more complicated means of selecting a monitor display resolution, but in my

estimation choosing the “right” resolution is choosing the resolution that makes the image

appear correctly sized on-screen. This choice also pretty much eliminates the possibility

that your monitor doesn’t have enough resolution. Any monitor with a dot pitch of less

than .28 (about .22 horizontally) should be able to handle the range that I suggest while

viewing sharply. This does not mean that having a higher-resolution monitor is wasted;

finer dot pitch almost always translates into finer image display. Using a higher resolution

can also have the advantage of making palettes and menus smaller, leaving more space on

the screen to work.

Table A.3 is a guideline to help you create an accurately sized image on-screen, and will

give you a target to shoot for. It may not be exact, because there are variables in displays,

but it should take you closer than just guessing at a size or choosing the maximum sug-

gested resolution willy-nilly (or based on what you think might look good when you have

the monitor control panel open). The point is that when you choose View ➔ Print Size,

your image will be close to displaying on-screen at the size you intend to use it.
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D I A G O N A L  V I E W  S I Z E 7 2  P P I  R E S O L U T I O N 9 6  P P I  R E S O L U T I O N

23″ 1600×1200 1920×1200

21″ 1280×1024 1600×1200

19″ 1152×870 1280×1024

17″ 1024×768 1152×870

15″ 870×640 1024×768

13″ 800×600 870×640

Monitor screen size is measured from corner to corner diagonally rather than as height

or width. If you are unsure of your monitor size, a quick measure of the diagonal surface

area of the screen will tell you approximately what the view size is for your monitor.

Choose an available display resolution in the monitor control panel that falls between the

range shown in the table (between 72 and 96 ppi) to get the most accurate sizing.

If you prefer to have a very accurate view of print size on-screen, you can choose your

resolution roughly and make adjustments in the horizontal and vertical projection of the

monitor to make the display dimensions nearly exact. To do this, you can match a display

ruler (show rulers on an open image displaying at 100 percent) to a household one by

using horizontal and vertical screen controls.

Number of Colors

You may be able to change your color settings to anything between monochrome and 

32-bit color in your control panel, and as with resolution, it might be tempting to always

pick the maximum. These settings may be presented as bits or number of colors (depend-

ing on the operating system and the utility or control panel you are using for the setting).

The more bits or colors, the more true-to-life color can be; at the same time, the more taxing

the color processing can be, so this may result in fewer options for refresh rates (see the fol-

lowing section for more information on refresh rates). Optimally you will want to choose

to display the most bits you can, but if you have a less powerful video card and a large mon-

itor, or if your refresh rate options are limited, it may be best to choose fewer bits or colors

as a trade-off. Your images store 24-bit information (3×8 bits) in Photoshop Elements at

maximum, so displaying at 32-bit is not necessarily better for viewing image color.

Refresh Rate

Refresh rate is the frequency at which an image on the screen is updated or refreshed. The

rate is measured in Hertz (Hz). The higher the frequency (the more Hz), the faster the

screen refreshes. The faster it refreshes, the less likely you are to detect flicker, and the

more likely that your view of changes and movement on the screen (such as the cursor)

Table A.3

Common
Monitor Sizes and

Resolutions
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will seem smooth. Quick refresh rates can also reduce eyestrain. This can be important if,

like some of us, you spend a lot of time staring at your monitor.

Use only suggested refresh rates for your monitor and video card or you can run the

risk of damaging your equipment. Refresh rates should be as fast as you can make them

within the manufacturer’s suggested range without cutting into other display properties

that reduce performance in other ways (see the previous section).

Output Resolution
Table A.4 shows some real-world examples of output resolution and workable ppi ranges.

Calculations for the table were based on the formulas shown in the Calculation Used col-

umn; square brackets in the calculations indicate the range of values used to determine the

lowest and highest resolution acceptable in that media. This table can be handy for choos-

ing a rough estimate of file size, and you can use the equations for calculating more spe-

cific results. The table also assumes you will be printing the image at 100 percent of the

image size; resizing the image in layout or another program will affect the calculations.

Check with your printing service for their recommendations before blindly assigning these

estimates.

M E D I A C A L C U L A T I O N

U S E D

Web page Mac/PC monitor 72–96 ppi ppi = dpi

Poster plotter 300 dpi printer resolution 100–150 ppi [0.33 to 0.5] × dpi

Inkjet (stochastic) prints 720 dpi 180–234 ppi [1 to 1.3] × (dpi / 4)

Inkjet (stochastic) prints 1440 dpi 360–468 ppi [1 to 1.3] × (dpi / 4)

Newsprint 75–120 lpi 117–240 ppi [1.55 to 2] × dpi

133–175 lpi 207–350 dpi [1.55 to 2] × lpi

Art publications 175–200 lpi 271–400 ppi [1.55 to 2] × lpi

Line art Printer output resolution 600–1342 ppi (dpi / 600)
1⁄2 × 600

Film recorder 4K lines, 35 mm 2731×4096 pixels Total pixels

Film recorder 8K lines, 2.5+ in. 5461×8192 pixels Total pixels

Interpolation
Say you have a pixel-based image at 5×7 inches and it has 300 ppi. That will print well to a

variety of outputs at the original size (although there may be too little or too much resolu-

tion for some options). If you want to resize the image or apply it at a different size by

changing the dimension, the ppi, or both, there are many possible results. Table A.5 looks

at these possibilities (all based on an original image that is 5×7 at 300 ppi).

Coated paper (books,
magazines, etc.)

A P P R O X I M A T E  F I L E

R E S O L U T I O N  ( P P I )

M E D I A

R E S O L U T I O N  B A S E Table A.4

Approximate
Resolutions for 
Various Media
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R E S U L T C O M M E N T

Bicubic 8×10 300 The result will probably not
be much better than apply-
ing the original image with-
out interpolation. It will
likely be a bit soft. Image
content may affect the
results. Bicubic interpolation
works best with blended
tones (photographs).

Nearest Neighbor 8×10 300 The result will be almost
exactly like applying the
original image without inter-
polation. It will likely be a bit
soft, and may be blockier
than Bicubic interpolated
results. Image content may
affect the results. Nearest
Neighbor interpolation
works best with solid color
and lines (screenshots).

Bicubic 8×10 72 Even though the size of the
file increases in this case, the
result is less information in
the file because of the lower
ppi. While this 8×10 may dis-
play fine on-screen and on
the Web, the result in print
will most likely be soft and
undesirable.

None 8×10 210 This will provide a very 
similar result to applying 
the image at increased ppi.
The resolution could proba-
bly be better targeted to the
desired output.

Bicubic 5×7 600 This file will have too much
resolution for just about any
type of output. It can slow
processing and increase file
sizes unnecessarily, without
improving output quality.

No change None 5×7 300 This is the targeted 
application of this pixel-
based image.

Continues

Applied at file
dimensions.

Increasing the num-
ber of pixels causes
image information
to be added or
faked.

Increase (double)
the ppi

Proportional changes
in ppi and dimension
result in the same
image information
being distributed over
a new area. There is no
change in file informa-
tion (or file size).

Increase file
dimension with-
out interpolation

Disproportional
changes in ppi and
dimension (in this case,
decreasing the ppi dra-
matically while increas-
ing the dimension)
cause image informa-
tion to be changed (in
this case, lost).

Increase file
dimension with
lower ppi

Increasing the num-
ber of pixels causes
image information to
be added or faked.

Increase file
dimension with
same ppi

Increasing the num-
ber of pixels causes
image information
to be added or
faked.

Increase file
dimension with
same ppi

E F F E C T I V E

I M A G E  P P I

A P P L I E D

I M A G E  S I Z E

( I N C H E S )

I N T E R P O L A T I O N

M E T H O D

D E S I R E D

C H A N G E
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Continued

R E S U L T C O M M E N T

Decrease ppi Bicubic 5×7 72 While this can be fine for the
Web, this file will have too
little resolution for most
types of printed output. It
may look fine on-screen, but
that shouldn’t be the deter-
mining factor.

None 3.5×5 429 By decreasing the file dimen-
sion without interpolating,
this file will have too much
resolution for just about any
type of output. It can slow
processing and increase file
sizes unnecessarily.

Bicubic 3.5×5 72 This image takes a double
whammy in decreasing both
dimension and ppi. While it
will be suited to screen dis-
play (and may not look too
different on-screen than the
display of the two options
that follow), results in print
will probably not be
satisfactory.

Nearest Neighbor 3.5×5 300 Resizing an image smaller is
usually less damaging to the
result than attempting to
add information to the
image. While making images
smaller shrinks the pixel base
and merges and loses infor-
mation, it tends to matter
less than increasing image
size. Nearest Neighbor inter-
polation, unless used with
great care, is not usually your
best choice in decreasing
image size. Results will prob-
ably be better in most cases
with Bicubic (or perhaps
Bilinear) interpolation.

Bicubic 3.5×5 300 Generally it is fine to repur-
pose an image by decreasing
its size. Because the result will
merge and blur somewhat,
sharpening is recommended.
Using Bicubic resizing actu-
ally invests a little sharpening
for you, so that additional
sharpening may not be nec-
essary. If possible, work with
images at the intended size
for best results.

Disproportional
changes in ppi and
dimension (in this case,
decreasing the dimen-
sion while retaining
ppi) cause image infor-
mation to be changed
(in this case, lost).

Decrease file
dimension with
higher ppi

Disproportional
changes in ppi and
dimension (in this
case, decreasing the
dimension while
retaining ppi) cause
image information to
be changed (in this
case, discarded or lost).

Decrease file
dimension with
higher ppi

Decreasing file dimen-
sion and ppi at the
same time removes
information from the
image.

Decrease file
dimension with
lower ppi

Proportional changes in
ppi and dimension result
in the same image infor-
mation being distributed
over a new area. There is
no change in file infor-
mation (or file size).

Decrease file
dimension with-
out interpolation

Decreasing ppi and
keeping the dimen-
sions the same
removes informa-
tion from the image.

E F F E C T I V E

I M A G E  P P I

A P P L I E D

I M A G E  S I Z E

( I N C H E S )

I N T E R P O L A T I O N

M E T H O D

D E S I R E D

C H A N G E
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File Types
When saving an image, you have to select a file type. To choose the right one, it is handy to

know what the available file types are and generally what they are used for. Table A.6 gives

a brief overview of file types supported when saving from Photoshop Elements. Other file

types are supported as “open only,” meaning that you can open the files, but you will have

to save them as something else.

F I L E  T Y P E S A V E  A S  C O L O R  M O D E S P U R P O S E / U S E

Photoshop document (PSD) All Native Photoshop Elements format.
Store working/in-progress Photo-
shop images.

Bitmap (BMP) All Traditionally a Windows-based file
format. PC screenshot format. Loss-
less compression.

All Web graphics. Uses an indexed-color
palette (256 colors max) to achieve
compression—colors are converted
during save if not already indexed.
Conversion to GIF from images with
more than 256 colors will cause
image information loss.

Encapsulated PostScript (EPS) All Mostly used in PostScript printing to
retain vector, pixel, and separation
information. Does not support
alphas. Can use JPEG compression.

Grayscale, RGB Often used for full-color web graph-
ics, and digital camera image storage.
Uses variable, lossy compression in
storage, which can damage images
over repeated saves. Better color
retention than GIF.

PC Exchange (PCX) All Another bitmap format like PCT and
BMP. Uses lossless compression.

Portable Document Format (PDF) All Designed by Adobe Systems to allow
viewing of PostScript-encoded docu-
ments (using Acrobat products such
as Reader). Uses compression includ-
ing lossless ZIP encoding and lossy
JPEG. Compression can be controlled
separately for color, grayscale, and
monochrome (bitmap) images. Highly
portable between platforms and used
broadly in print applications.

Photoshop 2.0 All Native Photoshop format with back-
ward compatibility to earlier versions.

PICT file (PCT) All The Mac equivalent of
Windows BMP.

Continues

Joint Photographic Experts
Group (JPEG)

CompuServe Graphics Inter-
change Format (GIF)

Table A.6

File Types to Save In
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Continued

F I L E  T Y P E S A V E  A S  C O L O R  M O D E S P U R P O S E / U S E

PICT resource (RSR) All Files used in resource forks (such as
icon graphics).

Pixar Computer Image (PXR) Grayscale, RGB Specially designed for Pixar Image
workstations, for editing rendered
graphics to return to a Pixar format.

Portable Network Graphics (PNG) All Developed as a royalty-free replace-
ment for GIF. Supports transparency
and animation (but not via Elements).
Supports both lossless and lossy com-
pression (but not via Elements).

Photoshop RAW (RAW) Grayscale, Indexed Color, RGB Undefined or raw image data. No
compression. Can be used for cus-
tom deciphering or encoding of file
formats that are otherwise unsup-
ported by Photoshop. Similar to but
not the same as Camera RAW.

Scitex Continuous Tone (SCT) Grayscale, RGB Developed by Scitex for proprietary
image-processing systems. Used
with high-end scanning devices. No
compression.

Targa (TGA) Grayscale, Indexed Color, RGB Most common in the video industry;
also used by high-end paint and 
ray-tracing programs because of
expanded bit depth. For specific
application in video output. No 
compression via Elements.

Tagged Image File Format (TIFF) All A broadly used, general-purpose file
type for printed output. Supports
most native Photoshop Elements 
file features. Supports lossless 
compression.

Wireless BMP BMP For application on wireless networks.

Compression
Compression is a means of making image files smaller. It occurs when saving files as part of

the file type, or it can be applied after saving by using a file compression utility.

Some file compression encoding is known as lossy in that it loses original image infor-

mation during processing. In some instances, it’s okay to sacrifice some image quality for

file size. For example, JPEG is a lossy format used on the Web to speed image transfer.

However, in most cases you should stick to lossless compression to retain the quality of

your images. Beware of lossy compression that gets reapplied each time you save. JPEG

compression, for example, is reapplied each time you open and then save the file, so image

quality will steadily degrade over time if you continue to use JPEG format.

Compression that is applied as part of the file format (JPEG, LZW, GIF, and so on) is

different from file compression. File compression is done with utilities (ZIP, SIT, SEA,
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MIME, and so on). Utility compression is always lossless as it acts on the file information

independent of it being an image. Image-type compressions may act on image informa-

tion directly to achieve compression.

Bit Depth
Bits and bit depth have been known to cause confusion, and understanding them may be

important to freeing those ghosts from the closets in your mind. A big deal is made of 16-bit

image editing, or how many bits a scanner or camera can capture. If you don’t have the foggi-

est idea what bits are, that can lead right to the bus stop of confusion. If you know, you can

make intelligent decisions about how important specifications really are to your image editing.

Bits represent how exactly color can be measured. They are the little encoded 1s and 0s

used in computer language to describe an image. Each pixel color in your image is described

by the bits. The more bits, the greater the potential accuracy of the color in each pixel.

Bits themselves are just tiny chunks of information—sometimes described by the term

binary. All that term means is that each bit used in your files can have one of two values:

either on (1) or off (0). If an image is 1-bit, each pixel in the image can be on or off: black

or white. The more bits per pixel, the more complex the relationship gets, and the more

color variations can be represented.

If your image is a 2-bit image, each bit has two potential values, and these values can be

paired in any of these four combinations: 00, 01, 10, or 11 to define the pixel. Each addi-

tional bit per pixel adds a multiple of two combinations, one additional set of combina-

tions for each additional bit. Just to show how quickly this can add up, if a third bit were

added to your two-bit image, this would result in the following set of possibilities for each

pixel: 000, 001, 010, 011, 100, 101, 110, 111—a total of eight possible combinations. So

each time another bit is added, there are twice as many possible combinations—one addi-

tional full set of possibilities for each of the two possible values of the bit.

To determine the total number of bit combinations, all you have to do is multiply by

two for each bit. Eight bits per channel would be 2 × 2 × 2 × 2 × 2 × 2 × 2 × 2 (or 28), total-

ing 256 combinations. However, this can get a little murky. Following that logic you

would think that a 24-bit image would be 224, representing 16 million colors. That is cor-

rect. But when describing an RGB image, 24-bit images can be described as 8-bits per

channel. That is, each of the three channels is allotted 8 bits. These three groups of 8 bits

describe the 256 tonal possibilities for each channel: red, green, and blue. Each of the col-

ors has 256 possibilities that can be combined in any fashion. Whether you multiply 224,

or 256 × 256 × 256, you get the same number of bit combinations: 16,777,216. That is how

many colors each pixel can represent in 24-bit color.

Bit terminology can be confusing because bit depth can be referred to as bits per channel

or total bits. If used with care, this shouldn’t pose a problem, but it can be confounding
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when you discover a 16-bit image actually has more image information than a 24-bit color

scan. Be sure you are comparing either total bits per pixel or bits per channel when looking

at specifications or comparing images. Comparing bits per channel to total bits is like com-

paring grayscale and color images…different representations of the same thing, but they

are not equivalent.

If you add bits, you add potential colors: if you have an image with 30 bits, there would

be 10 bits per channel, or 1024 bit combinations per pixel per color, or 1,073,741,824

potential combinations. That is 64 times as many color combinations as 24-bit, with only

a few more bits per pixel.

In other words, increased pixel depth exponentially increases the color possibilities,

which is why increased color depth is considered potentially so valuable in color work.

The negative effect of increased bit depth (for example, to 16-bits per channel from 8-bit)

is increased image size. There is also some question as to the value of increased bit depth.

In fact, it seems almost useless for anything but initial corrections for two reasons:

• If you have 16 million colors, it is not incredibly likely that having even more is going

to have a lot of effect on the way you see an image.

• Output in most cases can’t reproduce more than 24-bit color.

Increased bit depth can improve the capture of detail in poorly exposed images and

may be desirable for archiving. However, 8-bit is more than most people actually need.

(For more about 16-bit images, see the “16-bit Images” sidebar in Chapter 1.)

Blending Modes
Blending modes are a means of calculating a result between source and target information

in your image. Blending modes can be applied with brushes or layers. A blending mode

controls how the content (a layer or brush) is applied, based on the image content. When

a mode is used with a painting tool, Photoshop Elements uses the brush content as the

source (foreground color) as if the color were being applied in a layer, using the selected

brush dynamics. Brush applications change the content of the layer you are painting on to

achieve the result; layer modes cause a visual (rather than actual) change based on calcu-

lated interaction with all image information below the layer.

Modes can create effects by using calculations based on select color components. For

example, the result might be a calculation involving red, green, and blue components

(tone and color together), or a calculation based on luminosity, color, or other compo-

nents. Table A.7 describes the blending modes available in Elements.

Adobe is pretty stingy with the exact calculations involved in blending modes. The descrip-

tions are actually obfuscated by the language used to describe them. To simplify: the more

obscure and difficult to calculate, the less useful the mode will tend to be in normal use.
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B L E N D  M O D E Q U I C K  K E Y E F F E C T

Normal Shift+Option+N / Shift+Alt+N Plain overlay of content. The result takes on the
color/tone of the pixels in the upper layer.

Dissolve Shift+Option+I / Shift+Alt+I The result takes on the color/tone of the pixels in
the upper layer, but the result is dithered (random-
ized) according to the opacity of the application.
The greater the opacity, the more the selection is
weighted to the upper layer. 100% opacity will pro-
duce a 0% Dissolve effect; 50% opacity indicates
50% of the result has the applied color.

Darken Shift+Option+K / Shift+Alt+K Chooses the darker color value set for each pixel in
comparing the two layers. Uses either the applied
color or the original. No portion of the image gets
lighter.

Multiply Shift+Option+M / Shift+Alt+M Darkens the result by darkening the lower layer
based on the darkness of the upper layer. Any
applied tone darker than white darkens the result.
No portion of the image can get lighter.

Color Burn Shift+Option+B / Shift+Alt+B Burns in (darkens) the color of the underlying layer
with the upper layer, darkening the result. No por-
tion of the image gets lighter. The greater the differ-
ence between pixel colors, the greater the change.

Linear Burn Shift+Option+A / Shift+Alt+A Similar to Multiply but somewhat more extreme.

Lighten Shift+Option+G / Shift+Alt+G Chooses the lighter color value set for each pixel in
comparing the two layers. Uses either the applied
color or the original. No portion of the image gets
darker.

Screen Shift+Option+S / Shift+Alt+S Brightens the result by lightening the lower layer
based on the lightness of the upper layer. Any color
lighter than black lightens the result. No portion of
the image can get darker.

Color Dodge Shift+Option+D / Shift+Alt+D Dodges (lightens) the color of the underlying layer
with the upper layer, lightening the result. No por-
tion of the image gets darker. The greater the differ-
ence between pixel colors, the greater the change.

Linear Dodge Shift+Option+W / Shift+Alt+W Similar to Screen but the result is more extreme.

Overlay Shift+Option+O / Shift+Alt+O Multiplies (darkens) the light colors and screens
(lightens) the dark ones. Colors at light and dark
extremes are affected less than midtones.

Soft Light Shift+Option+F / Shift+Alt+F Multiplies (darkens) the dark colors and screens
(lightens) the light ones depending on the applied
color. If the applied color is light, the pixel lightens; if
dark, it darkens. Soft, or 50% application of the
upper layer.

Hard Light Shift+Option+H / Shift+Alt+H Multiplies (darkens) the dark colors and screens
(lightens) the light ones. 100% application of the
upper layer.

Vivid Light Shift+Option+V / Shift+Alt+V Similar to Color Burn when the applied color is
darker than 50% gray; similar to Color Dodge when
the applied color is lighter than 50% gray.

Continues

Table A.7

Photoshop Elements
Blending Modes

330 ■ appendix: Other Concepts and References

4385cA.qxd  11/7/04  11:45 PM  Page 330



Continued

B L E N D  M O D E Q U I C K  K E Y E F F E C T

Linear Light Shift+Option+J / Shift+Alt+J Similar to Linear Burn when the applied color is
darker than 50% gray; similar to Linear Dodge when
the applied color is lighter than 50% gray.

Pin Light Shift+Option+Z / Shift+Alt+Z Similar to Multiply when the applied color is darker
than 50% gray; similar to Screen when the applied
color is lighter than 50% gray.

Difference Shift+Option+E / Shift+Alt+E Reacts to the difference between pixel values. A
large difference yields a bright result; a small differ-
ence yields a dark result (no difference yields black).

Exclusion Shift+Option+X / Shift+Alt+X Uses the darkness of the original layer to mask the
Difference effect (described previously). If the origi-
nal value is dark, there is little change as the result; if
the original color is black, there is no change. The
lighter the original color, the more intense the Dif-
ference effect.

Hue Shift+Option+U / Shift+Alt+U Changes the Hue of the original to the applied while
leaving the Saturation and Luminosity unchanged.

Saturation Shift+Option+T / Shift+Alt+T Changes the Saturation of the original to the
applied while leaving the Hue and Luminosity
unchanged.

Color Shift+Option+C / Shift+Alt+C Changes the Hue and Saturation of the original to
the applied while leaving the Luminosity
unchanged.

Luminosity Shift+Option+Y / Shift+Alt+Y Changes the Luminosity of the original to the
applied while leaving the Saturation and Hue
unchanged.

Camera RAW Files
RAW is not an acronym; it simply stands for raw, as in raw image data. RAW files have

been around for a long time. In fact, you could open and save to a type of RAW file (Pho-

toshop RAW) in Photoshop Elements 1. When you open one of these RAW files you get a

dialog that allows you to put in parameters to decipher the image data (see Figure A.2).

The RAW (or Photoshop RAW) file format was

meant to provide the user a means of opening and

saving nonstandard image files—possibly created

before there were digital image standards, or devel-

oped with nonstandard processing (for example, in

scientific imaging). If you only had the file and did

not know how to open it up and what parameters to

use, you would have a very difficult time opening

the image because you’d have to guess at what was

stored in the files and how that translated into the

Photoshop RAW parameters—if it did at all.
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Figure A.2

The Photoshop RAW
options allow the
user to decipher
image structure by
choosing bit dimen-
sion, channel count
and bit depth, and
header length infor-
mation.
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RAW files that you get off your camera are really just another type of RAW file, though

they are handled in a much different (and friendlier way) by Elements 3, using the Camera

RAW plugin. These RAW camera files are assembled from the raw data captured by your

digital camera into proprietary image formats. You might think that is the same as any

image your camera spits out, but that isn’t exactly true. Before you download images from

your camera as JPEG or TIFF images, they start out as raw data; they are encoded, processed,

and turned into one of the more familiar digital file formats so that they can be used with

popular image editing programs. RAW files will be raw data, and all will be called RAW files,

but all RAW files will not all be constructed the same way. If fact, the file types that come off

different cameras as RAW can have unique file extensions depending on the manufacturer.

The Camera RAW plugin in Elements has the ability to recognize many of these RAW file

types, and it will automatically decipher the files and present them in the Camera RAW dia-

log, which you can then use to do some initial adjustment to the raw data from the image.

The processing that occurs in the Camera RAW plugin includes interpreting and merging

captured information. Similar to the way Prokudin-Gorskii’s captured images, the camera

will capture image information in a grid of tiny sensors that are filtered for red, green, or

blue light. The camera then takes the information from smaller groups of sensors and inter-

polates a result, because red, green, and blue are not usually captured in exactly the same

sensor area (there are exceptions, such as tri-sensor cameras, or X3 technology). While this

composite will likely be an adequate representation (better at higher resolutions), it may or

may not be the ultimate representation of the original image data. After all, the camera does

not have the slightest idea of image key, and it can’t read your mind to interpret your artistic

intent for the image. On top of that, standard TIFF or JPEG images may be stored in 8-bit

file formats rather than at the bit depth in which they were captured. The process of interpo-

lation and compression necessarily compromises image data; as with interpolated results

from resizing, you are left with the calculated result, whether that’s good or bad.

The Camera RAW plugin lets you control how the raw data gets combined. Making

adjustments in the dialog is an opportunity to get the most out of information captured

by the camera, plain and simple. If your camera shoots in 12-bit and produces an 8-bit

JPEG that is stored on your camera’s media, many calculations happen along the way to

compile the image from the RAW data and shrink the file size. This can be stated another

way: the process of storing the file compromised original capture data with a loss in

Adobe’s new DNG (Digital Negative) file format is an attempt by Adobe to standardize (or cre-

ate an open standard for) RAW camera images. Their hope would be that this file type would be

used widely as a standard by manufacturers to remove the possibility of increasing the already

large number of proprietary RAW file types. Adobe offers a DNG converter for free that works

with many file types. You can download it here: http://www.adobe.com/products/dng/.
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potential for the ultimate image quality. This loss may not be huge, and in some shots you

may not notice it at all (in comparing RAW and JPEG). The images where you will not see

a big difference are those that are properly exposed. However, the latitude that you have in

working on an image and coming up with what you need from the RAW data (and later in

16-bit) is worth the extra processing time for those who are serious about their images. If

you already know about exposure, aperture, and composition, and have some experience

in digital image processing, you might shoot RAW images to give yourself more to work

with in achieving the goals of your images in post-processing—and perhaps to give your-

self better data to store as the source of your image captures in your archives.

In other words, just as a user might appreciate the speed of automated processing when

using Auto Levels or Auto Contrast, setting your camera to store JPEG images might be a

godsend because the process is completed for you. However, if you don’t shoot only statues

outside on an overcast day at noon or so...then you may have more creative vision as to what

makes an interesting image. If you shoot scenes with a lot of potential for manipulating

shadow detail or highlights (low-key or high-key images), you would certainly like the advan-

tage you have in manipulating the images from your RAW originals. If you shoot a rock con-

cert, for example, the latitude you gain in manipulating the highlights, shadows, and light

color would certainly favor storing RAW files. You would more likely be able to make drastic

manipulations to the RAW, high-bit image without causing or enhancing damage that could

be introduced by overworking the image in 8-bit or by enhancing the JPEG compression

damage.

You can look at the RAW format as the ultimate archive version of an image, because

there is no compression, artifact, or other adjustment made by the camera before deliver-

ing the image—all you have is the raw capture data. This can enable you to make adjust-

ments and compensation to the capture, rather than the standard conversion enforced by

on-camera processing.

Working with RAW Images from Your Camera
Even though you can open a RAW file in Photoshop Elements, getting the camera to store

RAW files is a distinct matter. Not all cameras will allow you to save files in RAW formats.

To process the RAW data, your camera will have to offer a RAW save option and you will

have to change the camera settings to store the data in the camera’s RAW format. See your

owner’s manual for these instructions.

To handle your camera’s RAW images, you will most likely be able to use either propri-

etary software provided with the camera, or Photoshop Elements 3. Elements 1 and 2 do

not handle RAW files that come from your camera without the Camera Raw plug-in. The

Camera Raw plug-in is standard in Elements 3, and it enables you to open many types of

camera RAW files from the native data. The plug-in will open automatically when you

attempt to open a recognized RAW image file (see Figure A.3).
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When you open the image by using Elements, you will be presented with the dialog box

and can make adjustments that you prefer by using the on-screen preview as a visual

guide. Settings that you choose can be saved and used in actions and batch processes so

that you can process your RAW images in bulk. More interesting, you can store and

archive the camera’s RAW files, and at a later date process them differently if a different

interface or process becomes available.

The Camera Raw dialog includes sliders that help you adjust color Temperature, Tint,

Exposure, Shadows, Brightness, Contrast, Saturation, Sharpness, Luminance Smoothing,

and Color Noise Reduction. Other settings that effect the output are bit depth selection

(you can choose 8- or 16-bit) and rotation. Controls that only affect what you see on

screen include preview size (as a percentage of pixels viewed) and clipping previews

(Highlight and Shadows). You can do all this while looking at a preview and a color his-

togram that provide clues as to the best mixture of these elements in the image. Some of

the adjustments may be better deployed during correction stages, so do not feel obligated

to use every slider, and don’t attempt to make the image look perfect in the preview. In

some cases you will not even want to make an adjustment at this stage.

Figure A.3

When you open an
image saved in a

RAW file format, this
dialog appears,

allowing you the
opportunity to con-
vert the image data.
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C U R R E N T L Y  S U P P O R T E D  C A M E R A S

As of this writing, the Camera RAW plugin supports the following camera types. The list of sup-

ported cameras may be enhanced by Adobe over time as new cameras come on to the market

and upgrades to the plugin are made available. Check Adobe’s site (http://www.adobe.com)

or the Hidden Power of Elements site (http://www.hiddenelements.com) for updates and

information.
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Canon

• EOS-10D

• EOS-1Ds

• EOS-1D

• EOS-1D Mark II

• EOS-D30

• EOS-D60

• EOS-300D

• (Digital Rebel/Kiss

Digital)

• PowerShot 600

• PowerShot A5

• PowerShot A50

• PowerShot Pro 1

• PowerShot S30

• PowerShot S40

• PowerShot S45

• PowerShot S50

• PowerShot G1

• PowerShot G2

• PowerShot G3

• PowerShot G5

• PowerShot Pro70

• PowerShot Pro90 IS

Contax

• N Digital

Fuji•lm

• FinePix F700

• FinePix S5000 Z

• FinePix S7000 Z

• FinePix S2 Pro

Kodak

• DCS 14n

• DCS Pro 14x

• DCS720x

• DCS760

• DCS Pro SLR/n

Konica Minolta

• DiMAGE A1

• DiMAGE A2

• DiMAGE 5

• DiMAGE 7

• DiMAGE 7i

• DiMAGE 7Hi

Leaf

• Valeo 6

• Valeo 11

• Valeo 22

Leica

• Digilux 2

Nikon

• D1

• D1H

• D1X

• D100

• Coolpix 5700

• Coolpix 5000 (with

•rmware v.1.7)

• Coolpix 8700

Olympus

• E-10

• E-1

• E-20

• C-5050 Zoom

• C-5060 Zoom

• C-8080 Wide Zoom

Panasonic

• DMC-LC1

Pentax

• *ist D

Sigma

• SD9

• SD10

Sony

• DSC-F828
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Adjustments that you do make will often be to retain the best image information possi-

ble. This means you will want to balance the histogram while getting a preview that looks

good. Balancing the histogram in this case means expanding the dynamic range of the

white area of the graph, while maintaining the balance of colors and keeping the individ-

ual color components from clipping (not shifting one of the three component colors too

far into the highlights or shadows so that you lose captured detail). Each of the controls

will help balance image qualities differently—but usually intuitively (see Table A.8).

C O N T R O L U S E / D E S C R I P T I O N

Settings Enables the user to select preset, custom, or previous settings used with the plugin.
Selected Image uses the settings from the previous conversion; Camera Default
uses default settings that you created for the camera or from the image as shot (if
no default is stored); Previous Conversion uses the last settings used to process
images from this camera. To store a default, adjust the sliders as desired and
choose Set Camera Default from the pop-up menu to the right of the Settings.

White Balance Adjusts Temperature and Tint based on selection from the drop list. Drop list 
selections include: As Shot (from image data), Auto (automatically balanced), Day-
light (normal daylight, 5500 degrees Kelvin), Cloudy (cool, overcast lighting 6500
degrees Kelvin), Shade (cool light full shade, 7500 degrees Kelvin), Tungsten (bal-
anced light, 2850 degrees Kelvin), Florescent (greenish light, 3800 degrees Kelvin),
Flash (balanced light, 5500 degrees kelvin), Custom (manual slider settings). White
balance can be sampled from the image using the eyedropper tool from the upper
left of the palette; just click on what should be a gray area of the image.

Temperature Enables correction for the ambient color temperature (white balance). The plugin
will counter the correction by warming or cooling the image color. Moving the slider
to the right increases the ambient color temperature and warms as a result (com-
pensates for images taken on an overcast day). Moving the slider left decreases the
ambient color temperature and cools the image as a result (compensates for warm
images such as those taken with unbalanced incandescent light).

Tint Allows the user to balance the magenta/green tint of the image and counter bal-
ance the changes made by using the Temperature slider. Moving the slider right
increases the influence of magenta; moving the slider left increases influence of
green.

Exposure Exposure simply lightens or darkens an image by increasing (right) or decreasing
(left) exposure. Checking the Auto box will automatically select a balanced expo-
sure based on other existing settings.

Shadows Enhances the influence of shadows in the image. Moving the slider to the right
darkens the image; moving it to the left lightens image. Checking the Auto box will
automatically select a shadow presence based on other existing settings.

Brightness Enhances the influence of highlights in the image. Moving the slider to the right
lightens the image; moving it to the left darkens the image. Checking the Auto box
will automatically select a highlight intensity based on other existing settings.

Contrast Enhances image contrast. Moving the slider to the right increases global image
contrast; moving the slider left decreases image contrast. Checking the Auto box
will automatically select a contrast based on other existing settings.

Saturation Much like the Saturation slider on the Hue/Saturation dialog. This is used for adjust-
ing color saturation in the image globally. Moving the slider to the right increases
saturation; moving the slider left decreases saturation.

Continues

Table A.8

Camera RAW
Controls
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Continued

C O N T R O L U S E / D E S C R I P T I O N

Sharpness Enhances local contrast in the image much like the Unsharp Mask filter. Moving the
slider to the right increases the local contrast, sharpening the image; moving the
slider to the left decreases the intensity of the sharpening.

Luminance Smoothing Helps to attenuate tonal noise somewhat like blurring. Moving the slider to the
right increases the softening, moving the slider to the left reduces the intensity of
the blur.

Color Noise Reduction Mediates color noise. Moving the slider to the right increases mediation; moving
the slider left decreases mediation.

Bit Depth Enables the user to open the image at standard 8-bit depth or use the RAW file bit
depth to render a 16-bit image. If selecting 16-bit, RAW camera images with less
than 16-bit will be converted to 16-bit so no image information is lost. Select the
desired result from the drop list.

Rotation Rotates the image for the preview and opened image. Clicking the rotate button at
left rotates 90 degrees counterclockwise; clicking the rotate button at right rotates
the image 90 degrees clockwise.

Auto These check boxes appear above adjustment sliders for Exposure, Shadows, Bright-
ness and Contrast. When they are checked, the corresponding slider will adjust
automatically whenever you change any of the other settings.

Advantages and Disadvantages of 16-bit?
Once your images are processed and you are ready to go to print, you will be printing to

an 8-bit color device (I don’t know any printers that claim to handle 16-bit images). This

is a current technological impasse, which may be changed in the future, as 16-bit images

haven’t been around all that long in common practice. However, whether printing to 8-bit

with 16-bit information is a “loss” at this point is questionable. Technically you will be

changing from trillions of colors to millions, but the difference might be beyond human

perception.

The real thing that you are trying to do with RAW files is not to print them; it is to get

the best darned image information you can off your camera. One of the maxims for end-

ing with the best result is starting with the best image—not one that you will use digital

image editing to enhance later merely for fixing mistakes. That means trying to capture

what you imagine you see in the viewfinder and in your imagination by using the equip-

ment you have. If you are a creative shooter, your images (and correction possibilities)

could gain from using RAW files, but it is not critical, and not everyone needs it for image

editing. Using RAW format offers the opportunity to fine-tune images coming from the

camera. For many who are critical of their work, this can provide advantages.

The biggest drawback to using RAW format is that the files stored in RAW format tend

to be much larger than those stored as JPEG. This means that you will either need to get

more storage for image capture (more media cards, or cards that have greater capacity), or

be prepared to fill up your media many times faster. In short, it can cost you more space
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when shooting, more processing time when correcting, and more archival space when

storing. However, the potential gain in quality and possibilities when processing may be

worth the drawback.

Whether the ability to work with RAW files is a benefit depends on your camera, its

processing, and your workflow. An honest evaluation of images you open from RAW

against those processed by the camera should give you a good idea of whether it is worth

the additional space—and the cost of additional storage. In most cases it is likely that it

will be, at least for manipulation.

Reader Requests
If you think of anything you’d like to see in a chart or table that would simplify what you

do, please make a request on the website or newsletter for the book, or send the request to

me by e-mail. If you need it, it can probably prove useful to a lot of people. I’ll make

requested information available as I can (possibly as part of the Hidden Power tools).

Your input is invaluable! I can’t guarantee I’ll get to everything, but I may have a quick

answer to help out.

E-mail: thebookdoc@aol.com

Website: http://www.hiddenelements.com/
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A
Absolute Colorimetric value, 266–267
acceleration in animation, 307, 307
Active Links in Web Photo Gallery, 288
Add Luminosity tool

for color correction, 126
for tones, 104

Add Noise filters
purpose and location of, 8
working with, 99–101

Add Photos dialog box, 289
Add To Sample Eyedropper tool, 134, 135
Add To Shape Area mode, 240
Add Zone option, 270
additive color, 17
adjustment layers for gradients, 59
Adobe Acrobat, 263
Adobe Gamma

for monitor calibration, 24–28, 24–29
purpose and location of, 7

Adobe RGB workspace, 29–30
alpha channels, 195–197
Amount setting for Unsharp Mask, 94, 96–98
analog film, 38
animation, 302–303

acceleration, deceleration, and constant speed
in, 307, 307

building, 306
compiling parts in, 308–314, 309–311
planning, 303–305, 304
in Web images, 283

anomalies in histograms, 83
Anti-Aliased option, 69

applying
duotones, 149–153, 150–152
gradient maps, 62–64

Arc setting for warped text, 245–246, 246
artifacts in JPEG images, 279
Auto Contrast setting, 333
Auto control for RAW files, 337
Auto Levels setting, 333

B
Background Eraser tool, 317
backgrounds

in compositing, 195, 195
for textures, 220
for transformations, 202–204
with vector images, 249

balance, color, 138–140, 138–139
Banner tab, 288
banner text, 288
Basic Color Correction tool, 7
bevels, 227
Bicubic interpolation, 36, 324–325
Bilinear interpolation, 36
Bilinear resampling, 225
binary formats, 328
bit depth

description, 328–329
for RAW files, 337

Bit Depth control, 337
bitmap images

characteristics of, 16–17, 17
color modes and purpose of, 326
profiles for, 32

Index
Note to the Reader: Throughout this index boldfaced page numbers indicate primary discussions of a
topic. Italicized page numbers indicate illustrations.
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black-and-white images. See also grayscale
images
converting color images to, 43–53, 49, 51–52
converting to color images, 53–55, 55
duotones for. See duotones

black color
in CMYK separation, 168–173, 170–173
in duotone printing, 154

bleeding, 272
bleedingheart.psd file, 124, 124
Blend Mask tool

for noise, 101
purpose and location of, 9
for selections, 186
for textures, 223
for tones, 103, 103, 107–108

blending modes
for blue component, 48
for color calculations, 158
for duotones, 153
for green component, 47
list of, 329–331
for luminosity, 50
for red component, 46

blue component, creating, 48–49
Blur filters

for noise, 99–101, 115
shortcut and description for, 318
for textures, 223

body text for Web Photo Gallery, 288
booklets, 272, 272
boring composition, 180
bottle.psd file, 132–133, 132
bricks in patterns, 217–218, 217–218
brightness setting

in monitor calibration, 25
for RAW files, 336
for tone, 130

Brush tool, 317
brushes for Clone Stamp, 74
Burn tool, 318
butterfly.psd file, 142–145, 142
buttons

for gradients, 61

rollovers for, 297–301, 297
shaping, 209–211, 211

C
calculations

for color, 156–159, 156, 158–159, 162–163
for selections, 188–190, 189

calibration
in image editing process, 4
of monitors, 22–28, 24–29
tools for, 7

camera RAW files
characteristics of, 331–333, 331
working with, 333–337, 334

cameras
resolution, 320–321
working with, 38

canvas size for windows, 225, 230, 230
captainhook.psd file, 247
capture problems, anomalies from, 83
cathode ray tubes (CRTs) in film recorders, 273
Channel Mix Grayscale tool, 162
channels

in compositing, 195–197
creating, 43–49, 49
mixing, 156–157, 160–162, 160–161

Channels palette, 14
cleanup

for color, 112–113, 112–113
for tone, 72–73

Clear Grayscale tool, 105
Clear Guides tool

for transformations, 202
in window creation, 229

Click state for rollovers, 297–298, 297
clipping in histograms, 79, 84
clipping paths for vectors, 248–251, 249–250
Clone Stamp tool

for color cleanup, 112
for patterns, 219
purpose and location of, 7
shortcut and description for, 318
for tone, 73–75, 73

Clouds filter, 220–222, 221
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CMY Color tool, 166
CMY Separation tool, 168
CMY Setup tool, 165
CMYK color mode, 17–18, 18, 173–174

converting RGB to, 18, 259–260
drivers for, 262–263
vs. duotones, 146–147
output settings for, 262
PDF files for, 262–263
previewing, 267–269
for printing, 17, 174–176, 175–176
separation, 163–164

black separation in, 168–173, 170–173
making, 164–168, 165–168

testing, 260–261, 261
CMYK.pdf file, 260–262
CMYK Process tool, 172, 174, 268
CMYK Process Effect tool, 172
color

in 16-bit images, 18
for animation, 302
balance, 138–140, 138–139
and bit depth, 329
calculations for, 156–159, 156, 158–159,

162–163
channel mixing for, 156–157, 160–162,

160–161
cleanup for, 112–113, 112–113
color modes, 12–13
Color Settings dialog box, 31–32, 31
color space, 29–30
converting

black-and-white images to, 53–55, 55
to black-and-white images, 43–53, 49,

51–52
in cropping, 184
curves for, 120–127, 122, 124
duotones for. See duotones
in GIF images, 278–280, 283
gradients. See gradients and gradient maps
hand-coloring, 57–59, 58–59
History Brush for, 140–145, 141–142
Hue/Saturation for, 130–131, 130
in image editing process, 4–5

in JPEG images, 278–279, 283
levels correction for, 116–120, 116, 118–119
luminosity extracted from, 50–51, 51
managing, 20–22
in monitors, 321
noise in, 113–116, 114–115
preferences for, 28
in printing, 258–259
saturation masking. See saturation masking
separating. See separations
as tone, 12–14, 13
tools for, 7–9
types of, 14–18, 16–18
for Web Photo Gallery, 288

Color Balance tool
purpose and location of, 8
working with, 138–140, 138–139

Color blend mode, 331
Color Burn blend mode, 330
Color Dodge blend mode, 330
Color Noise Reduction control, 337
Color Picker dialog box

for blue component, 48
for gradients, 65, 67
for green component, 47
for projected light, 54–55
for red component, 46
for Web Photo Gallery, 288

color ranges for saturation masking, 133–136,
134–136

Color Settings dialog box, 31–32, 31
color stops for gradients, 61
color temperature, 23, 27
Color tool, 8
Colorize option, 131
colspan attribute, 295
columns for slice positioning, 293–295, 294–295
Combine tool, 241
Combine Vectors tool, 249, 250
combining shapes, 241
comments in HTML, 283
Commit Mode for saturation masking, 136–137
Commit Transparency tool, 190
components, color, separating, 43–59, 49
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Composite layer for color and tone, 57
composition, 179

compositing elements in, 192–193, 194
alpha channels in, 195–197
arranging parts in, 195, 196
backgrounds in, 195, 195
extracting elements in, 193

cropping for, 183–185, 184–185
isolating elements in, 185–192, 186, 188–191
tips for, 180–183, 181–182
tools for, 8–9

compression
characteristics of, 327–328
of GIF images, 279
of JPEG images, 279

constant elements in animation, 308
constant speed in animation, 307, 307
contrast

boosting, 94–99, 96–98
curves for, 88–94, 89–93
gradients for, 64–65, 65
in image editing, 11–12, 11
in monitor calibration, 25

Contrast control for RAW files, 336
contrastfix.psd file, 92
Convert CMYK Before Printing option, 262
converting

black-and-white images to color, 53–55, 55
in CMYK color separation, 165–169, 167–168
color images to black-and-white, 43–53, 49,

51–52
RGB color

to CMYK, 18, 259–260
to Indexed Color, 16

text to vectors, 244
Copy tool, 8
Create Texture option, 78
Create Warped Text option, 245
Create Web Photo Gallery dialog box, 243, 

287, 287
Creation Setup dialog box, 288
Crop tool and cropping, 183

for composition, 183–185, 184–185
paper, 272

purpose and location of, 8
shortcut and description for, 317
for slices, 291
tools for, 8
Web images, 283

Crop1.psd file, 185
Crop2.psd file, 185
CRTs (cathode ray tubes) in film recorders, 273
curtainmap.psd file, 232–233
curtains

creating, 231–232, 231–232
shadows for, 232–234, 233–234

Curves tool and curves, 88, 225
for CMYK color separation, 173
for color correction, 120–127, 122, 124
for contrast, 88–94, 89–93
for duotones, 148–149, 148–149, 151–153,

151–152
interface for, 89–90
manipulating, 91–94, 91–93
purpose and location of, 8
for textures, 223, 223
in window creation, 225, 228, 228

Custom Colors tab, 288
Custom Phosphors screen, 26, 26
custom picture packages, 269–271, 270–271
Custom Shape tool and custom shapes,

242–244, 243
shortcut and description for, 317
for vectors, 240

cycles in animation, 303

D
damage

Healing Brush for, 77
planning for, 72
tools for, 7–8

dark tones, gradients for, 64–65, 65
Darken blend mode

for Clone Stamp, 75
quick keys and effects of, 330

darkroom sharpening effect, 162
DCS EPS files, printing, 174–176, 175–176
DCS Templates tool, 10
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deceleration in animation, 307, 307
decimating images, 35
Default Foreground and Background Colors

tool, 319
Define Pattern option, 219
delays in animation, 305
Delete Selections and Alphas tool, 196–197
depth of field in composition, 182, 182
Description field for ICC profiles, 25, 25
Difference blend mode

for CMYK color separation, 169
quick keys and effects of, 331
for saturation masking, 136

Difference Clouds filter, 221–222, 221
digital cameras

resolution, 320–321
working with, 38

Digital Negative (DNG) file formats, 332
directories for Web images, 283
dirty lenses, 74
Displace filter, 233, 234
Display & Cursors preferences, 74
Display Calibrator Assistant, 7, 23
Dissolve blend mode, 330
Distort option for Transform, 201, 201
distortions

in animation, 309
with transformations, 200–203, 200–202

Distribution Type setting, 99
DNG (Digital Negative) file formats, 332
Dodge tool, 318
dot pitch for monitors, 321
dots

halftone, 255–256, 255
printer, 254

dots per inch (dpi) resolution, 33
for printing, 254–255
for scanners, 319

Down state for rollovers, 297–298, 297
downloading Web graphics, 283–284
downsampling images, 35, 37
dpi (dots per inch) resolution, 33

for printing, 254–255
for scanners, 319

drivers for printing, 262–263
Drop Black tool, 137
drop shadows, 191, 191

in compositing, 195
for separations, 185–186
Soft Edge option, 227, 230

dual-purpose images, 37
Duotone Bar tool, 153
Duotone_Preview_bar.psd file, 153
Duotone Setup tool, 153
duotones, 145–146, 145

applying, 149–153, 150–152
creating, 146–149, 148–149
printing, 154, 154–155
for tonal corrections, 155–156, 156

duotoning.psd file, 149
duplication for tone, 75–76
dust

Healing Brush for, 77
preventing, 72

Dust and Scratches filter, 116

E
edges, printing to, 272, 272
8-bit images, 15, 18–19
effects in compositing, 195
efficiency of color, 18
elements

creating, 216–217
patterns for, 217–219, 217–220
textures for, 219–224, 221, 223

Ellipse tool
shortcut and description for, 317
for vectors, 240

Elliptical Marquee tool, 317
Embed Color Profile option, 30
embedded profiles, 20–21
Emboss filter, 221–223, 221
EPS format files

color modes and purpose of, 326
printing, 174–176, 175–176
separations for CMYK, 268

equipment for image editing, 38–39
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Eraser tool
in duplication, 76
shortcut and description for, 317
in window creation, 229, 229

evaluation tools, 7
Exclude Overlapping Shape Areas mode, 240
Exclusion blend mode, 331
Exposure control for RAW files, 336
extracting elements, 193
Eyedropper tool

for curves, 90, 92
purpose and location of, 7
for saturation masking, 134
shortcut and description for, 319
for tones, 78–79

F
factory settings for monitor, 24
fading contrast, curves for, 88–94, 89–93
field depth in composition, 182, 182
file types, 326–327

compression with, 327–328
for Web graphics, 278–281

fill layers
for blue component, 48
for green component, 47
for patterns, 219, 219
for projected light, 54–55
for red component, 46
for RGB, 54
for saturation masking, 133–134

film
analog, 38
duotones for, 154

film recorders
characteristics of, 273
resolution for, 35

filters
for grayscale, 14
sharpening. See sharpening
for textures, 220–222, 221

finger smudges, 72
fishhook shape, 242–244, 243
Fixed Size option, 209

flatbed scanners, 320
Flatten command, purpose and location of, 9
Flatten Image command and flattened images

for duotones, 153
for hand-coloring, 58
for separations, 45

flip books, 302
flipping in composition, 182–183
fly-away hair, 192
Focoltone colors, 148
fonts

converting to vectors, 244
for Web pages, 284
for Web Photo Gallery, 288

formats for vector images, 250
frames

for animation, 302–306, 304
for windows, 225–227, 225–227

Free Transform option, 201, 206
Full Color Management option, 32
full toned images in histograms, 82, 82

G
gamma

Adobe Gamma for, 24–28, 24–29
for tonal response, 23

gaps in histograms, 82–83, 86, 86
Gaussian Blur tool

for noise, 99–100, 115
purpose and location of, 9
for textures, 223

Gaussian distributions, 100, 100
GIF (Graphics Interchange Format)

for animation, 302
characteristics of, 278–280
color modes and purpose of, 326
for downloaded images, 283–284

Global Angle option, 227
Gradient Editor, 60–64, 60
Gradient Map dialog box, 60
Gradient tool, 59, 318
Gradient Used For Grayscale Mapping 

swatch, 63
gradients and gradient maps, 9, 59–61, 60
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applying, 62–64
buttons for, 61
for color, 66–68, 67
for contrast, 64–65, 65
for duotones, 147, 148, 153
editing, 62
masks for, 68–70, 68–69
names for, 61
opacity and color stops for, 61–62, 66, 68
for textures, 220, 221

Graphics Interchange Format (GIF)
for animation, 302
characteristics of, 278–280
color modes and purpose of, 326
for downloaded images, 283–284

grays
for color references, 120–127, 122, 124
for curves, 89
in halftone printing, 257

grayscale images. See also black-and-white
images
8-bit, 19
color representation in, 13–14
DCS files, 174
from duotones, 154
file size of, 34
gray tone levels in, 16, 16
profiles for, 32

green component, creating, 47–48
grip edges, 272
Group With Previous Layer option, 125–126
Guides tool and guides

purpose and location of, 8
for slices, 290, 291
for transformations, 202, 205–206
in window creation, 228–229

H
hair, fly-away, 192
halftone screening, 254
halftones

printing, 146, 255–258, 255, 258
resolution for, 35

halo effects, 96–97, 97, 163

hand-coloring, 57–59, 58–59
Hand tool, 319
Hard Light blend mode, 330
harmonious color for duotones, 147–148
Healing Brush tool

purpose and location of, 7
shortcut and description for, 318
for tone, 76–78

Hertz, 321
hex values, 15
Hidden Power tools, installing, 49
hiddenlibrary.psd file, 242
high-contrast images in histograms, 80, 81
high-key images in histograms, 80, 81
highlights

for color balance, 139
in histograms, 87

histograms
for color, 119, 119
purpose and location of, 7
for tones, 79–85, 80–84

History Brush tool
application of, 144–145
for color, 140–143, 141–142
preparation for, 143–144
purpose and location of, 9

History palette, 10, 10
Horizontal Type tool, 318
Horizontal Type Mask tool, 318
horsehead.psd file, 103, 103
hosts, web, 285
HSB color scheme, 65
HSB measurements, 130
HTML (Hypertext Markup Language), inserting

Web images in, 284–286
html tags, 286
hue, 56, 130
Hue blend mode, 331
Hue/Saturation dialog box

for blue component, 48
for CMYK separation, 167–168, 167–168
for color, 130–131, 130
in curtain creation, 232
for duotones, 145–146, 145
for green component, 47
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purpose and location of, 8
for red component, 46
for saturation masking, 134–136, 134, 136
in window creation, 228–229, 229

I
ICC profiles, 22–28, 24–29, 30
image editing process, 3–4

checklist for, 4
color in. See color
correction in, 5
equipment for, 38–39
preparation for, 4–5
purposing in, 6
resolution in, 32–33

for images types, 34–35
measuring, 33–34
resizing images, 35–37

tonal range and contrast in, 11–12, 11
Image Size dialog box, 174–175, 175
Image Size palette, 218
Image Size panel, 281
Image Size tool, 8
image tags, 286
imagesetters

duotones for, 154
vs. laser printers, 257

img tags, 294
Impressionist Brush tool, 317
Indexed Color mode, 15

compression in, 279
converting RGB to, 16
profiles for, 32

Info palette
for grays, 121
purpose and location of, 7
for tones, 78, 78

ink, 254
inkjet printing, 35, 254, 258–259, 259
input resolution, 319–321
inserting Web images, 284–286
Intent setting in printing profiles, 266–267
interpolation, 35–37, 323–325
Intersect Shape Areas mode, 240

Invert option for layers, 171
isolating elements, 185–186

J
JavaScript for rollovers, 297–301
JPEG (Joint Photographic Experts Group)

format
characteristics of, 278–279
color modes and purpose of, 326
for downloaded images, 283–284
from RAW files, 332–333

K
Kodak Photo CD scanning, 320

L
Large Photos tab, 288
laser printers

vs. imagesetters, 257
for PostScript printing, 254

Lasso tool
for duplicating, 76
shortcut and description for, 317

Layer Styles, 227, 227
layers

for 16-bit images, 15
for blue component, 48
for channel mixing, 160–161
for CMYK color separation, 165–170, 165
for color calculations, 158–159
for curves, 88
for duotones, 151–152
for gradients, 59, 68
for green component, 47
for Hue/Saturation, 131
for luminosity, 50
for masking, 104
for projected light, 54–55
for red component, 45–46
for RGB, 54
for saturation masking, 133
for snapshots, 141
for textures, 220–221
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LED (light-emitting diode) printing, 274
levels

for CMYK color separation, 173
for color correction, 116–120, 116, 118–119
for curves, 89
for histograms, 79
for saturation masking, 136
for tones, 85–87, 86

Levels tool, 7, 9
libraries for shapes, 242
light

for buttons, 209–211, 211
projected, 54–55, 55
tonal range of, 11–12, 11
for tree shadows, 211–215, 211–212, 214–216

light-emitting diode (LED) printing, 274
Lighten blend mode

for Clone Stamp, 75
quick keys and effects of, 330

lighting for monitor calibration, 24
lightness for tone, 130
lily.psd file, 50, 59
Limited Color Management option, 31
line art resolution, 35
line screen setting, 255
Line tool

shortcut and description for, 317
for vectors, 240

Linear Burn blend mode
for channel mixing, 161
quick keys and effects of, 330

Linear Dodge blend mode
for channel mixing, 160–161
quick keys and effects of, 330

Linear Light blend mode, 331
lines per inch (lpi) resolution, 33, 255–256
links

for rollovers, 300
for Web images, 283, 288

Liquify tool, 200
local contrast, sharpening, 97–99, 98
Lock Transparent Pixels option, 191
logos, scalable vector art for, 244–248, 246–248
lossless compression, 279

lossy compression, 327
low contrast images in histograms, 82
low-key images in histograms, 80, 80
lpi (lines per inch) resolution, 33, 255–256
Luminance Smoothing control, 337
luminosity, separating, 49–51, 51
Luminosity blend mode, 331
luminosity masks, 170, 170
Luminosity tool, 8

M
Magic Eraser tool, 318
Magic Wand tool

for selections, 187–188
shortcut and description for, 317

Magnetic Lasso tool, 317
Make Clipping Path option, 250
Make CMYK Split tool, 268
Make Guide tool

for slices, 290
for transformations, 202, 205–206
in window creation, 228

Make Work Path dialog box, 242
manual selections, 187–188, 188
maps, gradients. See gradients and gradient

maps
Marquee tool

Fixed Size option, 209
purpose and location of, 8
for slices, 291
for windows, 205

Mask mode for Selection Brush, 187
Masking tool, 7–9
masks

for color calculations, 159
for gradients, 68–70, 68–69
for isolating elements, 185
saturation, 131–133, 132, 136–138

in CMYK color separation, 169
color ranges for, 133–136, 134–136
preparation for, 133

for textures, 223
with tones, 102–108, 103–107

measuring resolution, 33–34
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Median filter, 116
medium-key contrast images in histograms, 82, 82
Merge command, 9
Merge Down option

for blue component, 48
in curtain creation, 231
for green component, 47
for luminosity, 50
for masking, 105
for red component, 46
in window creation, 225–226

Merge Linked option
for blue component, 48
for green component, 48
for red component, 47

Merge Visible option, 208
midtones

for color balance, 139
contrast for, 91, 91
masks for, 108

mixing channels, 156–157, 160–162, 160–161
Mode tool, 7, 9
moire patterns, 256, 258
monitors

calibrating, 22–28, 24–29
in image editing process, 4
profiles, 21–22
resolution and settings, 321–323

Monochromatic option for noise, 100
Move tool, 317
movies. See animation
moving curve points, 90
multi-layered approach for hand-coloring, 59
Multiply Blending Mode

for blue component, 48
for duotones, 150
for green component, 47
quick keys and effects of, 330
for red component, 46

multipurpose images, 37

N
names

gradients, 61

ICC profiles, 25, 25
Web images, 283

Nearest Neighbor interpolation, 36, 324–325
negatives, scanners for, 320
New command, 7
New Image dialog box, 309, 312
new_perspectives.psd file, 209, 211, 213
No Color Management option, 31
noise

in color, 113–116, 114–115
managing, 99–101, 100, 102
in textures, 222

Noise filter, 222
Normal blend mode

for Clone Stamp, 75
quick keys and effects of, 330

Normal state for rollovers, 297–298, 297
Note Paper filter, 221–222, 221

O
object creation, 224–225

curtains, 231–232, 231–232
placement in, 235, 235
shadows, 232–234, 233–234
window, 225–231, 225–230

oceansun.psd file, 63, 64
offset color, 258
Offset dialog box, 218, 219
offset printing, 273
Offset setting for Displace filter, 233
onMouse command, 298
onMouseOut command, 299
onMouseOver command, 299
opacity

in channel mixing, 161
in cropping, 184
for gradients, 61–62, 66, 68
for textures, 223

optimizing
tools for, 9
Web graphics, 281

Option/Alt key for selection, 73–74
Options bar for vectors, 240–241, 240
orchid.psd file, 185–192, 185–186, 188–191

348 ■ median filter–orchid.psd file
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orientation of guides, 205–206
Out state for rollovers, 297–298, 297
output resolution, 323
Over state for rollovers, 297–298, 297
overlap with slices, 290
Overlay blend mode, 330

P
packages, picture, 269–271, 270–271
packaging images, tools for, 10
Page Size setting, 269
Paint Bucket tool

for gradients, 69
shortcut and description for, 317

painting color changes, 140–145, 141–142
Painting Cursors, 74
PANTONE colors, 148
paper

perforated, 272
for printing, 264–266

Paste tool, 8
patching for tone, 75–76
Pattern Stamp tool, 318
patterns, 217–219, 217–220
PCT (PICT) format, 326
PCX (PC Exchange) format, 326
PDF files

color modes and purpose of, 326
for printing, 262–263

Pencil tool, 318
percentages

for channel mixing, 157
for curves, 89
for grays, 123

Perceptual value in printer profiles, 266–267
perforated paper, 272
performance of rollovers, 300
perspective, 200–202, 200–202
Perspective Transform mode

in curtain creation, 232
description, 201, 201

perspectives.psd file, 202–203, 218
phosphors, 23, 26, 26

Photo Bin, 289
Photo CD scanning, 320
photo-quality inkjet printers, 254
photo-quality paper, 265–266
Photoshop documents (PSD) format, 326
PICT (PCT) format, 326
Picture Edit Layout screen, 269, 270
picture packages, 269–271, 270–271
Pin Light blend mode, 331
Pixar Computer Images (PXR) format, 327
pixels

in camera resolution, 320
redistributing, 35

pixels per inch (ppi) resolution, 33–34, 323
placement DCS files, 174–175, 175
planning

animation, 303–305, 304
composition, 180
for damage control, 72

PNG (Portable Network Graphics) format, 327
point and shoot, 182
points for curves, 90
Polygon tool

shortcut and description for, 317
for vectors, 240

Polygonal Lasso tool, 208
for gradients, 68–69
purpose and location of, 8
for shapes, 242, 243
shortcut and description for, 317

Portable Network Graphics (PNG) format, 327
PostScript printing, 254–255
ppi (pixels per inch) resolution, 33–34, 323
preload function, 300
preloading images for rollovers, 300–301
Preset panel for Web graphics, 281
Presets panel for gradients, 61
Preview CMYK tool, 268
Preview panel for Web graphics, 281
Preview RGB tool, 55, 126
Preview Selection tool, 196–197
previewing CMYK color, 267–269
Print Preview dialog box, 266, 269

orientation of guides–print preview dialog box ■ 349
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Print Size option, 321
Print Space, 266
Print To File option, 262
printers, 39, 254
printing, 253

Adobe RGB workspace for, 30
CMYK for, 17

converting RGB color to, 259–260
for DCS EPS files, 174–176, 175–176

drivers for, 262–263
duotones, 154, 154–155
to edges, 272, 272
film recorders for, 273
halftones, 146, 255–258, 255, 258
LED, 274
offset, 273
output settings for, 262
paper for, 264–266
PDF files for, 262–263
picture packages for, 269–271, 270–271
previewing, 267–269
profiles for, 266–267
resolution for, 254–259
RGB for, 264
services for, 264
stochastic, 258–259, 259

printing plates, duotones for, 154
PRN files, 263
profiles

color, 20–21
ICC, 22–28, 24–29, 30
monitor, 21–22
printing, 266–267

projected light from tones, 54–55, 55
Prokudin-Gorskii, Sergei Mikhailovich, images

by, 13
capture of, 332
cleanup for, 112, 113
separations for, 45, 53

Proximity Match option, 78
PSD (Photoshop documents) format, 326
purposing in image editing, 6
PXR (Pixar Computer Images) format, 327

Q
quality

of JPEG images, 279
vectors for, 248, 248

R
Radius setting for Unsharp Mask, 95–98
ranges for saturation masking, 133–136
RAW files

characteristics of, 331–333, 331
color modes and purpose of, 327
working with, 333–337, 334

reader requests, 338
Rectangle tool

shortcut and description for, 317
for vectors, 240

Rectangular Marquee tool
shortcut and description for, 317
for window selection, 206

red component, creating, 45–47
Red Eye Brush tool, 318
redistributing

pixels, 35
tones, 85–87, 86

Reduce Color Noise tool, 116
Reduce Noise Filter, 7
refresh rate for monitors, 321–322
Relative Colorimetric value, 266–267
relative links for Web images, 283
Remove Black Color tool, 172
repeating images on Web pages, 283
resampling

images, 35
in window creation, 225

resetting monitors, 24
reshaping elements, 199

light and shadow for, 209–215, 211–212,
214–216

transformations. See transformations
resizing

in animation, 309
CMYK files, 174–175, 175
images, 35–37
vector images, 248

350 ■ print size option–resizing
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resolution, 32–33
of film recorders, 273
in image editing process, 4
for image types, 34–35
input, 319–321
measuring, 33–34
monitors, 321–323
of multipurpose images, 37
output, 323
for printing, 254–259
resizing images, 35–37
tools for, 7
of Web images, 280, 283

RGB color mode, 12–13
8-bit images in, 15
combinations in, 164
converting

to CMYK, 18, 259–260
to Indexed Color, 16

for printing, 264
profiles for, 32
workspace, 29–30

RGB layers for converting black-and-white
images to color, 54

RGB.psd file, 164
RGB tool, 8
RGBL color, 127
RGBL separations tool, 8
rollovers, 283, 297–301, 297
rose.psd file, 119–120, 119
rotating with Transform, 201, 201
Rotation control for RAW files, 337
Rounded Rectangle tool

shortcut and description for, 317
for vectors, 240

rows for slice positioning, 293–295, 294–295
rowspan attribute, 295
RSR file type, 327
ruler, 205

S
sample size for Eyedropper, 78–79, 92
samples per inch (spi) resolution, 33

saturation, color, 56, 130
Saturation blend mode, 331
Saturation control for RAW files, 336
saturation masking, 131–133, 132

in CMYK color separation, 169
color ranges for, 133–136, 134–136
masks for, 136–138
preparation for, 133

Saturation Masking tool, 138
Saturation value in printer profiles, 266–267
Save As command, 7, 9–10
Save For Web command, 10
Save For Web dialog box

for animation, 302
options in, 280–281, 282
for slices, 291

Save Optimized As dialog box, 281
Save Slice tool, 291
saving

slices, 291
tools for, 7, 9–10
vector images, 250
Web graphics, 280–281

scalable art, vectors for, 244–248, 246–248
scaling with Transform, 201, 201
scanners

maintenance tasks for, 38
resolution, 319–320

scattered highlights in histograms, 87
Scitext Continuous Tone (SCT) format, 327
Screen Blending Mode

for blue component, 48
for CMYK color separation, 172
for duotones, 150
for green component, 47
quick keys and effects of, 330
for red component, 46

screening in halftone printing, 254–256
scrolling in Web pages, 284
SCT (Scitext Continuous Tone) format, 327
seamless patterns, 217–219, 217–220
Selection Brush tool

shortcut and description for, 317
working with, 187

resolution–selection brush tool ■ 351
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selections
calculations for, 188–190, 189
for Clone Stamp, 73–74
for duplicating, 76
for Healing Brush, 77
for isolating elements, 185–191, 188–191
manual, 187–188, 188

SeparateShoes.psd file, 311
separations

CMYK color, 163–164
black separation in, 168–173, 170–173
making, 164–168, 165–168

color from tone, 43, 56–57, 57
borrowing tones in, 51–53, 51–52
channels for, 43–49, 49
color component in, 56–57, 57
compositing in, 53–55, 55
gradients for. See gradients and gradient

maps
hand-coloring in, 57–59, 58–59
luminosity in, 49–51, 51

for duotones, 154
Separations tool, 10
services for printing, 264
Set Background Color tool, 319
Set Foreground Color tool, 319
Settings control for RAW files, 336
shadows, 191, 191

for buttons, 209–211, 211
for color balance, 139
in composition, 181, 181, 195
in histograms, 87
masks for, 103–105, 103–105
for separations, 185–186
Soft Edge option, 227, 230
for trees, 211–215, 211–212, 214–216
for windows and curtains, 232–234, 233–234

Shadows control for RAW files, 336
Shape tool, 240–241
Shape From Selection tool, 242, 247
Shape From Text tool, 244, 246
Shape Selection tool, 240

shortcut and description for, 317
for vectors, 240–241, 243

shapes
light and shadow for, 209–215, 211–212,

214–216
printer dots, 254
transformations for. See transformations

Sharpen tool
shortcut and description for, 318
for unsharp masking, 163

Sharpen Plus tool, 163
sharpening

calculations for, 162–163
local contrast with, 97–99, 98
Unsharp Mask filter, 94–97, 96–97

Sharpness control for RAW files, 337
shortened tonal range, 83–85
Show More Options option, 266
sidewalk object, 204, 205
silhouette.psd file, 85
silhouettes, 80
Simple Inner Bevel option, 227
16-bit images, 18–19

vs. 8-bit, 15
advantages and disadvantages of, 337–338

size
16-bit images, 15
in animation, 309
in camera resolution, 320
canvas, 225, 230, 230
CMYK files, 174–175, 175
halftone dots, 255–256
image files, 33–34
monitors, 321–322
picture packages, 269
tools for, 8
vector images, 248
Web graphics, 282–284

sketching
animation, 303
slices, 290, 291
Web images, 284

skew for shadows, 214, 214
Skew On Center keys, 214
Skew option for Transform, 201, 201
skin tones, 120

352 ■ selections–skin tones
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Sky Gradient gradient map, 69
slice1.jpg file, 294
slice5.jpg file, 294–295
slices, 289

cutting, 290–292, 290–291
positioning, 292–296, 294–295

slicetext.html file, 292
Smudge tool, 318
smudges, 72
Snap To Grid feature

in curtain creation, 231
in window creation, 230

Snap To option for slices, 291
snapping, curves for, 88–94, 89–93
Snapshot tool, 140–141
snapshots, 140–141, 141
Soft Edge option, 227, 230
Soft Light blend mode, 330
software, 39
Solid Color option

for blue component, 48
for green component, 47
for red component, 46

spi (samples per inch) resolution, 33
spikes in histograms, 79
Split Luminosity tool

in color separation, 50–51, 169
in unsharp masking, 163

Split RGB tool, 49
for channel mixing, 161
for color correction, 125
for layers, 54
for transformations, 202

Split RGB w-Preview tool
for channel mixing, 160–161
for separations, 55

Split RGBL tool
for color correction, 127
for unsharp masking, 163

Sponge tool, 318
spot colors, 146, 148
Spot Healing Brush tool

shortcut and description for, 319
for tone, 78

Spyder device, 29

src reference, 296
sRGB workspace, 29–30
states for rollovers, 297–298, 297
stochastic printing, 254, 258–259, 259
Stops options for gradients, 62
Stretch To Fit option, 233
Style Settings dialog box, 227, 227
Styles and Effects palette, 227
Subtract From Sample Eyedropper tool, 134
Subtract From Shape Area mode, 240
subtractive color, 17
swap command, 298–301
Switch Foreground and Background Colors 

tool, 319

T
tables for slices, 292–295, 294–295
Tagged Image File Format (TIFF)

color modes and purpose of, 327
from RAW files, 332

tails in histograms, 87
Targa (TGA) format, 327
targets for color correction, 131
td tags, 292–296
teapot image, compositing, 193–197, 194–196
temperature, color, 23, 27
Temperature control for RAW files, 336
templates for Web Photo Gallery, 287
testing

CMYK color, 260–261, 261
paper, 265–266
Web pages, 284

text
converting to vectors, 244
warped, 245–247, 246–247

Text To Shape command, 9
textures, 219–224, 221, 223
TGA (Targa) format, 327
third-party printer drivers, 262
35 mm film, 273
Threshold setting

for levels, 207, 208
for noise, 222
for Unsharp Mask, 95

sky gradient gradient map–threshold setting ■ 353
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thumbnails in Web Photo Gallery, 286–288
TIFF (Tagged Image File Format)

color modes and purpose of, 327
from RAW files, 332

timing for animation, 302
Tint control for RAW files, 336
tolerance levels for Unsharp Mask, 95
tonal range

for duotones, 148
in image editing, 11–12, 11

toner, 254
tones and tonal corrections, 71

for black-and-white images, 51–52
brightness for, 130
cleanup for, 72–73
Clone Stamp for, 73–75, 73
color as, 12–14, 13
curves for, 88–94, 89–93
duotones for, 155–156, 156
duplication for, 75–76
Eyedropper for, 78–79
healing tools for, 76–78
histograms for, 79–85, 80–84
in image editing process, 5
masking with, 102–108, 103–107
noise in, 99–101, 100, 102
redistributing, 85–87, 86
separating from color. See separations
sharpening for, 94–99, 96–98
tools for, 7, 9

toolbox, 316–319, 316
tr tags, 292–296
Transform tool

purpose and location of, 8
working with, 200–203, 201–202

transformations, 199–203, 200–202
in animation, 309
backgrounds for, 202–204
sidewalk object, 204, 205
tree object, 207–209, 207–209
window object, 205–206, 206

transparency, 190
Transparent Grayscale tool

for color calculations, 159
for tones, 107

tree objects
isolating, fixing, and positioning, 207–209,

207–209
shadows for, 211–215, 211–212, 214–216

TRUMATCH colors, 148
2-bit images, 328
24-bit images, 328

U
Undo History palette, 213
Uniform noise distributions, 99–101, 100
Units & Rulers option, 205
unsharp masking

calculations for, 162–163
Unsharp Mask filter, 94–97, 96–97, 162–163

Unsharp Masking tool, 9
Up state for rollovers, 297–298, 297
upsampling images, 35, 37
URLs for web pages, 285
Use All Layers option, 112
Use Cache For Histograms option, 86
Use Global Light option, 227, 227

V
vectors, 239

clipping paths for, 248–251, 249–250
converting text to, 244
for halftone printing, 258, 258
making, 240–244, 240, 243
for scalable art, 244–248, 246–248

Vertical option for guides, 205–206
Vertical Type tool, 318
Vertical Type Mask tool, 318
View Single Gamma Only option, 26
View Source option, 286
viewing size of monitors, 321–322
vince.psd file, 113–116, 114–115
Visited Links for Web Photo Gallery, 288
Vivid Light blend mode, 330

W
wallpattern.psd file, 222
warped text, 245–247, 246–247
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wavedirt.psd file, 74
Web graphics, 277

animation. See animation
download minimization, 283–284
file types for, 278–281
inserting, 284–286
resolution for, 34–35, 280, 283
rollovers, 297–301, 297
saving, 280–281
size of, 282–284
slices, 289

cutting, 290–292, 290–291
positioning, 292–296, 294–295

Web Photo Gallery, 286–289, 287
wedding images, exposure problems in, 84
White Balance control for RAW files, 336
white points, 23, 27, 27

white-to-black gradients for duotones, 147, 148
window objects

creating, 225–231, 225–230
isolating, fixing, and positioning, 205–206, 206
placing and fitting, 235, 235
shadows for, 232–234, 233–234

Wireless BMP format, 327
wisps of hair, 192
WiziWYG utility, 23
workspaces, 29–30
worms, drawing, 246–247, 246–247
Wrap Around option, 218

Z
zones for picture packages, 270
Zoom tool, 319

wavedirt.psd file–zoom tool ■ 355
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This image by Prokudin-Gorskii, titled Man in Uniform, Seated on Chair, Outside, was taken around
1910 by using color filters on the lenses to separate color into red, green, and blue components.
[Chapter 1]

Blue light (using a blue lens filter)

Original scene

Green light (using a green lens filter) Red light (using a red lens filter)
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Red light

Green light

Blue light

Red Tone

Green Tone

Blue Tone

The filtered light was captured 
on black-and-white glass plates,
encoding the color information
before there was ever color film,
but as three separate color plates
representing the red, green, 
and blue components as tone.
[Chapter 1]

4385color.qxd  11/6/04  9:01 PM  Page 2



With Photoshop Elements and Hidden Power tools, you can use color properties and layer modes to
reverse the process and re-create color in the scene that Prokudin-Gorskii shot almost 100 years ago.
[Chapter 1]

Restored original

Red Tone Green Tone Blue Tone

Red light Green light Blue light
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Any color image breaks down into the red, green, and blue components when you use the RGB sepa-
ration process enabled by the Hidden Power tools. [Chapter 2]

Original

GreenRed Blue
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Any image will also break down into the color and luminosity components when you use Hidden
Power color and luminosity separation tools. [Chapter 2]

Original

Color Luminosity
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Tone and color work together to create what you see in an image. Hidden Power tools show how layer
properties can be used to help you hand-color tone, creating new art from any image. [Chapter 2]

Original Original converted to tone

Layered result Hand-colored lily
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By separating color and tone with Hidden Power tools, either or both can be optimized
and enhanced to produce better image results. At the top of this diagram, color is sepa-
rated from tone; when the color is adjusted (bottom), color and tone are reassembled
for improved final results. [Chapter 2]

Combined result

Original

Tone Enhanced color

Tone Color
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Learning to control noise and blur can eliminate image
problems while retaining the realistic look of objects.
Hidden Power techniques for applying blurring and
noise are used here to improve skin tone. [Chapter 3]

Original

Close-up of original

Close-up of mixed blur and noise

Close-up of blur only
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Applying Hidden Power tonal manipulations and masking
adjustments can help you take images on the brink of being
useless and bring them back to life. [Chapter 3]

Before

After
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Simple adjustments with Levels can correct color imbalances, brighten tone, and make
images more dynamic in seconds. [Chapter 4]

Before

After
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Level adjustments can enhance tone and detail without changing image color. 
[Chapter 4]

Before

After
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Applying Curves with Hidden Power tools and techniques on image color components
can fine-tune color adjustments. [Chapter 4]

Before

After
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Enhance existing color, target color correction to color
ranges, and selectively make color adjustments by using
advanced Hidden Power masking techniques. [Chapter 5]

Before

After
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Reduce color noise in
your digital camera
shots easily by using
Hidden Power tools
that isolate color from
tone in your images.
[Chapter 5]

Before

Close-up
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After

Close-up
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Recolor image objects or apply filter effects to select areas of your images with brushes.
Hidden Power tools use layer properties and masking to imitate Photoshop’s exclusive
History Brush. [Chapter 5]

Before

After
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Learn several duotoning techniques to impart some
color and artistic vision into black-and-white images.
Make true duotone effects and print them by using
Hidden Power tools and techniques for image results
with greater dynamic range. [Chapter 5]

Duotone color result

Original tone

Spot color Black
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Color your images with duotone effects, or use properties of duotoning to correct and enhance
black-and-white results. [Chapter 5]

Original

Duotone result Final tone

Duotone component (spot color)Duotone component (black)
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Hidden Power’s masking, calculations, and color mixing techniques can
help you gain unique control over colors in your image. [Chapter 6]

Purple flowers

Blue flowers

Original pink flowers
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Controlling the blur and brightness around a subject by using
selection and masking can help it stand out in the image or
enable you to recolor any way you want. [Chapter 6]

Darkened, blurred background

Recolored

Original
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Understand how to create and use image patterns to rebuild image areas. Some selec-
tive work and randomizing patterns you create can make a patterned fill more realistic
and all but undetectable. [Chapter 7]

A simple fill pattern

An adjusted fill pattern
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Composition changes may require adjusting or re-creating shadows for realistic
results. These images show the original image (with a shadow distorted by the cam-
era lens), a simple replacement drop shadow, and a more accurate replacement
shadow created by using objects from the image. [Chapter 7]

The original image

A more accurate shadow replacementA simple replacement drop-shadow
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Image objects such as this window can be created from scratch and given realis-
tic dimension by using shapes, shadows, noise, and a few Hidden Power tricks.
[Chapter 7]
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In a similar way that you can take apart color and rearrange or rebuild it by using
Hidden Power tools, you can dissect and rebuild this image entirely to improve the
composition. [Chapter 7]

Original

C
O

P
Y

R
IG

H
T

 ©
 2

00
4 

P
H

O
T

O
SH

P
E

R
E

, W
W

W
.P

H
O

T
O

SP
H

E
R

E
.C

O
M

4385color.qxd  11/6/04  9:02 PM  Page 24



The adjusted composite
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It is possible to make custom illustrations, logos, and other high-
quality vector art with Photoshop Elements and Hidden Power tools.
This figure shows a breakdown of the parts of an image created
entirely with customized vectors. The composite result appears on
the facing page. [Chapter 8]
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Captain Hook’s logo can be scaled infinitely and reapplied to any project, from a business card to
a billboard and beyond. [Chapter 8]
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In CMYK color, all color is represented by cyan, magenta, yellow, and black. This fig-
ure shows a breakdown of the test image into pure CMYK colors. Being able to con-
trol your CMYK output can be the key to getting better color in print. [Chapter 9]
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In web design, you can use up to six rollover states to control how the page looks and what happens
as the visitor navigates your website. [Chapter 10]

Normal

Over

Down

Click

Out

Up
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Employing several Hidden Power tools, you can perform “impossible” stunts
such as creating custom CMYK color separations from your RGB images with-
out leaving Photoshop Elements and creating CMYK files for print. [Chapter 5]
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Images can be built almost entirely by using filters and effects such as these snake and fire effects. Special
effects can be discussed on the Hidden Power website and list server. [http://www.hiddenelements.com]

4385color.qxd  11/6/04  9:02 PM  Page 31



A lot of your work will be simplified or made pos-
sible by using the Hidden Power tools found on the
CD. Access the Hidden Power tools by installing
them from the CD (please follow the instructions 
in the Introduction carefully). After installing the
tools, open them from the Styles and Effects palette
(Windows ➔ Styles and Effects). Choose Effects in
the drop-down list at the left, choose one of the
Power categories from the category drop-down list
at the right, and then double-click the Hidden Power
tool of choice.
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